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Preface

Before using this documentation, we recommend that you review the document conventions (see 
“Document Conventions” on page 14).

Detailed information about Altiris products is included in each product’s documentation. The 
product’s documentation is installed when the product is installed. To access Altiris product 
documentation from the Web, go to our documentation Web page at www.altiris.com/support/
documentation.

If you have questions that are not answered in the documentation, we recommend that you use one 
of our support options (see “Support” on page 15).

If you have feedback about this documentation, please send an e-mail message to our documentation 
group at doc@altiris.com. 

Document Conventions
The following table describes the conventions used in this document.

Document Conventions

What you see Meaning
Altiris Infrastructure 
Guide

References to other documents are italicized.
Note Most references to Altiris documents are hypertext links to those 
documents. For these links to work, the target document file must be in the 
same location as the source document.
If viewing PDF documentation from our product CD or where the 
documents were installed on your hard drive, the links will work.
If viewing a PDF document from our web site, the links to other Altiris 
documents will not work. (The documents are stored in different folders).
If you download PDF documents from our web site and place them in the 
same folder, the document references will link to the other PDF document 
provided the target PDF document is in the folder.

Interface Element Name Buttons, menu items, tabs, and field names are displayed in bold text.
File > Save A series of mouse selections are represented in this format. The above 

example means click on the File command on the menu bar, and then click 
on the Save command.

server name/altiris/
documents

A value in a path that depends on the user’s system is in italics. In this 
example, server name needs to be replaced by the name of the user’s 
server.

set variable = 123 Sample code is in Courier font.
www.altiris.com Links to web pages are in blue text.
Deployment Solution Product Guide 14
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Support

Altiris is committed to providing world-class technical support and professional services to its 
customers. Included with every product purchase is complimentary Electronic Support. For 
customers who want a higher level of support, Altiris offers many fee-based services ranging from 
Priority Support, which includes priority telephone and priority e-mail support, to on-site 
consultation.

Before Contacting Support
We recommend that you do the following before contacting Support:

• Download and install the latest version of the product and product updates from our web site 
(www.altiris.com).

• Read the product Release Notes. The Release Notes contain important information on the current 
release including limitations and application-specific workarounds. Many customer questions 
are answered in the Release Notes.

• Review the information in the Altiris support forums (go to www.altiris.com and click on 
Support and then Forums). If you cannot find the answer to your question in the forums, you can 
post your own question. The forums are monitored by our Support engineers, who will help you 
with your questions.

Support Contact Information
Altiris is a global organization with operational centers in the following geographies:

• Americas in Lindon, Utah covering North and South America
• Asia Pacific in Sydney, Australia
• Europe, Middle East, and Africa (EMEA) in Landau, Germany
Contact information for each of these operational centers is available at www.altiris.com/contact.

When contacting Support, please include the following information in the e-mail or have it ready 
when calling:

• Your name, e-mail address, and phone number
• Product name and product version
• Specific details about the problem, including specific system messages, error codes, and logs
• Details about your system, including the operating system, applied services packs, hardware 

configuration, network details, and other applications running on the system.

Training
To ensure that you are using Altiris products in the most effective way, Altiris offers in-depth, 
instructor-led, hands-on courses. These courses will help you quickly learn the optimum methods 
for installing, configuring, and managing your network using Altiris’ award-winning products. For 
information about Altiris training, go to the following web site:

• http://www.altiris.com/services/training/
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Getting Started
If this is your first-time evaluation of Deployment Server then you have come to the right place. 
Read the Introduction to Deployment Solution chapter for to an overview of  features and 
reintroduce yourself to its value proposition and possibilities.

For long-time users, view the New Features chapter for a list of enhancements and additions to 
Deployment Solution 5.6. You can view a list of each feature with a brief description or jump to a 
full description in the documentation.

Quick Links

Introduction to Deployment 
Solution (page 17)

Basic features are introduced for a quick overview 
of Deployment Server.

New Features in Deployment 
Solution 6.0 (page 30)

Updates and enhancements are listed along with a 
brief description and links to the documentation.



 

Introduction to Deployment Solution 

Take control of all your computer resources across your organization using Deployment Solution 
deployment and management tools. Take a seat at any Deployment console to remotely manage all 
types of devices throughout your organization — handhelds, notebooks, desktops, switches and 
servers — through all phases of computer deployment and lifecycle management. Schedule remote 
system upgrades, distribute patches and drivers, re-image computer hard drives, or migrate large 
groups of users to new computers without missing a single custom setting or installed program. Use 
Deployment Solution to handle daily tasks and depend on it for occasional big jobs, like disaster 
recovery or large-scale software updates. And do it all remotely from any Deployment console on 
any device with a connection to your WAN or LAN.

That’s the attitude behind Altiris Deployment Solution: Increase access and productivity while 
decreasing costs and IT response time. You will appreciate the simple, easy-to-use graphical 
consoles to organize computer groups, schedule deployment jobs, and build computer packages and 
disk images. It’s easy. It’s powerful. It conforms and scales to your infrastructure. Go ahead—take 
some time and learn to take control.

Altiris Deployment Solution integrates a Windows-based Deployment Server systems with the web-
based Altiris Notification Server solutions and services. A Deployment Server system includes real-
time, high-bandwidth applications, tools, and utilities for daily management of computer resources 
at the local level. To manage multiple Deployment Server systems across your organization, 
Deployment on Notification Server centralizes reporting and management, integrating additional 
web solutions and unifying IT operations for the whole organization.

What Can I Do with Deployment Solution?
Deploy. Manage. Migrate. Regardless of your organization’s size or special IT requirements, 
Deployment Solution provides a complete system to cut costs and improve response times for both 
big and small jobs.

Manage from a remote console. Deploy, control, and manage all types of computers across your 
organization from a remote Deployment console. Use the feature-rich Deployment Server Console 
for real-time management of computers, or access the Deployment Server Web Console from a web 
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browser on your preferred OS. Use Deployment on Notification Server to integrate reporting and 
management across multiple network segments and to provide scalability and integration with other 
web management solutions. See “Managing from the Console” on page 97.

Migrate data, applications, and personal settings. Through easy-to-use wizards, migrate data and 
settings from a retiring computer to a new computer by capturing desktop, network, and application 
settings. Redeploy these personal settings remotely from a Deployment console. See “New Job 
Wizard” on page 153.

Upgrade and install software. Manage system software on a day-to-day basis for desktops, servers, 
notebooks, and handhelds to upgrade applications, install service packs, set up printer drivers, and 
modify systems as needed. Deployment Solution provides upgrade capabilities for all mobile 
computers by deploying to remote sites as needed by traveling personnel. See “Distributing 
Software” on page 167. 

Deploy computers in large groups. Easily deploy and configure large numbers of computers 
across an organization. Install hard disk images to groups of new or existing computer types using 
multicasting features. Install software and personality settings with common applications, data and 
drivers. Run post-configuration jobs or automated scripts to assign unique security IDs, configure 
user names, and set IP addresses using deployment jobs. See “Managing Computers” on page 111.

Deploy and manage servers. Administrate all types of web and network servers, including ultra 
high-density server board inserts. Automatically redeploy servers based on deployment history and 
saved server images, or use automated scripted installs with easy-to-create answer files. Operating 
systems can be installed as image files or run as scripted installs—or as a combination strategy 
(especially nice for managing ultra-dense server farms). See “Deploying and Managing Servers” on 
page 145.

Respond to common help desk requests. Remotely browse, diagnose, and repair problems on 
systems without ever leaving a Deployment console. Detailed hardware and software inventories, 
along with remote control and chat features, help simplify remote diagnosis of common problems. 
See “Remote Operations” on page 136.

Recover from disaster. Ease the pain of accidents by automatically backing up and restoring 
configurations, personalities, registries, partitions, and drives remotely from a Deployment console. 
Using the saved history of all deployment jobs assigned to a computer makes it easy to restore a 
system to a previous working state. See “Restoring a Computer from its Deployment History” on 
page 138.

Features of Deployment Solution
Deployment Solution can be installed and implemented locally as an independent Deployment 
Server system on a single LAN segment or site, or scaled across the enterprise using Deployment on 
Notification Server to consolidate all deployment and IT management efforts.

Each Deployment Server system includes services, applications, and utilities for high-bandwidth, 
real-time deployment, and includes a web console to perform IT duties from a web browser. 
Deployment on Notification Server integrates multiple Deployment Server systems and adds other 
web IT solutions. 
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Deployment Server system
For local sites, the Deployment Server system allows you to run high-bandwidth, real-time 
management jobs from a remote console. The Deployment Server Console is the primary user 
interface to deploy computers, image hard disks, migrate user settings and programs, run scripted 
installs, remotely control computers, and perform other tasks for real-time deployment and 
management of computer resources. Daily IT requests and jobs formerly completed by visiting each 
desktop, server or portable computer in the organization can now be completed from your 
Deployment Server Console. 

Components of the Deployment Server system can be installed on a single computer (a Simple 
install) or distributed across several local computers (a Custom install). A Custom installation allows 
you to install Microsoft SQL Server and access the Deployment Database on a separate computer. 
The Client Access Point, Deployment Server, PXE Server, and Deployment consoles can also be 
distributed to separate computers. The Deployment Server Web Console provides real-time 
management from a web browser and, like the Deployment Server Console, displays data directly 
from the Deployment database. See “Deployment Server Components” on page 56.

Deployment on Notification Server
For large organizations, multiple Deployment Server systems can be administered by a central 
Notification Server system to provide regional reporting for all computer resources and deployment 
activities. Deployment on Notification Server is a wide-area network system that integrates 
computer deployment and management functionality into the Altiris Notification Server system, 
furnishing enterprise-wide reporting and package distribution across HTTP connections. 

Deployment on Notification Server organizes Deployment Server systems from each network 
segment or site and consolidates operations from a web console. To extend management capabilities, 
you can combine additional web solutions from the Altiris Client Management Suite—Inventory, 
Application Management, Carbon Copy, Software Delivery and other solutions—to meet your 
unique needs. Deployment on Notification Server extends scalability for large enterprises and 
integrates additional web solutions across the organization. 

Managing from the Deployment Console
Deployment Solution includes several types of user interface consoles for different types of 
computer management tasks and access requirements. The Deployment Server Console (a 
Windows console) is included with the Deployment Server system and provides complete 
deployment and management features. The Deployment Server Web Console provides web 
browser access to individual Deployment Server sites. Deployment on Notification Server 
integrates the view of multiple Deployment Server sites and integrates with additional web 
solutions.

Deployment Server Console
IT technicians managing local sites use the Deployment Server Console installed with the 
Deployment Server system to take advantage of comprehensive deployment features. The 
Deployment Server Console is the only full-featured user interface that integrates all utilities, tools, 
features, and applications necessary to complete all types of deployment and management jobs. 
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Note The Deployment Server Console is the only console that allows you to create and build jobs. 
You can assign and schedule jobs from the Deployment Server Web Console and Deployment on 
Notification Server, but you cannot create or import them from these web consoles.

Like all Deployment consoles, the Deployment Server Console is divided into several operational 
panes:

• The Computers pane displays all computer resources managed by a Deployment Server system. 
It includes features to right-click and remotely execute operations on managed computers. From 
this pane you can drag computer icons to job icons to schedule deployment and management 
tasks.

• The Jobs pane executes and schedules deployment tasks for selected computers. Using one or 
more sequenced jobs, you can image, configure computer settings, distribute packages, and run 
scripts by dragging Job icons to individual computers or computer groups and scheduling an 
advantageous time to execute. It lets you schedule deployment jobs by dragging computer icons 
to job icons, or vice versa.

• The Details pane provides information and features to filter computers by type and build 
deployment tasks. It extends the user interface features when working in the Computers and Jobs 
panes. 

• A Shortcut and Resources pane organizes and provides easy access to MSI files, RIPs, image files 
(IMG), Personality Packages (EXE), and other file types. It functions as a library for packages 
used when building jobs in the console. 

In addition, the Deployment Server Console furnishes your IT team with easy-to-use wizards to 
simplify and expedite common deployment tasks. See also “Managing from the Console” on 
page 97.

Deployment Server Web Console
The Deployment Server Web Console provides a web interface accessible from any supported web 
browser for real-time management of computer resources. Like the Deployment Server Console, the 
Deployment Server Web Console accesses computer and deployment data directly from the 

Shortcuts and 
Resources pane

Computers pane

Jobs pane

Details pane
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Deployment Database. This web console allows management from Linux, Windows, and other 
operating systems for all types of managed computers, including management of Linux servers and 
workstations. 

The Deployment Server Web Console provides real-time access to Deployment Server systems. It 
is a stand-alone console that uses web services and protocols to deploy, migrate, and manage 
computers from a web browser. The Deployment Server Web Console can be installed on the same 
computer as the Deployment Server system or on another remote computer running Microsoft IIS. 
See also “Deployment Server Web Console” on page 59.

Deployment on Notification Server
Deployment on Notification Server links all Deployment Server systems together for reporting, 
scheduling, and remotely managing across a wide area network. It provides a web interface to 
manage multiple Deployment Server installations and integrate additional management solutions 
into your enterprise system. From the Deployment view on Notification Server you can generate 
enterprise reports and distribute corporate software and network configuration settings to all 
managed computers. 

Notification Server provides built-in features, such as 

Select 
computers

Assign jobs 

Schedule 
jobs 

Integrate web 
solutions

Wizards and 
help buttons

Computers pane

Details pane

Jobs pane
Deployment Solution Product Guide 21



 Introduction to Deployment Solution Features of Deployment Solution

 

• Alert Manager for help desk resolution 
• Package Servers to automatically distribute package files across the organization 
• Inventory policies and reporting templates
• Configuration events and other basic system functions
Deployment on Notification Server allows you to expand functionality by installing additional web 
solutions and combining multiple Deployment Server systems.

Managing Computers
From the Deployment Server Console you can directly manage all types of computers to perform 
immediate deployment and management operations. From the Computers pane of the console, 
computer resources can be grouped by location, department, type (portables, desktops or servers) 
and organized to reflect your environment. You can right-click computers to run on-the-fly 
operations or quickly schedule deployment jobs, or access each computer or computer group to 
change network settings, run a quick disk image, remotely control the managed computer, set up a 
chat session with the user, or perform other immediate management tasks.    

Each computer and computer group is identified by a unique icon in the console. To access a 
computer, simply click its computer icon to view configuration settings or right-click to run specific 
deployment and management operations. Computer icons can be dragged to job icons to schedule 
and run pre-configured deployment tasks. In the web consoles, you can manage computers using 
drop-down list boxes, secondary dialog boxes, and other familiar web features. See also “Managing 
Computers” on page 111.

 

Managing with Computer Icons
Computer types and deployment status are identified by icons displayed in the Computers pane of 
the console. Group icons can be expanded to view the member computers, and computer types can 
be identified by specific icons: handhelds, desktops and notebooks, servers, computer groups, and 
Linux computers. Computer icons can also identify the state of the managed computer—a logged in 
user, a computer waiting for further instructions, a user not logged in and other states of 
deployment—when performing operations or executing deployment tasks on a selected computer. 
See also “Viewing Computer Details” on page 112. 

  

This computer icon identifies a managed desktop or notebook 
computer that is active and has a user logged on. 

 

This computer icon identifies a managed Windows network or 
web server that is active and has a user logged on. 

This icon identifies a Linux computer.

 

 

 
 Computer types and status are identified 

by computer icons in the Computers pane 
of the Deployment Server Console

 

Computer groups

Handheld

User logged in and 
computer connected

Linux Server

Virtual computer
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Additional icons represent deployment status, inactive computers, computers running a deployment 
job, and new computers. See also “Viewing Computer Details” on page 112.

Immediate Management Access from the Console
From the Deployment Server Console you can select a computer and right-click to actuate various 
computer configuration and management operations for a specific computer in your system. You can 
remotely control the computer, chat, create new deployment tasks, reboot, restore the hard drive, 
view deployment history, and perform other advanced tasks using commands on this menu. Some 
operations, such as changing configuration settings, copying files, and creating quick disk images, 
create job files automatically. See also “Remote Operations” on page 136.

For complete information about Deployment consoles, see “Managing from the Deployment 
Console” on page 19. 

Building and Scheduling Deployment Jobs
Jobs are designed as objects with defined deployment tasks. Jobs can be built, organized, and 
scheduled to run on selected computers or computer groups from the Deployment Server Console. 
Jobs automate both simple and complex IT administrative duties — from complete deployment and 
migration tasks to simple DOS commands and modification of configuration settings. You can 
schedule jobs from any of the Deployment consoles, but jobs can only be built in the Deployment 
Server Console. 

Deployment jobs give you the ability to organize, store and assign administration tasks for each 
computer or computer group. You can create and deploy images, back up registry files, run scripted 
installs, or make post-imaging changes such as adding printers and applications. You can deploy and 
run packages—RIPs, images, personality packages, MIS programs, and others—to migrate 
applications, configure computer settings, deploy complete hard disk images, and much more. You 
can also assign jobs with conditions to run only on defined computer types. See also “Building and 
Scheduling Jobs” on page 152.

Jobs are built in the Deployment Server Console by creating a job name (identified by a job icon in 
the console) and adding predefined deployment tasks. Tasks such as Distribute Software, Run Script, 
or Create Disk Image are added and executed sequentially when scheduled to run on computers or 

This icon identifies a handheld computer.

This icon identifies a virtual computer with user account settings 
that are not associated with a new computer.

Right-click a computer in the Computers pane 
to view a list of commands to run on the 
selected computer. 

The New Job Wizard and Create Quick Disk 
Image guide you through operations to migrate 
computers or image hard disks. 

You can also access a computers using the 
Remote Control command or use Chat to set 
up instant messaging with users. 
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computer groups. And even within computer groups, different jobs can be assigned to different 
computer types based on OS, hardware, or other specified condition. See also “Deployment Tasks” 
on page 159.

When a job is built, it can be scheduled to run immediately or at any other advantageous time when 
traffic is low or at desired intervals. In addition, you can use bandwidth throttling features to 
schedule and run deployment tasks to large groups without affecting network traffic. See also 
“Scheduling Jobs” on page 158.

From the Deployment Server Console, you have several options when creating deployment jobs:

• Create common deployment tasks quickly and easily using the New Event Wizard.
• Import jobs from other Deployment Solution systems.
• Manually create deployment tasks from the console.
• Copy and paste deployment tasks from within the console.
See also “Building New Jobs” on page 156.

 
 

 
 
 

Initial deployment jobs to run on new 
computers

Jobs created automatically when 
running configuration and on-the-fly 
operations from the console 

Deployment job 

Sample jobs to schedule as is or 
modify and run 
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In the Jobs pane you can create and organize deployment jobs. You can then assign jobs by dragging 
icons to the desired computer or computer group. 

Building Jobs
Building jobs includes creating a new job and then adding tasks to the job to run in sequence when 
scheduled on selected computers. You can build jobs by adding tasks from the Add menu in the 
Details pane of the Deployment Server Console, or by opening the Job Properties dialog box. You 
can also employ the New Job Wizard to create common jobs and schedule them quickly and easily. 
Sample tasks are also included with Deployment Solution to use as installed or to easily customize 
and run. See also “New Job Wizard” on page 153. 

Drag a Job icon to a 
Computer icon (or vice 
versa) to assign and 
schedule deployment jobs. 

First create a job in the 
Jobs pane of the 
Deployment Server 
Console. Then view the 
job and assign it a name.

After you create a job in 
the Jobs pane, add tasks 
to the job from the Task 
commands (at right), 
order the tasks, and set 
conditions. 
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After creating and building a job, you can then assign it to a computer and schedule it to run at any 
time—immediately, after hours, or on a daily, weekly, or monthly schedule. The deployment status 
of each job will be reflected in the console.

Assigning Deployment Jobs with Icons
Like computer icons used to identify types of computers in the console, job icons identify the status 
and success of each scheduled deployment job. After scheduling jobs, you can then monitor the 
progress as the job icon updates at each step of execution.

See also “Viewing Job Details” on page 152.

Scheduling Jobs
From the Deployment Server Console you can easily schedule jobs by dragging a job icon to a 
computer icon (or vice versa). The Schedule Computers dialog box will open automatically. 

From the Schedule Job dialog box you can run jobs immediately or schedule the job to run in batches 
at defined intervals. You can also assign the job to repeat every hour, day, or week. Scheduling jobs 
can be as simple as clicking OK to run immediately or as sophisticated as required to meet your 
deployment needs. 

For complete information about building and scheduling deployment jobs, see “Building and 
Scheduling Jobs” on page 152.

 Imaging
A primary task of Deployment Solution is to capture an image (clone of the hard drive) from a 
reference computer and distribute the image to set up new computers or reinstall computers to their 
basic configuration. You can create a library of image files on the Deployment Client Access Point 
(file server storage) and schedule image jobs to different computer types as required.   

Deployment Server allows you to push down a boot image remotely and execute the image in DOS 
using the BootWorks client or a PXE server, eliminating the need to physically attend and boot each 
managed computer. 

See also “Creating a Disk Image” on page 160, “Distributing a Disk Image” on page 161, and “New 
Job Wizard” on page 153

This job is assigned to a computer but not scheduled to run. Until 
scheduled, this job icon will remain unchanged.

This job is assigned to the computer and scheduled to run either 
immediately or in the future.

This job is currently processing.

This job has completed successfully.
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Imaging from Deployment Server
Deployment Server includes multiple features to capture an image and lay it down to a new or 
existing computer. You can use the Deployment Server Console to create and distribute disk images 
using deployment tasks, such as the Quick Disk Image wizard shown below:

 
BootWorks allows you to boot to DOS to create and deploy images, back up and restore a 
computer’s registry file, or complete other tasks that run from DOS. The PXE Server lets you boot 
to files residing on the network.

 Migrating Computers
Deployment Solution provides various options to migrate operating systems, computer 
personalities, software, or complete hard disk images. You can accomplish migration tasks 
individually or as a single job.

Create a disk image 
remotely from a reference 
computer to deploy new 
computers, or create an 
image of a production 
computer to completely 
migrate a user.

Distribute the hard disk 
image to new computers at 
startup, or to a single 
computer when recovering 
from disaster or upgrading to 
new hardware.
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The New Job Wizard steps you through each migration option, allowing you to capture a complete 
hard disk image (to upgrade to a new computer), migrate a user to another operating system with the 
same personality settings and applications, or to simply move personality settings from one 
computer to the another. Using the New Job Wizard is one of the easiest ways to build deployment 
tasks to migrate user data and settings.

Deployment Solution allows you to build sophisticated deployment jobs that automatically migrate 
personalities, including deployment tasks to capture the user’s personality, migrate OS and software, 
and then reconfigure the computer with the user’s original personality settings. You can also edit 
Personality Packages or Rapid Install Packages (RIPs) on-the-fly using the PC Transplant Editor and 
RapidInstall Editor tools from the Deployment Server Console. 

Deploying and Managing Servers
Deployment Solution includes features designed specifically for deploying and managing network 
or web servers. Server-specific features include scripted installs for initial installation, and support 
for remote management cards, multiple network adapters, history transfers to support “rip and 
replace” redeployment, and additional functionality required for automating server management. 

Deployment Solution also integrates with other hardware vendors to provide systems and tools to 
manage large server installations and support automatic deployment strategies. These unified 
systems simplify and automate server configurations and large-scale migrations, and support 
emerging hardware for ultra high-density server systems.

From the Deployment Server Console you can build deployment jobs to run scripted installs for 
Windows and Linux servers. These “unattended” installs can be run directly over the network for 
individual web or network servers. Answer files can be created and edited from the Deployment 
Server Console for each scripted install.

You can also execute server-specific scripts and redeployment tasks. Enhanced task logging and 
history tracking features let you recall deployment actions to quickly redeploy mission-critical 
servers. See “Deploying and Managing Servers” on page 145.

Migrate hard disk image 
from source computer to 
destination computer

Migrate only applications 
and settings to new OS

Migrate only personality 
settings for new 
computer
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 Now Let’s Get Started

Deployment Solution is a full-featured remote deployment system designed to manage computer 
devices across all types and sizes of small to medium organizations and large enterprises. It includes 
Windows and web components to design and scale a system for specific IT needs and challenges, 
providing a wide array of tools, utilities and applications to design a system for your specific needs. 
Deployment Solution is easy-to-use and adaptable to your environment.

You can design and install a Deployment Server system specific to your hardware, organizational 
structure, network architecture, and other environmental variables. The installation and 
configuration process allows you to install Deployment system components (database, services, 
network share, user interface console) to a single computer or distribute components to separate role 
servers. See “Deployment Server Installation” on page 55.
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New Features in Deployment Solution 6.0

The following new features and component enhancements are included with Deployment Solution 
6.0.

Virtual Rack/Enclosure/Bay for HP Blade Servers
HP Blade Servers now have a Virtual Rack/Enclosure/Bay object similar to Virtual Computer 
objects displayed in the Deployment Console, allowing users to pre-assign deployment jobs to the 
Rack, the Enclosure, or to a specific server in the Bay. Any HP blade server can have predefined 
deployment jobs and configuration tasks associated with it to execute automatically upon 
installation.

For example, the physical view would display this hierarchy:

HP Virtual Rack 

HP Virtual Enclosure
HP Virtual Bay

The Virtual Rack/Enclosure/Bay icons will change from virtual icons to managed server icons in the 
Deployment console as live blade servers are inserted and identified in the Bay. Supported Hewlett-
Packard Blade Servers include Proliant e-Class and p-Class blade servers, including BL 10e, BL 10 
G2, BL 20p, BL 20 G2, BL 40p. See “Managing Server Blades” on page 147.

Changing MS SQL Server named instances for the Deployment Database
Using a Custom install, you can now identify a named instance of the MS SQL Server when 
installing Deployment Solution. The default name of Deployment Database within an instance of an 
MS SQL Server will still remain "express," but you can now identify other named instances on the 
database server to run multiple databases from one clustered MS SQL Server to manage multiple 
sites or network segments. This feature is supported in the silent install INI file and the GUI install 
executable. See “Deployment Database” on page 57.

Create Custom Tokens for Job Conditions
You can now create Custom Tokens to create conditions when assigning and scheduling jobs. Using 
the custom tokens, you can assign jobs to groups of computers based on values in an SQL column 
or row for any table in the Deployment Database. Administrators can now base conditions on user-
defined tokens and will no longer be limited by the existing tables and columns hard-coded into the 
Conditions dialog box. As always, the first condition met will be the condition used. See “Creating 
Conditions to Assign Jobs” on page 103.

Support for imaging and configuration of Citrix Metaframe XP
User can now copy and replace disk signatures to better support imaging of Citrix Metaframe XP.

Support for scheduling without a mouse device
The Deployment Console provides a wizard to schedule tasks without using a mouse. This new 
feature meets Section 508 requirements to improve disability access. The Job Scheduling Wizard 
allows the user to specify a job, schedule, and execute it on targeted computers and computer groups, 
allowing integration of voice activation software and other user interface features. See the “Job 
Scheduling Wizard” on page 157.
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New installation procedures for Deployment Solution (Windows components)
Deployment Solution provides an Install Helper to download and install prerequisite software such 
as MSDE 2000 before running the Deployment Solution installation executable. A common install 
file (AeXDeploymentSolution_6_0_Win) replaces previous install files that included MSDE 7 as 
part of the install executable. See “Simple Install for Deployment Server” on page 61.

Support for additional Blade Servers
Altiris now supports a variety of blade servers, including the Dell and Fujitsu Siemens blade servers. 
See “Managing Server Blades” on page 147.

Updated Altiris Deployment Server Configuration Tool
The Deployment Server Configuration Utility in the Control Panel provides new general and debug 
options. The Options > General tab provides features to set inventory polling and a timeout value 
when updating connections of managed computers. The Options > Debug tab allows you to set 
debug options for both the Deployment Server and communication errors with Deployment Agents. 
See “General Option” on page 225 and the “Debug Option” on page 229.

New CE.Net Deployment Agent
Deployment Solution includes a new Deployment Agent for CE .NET to manage Hewlett-Packard 
T5000 computer devices running the Windows CE .NET 4.2 operating system. These computer 
devices ship with the Deployment Agent for CE .NET already installed and will display in the 
Deployment Console as managed computers when attached to the network.

See “Deployment Agent for CE .NET” on page 131.

New RapiDeploy for Linux and WinPE
New RapiDeploy for Linux and WinPE (Windows pre-execution environment) allows execution 
from these pre-OS environments to capture and deploy an image. You can create your own WinPE 
or Linux boot disk/CD, load the appropriate pre-OS environment, and run the RapiDeploy 
executable from a CD, floppy, or network share. You can also capture or deploy an image using the 
standard Rdeploy.exe command line switches.
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Planning and Installing
Deployment Solution is a highly flexible and scalable system. It is designed to meet deployment, 
management, and migration needs for small, medium and large organizations with diverse 
topologies and varying computer management requirements. This section provides steps for 
installing Deployment Solution components, but also includes system architecture details and 
discusses planning strategies to install and optimize your Deployment Solution system. 

 Quick Links

Planning Deployment Solution 
Installations (page 39)

Design a system for small or large environments 
with varying needs. Understand basic scalability 
and optimization principles to set up your system.

Deployment Solution 
Architecture (page 33)

View a basic diagram and overview of the 
components that make up Deployment Solution. 

Deployment Server Installation 
(page 55)

Install the Windows components of Deployment 
Solution. Automatically install the Deployment 
Server Web Console.

Installing Deployment on 
Notification Server (page 83)

Install Deployment Solution by first installing 
Notification Server and then installing the 
Deployment view. You can then install 
Deployment Server systems to specific sites or 
network segments. A system of Package Servers 
can also be implemented.



 

Deployment Solution Architecture

Altiris eXpress Deployment Solution combines web-based IT management solutions with feature-
rich, real-time LAN-based deployment tools. It integrates web and Windows protocols and services, 
SQL Server databases, local agents, user-interface consoles, and provides additional DCOM, ASPs,  
and Win32 components, services, and applications. For all types of in-house servers and desktops or 
on-the-road laptops and handhelds, Deployment Solution lets you design and scale a deployment 
and management system for your unique needs and opportunities.

Deployment Solution is easy to customize for your environment. You can quickly set up a test 
environment from a specified computer and remotely install Deployment Agents to each client 
computer simultaneously. To move Deployment Solution to a production environment, set up 
Deployment Solution components on a single computer or use a distributed model, and then use 
Initial Deployment features to automatically install agents directly or through Package Servers. You 
can then scale a system and make modifications to meet the needs of your enterprise.
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To install only a Deployment Server system, see Deployment Server Installation (page 55). To 
install the complete Deployment Solution system, including Deployment on Notification Server, see 
Installing Deployment on Notification Server (page 83). Deployment Solution components — web 
and Windows — can be distributed across multiple nodes on your system or installed on a single 
computer.

See Deployment Server Architecture (page 34) and Deployment on Notification Server Architecture 
(page 36).

Deployment Server Architecture
Deployment Server includes the Windows components of Deployment Solution, including 
operations and services executed from the Deployment Server Console, a Win32 user interface that 
employs drag and drop features, wizards, management tools and utilities. The Deployment Server 
Console provides all features, utilities, and tools needed to remotely manage all computers across 
specified network segments or sites in real time.

Deployment Server is a group of Windows services, components, and applications that control the 
flow of work and information between managed client computers and Deployment Server 
components: Deployment Server Console, Deployment Database, Client Access Point, and 
Deployment Server services. Managed computers connect and communicate with the Deployment 
Server to register information about themselves;  jobs are scheduled from the Deployment Server 
Console. This information is stored in the Deployment Database. Software and image packages, 
scripts and configuration files are stored on a file server referred to as the Client Access Point.

Note You can install each Deployment Server component on separate computers for a Custom 
Install for Deployment Server, or use a Simple Install for Deployment Server to install components 
on a single computer.

Deployment Server provides wizards to simplify the most common tasks and drag-and-drop features 
to assign and schedule predefined tasks to target computers. Tasks can be executed immediately or 
scheduled for later execution. A feature-rich database tracks deployment jobs and ongoing status for 
all managed computers. 

Deployment Server Components
Deployment Server controls the flow of work and information between managed computers and 
other Deployment Server components in the Altiris system. The Deployment Server Console, 
Deployment Server services, and Deployment Database run on one or more Microsoft Windows 
computers. The Client Access Point can run on Microsoft Windows or Novell NetWare. Each 
managed Windows, handheld, or Linux computer runs a Deployment Agent to communicate from 
the client computer to Deployment Server.
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See also Deployment Server Components (page 56), Installing Deployment Solution Agents (page 
65) and Deployment Agents (page 120).

How Deployment Server Components Work 
Together
In this scenario a computer is being imaged using a PXE Server. For this simple exercise, no post-
configuration tasks are performed. These are general steps that have been combined for simplicity.

User actions at the console System jobs
1. From the Deployment Server Console a job is 
created to re-image selected computers.

2. The console sends the job to the MS SQL 
Server running Deployment Database.

3. From the console, the job is scheduled to run 
on selected computers. The console indicates 
that the job has been scheduled.

4. The console updates the Deployment Database 
and tells the Deployment Server to check for 
changes in the database.
5. Deployment Server checks the Deployment 
Database and sees there is a scheduled job.
6. The Deployment Server tells the client 
computer to reboot through the Deployment 
Agent.
7. As the computer reboots, the PXE process 
executes first and the DHCP server gives the 
computer an IP address.
8. The PXE Server hears the DHCP request and 
sends the PXE Bootstrap program to the 
computer.

DHCPDHCPPXEPXEDatabaseDatabase
Deployment
Server

Deployment
Server ConsoleConsole

1

2 4

55

Client to be imaged

7

8

3

6
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Deployment on Notification Server Architecture
Notification Server runs Deployment Web Console and provides features for Web access and 
management. Notification Server provides security features, general reports, and system-wide Web 
settings from the Deployment Web Console. Notification Server includes built-in features like 
Package Servers and Web administration consoles. It also includes general features to view and 
generate Helpdesk issues (in Action Manager), and employs additional Altiris products such as 
Inventory, SW Delivery, and Helpdesk solutions. For complete information about Notification 
Server, see the Altiris eXpress Notification Server User Guide.

User actions at the console System events
9. PXE Server downloads the boot image to the RAM of the 
computer (DOS, LAN drivers, autoexec.bat, etc.).
10. The computer executes the commands in the boot image. 
This executes Deployment Agent for DOS (BootWorks). See 
Deployment Agent Settings for DOS (BootWorks).

12. The console indicates that the 
job is being performed.

11. The Deployment Server updates the Deployment Database 
identifying that a job is in progress and notifies the console to 
query the database for this change.
13. RapiDeploy is executed and the computer is imaged.
14. The computer reboots and tells the Deployment Server that 
its job is complete.
15. The Deployment Server updates the Deployment Database 
and tells the console to check the database for new status.

17. Console now indicates 
computer is imaged.

16. The console checks the Deployment Database for new 
status.

Client
Access
Point

Client
Access
Point PXEPXEDatabaseDatabase

Deployment
Server

Deployment
Server ConsoleConsole

12 & 16

11 & 15

1410 & 13
9

Client to be imaged
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Notification Server relies on Microsoft Transaction Services (MTS) and Microsoft Internet 
Information Servers (IIS) to execute services across HTTP protocols. It also includes Package 
Servers and other built-in features to provide an enterprise-level system that is scalable and 
expandable.

Notification Server lets you specify and set up a Notification Server managed computer as a Package 
Server (any agent computer running the Notification Server Agent software is eligible to be a 
Package Server). Package Servers let you distribute your software packages—images, RIPs, 
executables, scripts and more—to different servers across your network to reduce the network load 
when downloading packages to each site. It allows you to create the packages in one location and 
replicate them automatically to other Package Servers. (See Using Package Servers to Replicate 
Deployment Jobs (page 310).)

Notification Server Management Components
The following are components and features of the Altiris Notification Server. For complete 
information, see the Altiris Notification Server Product Guide.

Deployment on Notification Server
The Deployment view on Notification Server is a web interface that provides management access to 
multiple Deployment Server systems and integrates additional IT management solutions. From the 
Deployment view on the NS console, you can generate reports on deployment activities across all 
sites, deploy software packages, schedule deployment jobs and more. Deployment on Notification 
Server provides single-point access to all computer resources and IT web solutions across a wide-
area network.

Notification Server combines Inventory, Helpdesk, Carbon Copy, Application Management and 
other web solutions to your Altiris system. Deployment on Notification Server leverages security, 
reporting, management, and other basic services from the Notification Server infrastructure. 

Notification Server Database
The Notification Server Database integrates data from multiple Deployment Databases and displays 
it in the Deployment view on Notification Server. The Notification Server Agent and its extended 
DS Agent communicate between the Notification Server Database and the Deployment Server 
Database to update information at specified polling intervals.

Package Servers
Package Servers allow you to set up Notification Server client computers as distribution points to 
disperse software packages. Distributing packages first to a local Package Server and then to the 
client computer reduces network traffic. When a managed client computer downloads a package, it 
considers the list of available Package Servers as possible sources from which it can download the 
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package. The Package Server selected for downloading the package is based on availability 
parameters, such as proximity and line speed of the source. See Using Package Servers to Replicate 
Deployment Jobs (page 310).

For a Notification Server client to be designated as a Package Server, the computer must be running 
Windows 2000/XP/2003, Microsoft IIS, and have the NS Client installed.

Notification Server Client Software
Notification Server Agent
Notification Server Agent is the client software that runs on each Notification Server managed 
computer (including Deployment Server). Among other duties, the Notification Server Agent 
queries the Notification Server database to identify how often a computer checks to see if there is 
work to be performed. 

Notification Server Agent resides on all Notification Server managed computers. The client software 
writes to the Notification Server database. This information is then displayed in the Deployment 
Web Console or in another Notification Server console.

A Notification Server Agent must be installed on each Deployment Server managed by the 
Deployment view on Notification Server. A DS Agent will be installed automatically to all 
Deployment Servers running a Notification Server Client. The DS Agent extends features of the 
Notification Server Agent to interact between Deployment on Notification Server and the 
Deployment Server. In effect, the DS Agent is a snap-in to the Notification Server Agent for 
Deployment Server integration. 

The Deployment Server Agent residing on a Deployment Server queries the Deployment Database 
at defined intervals to identify updated deployment tasks or computer information. These intervals 
can be set globally for all Deployment Server installations or set at different intervals for each 
Deployment Server installation. Set these polling and request intervals to manage network traffic 
and the refresh rate of Deployment on Notification Server. See Using Package Servers to Replicate 
Deployment Jobs (page 310).

You can also schedule existing jobs from the Deployment view on Notification Server. The 
Notification Server Agent sends scheduling and configuration information set in the Deployment 
view on Notification Server down to the Deployment Database. This updates the Deployment 
Database with scheduling information to run deployment tasks against selected computers.

DS Agent
 DS Agent is the client software required specifically for managing Deployment Server. It 
synchronizes the Deployment Database with the Notification Server Database and allows the 
transmission of data between the Deployment Server system and Notification Server. All 
Deployment Servers consolidated in a Deployment Solution system running Deployment on 
Notification Server must have the DS Agent installed.

Note Both Notification Server Agent and Deployment Agent for Windows can reside on the same 
computer if the computer is managed by both a Notification Server system and a Deployment Server 
installation. When both are installed, only the Deployment Agent for Windows icon appears in the 
system tray. Right-click on the Deployment Agent for Windows icon to view properties of the 
Notification Server Agent. 
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Planning Deployment Solution Installations

Altiris is a leading worldwide developer of fully integrated Web-enabled solutions designed to 
manage computer resources throughout their entire lifecycle. Each Altiris solution addresses a 
specific area of the IT technology lifecycle, including deployment and migration, software and 
operations management, inventory and asset management, and help desk and problem resolution. As 
a unified system, these IT tools and Web solutions provide a complete resource management system 
for Microsoft Windows, Linux, and Unix systems.

Deployment Solution helps reduce the total ownership cost of managing hardware and software for 
desktops, laptops, servers, and handheld devices. It was developed for IT administrators who 
manage computing devices across all types of organizations, from large main offices to small and 
large branch offices, and includes features for mobile users updating across the WAN. As a result, 
comprehensive planning is required to optimize and scale a system before devising a deployment 
and management system.

To design a comprehensive IT management system for your organization, first evaluate your 
infrastructure, including network resources, operational processes, management reporting needs, 
administration needs of the IT department, and other pertinent aspects of IT resource management. 
During this evaluation you can identify opportunities and challenges for automating procedures and 
easing problem areas. Then prioritize your needs and apply Altiris solutions to optimize a 
comprehensive design for present and future needs. 

About This Section
This planning section provides recommendations based on standard design models (large remote 
sites, small remote sites, enterprise, and dial-in users), and includes best practices to assist in 
designing, optimizing and scaling a system that meets your unique needs and opportunities. It 
includes general guidelines for implementing a comprehensive Altiris system for specific solutions 
and suites of solutions.

This guide introduces major issues that administrators face during deployment operations, and 
suggests management strategies and additional information for implementing a solution or a 
combination of solutions. The section identifies a basic design model and lists advantages and 
problem areas that you may encounter in installing and operating an Altiris Deployment Solution 
system.

Because each organization includes its own set of environmental variables, such as variations in line 
speed, database configurations, package sizes for software delivery, and is defined by its own unique 
organizational structure and differing business requirements, this guide attempts to provide general 
recommendations and furnish basic design models from which to extrapolate specific design 
features for each organization. Efficiency, speed and usability variables can be extrapolated from 
each configuration type to compensate for variations in design. 

Standard variables (such as package sizes, processor speed, bandwidth, database configuration) are 
identified in testing or stated as salient for all design scenarios. Other variables, such as placement 
of Package Servers, are also addressed in each scenario and reflected in the scalability testing. 
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Hierarchy of Altiris Servers

The Altiris infrastructure supports a hierarchy of Notification Servers, Deployment Servers, and 
Package Servers to reduce response time and design scalability into your deployment and 
management system. Organizations can use the hierarchy model to provide management capabilities 
for locations that require responsive administrative control at the site level. This model also 
increases overall scalability of the system since the data processing load is distributed across 
multiple servers. All solutions installed into the system—Deployment, Inventory, Application 
Management, and all other Altiris solutions—benefit from this hierarchy.

You can install multiple Deployment Solution systems to keep your images and software packages 
close to your managed computers. Administrators at remote locations can manage only the objects 
in their local Deployment Server system. From there, each Deployment Server system will replicate 
all information to a parent Notification Server to scale both management and inventory capabilities. 
From a Regional perspective, an administrator can manage and report on all managed computer 
resources in the organization. 

Reporting resource data from each region provides central administration and reporting capabilities 
to administrators at Corporate Headquarters. This multi-tiered architecture is a common design for 
Altiris eXpress systems. This design works well because it can all be installed on one server for a 
small company (5-2,500 nodes), for large enterprises (100,000+ nodes), or for organizations with a 
combinations of large sites, branch offices, and remote users.

As new offices or users get added, administrators can add new servers to meet emerging needs. 
Within the Altiris infrastructure, you simply deploy another Deployment Server or Notification 
Server based on your needs, management design, or network topology. You can also add new 
solutions to each Notification Server to meet emerging requirements for each network segment or 
site.
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Notification Servers can be configured to report any inventory class registered tables to Microsoft 
SMS. This means that many solutions, such as Application Metering, Inventory, Deployment 
Solution, Asset Control, TCO, Contract Management, and others collect data that can be forwarded 
and integrated into Microsoft's SMS database. Inventory data can also be reported to multiple 
Notification Servers for environments that require it (backup/redundant servers, reporting servers, 
etc.).

See About Deployment Solution Hierarchy (page 50).

Design Scenarios
To constrain environment variables when evaluating different design strategies and to provide 
comparable data for optimization and scalability practices, example scenarios of organizational 
types are used throughout this guide to standardize environmental variables and provide a structure 
for baseline statistics. Generic organizations are used to reference standard practices and illustrate 
common problem areas for each solution or combination of solutions in the Client Management 
Suite. 

Two-tier Distributed Model
The two-tier distributed model (sometimes called the “fan out” model) consists of dispersed sites or 
network segments supporting subordinate sites or network segments. This model provides network 
load balancing for companies with equally distributed locations.
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The two-tier model has direct management through both Notification Server (and the Inventory, SW 
Delivery, App Management, and other solutions) and Deployment Solution for day-to-day 
management of local computers from both regional and local branch offices. 

Notification Servers

Notification Servers will be located at each regional office:

• Each Notification Server has its own database, although these databases can exist on a common 
Microsoft SQL Server. 

• Dial-up users will access the Notification Server at designated regional offices.
• Package Servers will reside in each branch office. A Deployment Server at the regional level will 

manage multiple small branch offices.
Deployment Servers

Deployment Servers will be located at the branch offices:

• One Deployment Server will reside in each branch office with a Package Server.
• Deployment Server shares will be set up on a storage device (file server, network attached 

storage). Images, RIPs, Personality packages and large Software Delivery packages will be 
placed on the storage device.

Inventory Solution 

• Inventory will flow up from individual computers to the assigned Notification Server.

SW Delivery Solution

• SW Delivery will be the primary method of package distribution to dial-in users and to 
Deployment Servers.

Package Servers are distribution points for the Notification Server. Packages will be 
automatically distributed to the Package Servers (PS). Clients will access packages from the 
closest package server.
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Three-tier Reporting Model
The Three-tier Reporting model provides direct management from regional offices with a central 
Notification Server to allow reporting at a central office. In many cases it consists of a main campus 
with thousands of managed computers, large branches with more than 50 managed computers, small 
branches with less than 50 computers, and remote access (dial-up) users. 

Common design scenarios are included within the comprehensive three-tier model. The basic 
organization includes a main campus, small and large remote locations, and itinerant users that 
connect across the WAN. This organizational model breaks down into three basic subordinate 
models: 

1 Enterprise model represents a large organizational setting with many hundreds or thousands of 
client computers on multiple subnets in a single location. It has few eXpress servers managing 
many computer resources. 

2 Large Branch model represents international offices or other remote locations with many 
employees with an IT technician on site. 

3 Small Branch model represents geographically dispersed offices within an organization. These 
branch offices contain few employees and do not have an IT technician on site. 

4  The Dial-up model represents traveling users who connect sporadically to download data, 
drivers, and applications from the central office.

This guide applies Altiris solutions to the three-tier model scenario and identifies problem areas for 
each identified solution across large and small Branch models, Enterprise, and Dial-up scenarios 
represented in the example. 
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A standard management hierarchy is identified for a multi-tiered approach to corporate management 
and reporting, regional management across the WAN, and local management across the LAN. This 
management strategy is illustrated below:

To plan a strategy for your organization, identify a model (Enterprise model, Branch model, Dial-
up model, etc.) defined within this comprehensive example and extrapolate differences in specific 
environmental variables for your organization.

Notification Servers

Notification Server installations will be located at headquarters for central reporting and 
management of dial-up users, at each large international site, at a regional site to manage small 
branch sites, and at the main campus.

• Each Notification Server has its own database, although these databases can exist on a common 
Microsoft SQL Server. 

• One Notification Server will be used to manage all remote branch offices and one will be used 
to manage the main campus. 

• Dial-up users will access the Notification Server at headquarters.
• One Package Server will reside in each small branch office. A Deployment Server at the regional 

level will manage multiple small branch offices.
Important Inventory data flows from the lower level NS servers to the Central Reporting 
Notification Server. In the Notification Server 5.5. product, there is no downward flow of 
collections, packages, advertisements, or policies from the Central Reporting Notification Server 
to the lower level NS servers. 
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Deployment Servers

Deployment Servers will be located at multiple locations:

• One Deployment Server will reside in each large branch office.
• There will be multiple Deployment Servers and Package Servers on the Main Campus. 
• Deployment Server shares will be set up on a storage device (file server, network attached 

storage). Images, RIPs, Personality packages and large Software Delivery packages will be 
placed on the storage device by a TBD process.

• For international locations, Package Servers will be set up on the eXpress share on the 
Deployment Servers. Images, RIPs and Personality packages will be distributed to the eXpress 
shares using SW Delivery Solution on Notification Server.

Inventory Solution 

• Inventory will flow up from individual computers to the assigned Notification Server.

• Inventory data will be forwarded to the Central Reporting Notification Server for centralized 
reporting.

SW Delivery Solution

• SW Delivery will be the primary method of package distribution to headquarters and 
international locations.

Package Servers are distribution points for the Notification Server. Packages will be 
automatically distributed to the Package Servers. Clients will access packages from the closest 
package server.

• Deployment Server will be used to distribute packages to Retail Sites.

The current practice is to use an existing system to distribute packages to the storage device in 
the retail sites.
Deployment Server will use deployment jobs to deliver the packages from the storage devices to 
the individual computers.

Imaging and Migrating Packages

• Deployment Server will be the primary mechanism for imaging and for migration of images, user 
data and settings to managed computers.

• For headquarters and large branch locations (international sites), Deployment Servers will act as 
the Package Servers. SW Delivery Solution will be used to deliver images, personality packages 
and RIPs to the Express shares on the Deployment Servers.

• For small branch sites, images and personality packages will be distributed to the storage devices 
using an existing system. Deployment Server will then deliver images and collect and deliver 
personality packages from and to the managed computers at the small branch sites.

Installation Variables
This section allows you to identify some of the variables that must be considered when designing an 
Altiris system for each organization. These values must be established to determine optimization and 
scalability design strategies and configuration settings.

The major design and scalability variables in designing a system are listed in order of importance. 
For example, when there is enough RAM, then CPU speed and processing power will affect 
throughput:

1 RAM

2 CPU
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3 Bandwidth

The following is an incomplete list of other installation and configuration variables: 

General Guidelines
This section provides general recommendations for designing, optimizing, and scaling information 
for Deployment Solution. 

Network 
Network Bandwidth
Network Speed
Number of Network Segments
Network topology
Number of Network Domains
Number of computers per domain
Wireless nodes
VPN connections
Dial-up connections
Altiris Servers
Processor speed
Type and number of processors
RAM
Type of OS
Deployment Packages
Average size of package
Average number of packages
Database location and configuration
Frequency of Reports
History collection

Notification Server placement
Database size
Nodes in database
Number of NSEs reporting to a central Notification Server
SQL 7 or SQL 2000 (with support packs)
Type of connections: Direct LAN, wireless, Dial-up, VPN
Transport time to Package Servers
Deployment Server placement
Database size
Nodes in database
Number of Deployment Servers reporting to eXpress servers
Total Number of clients being rolled up to NS
Size of packages used
Transport time to Package Servers
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Database Recommendations
Database placement, configuration, and sizing constraints are important when designing a scalable 
system for Deployment Solution. This section provides recommendations for configuring and 
placing Microsoft SQL Server databases in your system.

Available RAM to SQL Server
Limit the available amount of RAM in the system to 65% available for SQL Server. 

If SQL is going to be run on the same computer (which is recommended for best performance on 
servers managing clients), limit SQL usage to 65% of the total available RAM. This will optimize 
your system with the correct balance of processing power for the Microsoft SQL Server while 
allowing you enough processor power for other services and applications. In a large environment, 
SQL Server performance is enhanced with 3GB or more of RAM total.

SQL Server Enterprise Edition can use up to 4 Gb of RAM and supports additional processors. 

Database Size and Disk Space
In designing an Altiris eXpress system, you first need to estimate the size of your database. MS SQL 
has a default ability to automatically grow the database as needed. While this is helpful if you run 
out of space in the database, it usually means that SQL server will start to partition the database and 
will soon become fragmented all over your server's hard drive. This will drastically affect your 
server performance. Starting with a drive that's been defragmented and automatically assigning the 
drive space for your database will help performance a great deal.

The following is a quick recommendation for estimating the database size:

Install your Notification Server and check the database size. Do this by highlighting the database 
within SQL Enterprise Manager, usually AeXNS. Click on AeXNS > right-mouse click > Properties 
to see the actual database size and how much space is available. 

    

You can then use the NSE Generator, located on the Technical Resource Kit, to generate some NSE 
inventory files (NSE Generator has its own documentation). Create 50 NSE files and once they have 
all been processed, check the properties to see how the database has grown. Generate another 50 and 
see how it grows again. Then extrapolate your size by taking the increased growth for 100 PCs times 
the number of managed computers (count by 100, 2000 PCs = 20 X 100) and multiply by 2 to give 
yourself room for other data gathered besides inventory (e.g., Application Metering, Inventory, and 
other installed solutions).

For example: 9MB (growth of DB for 100 PCs) X 42 (4200 clients) X 2 = 756 or approximately 
750MB of disk space.

Go back into Properties, click Data Files and edit the Space allocated (MB) field to read 750. Then 
clear the box below marked Automatically grow file under the File Properties section. This will grow 
the database to 750MB now. When you have reached that limit, instead of letting SQL automatically 
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grow the size of the database and start to defragment it all over your server's hard drive, you will 
receive a SQL error. You can then defragment the drive, go back into Data Files and increase the 
size again.

Going back into the Properties dialog box, you can now see that the database size has been changed 
from 23MB to 753MB.

Memory
Microsoft has designed SQL Server to use any and all available memory that it can take. This 
includes swap space and RAM. If SQL Server is the only application running on your server, and 
you have 1 Gb of RAM, it will use all of it. It's made to release memory as other processes load and 
need resources. This memory grabbing, however, is very taxing on the utilization and performance 
of eXpress servers. Swapping information to disk is obviously a huge performance consideration as 
well.

There are two basic ways to lock down the amount of memory SQL will use on your server. The first 
is to assign a range of RAM that SQL will automatically use if necessary, trying to use the least 
amount specified but using the maximum defined amount. The second one is to assign a fixed 
amount of RAM to use. This is our recommended option. 

To calculate how much RAM you will need, divide your server RAM in half and assign it to the SQL 
Server. We recommend at least having 512 Mb of RAM in your server, leaving 256 Mb for SQL.

Click on the Use a fixed memory size (MB) setting and set the value to half of your RAM. Then select 
the Reserve physical memory for SQL Server check box. This option will assign the above RAM as the 
only memory available for SQL processes. This will prevent SQL from swapping information to 
disk and only use the above memory for all transactions. This will drastically increase performance.
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Scaling Deployment Solution

Deployment Solution includes both Windows and web components to design and scale a custom, 
hierarchical system for any type of organization. Large enterprise sites can use Deployment Solution 
to manage several thousand computers in groups of various sizes, while remote locations can deploy 
and manage few computers across many geographically-distributed sites. Dial-up users can also be 
managed with features to download applications and data across low-bandwidth connections.   

For local network segments or sites, IT departments remotely deploy and manage computer 
resources using feature-rich, Windows-based Deployment Server components. Deployment Server 
includes the PXE Server and Bootworks for DOS-based drive imaging, with additional features to 
deploy software packages, migrate personalities, remote control computers and build deployment 
packages. Deployment Server also includes server management features to deploy and restore high-
density server farms. Included with the Deployment Server Console is a web console installation that 
allows administration from any computer with a web browser. 

 
Multiple Deployment Server sites can be managed and integrated using the Deployment view on 
Notification Server. This web-based management console acts as a second-level user interface that 
consolidates administration of multiple Deployment Server sites and allows integration of multiple 
software solutions, including Package Servers. For IT management of multiple Deployment Server 
installations, the Deployment view on Notification Server furnishes complete reporting, scheduling, 
package distribution, and solution integration across the organization. 

Design Strategies for Deployment Solution
Optimum designs for Deployment Solution for a particular organizational model depend on general 
factors in a customer's environment, but rely basically on two main points: (1) the transmission of 
packages from Deployment Server to managed client computers, and (2) the communication of data 
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for the Deployment on Notification Server, which requires communication between the Deployment 
Database and the Notification Server Database. Polling intervals are set to send updates between the 
two databases. 

Scalability margins and optimization values are provided primarily for two separate network 
transactions within the Deployment Solution system:

• Deploying packages from Deployment Server to managed client computers. 
• Data transmission from Deployment Server to Notification Server. Data packets with 

deployment tasks (events), computer information, and scheduling information are transmitted 
from multiple Deployment Server databases to a central Notification Server database to be 
displayed in the Deployment Web Console.

About Deployment Solution Hierarchy
Altiris provides a hierarchical architecture that allows you to install software solutions at different 
levels for different computer deployment, management, and reporting needs across your 
organization. Deployment Solution provides both Windows components (the Deployment Server) 
for real-time computer management, and web components (the Deployment on Notification Server) 
to extend and scale a system specifically for your IT requirements.
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Direct, real-time management over the LAN is performed from the Deployment Server Console in 
a Deployment Server installation. When the organization grows, more Deployment Servers are 
added to manage growing network segments. To integrate and centralize management of 
Deployment Server systems, you add the Deployment view on Notification Server and combine 
other web solutions for a complete Altiris system. 

Each level of management both centralizes and expands your deployment and reporting capabilities. 
Integrating Windows and Web solutions allows you to scale vertically to centralize Web reporting 
and management, while extending laterally with new network segments and sites. Systems can be 
scaled to conform to geographical location, network topology, company organization, remote access 
needs, and additional requirements unique to each organization.

Deployment Solution performs tasks specific to each level of IT administration across your 
organization. At a local level, IT technicians remotely deploy and manage computers across the 
LAN using tools and applications in Deployment Server. At a district level, IT managers can access 
and manage multiple Deployment Server installations and centralize deployment tasks. And at the 
corporate level, additional inventory, help desk, and asset reports can be generated for executive 
planning.

At a LAN level, an IT technician can manage in real-time thousands of computers per Deployment 
Server installation. IT personnel can perform low-level, real-time deployment tasks for large or 
small LAN segments. Throughout their lifecycle computers can be installed, configured, 
reconfigured, and retired. Each Deployment Server installation can manage high-density server 
farms, desktop computers across multiple domains, and remote handheld and notebook computers 
for specified network segments or sites.

At a district level, another level of management can be established using the Deployment view on 
Notification Server to centrally view, report, and deploy computers across multiple Deployment 
Server installations. From a central IT location, standard packages can be built and automatically 
distributed, reports can be generated for all sites, and additional solutions can be integrated.

From the corporate office level, a third level of control and reporting can be added by integrating 
Helpdesk Solution, TCO Mgmt (total cost of ownership management), Asset Management solution 
(for non-computer assets), Inventory Solution, and other Altiris eXpress solutions.
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Branch Design for Deployment Solution
To manage multiple geographically dispersed locations, multiple Deployment Server installations 
are deployed and managed from the Deployment view on a central Notification Server. This section 
identifies basic issues for branch model design, including placement of Package Servers.

Placement of Package Servers for Branch Model

Two options exist for placing Package Servers at branch locations: 

• Install only a Package Server at branch 
locations with no resident IT personnel and 
fewer than 50 managed computers, 
allowing IT personnel at the regional office to 
build and deploy packages and save them to 
Package Servers at each branch location.

• Install Deployment Server with Package 
Servers with more than 50 managed 
computers for a resident IT technician. A 
good recommendation is if your IT department 
is rebuilding (imaging) and reconfiguring 
more than one computer a month, then you 
will need a Deployment Server installed on 
site.
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Managing Multiple Deployment Servers for Branch Model

Deployment Solution allows you to place a Deployment Server on each remote branch in your 
organization to manage computers in real-time for each site. Multiple Deployment Server 
installations can then be managed from a regional site using the Deployment view on Notification 
Server. 

Test Results: 25,000 managed computers (5 DS x 5,000 managed computers) can be managed by 
a single Deployment on Notification Server.

Enterprise Design for Deployment Solution
To manage large organizations, few Deployment Server installations are used to deploy and manage 
several thousand managed computers. For large sites with more than 5,000 nodes, more than one 
Deployment Server installation would be installed in order to place image files, software packages, 
and RIPs (RapidInstall Packages) more closely to the receiving computers. 

Local IT personnel manage day-to-day activities 
using Deployment Server components for network 
segments or defined sites across the enterprise. 
Regional IT departments can then manage each 
Deployment Server installation from the Deployment 
view on Notification Server by running inventory and 
deployment reports, creating and distributing 
enterprise-wide packages, and scheduling general 
deployment tasks from Notification Server. 

At the regional IT office, a Deployment Server can be 
installed to image reference computers and create 
image files, RIPs, MSI’s and other packages that will 
be distributed to subordinate Deployment Server 
installations using Package Servers installed on each 
managed Deployment Server installation (each DS 
has an NS Client so it can be designated as a Package 
Server). 
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Best Practices
The following are recommendations to assist in optimizing and scaling Deployment Solution 
components:

Consoles

• With many clients being managed, performance may be affected by the number of open 
consoles. 

• Recommend a Deployment Server per site or network segment to optimize bandwidth, PXE 
connections, and other limiting factors.

• Installations of 2,500 clients per server or less can use MS SQL MSDE. Larger sites should use 
Microsoft SQL Server. 

Deployment on Notification Server

• If an organization is rolling up the management of several existing Deployment Servers (under 
NS), there is the potential for a NS server bottleneck while the initial database data is being 
processed. It is recommended that existing Deployment Servers be brought under management 
one or two at a time to help reduce this load. Once the initial process is complete, the incremental 
updates are small and should not overly impact NS performance. 

Deployment Server installations that are initially deployed from within NS should not cause a 
performance impact. (It was reported anecdotally that one company successfully rolled out 50 
Deployment Servers around the country from a single Notification Server in approximately 1 hour.)
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Deployment Server Installation

Deployment Server is a flexible, scalable computer deployment and management system that can be 
installed and configured quickly on a single computer, or installed across several computers to 
distribute processing for large enterprise environments. You can run a Simple install to position all 
Deployment Server Components on a single computer (most frequently used), or plan and perform 
a Custom install to distribute installation of components across separate computers in the site. The 
Deployment Server Web Console can be installed to any computer running Microsoft IIS as part of 
the Deployment Server installation.

After installing Deployment Server components, you can remotely install Deployment Agents to all 
types of computer resources across your organization: laptops and handhelds, LAN and web servers, 
network switches, and much more. Windows computers, Linux computers, and handhelds can be 
managed as a unified environment, with each client communicating through its own Deployment 
agent to update inventory data and react to Deployment Server commands and deployment tasks.

Select one of the following methods for installing a Deployment Server system:

Simple Install for Deployment Server (page 61)

Custom Install for Deployment Server (page 62)

Add Component Install for Deployment Server (page 65)

To install Deployment Agents to the client computer, see “Installing Deployment Solution Agents” 
on page 65

Note You can also install the Deployment Server components remotely from the Notification Server 
Web Console after installing Deployment on Notification Server. 
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Deployment Server Components

The Deployment Server system includes the following components:

• Deployment Server Console (page 56)
• Deployment Server (page 56)
• Deployment Database (page 57)
• Client Access Point (page 58)
• PXE Server (page 58)
• DHCP Server (not an Altiris product)
• Deployment Server Web Console (page 59)
All of these components can be installed on the same computer or distributed across multiple 
computers as needed for your environment.

Deployment Server Console
The Deployment Server Console is the Win32 user interface for Deployment Solution. You can 
install this Windows console on computers across the network to view and manage resources from 
different locations. In addition, you can access the Deployment Database on other Deployment 
Server systems to manage sites across the enterprise. See “Connecting to Another Deployment 
Server Site” on page 109. 

Deployment Server Console communicates with the Deployment Database and Deployment Server 
services. In a Simple Install for Deployment Server, the Deployment Server Console is installed on 
the same computer as all other components. In a Custom Install for Deployment Server, you need to 
make sure a connection is available to these computers and security rights are set. You will need to 
have administrative rights on any computer running the Deployment Server Console.

See also “Deployment Server Web Console” on page 59, “Managing from the Console” on page 97, 
and “Deployment Server Components” on page 56.

Deployment Server
Altiris Deployment Server controls the flow of the work and information between the managed 
computers and the other Deployment Server components (Deployment Server Console, Deployment 
Database, and the Client Access Point). Managed computers connect and communicate with the 
Deployment Server to register inventory and configuration information and to run deployment and 
management tasks. Computer and deployment data for each managed computer is then stored in the 
Deployment Database. 

Note To view, start or stop Deployment Server, go to the Altiris Server services in your Windows 
Manager. 

Managed computers require access to the Deployment Server at all times, requiring that you have 
administrative rights on the computer running the Deployment Server.

Setting Rights to install Deployment Server

 

Create a user account to run the Deployment Server. The service runs 
as a logged in user, not as a system account. You must create this 
account on all Deployment Server computers. The account must have 
full rights to the Client Access Point. The account must have a non-
expiring password. 
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Hint Creating an administrative account using the same name and password on each computer will 
be easier to remember than using the names and passwords of existing accounts. 

Most packages (RIP, Personality Packages, and MSI files) are passed through the Deployment 
Server. Therefore storing these files on the same computer as the Deployment Server can speed up 
the deployment of these packages. Image files, however, are sent directly from the Client Access 
Point to the client computer when executing an imaging task. 

See also “Deployment Server Components” on page 56.

Deployment Database
The Deployment Database can is installed on Microsoft SQL Server™ 2000 or Microsoft Data 
Engine (MSDE) 2000. See “System Requirements” on page 59.

Note In Deployment Solution 6.0 and later, if you have multiple instances of the MS SQL Server 
already set up, you can identify a specific instance using this format: <database 
instance>\express. For example, if you have a clustered MS SQL Server to manage multiple 
Deployment Solution systems on different network segments, you can enter the name 
salesSegment\express or marketingSegment\express depending on the previously 
established database instance. This feature is supported in the silent install INI file and the GUI 
install executable.

The database maintains all of the information about the managed computers, such as: 

Hardware. RAM, Asset tag, Serial numbers 

General Information. Computer name and MAC address 

Configuration. TCP/IP, Microsoft Networking, and User information 

Applications. The applications installed and information about these applications, such as the name 
of the application, Publisher, Product ID 

Services. Windows services installed 

Devices. Windows devices installed such as network adapter, keyboard and monitors 

Location information. Contact name, phone, E-mail, Department, Mail Stop, Site 

The Deployment Server Database also contains jobs and other data used to manage your computers. 

Note You can install a single Deployment Database per Deployment Server system--you cannot 
have two databases storing data for a single computer. If the computer you are installing the database 
to has an existing Microsoft's SQL Server™, then the Deployment Database will simply be added 
to that instance of the database engine.

Support for Multiple Database Instances
In Deployment Solution 6.0, you can now identify a named instance of the MS SQL Server when 
installing Deployment Solution. The name of Deployment Database within an instance of an MS 
SQL Server must still remain “express,” but you can now identify other named instances of MS SQL 
Servers rather than accessing only the default instance. This new feature allows you to identify and 

 

Assign a static IP address to the Deployment Server computer. Other 
components will not be able to connect to the Deployment Server if you 
use DHCP and dynamically change the IP address. 

 

To install the Deployment Server to a remote computer, the default NT/
2000 administration shares must be present. Restore any shares that 
have been removed before you install Deployment Server.

Setting Rights to install Deployment Server
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run multiple databases from one clustered MS SQL Server to manage multiple sites or network 
segments. This feature is supported in the silent install INI file and the GUI install executable. See 
“Custom Install for Deployment Server” on page 62.

See also “Deployment Server Components” on page 56.

Client Access Point
The Deployment Server Client Access Point is a file server or shared directory where Altiris 
program files and packages are stored. The Client Access Point can be a shared directory (default 
Simple install in Program Files\ Altiris\eXpress\Deployment Server) or on another file 
server (in the Custom install you can assign a Microsoft Windows or Novell NetWare file server). 

The Client Access Point is where you store image files, registry files, RapidInstall packages (RIPs), 
Personality Packages, script files, MSI files and more. When a computer is being deployed or 
managed, Deployment Server will store and retrieve these packages from the Client Access Point as 
needed.

Note You can only install one Client Access Point per Deployment Server system. However, if the 
Client Access Point's hard drive gets full, other computers can be used as additional, backup storage 
points. In some cases, other systems emulating a Microsoft or NetWare environment can be used as 
the Deployment Server Client Access Point.

Note for NetWare users If you are having trouble using the Novell NetWare server as a client access 
point, install the Novell Client rather than the Microsoft NetWare Client.

See also “Deployment Server Components” on page 56.

PXE Server
The Altiris PXE Server allows client computers to boot up to DOS over the network and run DOS-
specific deployment jobs for computers that support Intel's PXE (Pre-boot Execution Environment) 
technology. This eliminates the need to have an operating system or BootWorks on the hard drive 
or to visit each managed computer with a DOS floppy disk. To run PXE Server you must also install 
a DHCP Server.

Every time you image a computer, it needs to boot to a DOS environment to log on to a server to 
save an image of its hard disk or lay down another hard disk image. This process would normally 
require that you boot the computer from a BootWorks floppy disk or install BootWorks to the 
computer’s local hard drive. PXE Server eliminates the need to do either of these as it downloads 
the needed files (including BootWorks) to the RAM of the computer to perform all of the work 
needed to image it. 

If you have computers that do not support PXE, BootWorks can still be installed for backward 
compatibility. Both PXE and non-PXE managed computers can exist in the same Deployment 
Server system. 

The PXE server functions on the same protocols as a standard DHCP server, allowing you to place 
the PXE Server anywhere you would place a DHCP server. You can install as many PXE servers as 
required in your system. 

 

If you are installing Deployment Solution on a remote file server (not 
the computer where you are running the install program), create a 
share (or give Read/Write rights for NetWare) on the file server 
where Deployment Server will be installed. The share must allow 
access to all of the other components, including managed computers 
and the user account that runs Deployment Server. 
This share must be created before you begin installing! If you are 
not installing to a remote computer, you can select the option to 
create the share during install.
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Note Altiris PXE Server can only be installed on a Microsoft NT server operating system: NT v4, 
Windows 2000 Server and Advanced Server, and Microsoft Server 2003 servers. 

DHCP Server
The DHCP (Dynamic Host Configuration Protocol) server is a server set up to assign TCP/IP 
address to the client computers. This server is not an Altiris product, but it is required if you intend 
to use PXE Server. 

It is suggested that you use DHCP to manage the TCP/IP address in your network regardless of 
whether you use PXE or not. This will greatly reduce the amount of time it takes to set up and 
manage your computers.

See also “Deployment Server Components” on page 56.

Deployment Server Web Console
The Deployment Server Web Console remotely administrates a Deployment Server installation from 
a web browser. It deploys and manages Windows and Linux computers (both client and server 
editions) in real-time with many of the features present in the Deployment Server Console.

The Deployment Server Web Console can be installed on any computer running the Microsoft IIS 
Server, including a computer running Deployment Server, Notification Server, or a remote computer 
running only Microsoft IIS. After installation, the Deployment Server Web Console requires you to 
enter the name of an installed Deployment Database to access the desired Deployment Server 
installation.

Install the Deployment Web Console by running the DeploymentWebConsole.msi file located in 
the Deployment Server shared directory (in the Client Access Point).

Note The Deployment Server Web Console will install automatically during the Windows 
installation.

See also “Deployment Server Console” on page 56 and “Deployment Server Components” on 
page 56.

System Requirements
The following lists the system requirements for Deployment Server components and the network 
environment.

Network
• TCP/IP is used for communication between all Deployment Server components. If you have a 

NetWare file server for your Client Access Point, IPX can also be used to communicate with this 
component. 

• For Windows 2000 systems, you must set up Active Directory with the “Permissions compatible 
with pre-Windows 2000” option. If you choose the option “Permissions compatible only with 
Windows 2000 servers,” the Deployment Server cannot manage domain accounts for you. 

• If you’re using Windows 2000 only permissions, change them to the pre-2000 option from the 
Windows Start menu. Open a DOS prompt to add the group Everyone by typing the following: 
net localgroup “Pre-Windows 2000 Compatible Access” Everyone /add 

• Then restart all domain controllers for the change to take effect.

Deployment Server Infrastructure
• 256 MB of RAM
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• 20 GB of available disk space total.

Deployment Agents
Client minimum requirements:

• Pentium processor
• Operating Systems:

• Windows 95 or later
• Linux: Red Hat 7.2, 7.3, 8.0, 9.0 and Advanced Server 2.1, 3.0
• Linux: SuSE 8.0, 8.1 and Enterprise Server 8
• Linux: United Linux 1.0

• 5 MB contiguous disk space
See the following sections for additional information:

Installing Deployment Agent for Windows (AClient) (page 66)

Installing Deployment Agent for Linux (page 70)

Installing Deployment Agent for DOS (BootWorks) (page 72)

“Installing Deployment Agent for PocketPC” above

Deployment Server Components

Component Hardware Software
All components require Pentium III processors
Deployment Server RAM: 256 MB

Disk Space: 20 GB required
Windows 2000 Server and Advanced 
Server
Windows Server 2003

Deployment Server 
Console

RAM: 128 MB 
Disk Space: 3.5 MB

Windows 2000 Professional, Server and 
Advanced Server
Windows XP Professional
Windows Server 2003

PXE Server Memory: 128 MB
Disk Space: 25 MB (for boot 
files)

DHCP server (must be on the network, but 
does not have to be on the same computer 
as PXE server)
Windows 2000 Server or Advanced Server
Windows Server 2003

Deployment 
Database 

Memory: 128 MB 
Disk Space: 55 MB (for program 
files), plus space for data.

(Microsoft SQL ServerTM 2000 (SP3) or 
MSDE 2000 (SP3)

Client Access Point
(File server for 
storage)

Memory: 128 MB 
Disk Space: 100 MB for 
Deployment Server program 
files plus space for storing files 
(image, boot, RIP, etc.)

Windows NT (SP6)
Windows 2000 Server or Advanced Server 
Windows Server 2003
NetWare (file server only. Cannot use for 
any other components).

Deployment Server 
Web Console

Memory: 128 MB Windows 2000 Professional, Server or 
Advanced Server
Windows XP Professional
Windows Server 2003
MS IIS 5.5
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Simple Install for Deployment Server

The Simple Install places all Deployment Server Components — Deployment Server, Deployment 
Server Console, the Client Access Point, and the Deployment Database—on the same computer. 
You can install Deployment Server with a Microsoft Desktop Engine (MSDE) from the Simple 
install. The Deployment Server Web Console will install automatically during a Simple Install (and 
during a silent install) if the Microsoft IIS services are currently running on the selected computer.

Downloads for the Altiris Deployment Solution are available either on the Altiris product CD or 
downloaded from www.altiris.com.

To run a simple install
1 Start the server and log in using the administrator login you created for Deployment Server. See 

“System Requirements” on page 59.

2 Launch the appropriate Altiris Deployment Server installation file and follow the setup steps. 
The Deployment Server self-extracting install dialog box will open.

3 Click the option to Use current temp folder, or click the option to Extract to a specific folder and set 
a path to an existing folder to download installation files. Click Extract and Execute App. 

4 Click Simple Install. 

5 (optional) Select Include PXE Server. This option will install the Altiris PXE Server. See “PXE 
Server” on page 58.

6 Click the Install button. Click Yes to the Software License Agreement.

7 Enter the following information in the Install Information screen:

a In File Server path, enter the drive letter and path where you want to install the Deployment 
Server program files. 
(The default is C:\Program Files\Altiris\eXpress\Deployment Server.)

b Select Create eXpress share to create a Client Access Point on the computer. The Client 
Access Point allows you to store files on the computer and run Deployment Server system 
applications. See “Client Access Point” on page 58.

c Click License File and browse to locate a license file (.lic file). This is the activation key you 
received when you registered your Altiris software. If you do not have a license file, click 
Free 7 day license or maintenance upgrade. The installation will continue and allow you to use 
a free evaluation license file. See the Altiris Getting Started Guide for further licensing 
information.
Note You do not need to apply a license key to activate the HP Compaq Thin Client t5000 
Series. This managed client computer will automatically receive a non-expiring license when 
connected to the console.

d Enter an administrator user name and password for the Deployment Server system. This 
account must already exist. The name you are currently logged on as will appear by default.
If you use a domain account, enter the domain and the user name (for example, 
Domain1\administrator). 

e Click Next. The Installation Information dialog box will open to display the selected 
Deployment Server components to be installed.

Note If you are upgrading your installation, a message box will open asking: Do you want to 
replace the share? Click Yes and continue. If you click No, then a secondary message box will 
open stating that the share is already in use and you will want to manually set the share to point 

 

AeXDeploymentSolution_6_0_Win installs all Windows components of 
Deployment Solution. Using the Simple install option, you can install 
MSDE 2000 on the local computer if a database is not already installed.
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to the correct directory. Click OK to this screen. This features tells you that you may be creating 
a new share (in rare occurrences where you changed the path in the previous screen) and you may 
have to manually point to the new share after installation. 

8 Click Next to install the components listed on the summary screen, or choose Back to modify 
settings before starting the install. The installation process will begin. It will take several 
minutes. 
Note When installing for the first time, you will be prompted to insert a CD or floppy with the 
required DOS files. These DOS files are used in the PXE Configuration and BootWorks features 
for DOS-specific deployment tasks like imaging and saving registry settings. You can get the 
required and optional DOS files from these sources: 
• Win 95 or Win 98 CD
• DOS startup disk

9 Install Deployment Agent to client computers. The Installation Information dialog box will open 
asking if you want to install clients.
Remote Install Clients. Select if you want to push the Deployment Agent to computers running the 
Windows NT, 2000, XP, and Windows Server 2003 operating systems. 
Download Adobe Acrobat. Select if you want to download the Adobe Acrobat Reader to read 
documentation in PDF format.

10 After the installation is complete, click Finish. After finishing the installation process, you can 
further configure your system by completing any of the following tasks:
• Install clients.
• Add more components to your system.
• Change the default settings for Boot Disk Creator, applied during the Simple Install.

11 (optional) Add more components after a Simple Install
To add additional Deployment Server Consoles to your system, run the Install Wizard again and 
select Add Components. 

12 (optional) Change default settings applied during the Simple Install.
To change default settings that were applied during the Simple Install, create a new configuration 
using the Boot Disk Creator tool on the Deployment Server Console toolbar. You can use this 
tool to change the default settings if you: 
• Use BootWorks to image and change registry settings and to perform other tasks requiring 

you to boot from DOS.
• Use multicasting instead of static IP to connect client computers. 
• Use BootWorks instead of PXE.

You have successfully completed a Simple install for a Deployment Server system. Click the 
Deployment Server Console icon on your desktop to view all computer resources running 
Deployment Agents configured for your Deployment Server. 

See “Custom Install for Deployment Server” on page 62.

Custom Install for Deployment Server
The Custom Install allows you to distribute all Deployment Server Components—Deployment 
Server, Deployment Server Console, the Client Access Point, and the Deployment Database—on 
different computers. You can install Deployment Server with Microsoft Data Engine (MSDE) or 
install it to an existing SQL Server.

Downloads for the Altiris Deployment Solution are available either on the Altiris product CD or 
downloaded from www.altiris.com.
Deployment Solution Product Guide 62

http://www.altiris.com 


 Deployment Server Installation Custom Install for Deployment Server

 

To run a custom install
1 Start the server and log on as the administrator login you created to run Deployment Server. See 

“System Requirements” on page 59.

2 Launch the appropriate Altiris Deployment Server installation file and follow the setup steps. 
The Deployment Server self-extracting install dialog box will open. 

3 Click the option to Use current temp folder, or click the option to Extract to a specific folder and set 
a path to an existing folder to download installation files. Click Extract and Execute App.

4 Click Custom Install option if any of the following conditions exist: 
• You are using the NetWare file server as a Client Access Point.
• You are managing many computers and require a distributed architecture to meet bandwidth 

restrictions and other design requirements.
5 Click the Install button. Click Yes to the Software License Agreement.
6 Install the Client Access Point and enter the license file location:

a In File Server path, enter the drive letter and path where you want to install the Deployment 
Server program files. The default is C:\Program 
Files\Altiris\eXpress\Deployment Server.

b Select Create eXpress share to create a Client Access Point in the system. The Client Access 
Point allows you to store files on the computer and run Deployment Server system 
applications. The Client Access Point can be on a Microsoft Windows server or Novell 
NetWare server. (You can only create the share if it is on a Microsoft Windows Server; the 
Novell has to be already set up.) See “Client Access Point” on page 58.

c Click License File and browse to locate a license file (LIC file). This is the activation key you 
received when you registered your Altiris software. If you do not have a license file, click 
Free 7 day license or maintenance upgrade. The installation will continue and allow you to use 
a free evaluation license file. See the Altiris Getting Started Guide for further licensing 
information. Click Next.
Note You do not need to apply a license key to activate the HP Compaq Thin Client t5000 
Series. This managed client computer will automatically receive a non-expiring license when 
connected to the console.

7 Enter Deployment Server information. Select the computer to install Deployment Server, the 
services that controls the flow of the work and information between the managed computers and 
Deployment Server components. Enter a static IP address for the Deployment Server computer 
to ensure that the IP address remains constant. Click Next. See “Deployment Server” on page 56.

8 Enter Deployment Database information. Identify where you would like the database installed, or 
enter the path of an existing Microsoft SQL Server. See “Deployment Database” on page 57. 
Click Next.
Note If you have multiple instances of the MS SQL Server already set up, you can identify a 
specific database instance in this field using the format: <SQL Server Name>\<database 
instance>.

9 Identify the type of Deployment Database authentication. Enter the user name and password if 
using SQL Server authentication. Click Next.

10 Enter PXE Server information. Select if you will use BootWorks or PXE Server. Click Next. See 
“PXE Server” on page 58. 

11 Enter the static IP address of the Deployment Server, or use the IP multicasting option. Click Use 
IP multicasting to allow managed computers to access a Deployment Server by its computer name 

 

AeXDeploymentSolution_6_0_Win installs all Windows 
components of Deployment Solution. Select the Custom install 
option to add new components or to install Deployment Solution to 
an existing database.
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or to find the first Deployment Server that will respond (if the Server name box is left blank). 
Click Next.

12 Enter Deployment Server Console information. Select if you want to install on the computer you 
are currently installing from or on a remote computer.

13 Select Install Web Console on this Windows to set up the Deployment Server Web Console on the 
computer you are currently installing from. This computer must be running Microsoft IIS. Click 
Next.
Note This option will be shaded if Microsoft IIS is not detected.

14  The Installation Information dialog box will open to display the selected Deployment Server 
components to be installed.
Note If you are upgrading your installation, a message box will open asking: Do you want to 
replace the share? Click Yes and continue. If you click No, then a secondary message box will 
open stating that the share is already in use and you will want to manually set the share to point 
to the correct directory. Click OK to this screen. This features tells you that you may be creating 
a new share (in rare occurrences where you changed the path in the previous screen) and you may 
have to manually point to the new share after installation.

15 Click Next to install the components listed on the summary screen, or choose Back to modify 
settings before starting the install. The installation process will begin. It will take several 
minutes. 
Note When installing for the first time, you will be prompted to insert a CD or floppy with the 
required DOS files. These DOS files are used in the PXE Configuration and BootWorks features 
for DOS-specific deployment tasks like imaging and saving registry settings. You can get the 
required and optional DOS files from these sources: 
• Win 95 or Win 98 CD
• DOS startup disk

16 Install Deployment Agent to client computers. The Installation Information dialog box will open 
asking if you want to install clients.
Remote Install Clients. Select if you want to push the Deployment Agent to computers running the 
Windows NT, 2000, XP, and Windows Server 2003 operating systems. 
Download Adobe Acrobat. Select if you want to download the Adobe Acrobat Reader to read 
documentation in PDF format.

17 After the installation is complete, click Finish. After finishing the installation process, you can 
further configure your system by completing any of the following tasks:
• Install clients.
• Add more components to your system.
• Change the default settings applied during the Custom Install.

18 (optional) Add more components after a Custom Install.
To add additional Deployment Server Consoles to your system, run the Install Wizard again and 
select Add Components. 

19 (optional) Change default settings applied during the Custom Install
To change default settings that were applied during the Custom Install, create a new 
configuration using the Boot Disk Creator tool on the Deployment Server Console toolbar. You 
can use this tool to change the default settings if you: 
• Use BootWorks to image and change registry setting and other tasks requiring that you boot 

from DOS.
• Use multicasting instead of static IP to connect client computers. 

20 (optional) Use BootWorks instead of PXE.
You have successfully completed a Custom install for a Deployment Server system. Click the 
Deployment Server Console icon on your desktop to view all computer resources running 
Deployment Agents configured for your Deployment Server. 

See “Simple Install for Deployment Server” on page 61.
Deployment Solution Product Guide 64



 Deployment Server Installation Add Component Install for Deployment Server

 

Add Component Install for Deployment Server

The Add Component installation option allows you to add selected Deployment Server 
Components—Deployment Server, Deployment Server Console, the Client Access Point, and the 
Deployment Database—after the initial installation.

To add components
1 Start the server and log on as the administrator login you created to run Deployment Server. See 

“System Requirements” on page 59.

2 Launch the appropriate Altiris Deployment Server installation file and follow the setup steps. 
The Deployment Server self-extracting install dialog box will open. 

3 Click Extract and Execute App.
4 Click Add Component. 
5 Click Install. Click Yes to the Software License Agreement.
6 Enter a path for the Client Access Point. Click Next.
7 Select the Components to install. 

Install an additional Deployment Server Console. Click to install another Deployment Server 
Console (a Windows executable) on another computer. You can add as many Deployment Server 
Consoles as required to manage from multiple consoles across your system, but you can only 
install one at a time.
Install additional Deployment Agents. Click to install additional Deployment Agents on client 
computers, setting up managed computers in the Deployment Server system. 
Install an additional Altiris PXE Server. You can add additional PXE Servers across a network 
segment to handle boot requests for large environments. 
Master PXE Server. When you add another PXE Server, the PXE Server installed initially will be 
designated as the Master PXE Server. The Master PXE Server works concurrently with any 
additional PXE Server to handle boot requests across the network segment, but it also allocates 
additional blocks of IP addresses to other PXE Servers in the system. 
Install the Deployment Server Web Console. Click to install the Deployment Server Web Console 
on the local computer. The web console will install on the local machine if it is running Microsoft 
IIS.

Installing Deployment Solution Agents
Each client computer requires a Deployment Agent running on a local hard drive to communicate 
with Deployment Server and register in the Deployment Database. For Windows and Linux client 
computers, Deployment Solution lets you “push” agent software to a client computer from a 
Deployment console, or you can “pull” the Deployment agent from the client computer from the 
Deployment Server Web Console (or just pull it from the Client Access Point). 

To install the Deployment Agent for DOS (BootWorks), you can embed or create a BootWorks 
partition on the managed computer using the Install BootWorks command. The Deployment agents 
for handhelds are also easily installed from the console using prebuilt jobs.

• Deployment Agent for Windows (AClient). Install on any Windows desktop, notebook, or 
server computer. See “Installing Deployment Agent for Windows (AClient)” on page 66. 

• Deployment Agent for Linux. Install on any supported Linux workstation or server. See 
“Installing Deployment Agent for Linux” on page 70.

• Deployment Agent for DOS (BootWorks). Install on any Windows desktop, notebook, or server 
computer. See “Installing Deployment Agent for DOS (BootWorks)” on page 72.

• Installing Deployment Agent for Pocket PC. Install on handheld computers running the Pocket 
PC operating system. See “Installing Deployment Agent for PocketPC” on page 73.
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Client Connectivity and Network Adapters
Altiris supports all standard network adapter cards and includes many drivers with the installation 
of Deployment Solution. However, sometimes outdated drivers (including default drivers that come 
with the hardware) cause problems when clients are in BootWorks mode. To avoid these problems, 
you should check the manufacturer’s web site for your network adapter to make sure you use their 
latest driver in your BootWorks configuration file.

Some common client problems that can be solved by updating drivers are:

• Locking when loading drivers or failing to connect to the server
• Locking when imaging (downloading, uploading, or multicasting)

Microsoft Client Drivers
The Boot Disk Creator is set up to work with drivers that follow a certain standard. Since not all NIC 
drivers follow that standard, files may need to be moved to a different location. These three files 
must be in the same directory:

• The DOS driver for your card (drivername.dos)
• The sample protocol.ini that comes with your driver (protocol.ini)
• The OEM setup file that specifies the DOS driver (oemsetup.inf)
For example, the OEM setup file will contain lines similar to the following:

[netcard]

NGRPCI=”NETGEAR FA310TX Fast Ethernet PCI 
Adapter”,0,ndis,ethernet,real,NGRPCI,NGRPCI_NIF

[NGRPCI] (This header must be the sixth item listed in the line above)

Device=NGRPCI.DOS (If this line is missing, add it. The syntax is 
device=drivername.)

If there is no protocol.ini file, create a text file that contains the following command:

DriverName=drivername

Novell Client Drivers
The Boot Disk Creator does the following:

• Searches all subdirectories for a directory that contains *.ins, *.com, and net.cfg files. (They 
must be in the same directory.) The .ins file is then opened to get information about the network 
card.

• The program searches the file for a line starting with a carat (^). This line must have at least two 
values listed, separated by a comma. The two values needed are the description of the card 
(value1), and the .com driver file name (value2).

The following are requirements to install Deployment Agents to set up managed computers for each 
Deployment Server system. 

Installing Deployment Agent for Windows 
(AClient) 
For client computers running a Windows operating system, Deployment Solution allows you to 
install agent software using Remote Agent Installer to “push” the agent to a client computer from a 
Deployment console. Or you can “pull” the Deployment agent from the client computer by accessing 
the Windows share or downloading the install package from the Deployment Server Web Console 
You must have administrative rights to the client computers and File and Print Sharing must be 
enabled to install the agent software.
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Windows 9x. For Windows 95/98/Me clients, you must install the agent software locally. There are 
several ways to do this: You can add commands to the client login script to map to the Deployment 
Agent on your file server and run the executable, or you can e-mail the executable or a shortcut to 
users and run the install program from the client computer. For Windows 95a, you must add 
Microsoft updates for COM support for the Deployment Agent to run on the client computer. 

Windows XP. The Deployment Agent will not install to Windows XP if the Use simple file sharing 
(recommended) option is enabled on Windows XP. To ensure that this option is cleared, open My 
Computer and click Tools > Options. Select the View tab and ensure that the Use simple file sharing 
box is cleared.

When remotely installing the Deployment Agent for Windows (AClient) on a Windows XP 
computer, each user must have an account password. Remote Agent Installer will return an error 
message if it is unable to get to the Administrative share on the remote XP machine for each user. 
Windows XP will not allow access to any Administrative shares if the user on that computer does 
not have an assigned password (including the guest account). When all users have passwords and 
the network setup wizard has been run, you can successfully install the Deployment Agent using the 
Remote Agent Installer.

Remote Agent Installer
You can use the Remote Agent Installer utility program to install the Deployment Agent for 
Windows on Windows NT/2000/XP/2003 operating systems. For Windows 95/98/ME computers, 
you will have to install manually by running aclient.exe downloaded from the network share or 
from the Deployment Server Web Console. After downloading the install executable, run it on the 
local computer to install.

The Remote Agent Installer includes a wizard with the following screens. Follow instructions on 
each successive dialog box to install the Deployment Agent for Windows

Enter administrator account information
Enter common administrator credentials for all client computers, or keep default to be prompted for 
login credentials for each client computer.

Let me specify a user name and password. (default) Prompts for an administrative user name 
password for each computer in the remote install list.

Use this user name and password for all clients. Enter credentials for an administrator account that has 
rights to all client computers added to the remote install list.

Click Next.

 

Click the Remote Agent Installer button on the Deployment Server Console toolbar, 
or click Tool > Remote Agent Installer to open the utility program. You can also 
download aclient.exe from the network share or Deployment Server Web 
Console to install a Deployment agent.

Deployment Agent for Windows (AClient)

Processors Pentium
Disk space 5 MB contiguous
Operating systems: Windows 95, 98, ME

Windows NT 4.0 (Service Pack 4 or later)
Windows 2000
Windows XP
Windows Server 2003

RAM 32 Mb
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Specify install directory
Enter a location to install the Deployment Agent.

Install directory. Enter the path where the Deployment Agent will be installed on the client computer.

Enable this agent to use SIDgen and/or Microsoft Sysprep. Select if you are going to set NT security on 
the client computer. If you enable this option, you will be required to locate and download program 
install files. 

View agent settings in the summary box.

Click Change Settings to set Computer Configuration Properties for the Deployment Agent. 

Download Altiris SIDgen and/or Microsoft Sysprep 
If you previously selected Enable this agent to use SIDgen and/or Microsoft Sysprep on the previous 
dialog box, the Remote Agent Installer dialog box will assist in finding required install files for 
specific versions of the hard disk configuration utilities from Altiris and Microsoft.

  

Update file system permissions when changing SIDs. Click to automatically update file system 
permissions to maintain the individual file permissions that may have been set. This also includes 
the individual network shares that may exist on this client (in NT you can set permissions on folders, 
shares, and individual files.) Checking this option also includes those individual permissions. This 
will take a long time to convert the SIDs. To make the SID utility run faster, do not mark this option.

 

Click Next.

Select Client Computers on the Network
Identify client computers on the network and add them to a list of computers to remotely install the 
Deployment Agent. 

Add. Select the computers by name in the list box, or enter a computer name or IP address.

Computer Name. Enter the name of a computer on the network or its IP address.

Properties. Select a computer and view agent install settings. You can also change SID and Agent 
settings from this Agent Properties dialog box.

Import. Find an RCI file and import new computers from a file previously created file in a DOS text 
file. 

 

Select to download and install the Altiris SIDgen executable or the Microsoft 
Sysprep files. The Microsoft Sysprep files are specific to the NT operating system. 
You can select to install one or both utilities.

 

The installation program for installing Altiris SIDgen is located in the Client Access 
Point (in Program Files > Altiris > eXpress > Deployment Server 
> sidgen.exe by default). 

 

To install Microsoft Sysprep, you need to download the install files required for 
the Windows NT operating systems running on the client computer. 
Windows NT 4 (nt4prep.exe)
Windows 2000/XP/2003 (deploy.cab) 
You can install these files from the Microsoft Resource Kit Microsoft Resource 
Kit CD’s for each Operating system.
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This file has the following parameters: -c:[computer] –u:[username] –p:[password] –
i:[input file]. The parameters must be entered in this order. The password parameter is not 
required if the administrator account does not have one assigned. If you are using the default settings, 
you don’t need to specify an input filename. Each computer entry must be on a separate line.

Export. You can export the computers listed into an export file for future use. The default extension 
is *.RCI. Remote Agent Installer first looks for an RCI file extension, but any DOS text file can be 
used. 

When the computers appear in the installer list and the properties have been set, click Finish. The 
status of the agent install is shown on screen.

After the Deployment Agent is installed, it will connect to Deployment Server automatically and 
appear in the Computers pane of the Deployment console.

Install Deployment Agent from the Client Computer
Run AClient.exe from the Client Access Point (shared folder) or download the install file from 
the Deployment Server Web Console. 

1 At the Altiris Client Service dialog box, enter a location to install the Deployment agent. Select 
one of these options, if required:
Secure modification of server properties. This prohibits users from changing any agent settings.
Enable changing of Security ID. Select when managing security IDs to run a SID utility as part of 
an imaging job. 
Advanced. Click to open the Computer Configuration Properties dialog box and enter settings for 
the Deployment agent you are installing. 

2 Click Next.
If you chose to enable security IDs, you will see a screen listing options you can use for managing 
SIDs. Select the utilities that you want to use and enter the path where the utilities are stored.

3 Click Next to install the Deployment Agent. Select a group in Deployment Console to add the 
client to (optional). You can also leave it at the default group.

After the Deployment agent is installed, it will connect to Deployment Server automatically and 
appear in the Computers pane of the Deployment console.

See also “Installing Deployment Solution Agents” on page 65.

Automating the Installation of Deployment Agent 
for Windows (AClient)
If you choose not to use Remote Agent Installer to install Deployment Agent for Windows, perform 
the installation using log-on scripts or batch flies. However, this requires that you manually complete 
the installation at each client machine. Instead, you can use a template file to set applicable options 
and properties. 

The template file is a text file that can be used to automate configuration of the properties when 
installing Deployment Agent for Windows from a batch file, login script, or manually from a client 
computer. The template file can be created using two methods: editing the sample.inp file or using 
Remote Agent Installer.

Editing the Sample.inp file
Deployment Solution ships with a sample template file named sample.inp, which contains the 
commands to configure installation options and properties. This file is located in Program 
Files\eXpress\Altiris\Deployment Server.
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Most of the parameters have been disabled in this file. To enable an option, remove the semicolon. 
For example, to specify a specific IP address and port number for the client to use to locate the 
Deployment Server, remove the semicolon from the TcpAddr and TcpPort lines and then change the 
address and port number to the correct values.

Creating a Template File using Remote Agent Installer
A template file can be created when running Remote Agent Installer. After modifying agent 
properties and adding computers to the Selecting Clients window, use the Export button to create the 
template file. Clicking the Export button creates a file to import computers (*.rci) as well as the 
template file (*.inp). 

For example, if you had computers named PC-1 and PC-2 listed in the Selecting Clients window and 
then exported these computers using the file name Export.rci, these two template files would be 
created:

Export_PC-1.inp

Export_PC-2.inp

Using the Template File
To use the template file you created, run the AClien.exe installation program specifying the template 
file and using the -install switch. For example:

\\FX1\eXpress\AClient.exe aclient.inp -install

The following command-line switches are available:

Installing Deployment Agent for Linux
The Deployment Agent for Linux is installed by downloading and running the Deployment Agent 
for Linux installation file (a RedHat Package Manager [RPM] file) on the client computer. 

Note Like the Deployment Agent for Windows, the Deployment Agent for Linux is updated 
automatically when upgrading to a new version of Deployment Solution. Deployment Solution will 
check the creation date of the Deployment Agent and update the agent if a new one is available. 

One of the easiest ways to access the installation file for the Deployment Agent for Linux is to access 
the Deployment Server Web Console from the client computer and download the install file to the 
local hard disk. The Deployment Server Web Console can be set up for any Deployment Server 
installation. See “Deployment Server Web Console” on page 59.

Switch Definition
-install Tells AClient.exe to install Deployment Agent for Windows on the computer 

as opposed to just running it in memory.
-remove Permanently removes Deployment Agent for Windows from the computer 

where it was installed.
-silent Allows you to use the switches without being prompt for further input.
-stop Stops Deployment Agent for Windows from running, but does not remove it. 

The next time the computer is booted, Deployment Agent for Windows will 
run normally.

-start Starts Deployment Agent for Windows. This switch will only work when 
Deployment Agent for Windows is installed on the computer.
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Downloading Deployment Agent for Linux
Access the Deployment Server Web Console to download the Deployment Agent for Linux 
installation file. Then install and configure the agent from the client computer. 

1 Open a browser and type <computer name or IP address> / webconsole in the address field.
2 Type the name of the computer where the DeploymentWebConsole.MSI is installed.

If you don’t have a DNS server properly running and resolving names to IP addresses, you may 
have to enter the static IP address of the server, for example: 192.168.1.1/webconsole. The 
login page for the Deployment Server Web Console will open.
Note You can also distribute the Deployment Agent for Linux installation file using e-mail, 
saving it to an accessible file server directory, posting to an intranet or FTP site, or employing 
some other method of file distribution. You can locate the RPM file (altiris-adlagent-
<version numbers>.i386.rpm) in the Client Access Point (default location is Program 
Files > Altiris > eXpress > Deployment Server).
When downloading the installation file from the Deployment Server Web Console, if multiple 
RPM files exist then they will be displayed on the download page. You can then select the correct 
RPM file for download and installation. 

3 Click Install Agent Software in the left pane of the login screen. The Install Client Software 
page will open:

System Requirements

Processors Pentium
Disk space 5 MB contiguous
Operating systems: RedHat 7.2, 7.3, 8.0, 8.1

RedHat Advanced Server 2.1
United Linux 1.0

RAM 32 MB

Deployment Agent 
for Linux install file

Deployment Agent for 
Windows (AClient) 
install file
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4 Click the Deployment Agent for Linux installation file (altiris-adlagent-<version 

numbers>.i386.rpm) and save it to the a local directory on the client computer. 

 Installing the Deployment Agent for Linux
1 After downloading the RPM file to a local directory, you can install from the command-line or 

using a Package Manager application shipped with your Linux OS.
• To install from the command line, drive to the directory where you saved the RPM file and 

type: RPM -i <file name> 
• To install using the Package Manager shipped with Linux, you need to associate the RPM 

file with the Package Manager application.
The Deployment Agent for Linux will be installed in the /opt/altiris/deployment/
adlagent directory.

2 After installing the Deployment Server Console, you can change settings in the configuration file 
by making direct edit changes to the adlagent.conf file, or running a script from the /opt/
altiris/deployment/adlagent directory where the adlagent.conf file is located.
• To run the script to change settings for the adlagent configuration file, drive to the /opt/

altiris/deployment/adlagent directory from the shell and type the following:
./configure

You will then be prompted to select Multicast options to identify a Deployment Server to 
manage the current client computer, or you can select a specific Deployment Server by 
setting the Multicast option to false and adding the IP address of the desired Deployment 
Server. 

• To edit the configure file directly, open the adlagent.conf file located in the 
/opt/altiris/deployment/adlagent 
directory and make setting changes to the configuration document.
In many cases, you may want to edit the configuration file to change functionality or 
properties. For example, you can open the adlagent.conf file in an editor and scroll to 
the [Transport] section and the UseMcast line. Change UseMcast=true to 
UseMcast=false. Then type the IP address of the specific Deployment Server you want to 
manage the client computer into the TCPAddr=<IP address> line. Additional 
configuration settings can also be identified and edited in the configuration file.

3 After making edits to the configuration file, restart the Deployment Agent for Linux. 
To start and stop the Deployment Agent for Linux, you must enter the full path name or drive to 
the /etc/rc.d/init.d directory (with administrator/root rights) and use the 
adlagent stop and adlagent start commands, or the adlagent restart command. 
You can also use the Package Manager installed with Linux to restart the Deployment Agent for 
Linux.
By stopping and starting the Deployment Agent for Linux, the service will update the changes 
made in the adlagent configuration file.

You can now view the Linux managed computer from a Deployment console. 

See “Installing Deployment Solution Agents” on page 65.

Installing Deployment Agent for DOS (BootWorks)
After Deployment Server has detected the managed computer through the Deployment Agent for 
Windows, you can install BootWorks from the Computers pane. You can use this feature on 
Windows NT/2000/XP/2003.

Note: For Windows NT, embedded BootWorks partitions will not boot if the partition starts at a size 
larger than 2 GB. In most cases you will not want to use a hidden Bootwork partition with Windows 
NT. PXE Servers or the embedded Bootworks is preferable for Windows NT.
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To install Deployment Agent for DOS from the console
• Click Advanced > Install BootWorks. 

BootWorks will install on the client computer and shut down to boot to DOS. This installs 
BootWorks using default configuration information (entered when you installed Deployment 
Server), and settings from the Deployment Agent.

Here are some other ways to create and install BootWorks boot files:

• For Windows 95, 98, or ME computers, create boot disks to install locally.
• For Deployment Solution systems running PXE Server, create and install boot files for PXE 

using Boot Disk Creator.
• To install BootWorks on Windows NT/2000/XP/2003 computers, you can create a Microsoft 

Install Package (MSI) and deploy it using a job from the console. See “Distributing 
Software” on page 167.

For additional information about creating and configuring boot files, see Boot Disk Creator Guide.

See “Installing Deployment Solution Agents” on page 65.

Installing Deployment Agent for PocketPC 
The Deployment Agent for Pocket PC allows you to manage and deploy handheld computers 
running the Pocket PC operating system, including:

• Compaq iPAQ
• HP Jornada Pocket PC
• Casio Cassiopeia Pocket PC
You can manage handhelds through a cradle attached to a host computer, or through direct 
connection to the network using a LAN or wireless network adapter. When connected through the 
cradle, the Pocket PC Agent software will reside on the host computer and the Pocket PC Client 
software will reside on the handheld computer. This configuration allows Deployment Server to 
recognize and update the handheld each time it returns to the cradle and synchronize with the host 
computer using Microsoft ActiveSync. Handheld computers connected directly to the network 
install only the PPC Client software and are managed like any other computer in your Deployment 
Server system. 

Install from a cradle or cable. See “Install a Pocket PC Agent from the Deployment Console” on 
page 74 to install to a handheld computer in the cradle attached to a host computer.

System Requirements

Processors Pentium
Disk space 5 MB contiguous
Operating systems: MS DOS and Linux
RAM 32 MB

System Requirements

Processors ARM
MIP
SH3

Disk space 5 Mb contiguous
Operating systems: Pocket PC
RAM 16 Mb
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Download CAB files with ActiveSync. See “Install Pocket PC Agent from the Host Computer” on 
page 75 to install the handheld by running or copying the Deployment agent install file or the 
Deployment Client CAB files over the network.

Install directly to the handheld. See “Install Pocket PC Client on the Handheld” on page 75 to 
install only the Deployment Client from CAB files on the handheld computer.

The Deployment Agent for Pocket PC (PA) runs on the host computer, which itself is a managed 
computer running the Deployment Agent for Windows (DS). The Deployment Agent for Pocket PC 
automatically installs the Deployment Client for Pocket PC (PC). You can also install the 
Deployment Client for Pocket PC directly to the handheld by installing the required CAB files.

Install a Pocket PC Agent from the Deployment Console
When installing a handheld running the Pocket PC operating system, you can attach to a host 
computer and run Microsoft ActiveSync software to synchronize data between the host computer 
and the handheld. Deployment Solution allows you to install Deployment Agents on both the host 
computer and the handheld to communicate with Deployment Server as a managed computer.

The Altiris Pocket PC Agent is software that runs on the host computer. This agent communicates 
through the handheld’s cradle to the Pocket PC Client running on the handheld. The Pocket PC Agent 
also automatically installs Pocket PC Client on the handheld. The Pocket PC Agent provides 
communication between the Pocket PC Client on the handheld and the Deployment Server. 
ActiveSync is required for the Pocket PC Agent because it provides the IP stack the Pocket PC Agent 
uses to communicate with the handheld.

The Pocket PC Agent monitors the connect and disconnect jobs sent to the handheld. If the Pocket 
PC Client on the handheld is present but not started, then the agent will start it. The Pocket PC Agent 
also acts as a relay agent to transfer data from the Pocket PC Client on the handheld to the 
Deployment Server.

From a Deployment console, you can schedule and run a Sample job to install the Pocket PC Agent 
on a host computer. Make sure that the handheld is connected to the host computer and seated in the 
cradle. You must also download Microsoft ActiveSync™ and install it (this is free software 
available on the Microsoft web site) on the host computer. Then synchronize the host computer with 
the handheld.

To install from a Deployment console
Use Deployment Solution to find computers with ActiveSync and run deployment jobs to 
automatically copy the necessary files and install the Deployment PPC Agent and PPC Client.

1 From a Deployment console, in the Jobs pane open the Samples > Pocket PC folder. 
2 Click the Install Altiris Pocket PC job and then select the Active Sync Machine condition in the 

Condition box in the Details pane.
3 Drag the Install Altiris Pocket PC job to the host computer. If you are using a Web console, then 

assign using web features.
4 Schedule the job.
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After the Pocket PC Agent has installed, the Altiris Pocket PC Agent icon will appear in the 
system tray of the host computer. 
When the Deployment Agent is initialized, it will connect to the handheld. The agent will check 
if the Altiris Pocket PC Client is installed on the handheld. If not, the agent will automatically 
install it. 
When the Pocket PC Client is installed on the handheld, the Deployment Client icon will appear 
in the system tray of the handheld and the client details screen will display. 
Note For ease of use, the Pocket PC Client will first try to connect to a Pocket PC Agent. If it 
fails, the Pocket PC Client will try to connect directly to the Deployment Server.

5 Click OK. 
The handheld will appear in the Deployment Server Console as a unique computer displaying 
the handheld’s name.

See “Installing Deployment Agent for PocketPC” on page 73.

Install Pocket PC Agent from the Host Computer
From the host computer, you can install the Pocket PC Agent by running the ppcagent.exe 
installation file on the host computer. After installing the Pocket PC Agent, it will automatically 
install the Pocket PC Client when the computer’s synchronize. This is the fastest and easiest way to 
install both agents on the host and handheld computers.

In addition, if you are using ActiveSync 3.5 or a later version, you can also log in to the Client Access 
Point in the Deployment Server > Pocket PC Client folder and copy the correct CAB file 
for the handheld (based on type of processor) to the host computer. You can then copy the CAB files 
directly to the handheld using the Explore feature in ActiveSync.

To install Pocket PC Client directly with ActiveSync
1 Copy the CAB file to the host computer with ActiveSync (or to a share where you can copy the 

file from).
2 Connect your device to your desktop computer using a cradle or cable. 
3 In ActiveSync, click Explore. Windows Explorer will open the Mobile Device window for your 

device.
4 In Windows Explorer, browse to the CAB file that you want to copy.
5 Right-click the file and click Copy. 
6 Place the cursor in the desired folder for your device, right-click, and click Paste.
7 From the device, tap Start > Programs > File Explorer.
Browse for the CAB file and tap the file to execute it. When the Pocket PC Client is installed on the 
handheld, the Altiris AClient icon appears in the handheld’s system tray.

Note If using ActiveSync 3.5, the Pocket PC Agent is not required after the Pocket PC Client is 
installed. However, the Pocket PC Agent can still be useful for installing the Pocket PC Client onto 
the handheld, loading the client, and managing client settings.

See “Installing Deployment Agent for PocketPC” on page 73.

Install Pocket PC Client on the Handheld
You can install the Pocket PC Client directly to the handheld computer if your handheld has a 
network adapter (LAN or wireless), allowing you to download the correct CAB file and install the 
Pocket PC Client to communicate with the Deployment Server.

The following CAB files are provided based on processor type. Copy the CAB files from the Client 
Access Point in the Deployment Server\PocketPCClient folder: ppccInt.Arm.CAB, 
ppccInt.MIP.CAB, ppccInt.SH3.CAB. 
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To install Pocket PC Client using CAB files
1 Copy the CAB file to the host computer with ActiveSync (or to a share where you can copy the 

file from).
2 Connect your device to your desktop computer. 
3 In ActiveSync, click Explore. Windows Explorer will open the Mobile Device window for your 

device.
4 In Windows Explorer, browse to the CAB file that you want to copy.
5 Right-click the file and click Copy. 
6 Place the cursor in the desired folder for your device, right-click, and click Paste.
7 From the device, tap Start > Programs > File Explorer.
Browse for the CAB file and tap the file to execute it. When the Pocket PC Client is installed on the 
handheld, the Altiris Deployment Agent (AClient) icon appears in the handheld’s system tray.

See “Installing Deployment Agent for PocketPC” on page 73.

Uninstall the Pocket PC Agent
1 Open the Pocket PC Agent status sheet by double-clicking Altiris Pocket PC Agent icon.

2 Click Options > Uninstall.
You can also uninstall the agent by running the ppcagent -remove switch from the command line. 

Note There is no uninstall program for the PPC Client. To remove the Pocket PC Client, you must 
remove the client file from the My Device\Windows\ppccInt.exe file on the handheld.

Managing Licenses
From the Deployment Server Console you can find the number of licenses used, detect an expired 
license, or apply a license to a client computer.

The Deployment Server system also provides a license utility to update or add licenses to installed 
sites. This utility allows you to show license status, install a newer license, and add additional 
licenses. See “Using License.exe” on page 77.

Finding the Number of Licenses Used
Open the Deployment Server console and select Help > About from the main menu bar. You will now 
be able to see the total number of licenses that you have purchased, the total licenses that you have 
used, and the total licenses available.

You can also tell which computers have not had a regular license applied to them by looking at the 
computer in the Computers pane. If the icon has a clock in the lower left-hand corner, this computer 
is still using the free license.

Detecting an Expired License
A computer listed in the Computers box of the Deployment Server console will be gray instead of 
blue if the license has expired. However, this may not always mean the license has expired, so also 
check the other options listed below.

1 A computer with an expired license will state Client license expired - see computer properties when 
selected.

2 If you try to display the properties of a computer with an expired license, you will see the 
following error message: 
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Error: You have chosen a computer that has expired. Clients that are expired cannot be managed 
until a license is purchased for them and they have been flagged in the Computer Properties 
dialog box to accept a regular license.

Note If you place a job on a computer with an expired license, the same error message will be 
displayed.

Adding a License from the Console
You must apply a license to a computer to continue to manage it after the free trial has expired. To 
add a regular (permanent) license, complete the following steps:

1 Right-click the computer where you want to apply the license.
2 Select Properties.
3 Select Apply regular license. Click OK.
Note To apply licenses on multiple computers, right-click the computer group and select Advanced 
> Apply Regular License.

Using License.exe
The Deployment Server system also provides a license utility to update or add licenses to installed 
sites, allowing you to apply the license activation key file (a .lic file) when you install the product. 
The license utility is installed when the specific product is installed. The License Utility allows you 
to show the license status, Install a newer license for installed software, and add additional licenses 
for installed software.

To show license status
1 Open the License Utility.

2 Enter the directory path to the new LIC file. Click Next.
The default path is a:\.

3 Select the new license and click OK.
A summary screen will open showing activation key information.

Installing a Newer License for Installed Products
Follow these steps to apply a 30-day evaluation license or a purchased license to installed products 
that use a license activation key file (LIC). When a product is installed from the Altiris CD or the 
Altiris web site, a 7-day trial license is automatically applied.

Note You do not need to apply a license key to activate the HP Compaq Thin Client t5000 Series. 
This managed client computer will automatically receive a non-expiring license when connected to 
the console.

Important You will need the license activation key file for future product updates. After you receive 
the key, store it in a safe place (such as a floppy diskette) for future reference. Multiple license 
activation key files can be stored in individual folders on a single diskette. You can also store 
multiple license activation key files in the same folder, as long as the file names are different.

 

To open the Altiris License Utility:
Click Start > Programs > Altiris > Altiris eXpress > Deployment Server > 
Product Licensing Utility, or in the Altiris program directory where you 
installed the Altiris product, locate and run the LICENSE.EXE utility.
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To apply the license file 
1 Open the License Utility.
2 Enter the directory path to the new LIC file and click Next.

The default path is A:\.
3 Select the new license and click OK.

An information window will appear showing activation key information.
4 Click Next.

A list appears showing the Altiris products that use license activation key files that you have 
licensed.

5 Click Finish.
See “Installing Deployment Solution Agents” on page 65.

To add licenses
Some Altiris utilities can combine multiple licenses together for the total number of nodes (for 
example, two 50-node licenses can be combined to a single 100-node license). Follow these steps to 
apply an “add-on” license to your installed Altiris product.

1 Open the License Utility.
2 Enter the directory path to the new LIC file and click Next.

The default path is A:\.
3 Select the new license and click OK.

An information window will appear showing activation key information. 
4 Click Next.

A list appears showing the Altiris products that you have licensed. 
5 Click Finish.

Appendix
The following are help file topics for the Deployment Server installation program accessed by 
clicking the Help button or pressing the <F1> key. These topics identify and explain the screen 
elements on the dialog boxes used in the installation process.

Install Configuration
The Deployment Server system supports both a Simple Install and a Custom Install option. A Simple 
installation allows you to install all components on a single computer. The Custom installation 
allows you to distribute individual components of a Deployment Server system on separate 
computers. Use the Add Component option to install additional components to your system. 

Simple Install. Click this option to install all Deployment Server components on a single computer. 
This configuration is recommended for managing computers on a single LAN or across a site with 
few subnets. See “Simple Install for Deployment Server” on page 61.

Include PXE Server. Select this feature to install the Altiris PXE Server when running the Simple 
install option. The PXE Server requires that a DHCP server is also installed on your network.

Local Computer Install Helper. Click this option to check for an installation of Microsoft SQL Server 
for a Simple install. If Microsoft SQL Server or MSDE is located, then the installation program will 
continue. If not, then the installation program will prompt you to automatically install MSDE 2000 
from an Altiris download web site. 
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Custom Install. Click this option to install Deployment Server components on separate computers 
across your system. A Custom install allows you to balance network activity for large enterprises 
with multiple subnets. For example, use this option to distribute the Deployment Database on a 
separate computer or assign another file server as the Client Access Point to store image and package 
files. See “Custom Install for Deployment Server” on page 62.

Add Component. Click this option to install additional Deployment Server components to your 
system. For example, use this option if you want to add a PXE Server to your Simple or Custom 
install, or if you need multiple Deployment Server Consoles. See “Add Component Install for 
Deployment Server” on page 65.

If you have multiple network adapter cards, then a secondary dialog box will open asking you to 
select the IP address for the Deployment Server interface.

See also “System Requirements” on page 59. 

Installing Deployment Server
Specify the Client Access Point (shared directory) where image files, RIPs, and other package files 
will be stored. Make sure you have a shared Windows or NetWare directory with available disk 
space and security rights before installing. 

File Server path. Select the drive letter and directory path where Deployment Server will be installed. 
The default is to install in the Program Files directory on the local computer.

Create eXpress share. If installing to a local Windows computer, select the check box to create a 
shared directory as your Client Access Point. If installing to a remote file server or if you choose an 
invalid path, then this option will be unavailable.

Note If installing to a remote file server, create a share or grant access rights to the Deployment 
Server directory on the file server before you start the installation. For Windows XP, you must run 
the Network Setup Wizard accessed from My Network Places to enable sharing.

License file. Type the path or browse to the license (.lic) file received when you registered on the 
Altiris web site.

Free 7 day license or maintenance upgrade. Click to use the evaluation license for a new Deployment 
Server installation.

License file. Browse and select the license file provided with your purchase of Deployment Server.

Service user name and password. If running a Simple Install, type the user name and password of the 
Deployment Server service and the Client Access Point. For domain accounts include the domain 
name, for example: orgDomain\admin. Make sure you create the administrator domain account 
before starting the installation.

See also “Deployment Server Components” on page 56.

Deployment Server Install
Install the Deployment Server on a computer. The service is identified in the Services section of the 
Windows Computer Management as Altiris eXpress Server. 

To install service on a local computer
1 Click On this computer. Edit the default installation path if desired.
2 Type the user name and password of the Deployment Server (Altiris eXpress Server). For a 

domain account, type the domain and user name. Create this account before starting the 
installation.
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To install service on a remote computer
1 Click the On a remote computer button. 
2 Type the name of the computer or browse to where you want to install. The destination path and 

IP address of the computer will appear automatically.
3 Type the user name and password of an administrator account for the Deployment Server (Altiris 

eXpress Server) computer. For domain accounts include the domain name, for example: 
orgDomain\admin. The user account must have rights to the Client Access Point. Create the 
administrator domain account before starting the installation.

See also “Deployment Server Components” on page 56.

Deployment Database Install
Install the Deployment Database on a local or remote server with or without an existing Microsoft 
Data Engine (MSDE) or Microsoft SQL Server. To install the database you must have 
administration rights to the selected server.

Note In Deployment Solution 6.0 and later, if you have multiple instances of the MS SQL Server 
already set up, you can identify a specific instance using this format: <SQL Server 
Name>\<database instance>. The database name must remain “express,” but the instance of the 
database can vary. For example, if you have a clustered MS SQL Server to manage multiple 
Deployment Solution systems on different network segments, you can enter the name 
salesSegment\express or marketingSegment\express depending on the previously 
established database instance.

Install the Deployment Database using these options:

• Click On this computer to install the Deployment Database on the local computer.
• Click On the same computer as the Deployment Server to install MSDE and/or the Deployment 

Server Database on the same computer as the Deployment service (Altiris eXpress service). 
• Click On a remote computer to install MSDE and the Deployment Server Database on a remote 

computer other than the same computer as the Deployment Server (Altiris eXpress service). A 
default path installation path is entered automatically.

• Click On an existing Microsoft SQL Server 7/2000 database to create the Deployment Server 
Database on an existing Microsoft SQL Server 7 or Microsoft 2000 database. Type the name or 
browse to the database server. You must have administration rights to the existing Microsoft 
SQL Server. 

See also “Deployment Server Components” on page 56.

PXE Server Install
Select options to boot locally using BootWorks or across the network using the Altiris PXE Server 
using the Intel Pre-boot eXecution Environment (for PXE-compliant computers only). 

Note If you have a Novell NetWare file server, you must set up the Altiris PXE Server after installing 
Deployment Server. The Universal Network Device Interface (UNDI) default driver is not supported 
by Novell NetWare.

• Click No if you do not use PXE and prefer using Bootworks to run tasks from DOS.
• Click Yes, I want to install PXE on this computer to install on the local computer.
• Click Yes, I want to install PXE on a remote computer to install the Altiris PXE Server on a remote 

computer. Type the name of the computer and the path.
When you install PXE, the Deployment Server IP address is entered automatically.

See also “Installing Deployment Agent for DOS (BootWorks)” on page 72.
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Client Connection to Server
Select the protocol that your managed computers will use to connect to the Deployment Server. 

Use IP multicasting. Allows managed computers to connect to any Deployment Server. To use 
multicasting and connect to a specific Deployment Server, enter the name of the Deployment Server 
computer.

Multicasting cannot be used with the UNDI driver. If you want to use different drivers on the PXE 
Server, you can create multiple PXE boot files after installing.

Use TCP/IP. Installs the Altiris PXE Server using the Intel Pre-boot eXecution Environment (for 
PXE-compliant computers only). You can use this without PXE for faster access, as it goes directly 
to the IP address without searching. 

If managed computers are on a different segment or if you are using the Altiris PXE Server with an 
UNDI driver, choose Use TCP/IP and enter the IP address of the Deployment Server that the managed 
computers will connect to. Do not change the port number unless the default is already being used. 
(If you change the port number, you will have to change the client configurations.)

See also “Deployment Agents” on page 120.

Installing Components
Choose Next to start installing, or choose Back to change settings.

To install additional components after the install is complete, select Install Additional Components.

See also “Deployment Server Components” on page 56.

Summary
The components shown in the list have been installed.

If you want to install clients remotely (Windows NT/2000/XP/2003 only), select the option and 
select Finish.

See also “Deployment Server Components” on page 56.

User name and Password
Type the user name and password with administrator rights of the computer where you will install 
the component.

See also “Deployment Server Components” on page 56.

Add Components
If you have already installed Deployment Server, you can add components to the existing system. 
Select the type of component you want to add.

See also “Deployment Server Components” on page 56.

Console Install
You can install the Deployment Server Console to either the local computer or multiple remote 
computers. Installing to remote computers allows you to manage computers from multiple 
Deployment Server Consoles across the Deployment Server installation. 
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• Click On this computer to install the Deployment Server Console to the local drive.
• Click On a remote computer to install the Deployment Server Console to a remote computer. Type 

the computer name or browse and select a computer.
See also “Deployment Server Components” on page 56.
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Installing Deployment on Notification Server

Deployment Solution lets you design and scale a system based on your network topology, 
geographical divisions, or other organizational considerations. To scale a system for your needs, you 
can set up Deployment Solution on Notification Server to identify and manage multiple existing 
Deployment Server installations, or install new Deployment Server systems remotely to centrally 
manage each network segment. 

Deployment Solution runs on and installs from the Notification Server platform, and allows you to 
set up both the web and Windows components of Deployment Solution. After installing Notification 
Server, you can use the Solution Center to install Deployment solution (select Deployment Solution 
from the Solution Center list). 

Note You can run the Notification Server Install Helper to expedite installation of Notification 
Server and its web components. See the Notification Server User Guide for complete installation 
instructions.

Planning and installing the Deployment view on Notification Server:

• See Planning Deployment Solution Installation (page 84) for general information about site 
hierarchy and scalability.

• See Installing Deployment Solution on NS on a Single Server (page 86) to install both the 
Deployment  on Notification Server and the Windows-based Deployment Server components. 

•  See Adding Deployment Solution to Existing Notification Server (page 91) to add Deployment 
Solution to manage existing Deployment Server installations.

Supported Platforms

When installing Notification Server, you can install on Windows 2000 or Windows Server 2003 
using the default settings. In most cases, all Notification Server prerequisites will be met except for 
these requirements:

• FTP (installed and activated using Internet Services)
• Database: Microsoft SQL Server 2000 or MSDE 2000

Note: When pushing an install of Deployment Solution from Notification Server, you must have 
Microsoft SQL Server or MSDE previously installed on the target computer or the installation 
process will fail.

• NTFS partition
Note If you manually run the install from the package directory (for example, in the NSCap 
directory), it creates a hidden file in the directory which will cause the install package to fail. If the 
package fails, you should ensure that no hidden files exist in the package directory.

Microsoft Windows 2000 Server/Advanced Server
Microsoft Windows Server 2003
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Prerequisites 

Licensing

You do not need a license to install and use the Deployment view on Notification Server. The 
Deployment view on Notification Server allows you to manage multiple Deployment Servers 
without additional licenses for web functionality. Each Deployment Server installation, however, 
requires an Altiris license per managed user. See the Altiris Getting Started Guide for additional 
licensing information.

Planning Deployment Solution Installation
Altiris Deployment Solution provides centralized, remote deployment and management of all types 
of computers using complementary Windows and Web components and protocols. By planning, 
designing, and implementing a Deployment Solution system specific to your IT requirements, you 
can increase productivity, save on IT costs, and significantly decrease administrative response time 
across your organization or enterprise.

• Individual sites or network segments can implement the Windows components of Deployment 
Solution (Deployment Server installations) to deploy, manage, and migrate all types of 
computers in real-time across the LAN.

• Organizations running multiple Deployment Server installations can centralize management of 
each network segment or site using the Deployment view on Notification Server to generate 
reports, run or schedule deployment tasks from a central console, and integrate additional web 
applications.   

• Existing Notification Server sites can now integrate Deployment Solution installations with their 
Inventory, SW Delivery, Asset Control, Helpdesk and other solutions to provide comprehensive 
control and reporting of hardware and software resources. Package Servers also allow you to 
replicate package stores across your organization to decrease download time and network traffic. 

When planning your Deployment Solution system, you need to determine the best use of 
Deployment Solution to meet specific requirements for your environment. The Windows and Web 
features of Deployment Solution can be configured to meet your specific needs based on 
organizational size, access requirements, and existing network configuration.

About Hierarchy and Scalability
Altiris provides a hierarchical architecture that allows you to install software solutions at different 
levels for different computer deployment, management, and reporting needs across your 
organization. Deployment Solution provides local, real-time management using Deployment Server 
components, and the Deployment view on Notification Server to extend and scale a system 
specifically for your IT requirements.

Direct, real-time management over the LAN is performed from the Deployment Server Console (or 
the Deployment Server Web Console) in a Deployment Server system. When your organization 
grows, you can add more Deployment Servers to manage additional network segments. To integrate 
and centralize management of Deployment Server systems, you can add the Deployment view on 
Notification Server and combine other Web solutions to complete a comprehensive IT management 
system. 

Microsoft SQL Server 2000 (SP3) and MSDE 2000 (SP3)
500 MB Free HD space
256 MB RAM (512 MB recommended)
20 GB Hard Drive
NTFS Partition
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Each level of management both centralizes and expands your deployment and reporting capabilities. 
Integrating Deployment Server and Notification Server solutions allow you to scale vertically to 
centralize Web reporting and management, while extending laterally with new network segments 
and sites. Systems can be scaled to conform to geographical location, network topology, company 
organization, remote access needs, or other organizational divisions unique to your organization. 

Deployment Solution allows you to perform tasks specific to each level of IT administration across 
your organization. At a local level, IT technicians can remotely deploy and manage computers across 
the LAN using Windows tools and applications in Deployment Server. At a district level, IT 
managers can access and manage multiple Deployment Server installations and centralize 
deployment tasks. And at the Corporate level, additional inventory, help desk, and asset reports can 
be generated for executive needs.  

At a LAN level, each IT technician can manage in real-time thousands of groups of computers in 
each Deployment Server installation, including imaging and deploying computers, migrating 
personality settings, updating operating systems, and deploying software for a specific network 
segment. IT personnel can employ Deployment Server to perform low-level, real-time deployment 
tasks for large or small LAN segments. Using Deployment Server components, all types of 
computers can be installed, configured, reconfigured, and retired throughout their lifecycle. Each 
Deployment Server installation can manage high-density server farms, desktop computers across 
multiple domains, and remote handheld and notebook computers for specified network segments or 
sites.

At a district level, another level of management can be established using the Deployment view on 
Notification Server to centrally view, report, and deploy computers across multiple Deployment 
Server installations. Reports of computer properties, configuration histories, assigned deployment 
tasks, and other summary data for Deployment Server installations can be generated at the district 
level from a consolidated IT department using the Deployment view on Notification Server. From 
this central IT location, packages can be built and deployed, including install packages, hard disk 
images, scripts, RapidInstall packages (RIPs), and other software deployment packages for use 
across the organization. 

From the Corporate Office level, you can install a third-level of control and reporting by adding the 
Helpdesk Solution, TCO Mgmt (total cost of ownership management) , Asset Management solution 
(for non-computer assets), Inventory Solution, and many other Altiris solutions. 

Using a various Web and Windows components of Deployment Solution, you can scale a 
Deployment system to meet specific computer deployment and management needs. 
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Installing Deployment Solution on NS on a Single Server

You can install the complete Deployment Solution system to a single computer, including 
Deployment Server components for real-time management, and the Notification Server with the 
Deployment view for reporting, scheduling, and Web integration features. 

Note When you first add the Deployment view on Notification Server to your Deployment Solution 
system, you will want to install it to a test environment to get acquainted with the Web features and 
settings, optimum polling intervals between databases, and other important design and 
implementation features. 

After installing Deployment Solution in a test environment, you can modify it to be a production 
system by changing polling intervals and other settings in Deployment on Notification Server (see 
“Setting Polling Intervals” on page 316). From the Deployment view, you can install Deployment 
Servers for each defined network segment, or push out the Notification Server Client to existing 
Deployment Server installations. 

This section provides steps for performing a complete Deployment Solution install, beginning with 
the Notification Server installation and then installing the Deployment view on Notification Server. 
You can then install Deployment Server components (Windows components) from the Deployment 
view on Notification Server. 

Note These installation steps are provided as a demonstration of the Deployment view on 
Notification Server and Deployment Server components on a single server. As a result, instructions 
are given to update polling intervals over short spans of time not usually optimal for production. 

Installation Steps
1 Install Notification Server. 

You need Administrator rights on the selected computer(s) to install Notification Server. 
a Run the Install Helper (AeXNSInstallHelper.exe) to identify and install prerequisite 

components required for installing Notification Server. This utility runs automatically if 
installing from the Altiris Product CD.

b Install all components required for Notification Server as identified in the Install Helper. 
In most cases, you will be required to install the MS SQL 7/2000 database or Microsoft Data 
Engine (MSDE) database. The MSDE database ships on the Altiris Product CD or can be 
installed from the Microsoft Web site. 

c Select Install eXpress Server to launch the Notification Server installation file 
(AeXNS_5_5.msi) from the Install Helper. 
You can also run the Notification Server installation program by double-clicking the 
AeXNS_5_5.msi file. 
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Follow all installation instructions, including: 
• Click Yes to install the AdminContext.cab file.
• Step One: Enter an administration user name and password. You must have administration 

rights to install Notification Server.
• Step Two: Click through this page without entering any values to disregard e-mail 

functionality when installing only Deployment Solution. 
• Step Three: Enter the user name and password for an existing Notification Server Microsoft 

SQL database, or create a new database. If Login ID is left blank, then Notification Server 
uses Windows authentication.
Caution Do not access an existing Deployment Server database. Only access an existing 
Notification Server database or create a new database. 

Note When you install Notification Server, the Notification Server Client will install 
automatically to that computer. To manage existing Deployment Server installations you will 
need to install the Notification Server Client on those computers running Deployment Server.

2 Set polling intervals for Notification Server. 
During your first stage of installation, you will want to configure Notification Server and 
Deployment Solution for testing purposes only. This means you will need to set short polling 
intervals so that you can view updated data in the Deployment view of Notification Server.
a From the Solutions tab in the left frame of the Notification Server Administration Console, 

click server > Altiris Express Configuration > Policies > NS Client Configuration > Client 
Settings. 

b From this page, click Configure the Win32 Client, then click Client Communication in this list.
The Client Communication page will open with settings to configure communication with 
Notification Server and its client computers, including polling intervals. 

c In the client should request new configuration information every box, select 1 minute 
from the drop-down list. 

d In the client should send basic inventory every field, select 15 minutes from the drop-
down list. 
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Note These settings are for testing only, allowing you to update quickly for viewing data. 
This setting would be too frequent for production, but allows you to test the system without 
waiting for long periods before verifying changes. 

e Click Apply.
3 Install Deployment Solution (Deployment view on Notification Server). 

Install Deployment Solution from the Solution Center in the Notification Server Administration 
Console. 
a From the Solution Center tab, click Deployment Solution. Follow all installation 

instructions provided in the Deployment Solution installation wizard. 
You can also double-click the AeXDeployment_5_5.msi file on your local drive and 
follow all installation instructions.
Note If an error appears when installing from the Solution Center, you may have linked to 
the wrong location. Click the Solution Center link to change your Solution Center 
configuration, if required to install from the local drive or another Solution Center (such as 
the beta site Solution Center). 

b Click Finish when the installation is completed.
c After installing Deployment Solution, click the Refresh button on the browser. 

After installing Deployment Solution, the Deployment tab will appear on Notification Server 
Administration Console. 

4 Set polling intervals for Deployment Solution (Deployment view on Notification Server). 
a Click the Solutions tab.
b Click server > Deployment Solution > Policies > Deployment Server Agent Configuration > 

Deployment Server Agent Config for all Deployment Servers.

The Deployment Solution Agent Configuration page will open. 
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Note You can also click the Deployment tab, and then click the Options button and select 
Configure from the drop-down list.

c In the Event Polling Interval box, select 1 minute from the drop-down list.
Note These settings are for testing only, allowing you to update quickly for viewing data. 
This setting would be too often for production but allows you to test the system without 
waiting for long periods before verifying changes.

d Click the Apply button.
5 Update Notification Server Client (testing only).

For testing purposes, ensure that the polling interval settings are updated by the NS Client (so 
that you do not have to wait the default 12 hours polling interval).
a Wait for the client icon to appear after installing Notification Server. The NS Client icon 

appears in the system tray (in the lower right-hand corner or the screen).

b Double-click the NS Client icon in the system tray.
The NS Client page will open.

c Click the Configuration tab.
d Click the Update Configuration button.
e Confirm the value of the Configuration Request Interval setting on this page (1 minute for this 

test setup). 
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If it is not set to the value you set in the Notification Polling configuration (see step 3c in this 
document), proceed with these steps in this Update Notification Server Client section.

f Click the Send Basic Inventory button. Wait one minute (or the amount of time you set in step 
3c).

g When the value is updated, click the Update Configuration button again.
h If the polling interval is not updated on this screen, reconfigure the polling interval for 

Notification Server by going through step 3 again.
i Close the NS Client page.

6 Install a new Deployment Server.

From the Deployment view on Notification Server, you can install the Deployment Server 
components. Click Options > Installation on the Deployment view to open the dialog box to install 
Deployment Server. 
Note The Notification Server Administration console > Solutions tab > Deployment Solution > 
Policies folder includes a policy named Full Installation/Upgrade of Deployment Server. This 
policy runs automatically when installing Deployment Server components, however, you cannot 
install Deployment Server components by enabling or actuating this policy from the tree view in 
the Solutions pane. Instead, install Deployment Server from the Deployment tab > Options button 
> Installation. 
a Click the Deployment tab. Click Yes to install any CAB files throughout this installation.
b Click the Install Deployment Server link on the dialog box that pops up or click Options > 

Installation... from the Deployment view on Notification Server.
The Gather DOS boot files dialog box will open.

c Gather the required DOS files by any method identified on the screen. Click Finish when the 
DOS file copy is completed.
Deployment Solution Product Guide 90



 Installing Deployment on Notification Server Adding Deployment Solution to Existing Notification Server

 

The Deployment Server Installation dialog box will open.

d Click the Add button to select a computer to install Deployment Server.
e Select a computer to install Deployment Solution. To install all components on a single 

computer, select the name of this computer (the local computer on which you just installed 
Notification Server). Click Next.

f Type an administrator user name (Administrator is the default) and password.
g  Clear the check box if you do not want the PXE Server installed on this computer.
h Enter the path of the license file for Deployment Server or select the license file from a 

secondary dialog box. Click the Finish button.
The Deployment Server Installation dialog box will open. 

i Click the Install button.
A screen stating that Deployment Server could take several minutes to install will open. This 
installation time depends on the polling interval you previously set.

j Click OK. 
7 Set up managed computers.

From the Deployment Server Console, you can remotely install the AClient application to client 
computers to communicate with Deployment Server as a managed computer in the Deployment 
Solution system. These computers will appear in the Deployment view after the polling interval 
has elapsed. 

You have now completed setting up and configuring the Deployment view on Notification Server 
and Deployment Server components on a single test computer. After the polling interval expires, all 
managed computers from the Deployment Server installation will be displayed in the Deployment 
view on Notification Server. 

Adding Deployment Solution to Existing Notification Server
Use these steps to add the Deployment view on Notification Server to existing Deployment Server 
installations. You will install Notification Server on the same computer as Deployment Server or 
install it on a remote computer, depending on your needs and network system. Much of the 
installation process to integrate and synchronize Deployment Server installations with the 
Deployment view on Notification Server is automated, or can be completed from the Notification 
Server Administration Console.
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Because Deployment solution is installed from and runs on a Notification Server system, you first 
install Notification Server to a selected computer. You can then push down the Notification Server 
Client to the Deployment Server installations in your organization. Notification Server then 
recognizes the Deployment Server installation and automatically push down the DS Agent (the 
Deployment Server Agent that brokers information between the Deployment Database and the 
Notification Server database). After installing the DS Agent, data from the Deployment Server 
installation will appear in the Deployment view on Notification Server after the polling interval for 
communicating between databases has elapsed.

Select which computer to install the Deployment So (with Notification Server) and then follow these 
steps.

1 Install Notification Server. 
You need Administrator rights on the selected computer(s) to install Notification Server. 
a Run the Install Helper (AeXNSInstallHelper.exe) to identify and install prerequisite 

components required for installing Notification Server. This utility runs automatically if 
installing from the Altiris Product CD.

b Install all components required for Notification Server as identified in the Install Helper. 
In most cases, you will be required to install the MS SQL 7/2000 database or Microsoft Data 
Engine (MSDE) database. The MSDE database ships on the Altiris Product CD or can be 
installed from the Microsoft Web site. 

c Select Install eXpress Server to launch the Notification Server installation file 
(AeXNS_5_5.msi) from the Install Helper. 
You can also run the Notification Server installation program by double-clicking the 
AeXNS_5_5.msi file. 

Follow all installation instructions, including: 
• Click Yes to install the AdminContext.cab file.
• Step One: Enter an administration user name and password. You must have administration 

rights to install Notification Server.
• Step Two: Click through this page without entering any values to disregard e-mail 

functionality when installing only Deployment Solution. 
• Step Three: Enter the user name and password for an existing Notification Server Microsoft 

SQL database, or create a new database. If Login ID is left blank, then Notification Server 
uses Windows authentication.
Caution Do not access an existing Deployment Server database. Only access an existing 
Notification Server database or create a new database. 

2 Install the Notification Server Client.
Because you are installing to a remote Deployment Server computer (a computer other than the 
one to which you installed Notification Server), you must follow the steps to remotely install the 
NS Client. Deployment Solution will automatically push down the DS Agent to communicate 
between databases when a Deployment Server has Notification Server Client installed.
To install the Notification Server Client, you first discover the available computers on your 
network from the Notification Server Administration Console, and then push down the NS Client 
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to the selected computer. For complete Notification Server installation instructions, see the 
Notification Server User Guide.
a From the Notification Server Administration console, click the Configuration tab. 
b Click the Machine Discovery link in the left frame. Follow directions to discover the desired 

computer.
c After completing the machine discovery process, click the Client Installation link. Follow 

directions to push down the NS client. Several options exist for installing the NS Client. 
Follow directions on the Client Installation page, or click the Help button for further 
information.   

3 Set polling intervals for Notification Server. 
During the first stage of installation, you will want to configure Notification Server and 
Deployment Solution for testing purposes only. This means you will need to set short polling 
intervals so that you can view updated data in the Deployment view on Notification Server.
a From the Solutions tab in the left frame of the Notification Server Administration page, click 

server  > Altiris Express Configuration > Policies > NS Client Configuration > Client Settings. 
b From this page, click Configure the Win32 Client, then click Client Communication in this list.

The Client Communication page will open with settings to configure communication with 
Notification Server and its clients, including polling intervals. 

c In the client should request new configuration information every box, select 1 minute from the 
drop-down list. 

d In the client should send basic inventory every box, select 15 minutes from the drop-down list. 

Note These settings are for testing purposes only, allowing you to update quickly for viewing data. 
This setting would be too often for production, but allows you to test the system without waiting for 
long periods before verifying changes.

e Click Apply.
4 Install Deployment Solution. 

Install Deployment Solution from the Solution Center in the Notification Server Administration 
Console. 
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a From the Solution Center, click Deployment Solution. Follow all installation instructions 

provided in the Deployment Solution installation wizard. 
You can also double-click the AeXDeployment_5_5.msi file on your local drive and 
follow all installation instructions.
Note If an error appears when installing from the Solution Center, you may have linked to 
the wrong location. Click the Solution Center link to change your Solution Center 
configuration, if required to install from the local drive or another Solution Center (such as 
the beta site Solution Center). 

b Click Finish when the installation is completed.
c After installing Deployment Solution, click the Refresh button on the browser. 

After installing Deployment Solution, the Deployment tab will appear on Notification Server 
Administration Console. 

5 Set polling intervals for Deployment Solution. 
a Click the Solutions tab.
b Click server > Deployment Solution > Policies > Deployment Server Agent Configuration > 

Deployment Server Agent Config for all Deployment Servers.
The Deployment Solution Agent Configuration page will open. 
Note You can also click the Deployment tab, and then click the Options button and select 
Configure from the drop-down list on the Deployment Web page.

c In the Computer/Event Polling Interval box, select 1 minute from the drop-down list.
Note This settings is for testing only, allowing you to update quickly for viewing data. This 
setting would be too often for production but allows you to test the system without waiting 
for long periods before verifying changes.

d Click the Apply button.
6 Update Notification Server Client (testing only).

For testing purposes, ensure that the polling interval settings are updated by the NS Client (so 
that you do not have to wait the default 12 hours polling interval):
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a Wait for the client icon to appear after installing Notification Server. The NS Client icon 

appears in the system tray (in the lower right-hand corner or the screen).

b Double-click the NS Client icon in the system tray.
The NS Client page will open.

c Click the Configuration tab.
d Click the Update Configuration button.
e Confirm the value of the Configuration Request Interval setting on this page (1 minute for this 

test setup). 
If it is not set to the value you established in the Notification Polling configuration (see step 
3c in this document), proceed with these steps in this Update Notification Server Client 
section.

f Click the Send Basic Inventory button. Wait one minute (or the amount of time you set in step 
3c).

g When the value is updated, click the Update Configuration button again.
h If the polling interval is not updated on this screen, reconfigure the polling interval for 

Notification Server by going through step 3 again.
i Close the NS Client page.
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Using Deployment Solution
This section provides feature identification and basic procedures for deploying and managing 
computer resources from the Deployment Server Console and the Deployment Server Web Console.

Quick Links

Managing from the Console 
(page 97)

Compare Deployment consoles and refer to 
general Deployment Server Console features.

Managing Computers (page 111) Create new computer accounts, remotely operate 
computers, and modify computer properties.

Building and Scheduling Jobs 
(page 152)

Build deployment jobs by adding and modifying 
deployment tasks. Schedule jobs to run at Initial 
Deployment or at an optimum time. 

Deployment Server Web Console 
(page 204)

Deploy and manage computer devices from the 
browser.

Deploying and Managing Servers 
(page 145)

Configuration and management information for 
deploying network and Web servers



 

Managing from the Console

Deployment Solution provides both Windows and web user interface consoles to deploy and manage 
computer devices across local or wide area networks. As an IT administrator, you can sit down to 
the Deployment Server Console and drag a job icon to a computer icon to remotely deploy new 
computers. Or provision new Web servers from the shipping box to online readiness. You can 
manage all computer devices from a browser using the Deployment Server Web Console, or access 
multiple sites from the Deployment view on Notification Server.

The Deployment Server Console is a Windows-based console included with the Deployment Server 
system to provide complete deployment and management features. From the Deployment Server 
Console you can build and deploy deployment jobs, set up BootWorks or PXE Servers, edit and 
organize packages and computer groups, and much more. See “Deployment Server Console Basics” 
on page 98.

The Deployment Server Web Console provides web browser access to individual Deployment Server 
sites on Windows or Linux computers, and furnishes access from mobile computers and wireless 
handhelds.

Deployment on Notification Server is also a web console, but combines management of multiple 
Deployment Server systems and allows you to integrate additional web applications such as the 
Inventory, HelpDesk, and Application Management solutions. 

Features of the Deployment Server Console. The Windows console for Deployment Solution 
provides standard Computers, Jobs, and Details panes to drag and drop icons, view properties, and 
identify state and status of Deployment objects. In addition, the Deployment Server Console also 
includes a Shortcuts and Resources view and provides the tools, utilities and features required for 
complete computer resource management. See “Deployment Server Console Basics” on page 98.

Set Program Options. From the Tools > Options dialog box, you can set preferences for each 
Deployment Server system. See “General Options” on page 104.

Set Security. From the Tools > Security dialog box, you can set security rights and permissions for 
all Deployment consoles. See “Security” on page 106.

Connecting to other Deployment Server systems. Connect to other Deployment Server sites from 
your current Deployment Server Console and manage computers beyond your current network 
segment or site. See “Connecting to Another Deployment Server Site” on page 109.

Customize the Tools menu. You can add commands to the Tools menu to open commonly-used 
deployment programs and utilities. See “Extending the Tools Menu on the Console” on page 101.

 

To launch the Deployment Server Console, double-click the icon on the desktop 
or click Programs > Altiris > Altiris eXpress > Deployment Server > Console.
See “Deployment Server Console” on page 56 for installation tips.

 

To launch the Deployment Server Web Console, click Programs > Altiris > Altiris 
eXpress > Deployment Server > Deployment Web Console. 
See “Deployment Server Web Console” on page 59 for installation tips.
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Deployment Server Console Basics

The Deployment Server Console is your main portal to Deployment Solution. It is a feature-rich Win 
32 program with real-time access to computer resources, deployment jobs, and package files, each 
represented with distinct icons to identify status and settings. From the Deployment Server Console 
you can build simple or complex deployment jobs, assign them to a computer group, and then verify 
deployment execution.

Because the Deployment Server Console can reside on its own computer, you can have multiple 
consoles running from different locations. The Deployment Server Console only needs to be running 
while making assignments or viewing information about the managed computers. You can turn on 
the console, run management tasks, and then turn off the console.

Scheduling information is saved in the Deployment Database and tasks are executed at their 
scheduled time. If an assignment to a managed computer is made from two different consoles at 
approximately the same time, the computer will be assigned those tasks in the order they are 
received. See “Console options” on page 104 to set refresh intervals for the Deployment Server 
Console.

Features of the Deployment Server Console
Like all Deployment consoles, the Deployment Server Console is divided into several panes to 
organize computers, deployment jobs, and software packages and scripts. It gives you a graphical 
view of your network and provides features to build jobs, drag-and-drop icons to schedule 
operations, store and access jobs and packages, and report the status and state of all of your computer 
resources. The Deployment Server includes three main panes, plus toolbars, wizards, shortcuts, and 
utility programs.

Computers pane
Use this area to view and select managed computers for the Deployment Server system. You can 
select and right-click a computer in the Computers pane to run “Remote Operations” on page 136 or 
view “Computer Properties” on page 133. You can also create computer groups to organize 
collections of similar computers.

Shortcuts and 
Resources 
View

Computers pane

Jobs pane

Details pane
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When a computer or group is selected, the Details pane shows a list of computers in the group and 
gives basic information about each computer. The Filter detail bar appears in the Details pane to view 
computers by a set criteria. When a computer is selected, you can view the computer status in the 
Details pane, including a list of jobs that have run or are scheduled to run on the computer and the 
status of each job. 

To get more details about all of the tasks that have run on computers, click Status Detail. Yo can then 
see a more detailed breakdown of all of the processes the job has executed and a status message 
indicating what has been completed.

You can also import new computers from a text file or add security rights and privileges for a 
specified computer or group of computers. See “Managing Computers” on page 111 for complete 
information about setting up, importing, and managing computers from the Computer pane.

Jobs pane
Use this area to create and build jobs with specific deployment tasks. You can select and right-click 
a job in the Jobs pane when Building New Jobs or running the New Job Wizard. You can also import 
new jobs from a text file or add security rights and privileges for a specified job or collection of jobs. 

Set up folders to organize and access jobs in a way that makes sense to you. Create a new folder by 
right-clicking in the Jobs section and select the New Folder option. You can also create folders by 
selecting File > New > Folder.

When a job is selected, then the Details pane displays a list of computers in the folder and gives basic 
information about each job, such as its state and status. It also shows the computers or computer 
groups to which the job is assigned.

• The Conditions detail bar also appears, letting you assign jobs to computers. See “Setting 
Conditions for Task Sets” on page 157.

• In System Jobs, folders are created to store jobs that are created when running operations from 
the console.
Drag-n-Drop Jobs. Jobs are created and automatically placed in this folder when you drag an MSI, 
RIP, or other package files from the Resources view to a specific computer or group (see the 
“Shortcuts and Resources View” on page 100).
Image Jobs. Jobs are placed in this folder when you create a Quick Disk Image.
Restoration Jobs. Jobs are placed in this folder when you run a Restoring a Computer from its 
Deployment History job.

From the Jobs pane you can drag job icons to computer icons to execute jobs, such as creating 
images, deploying computers, changing configurations, or installing software. Once a job is created, 
you can change it by adding, modifying, or deleting tasks. Jobs can be run immediately, scheduled 
to run a particular time, or saved for a later time. See “Building and Scheduling Jobs” on page 152 
for complete information about setting up, importing, and managing computers from the Jobs pane.

Create Computer Groups by clicking the button on the toolbar, or right-clicking 
in the Computer pane and selecting Groups. Click View > Show Computers to 
display only computer group icons and not the individual computers. 

   

Click View > Jobs View to show or hide the Jobs pane. 
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Details pane
The Details pane extends the user interface features when working in the Computers, Jobs, or 
Shortcuts panes. 

• When you select a computer in the Computers pane, the Details pane changes to a Filters area (if 
you click a group icon) and displays the status of all jobs assigned to the selected computer.

• When you select a job icon in the Jobs pane, the Detail pane displays information about the job 
to set up conditions, order tasks, and add, modify, or remove tasks.

• When you select a computer or computer group in the Computers pane, the Detail pane displays 
information about a computer, including IP address, MAC address, and status.

• When you select a batch file, you can click Modify to update the file.
• When you select a hard disk image file (IMG), the Detail pane displays a description of the image 

file, plus information about the included partitions.
• When you click on package files, the Details pane displays the title, description, version, creation 

date, and platform of a RIP or Personality Package.

Shortcuts and Resources View
The Shortcut and Resources pane provides easy access to the computers and job objects identified in 
the console and the software packages stored in the Client Access Point. In the Shortcuts view, you 
can drag computers, computer groups, jobs, and job folders to organize and access commonly-used 
console objects. In the Resources view, you can identify and assign package files.

The Shortcuts view provides quick links to view and access computers, jobs and packages. It can act 
as a palette of Deployment Solution icons to drag to other working panes in the console, or storage 
to save commonly-used jobs and computer icons.

The Resources view allows you to see a filtered view of the package files—MSI files, RIPs, image 
files, Personality Packages, and other resource packages—stored in folders in the Client Access 
Point. From the Resources view, you can drag packages directly to computers in the Computers pane 
to deliver software. This automatically creates jobs in the System Jobs > Drag-n-Drop Jobs folder in 
the Jobs pane. The Resources view allows you to identify packages assigned to each job and assign 
those packages to create new jobs.

See “Console options” on page 104 for options to set refresh intervals for Resources view.

Toolbars and Utilities
The toolbars and menus on the Deployment Server Console provides major features and utility tools 
to deploy and manage computers from the console. From the Main toolbar, you can create new jobs 
and computer accounts and quickly run basic deployment tasks. On the Tools toolbar, you can launch 
Deployment Solution administration tools and package editing tools. It also includes buttons to 
quickly run commonly used Remote Operations.

 

Click View > Shortcuts to open the Shortcuts and Resources pane. You can drag 
the jobs and computer icons to this pane. Click the Resources button in the 
Shortcuts and Resources view, or click View > Resources or Ctrl+R to open a 
filtered list of packages residing on the Client Access Point.
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Deployment Solution Utility Tools
The Deployment Server Console allows you to open utility programs from the Tools menu or from 
the Tools toolbar. You can launch Deployment Solution administration tools (Boot Disk Creator, 
PXE Configuration, Remote Agent Installer) and package editing tools (RapidInstall Editor, PC 
Transplant Editor, and Image Explorer).

Administration tools

  Boot Disk Creator. Use this tool to set up a boot disk configuration for Altiris BootWorks or 
the Altiris PXE Server. The Boot Disk Creator can maintain several different boot disk 
configurations for different types of network adapter cards. It also provides various set up options 
for accessing BootWorks. See the Altiris Boot Disk Creator help.

  PXE Configuration. After installing the Altiris PXE Server, you can modify configuration 
settings using this tool. You can change the menu commands displayed to the user when booting up, 
and change options for the PXE Server to set the boot configuration, MAC filtering, and multicast 
options. See the Altiris PXE Configuration help. 

  Remote Agent Installer. Remotely install the Deployment Agent for Windows (AClient) to 
client computers. See “Installing Deployment Agent for Windows (AClient)” on page 66.

  BIS Configuration. If you are using PXE boot files to manage your computers and you want 
to secure the computers so they accept only certified images, you can set up Boot Integrity Services 
(BIS) configuration boot files and certificates to sign boot files stored on the PXE. This establishes 
security for PXE Server and the boot files.

Package Editing Tools

  RapidInstall Editor. Use this edit tool to edit and modify Rapid Install Packages (RIPs) that 
have already been created. See the RapidInstall help and its product guide located in the Client 
Access Point.

  PC Transplant Editor. Use this edit tool to edit a Personality Package to add or remove data. 
See the PC Transplant help and its product guide located in the Client Access Point.

  Image Explorer. After a hard disk image has been created, use this edit tool to view and 
manage data in the image file. You can extract, update, edit, exclude and modify the image file. See 
the Altiris Image Explorer product guide located in the Client Access Point. 

Extending the Tools Menu on the Console
You can add commands to the Tools menu on the Deployment Server Console to quickly access 
additional management applications. This allows easy access to applications commonly used with 
Deployment Solution. 

Commands are added by modifying or adding new INI files. You can insert commands to the root 
Tools.ini file for the main menu or add new INI files to create submenus. Place both types of INI 
files in the same directory where the Deployment Server Console executable (eXpress.exe) is 
located (by default in the Program Files\Altiris\ eXpress\Deployment Server). 

You can add up to eight menu items to the main menu, and eight menu items for each submenu. 
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These INI fields are included for each application added to the Tools menu:

[Application name or submenu declaration]

Menu Text=<the application name displayed in the menu>

Description=<the name displayed when you mouse over the menu item>

WorkDir=<directory set as default when executable is run>

Executable=<path to the executable files>

The Tools.ini file extends the main Tools menu on the console. This sample file contains one 
submenu, Web Tools, and two additional menu items, Notepad and Netmeeting. The INI files are 
located is the Client Access Point.

[Submenus]

Web Tools=wtools.ini

[Notepad]

MenuText=Notepad Editor

Description=Simple Editor

WorkDir=.

Executable=C:\WINNT\notepad.exe

[NetMeeting]

MenuText=NetMeeting

Description=NetMeeting

WorkDir=.

Executable=C:\Program Files\NetMeeting\conf.exe

Another Tools INI file is named wtools.ini. It is a submenu file referenced by the main Tools.ini file. 
On the main menu this is titled “Web Tools” (see Tools.ini) and contains two applications, Explorer 
and Acrobat. 

[Explorer]

MenuText=Explorer

Description=Windows Explorer

WorkDir=.

Executable=C:\Program Files\Internet Explorer\explorer.exe

[Acrobat]

MenuText=Acrobat Reader

Description=Acrobat Reader

WorkDir=.

Executable=C:\Program Files\Adobe\Acrobat\acrobat.exe
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Computer Filters and Job Conditions 

Use this dialog box when Creating a Computer Group Filter to filter only the specified computers in 
a computer group, or when Setting Conditions for Task Sets when running a job only on specified 
computers in a group.

Creating Conditions to Assign Jobs
You can Set Conditions on a scheduled job to run only on the computer devices that match a defined 
criteria. As a result, you can create a single job with tasks defined for computers with varying 
properties, including OS type, network adapters, processors, free drive space and other computer 
properties. You can then create task sets for each job that will apply only to the computers matching 
those conditions.

Creating Custom Tokens
You can also create Custom Tokens to set conditions based on database fields not provided in the 
provided preset conditions. in the Conditions dialog box. For example, select User Defined Token 
from the drop-down list in the Fields box. Select contains in the Operation field and enter Milo in the 
Value field. In the Token field, enter the following custom token: 
%#!computer@lic_os_user%.This will filter out only the jobs with the registered license user 
named Milo. The job will run only on the computers meeting that criterion.

Creating a Computer Group Filter
For Computer Filters, this dialog box allows you to display and list all computers in a group according 
to a specified criteria. For example, you can create a filter to view all computers in a particular group 
that have Windows 2000, 256 MB of RAM, and 20 GB hard disks only. By applying the filter, you 
can then view all computers with that criteria in the Details pane of the Deployment Server Console.

To create or modify a computer filter
1 Click the All Computers group or any other computer group.
2 On the Filter bar in the Details pane, click Setup > New to create a new filter.

Or
click Setup > Modify.

3 Type a name for the filter, and click Add. The Filter Definition screen will be displayed.
4 Define the conditions you want to filter. 

Click the Field box to see a list of computer values stored in the Deployment Database. Select a 
computer value and then set the appropriate operation from the Operations list. In the Value box 
enter an appropriate value for the selected database field.
For example, you might choose Computer Name as the Field, Contains as the Operation, and 
Sales as the Value. 

5 Repeat to include other conditions. Click OK.

Click a job in the Jobs pane. The Condition feature will open in the Detail pane. Click 
the Setup button to add new conditions or edit existing conditions. When setting 
conditions to schedule a job, you can select from a list of predefined database fields or 
create custom tokens that key on other fields in the database.

 

Click a computer group in the Computers pane. The Filter feature will open in 
the Details pane for the selected computer group. Click the Setup button to add 
new filters, or modify and delete existing computer filters. 
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See also “Find a Computer in the Database” on page 150.

General Options
Use these dialog boxes to set general options for Deployment Solution. Click Tools > Options to 
display the Program Options dialog box.

Console options (page 104)

Global options (page 104)

Domain Accounts options (page 105)

RapiDeploy options (page 105)

Agent Settings options (page 105)

Custom Data Sources options (page 106)

 Console options 
Set basic console features for miscellaneous refresh actions and warning messages. 

Scan resource files for changes every ____ seconds. Specify how frequently (in seconds) that the 
Deployment Server Console updates its view of package files in the Resources view (see “Shortcuts 
and Resources View” on page 100).

Warn user when no tasks are assigned to the 'default' condition. When a job is assigned to computers 
and the Default condition has no tasks assigned, then a message box will appear. The job has no 
secondary default tasks assigned if a computer in the group does not meet the primary conditions. 
See “Setting Conditions for Task Sets” on page 157.

Refresh displayed data every ____ seconds. Refresh the display of data accessed from the Deployment 
Database. This allows you to refresh console data at defined intervals rather than updating every time 
the Deployment Server Console receives a command from the server, which can be excessive traffic 
in large enterprises.

Global options 
Set global options for the Deployment Server system. 

Delete history entries older than _____ days. Specify the number of days an entry is kept in the history 
until it is deleted. If the number of days is set to 0, no entries will be kept in the history. If this option 
is not selected, log entries will remain in the history.

Synchronize display names with Windows computer names. Automatically update the displayed name 
of the managed computer names in the console when the client computer name changes. If this 
option is not selected, changes to computer names will not be reflected in the console. 
Synchronization is off by default. (The names do not have to be synchronized for the Deployment 
Server to manage the computer.)

Reschedule failed image deployment jobs to immediately retry the failed task. Immediately retry a failed 
image deployment job. The program will continue to retry until the job succeeds or until the job is 
cancelled.

Client/server file transfer port: _____. Specifies a static TCP port for file transfers to the clients. The 
default value is 0 and will cause the server to use a dynamic port. This setting is useful if you have 
a firewall and need to use a specific port rather than a dynamically assigned port.

Automatically replace expired trial licenses with available regular licenses. Allow Deployment Solution 
to automatically assign a permanent license to the computer after the trial license expires.
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Primary lookup key. Specifies the lookup key type used to associate a new computer with a managed 
computer. The options are Serial Number (SMBIOS), Asset Tag (SMBIOS), UUID (SMBIOS), or MAC 
Address.

Domain Accounts options 
This single sign-on feature retrieves the administrator (or user with administration rights) name and 
password for each domain, allowing you to avoid logging in for each managed computer when 
completing imaging and configuration jobs.

Click Add to enter the Domain name. The Add Domain account will open. Enter the name of the 
selected domain and provide the administrator credentials. Click OK. The administrator name and 
Domain will be listed in the Domain Accounts list box.

Note To enter the administrator user name for a Windows XP domain, you need to add both the 
domain name with the user name. For example, instead of entering just the user name jdoe, you 
need to enter domainName\jdoe.

RapiDeploy options 
This feature optimizes the multicasting ability of the RapiDeploy application in Deployment Server, 
allowing you to deploy images to a group of computers simultaneously, download an image from a 
file server (or access a local hard drive) and manage the imaging of several client computers 
concurrently.

Because RapiDeploy is more efficient when writing directly to the IP address of the network adapter 
driver, you can enter a range of IP addresses when using the multicasting feature to speed computer 
deployment and management. Deployment Server accesses the range of computers using the defined 
IP pairs and avoids retrieving the computers through the port and OS layers. 

However, because some network adapter cards do not handle multiple multicast addresses, you can 
also identify a range of ports to identify these computers. On the first pass Deployment Server 
accesses the selected computers using the list of IP numbers. On the second pass, Deployment Server 
accesses the selected computers using the port numbers or higher lever OS ID's. 

Note Multicasting images is not supported when using the UNDI driver on PXE, and will be 
disabled on the client.

Agent Settings options 
These are the default agent settings for new computers. Click the Change Default Settings button to 
change Windows Agents Settings for Windows and DOS. You will open the dialog box to set 
Deployment Agent Settings for Windows and Linux for new computer accounts or to set 
Deployment Agent Settings for DOS (BootWorks) for new computers.

These default settings are applied only for new client computers that have never connected to the 
Deployment Server and have no information stored in the Deployment Database. These settings are 
not for existing managed computers nor are these settings applied when setting properties using the 
Remote Agent Installer. 

Force new agents to take these default settings. Select this option to force these settings when adding 
a new computer. 

When the Deployment Agent connects, Deployment Server will verify if the computer is a new or 
existing computer. If the client computer is new and if the Force New Agents option is selected, then 
the Deployment Agent on the client computer is sent the default settings established in the Options 
> Agent Settings dialog box. If the computer is recognized as an existing managed computer, then it 
will use the existing agent settings.
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Custom Data Sources options 
This option allows you to set up credentials to authenticate to external Deployment Databases and 
other MS SQL Server databases to extract data using custom tokens. Click Add to enter an 
administrator alias and other login information for the Microsoft SQL Server (or MSDE) hosting the 
desired Deployment Database.

The information required to create a custom data source entry are listed below:

Alias. The alias name you would like to use when referencing the external SQL database.
Server. The name of the external SQL database server or IP address.
Database. The name of the external database from which you want to extract data.
Use Integrated Authentication. This option tries to authenticate to the external database using 
the domain account you are currently logged on as.
Username and Password. When the integrated authentication is not being used, you must 
provide a user name and password to authenticate to the external database.

See Custom Tokens (page 140) for information about creating and using custom variables.

Security
Deployment Solution provides a security system based on associating job and computer objects with 
user and group permissions, allowing IT personnel to be assigned to different security groups to 
manage operations on specific computer groups or job folders. Each security group can then perform 
only a defined scope of deployment operations on each computer group or job folder. In addition, 
each user can be assigned rights to access general console features. 

Note Security rights and permissions set in one console will be enforced in all Deployment consoles.

See also
Best Practices for Deployment Solution Security (page 106)

Enabling Security (page 107)

Setting Permissions (page 108)

Groups (page 108)

Rights (page 108)

Best Practices for Deployment Solution Security
Deployment Solution is based on defining groups of users and groups of computers and jobs, and 
then associating one with another. It is recommended that you first create user groups based on 
administration duties or access to levels of deployment operations. For example, you will most likely 
set up a group with full Administrator rights. This group will have access to run all operations on all 
computers using all types of jobs. No permissions need to be set on each computer group or job 
folders for the Administrator group because they have full rights to all features and resources.

 

To set general security rights, click Tools > Security and add a user name and 
password. You can create users and groups and set scope-based rights. 
To set feature-based permissions for specific computers or jobs, select the object 
in the console, right-click and click Security.
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However, you may also want to set up a Technician group that has only basic access and permissions 
limiting deployment operations. This will prohibit members of the group from re-imaging the Server 
computer group or scheduling Distribute Disk Image jobs. You can explicitly Allow or Deny the 
group from running these operations for each computer group in the Computers pane or each job 
folder in the Jobs pane. 

After creating the Technician group, you can limit their rights to set General Options and then set 
permissions on each computer groups and job folder for the group. You can select the computer 
group, right-click and select Security. Then select the group name in the left pane, and click Allow 
or Deny for a list of deployment operations. For example, you can select the Deny check box for 
Restore, Schedule Create Disk Image, and Schedule Distribute Disk Image. 

Additional groups can be created with different rights and permissions depending on the needs and 
responsibilities in the IT team. If users are assigned to multiple groups, the Evaluate Permission and 
Evaluate Rights features will sort and display effective permissions and rights.

Enabling Security 
You can enable security by first creating a group with Administrator rights, adding a user to the 
Administrator group, and then selecting Enable Security.

1 Click Tools > Security.
2 Click Groups. The Manage User Group dialog box will open. 
3 Click Add. Enter a name and description in the User Group dialog box. Click OK. 

The group name will appear in the window. 
4 Select the new group name and click the Rights button.
5 In the Rights dialog box, select Administrator. This assigns complete rights and permissions to 

the group. Click OK. Click Close.
6 On the main Security dialog box, click Add. The User Properties dialog box will open.
7 Enter a user name and password. Click OK.
8 Select the user name in the main Security dialog box. Click the Rights button.
9 Click the name of the new Administrator group in the Groups window.

This assigns the new user to the new group with Administrator rights. Click OK.
Note You can assign the user Administrator rights directly, but assigning users to groups is 
advised. See “Best Practices for Deployment Solution Security” on page 106.

10 Now that you have a user with administrator rights, select the Enable Security box.
Security is now enabled. You can now create users and groups and assign permissions to computer 
groups and job folders.

Importing users from Active Directory
You can also import users from Active Directory. In the main Security dialog box, click AD Import 
to open a standard Windows Active Directory dialog box. Add users from Active Directory (not 
groups). The users will be added to the Deployment Database. However, you will still need to assign 
the users to security groups with appropriate rights and permissions.

Note When logging in with the imported AD account, Deployment Solution will access the Windows 
server to validate the user password.

Evaluate Rights
Click the Evaluate Rights button to identify the combined rights of the selected user and its user 
group(s). This feature identifies effective rights for each user by resolving any possible conflicts 
between multiple group settings.
Deployment Solution Product Guide 107



 Managing from the Console Security

 

Groups
Assign the user to previously created groups. If enabling security, you can assign the user to a group 
with Administration rights. 

To add groups, from the Security dialog box click the Groups button and click Add. Enter a name for 
the group and a description. 

See also “Best Practices for Deployment Solution Security” on page 106 and “Enabling Security” 
on page 107.

Rights 
This dialog box allows you to set general rights for a user or group. To verify, add or change the 
rights assigned to each console user, use the following steps:

1 From the Security screen, select a user and click Rights.
2 From the Set Rights For window, click the Rights tab.
3 Place a check mark for each right you want to grant.
4 After selecting all applicable rights, click OK to save your changes.
A brief explanation of each deployment server right that can be assigned is detailed below:

Administrator. Allow user access to all features available on the Deployment console. You must 
have Administrator rights to enable security. See “Enabling Security” on page 107.
Options Console. Allows you to set Console options.
Options Global. Allows you to set Global options.
Options Domain Accounts. Allows you to set Domain Accounts options.
Options RapiDeploy. Allows you to set RapiDeploy options.
Options Agent Settings. Allows you to set Agent Settings options.
Options Database Tokens. Allows you to create Custom Data Sources options.
Manage Rejected Computers. Allows you to view Rejected Computers and change status.
Refresh Clients. Allows you to Refresh Deployment Solution clients. You can 
use the View > Refresh clients <Ctrl +F5> feature to disconnect and reconnect client computers.

Setting Permissions 
Set permissions for jobs, job folders, computers, and computer groups. See “Best Practices for 
Deployment Solution Security” on page 106 for additional design tips. 

1 Right-click on a computer group or job folder (or individual computers and jobs) and select 
Security.  The Object Security dialog box will open.

2 Click the Groups tab and select a group name. Or click the User tab and select a user name. 
3 From the list in the right pane, select if you want to Accept or Deny permission to run the 

operations on the selected computers or job objects. These permissions include access to Remote 
Operations and features for scheduling Deployment Tasks.

4 Click the Allow or Deny check boxes to explicitly set security permissions for these Deployment 
Solution features for the selected objects. 
Note Administrators have access to all objects with unrestricted rights and permissions. You 
cannot explicitly deny permissions to computer or job objects for users with administrator rights.

5 To assign permissions to multiple groups, click Set permissions on all child objects to assign the 
values without closing the dialog box.

6 Click Close.
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Note You can set permissions for all jobs and computers by clicking in the Jobs pane or Computers 
pane without selecting a job or computer object. 

Permission Rules
Permissions received through different sources may conflict with each other. The following 
permission rules determine which permissions will be enforced:

• Permissions cannot be used to deny the user with Administrator console rights access to use 
any console objects or features.

• User permissions take precedence over Group permissions. 
• Deny overrides Allow. When a user is associated with multiple groups, one group could be 

allowed a permission at a particular level while the other group is denied the same 
permission. In this scenario, the permission to deny the privilege will be the one enforced.

• Permissions do not flow down an object tree. Instead, the object in question looks in the 
current location, and then up the tree for the first permission it can find, which is the one it 
will use. 

• If a console user does not have permissions to run all of the tasks the job contains, the user 
will not be allowed to run the job.

Evaluate Permissions
Click the Evaluate Permissions button to identify the combined permissions of groups and containers 
with contrasting permissions. This feature identifies effective permissions for each object by 
resolving any possible conflicts. 

If a job includes multiple tasks and one of the tasks does not have sufficiently assigned permissions, 
then the whole job will fail due to lack of access permissions.

Note Permissions to schedule jobs also allows a user to delete jobs in the Details pane after a job 
runs. For example, if a job contains errors and does not run, then no other jobs can be scheduled. The 
user must delete the job before scheduling a new job.

Connecting to Another Deployment Server Site 
From the Deployment Server Console you can connect to other Deployment Server sites on your 
LAN and manage computers beyond the network segment or site that you are currently logged in to. 
Opening a site requires that you connect to the Deployment Database of the preferred Deployment 
Server site using the ODBC Data Source Administrator.

Note Although you are accessing another site (another Deployment Database), Windows remembers 
the last place you browsed to, which would be the Client’s Access Point of the previous Deployment 
Server site. You will need to browse to the new site’s Client Access Point to access its shared folder 
containing its RIPs, images, executables, and other resources.

Connecting to a new Deployment Database
1 Click the New site... button. The Define Site information dialog box opens.
2 Enter a name for the site to be opened.
3 Establish a ODBC data source.

a Click the ODBC Administrator button.
b Click the System DSN tab and then click the Add button.
c Select the SQL Server driver source and click Finish.

 

Click File > Connect to or press Ctrl+O to open the Connect to Deployment Server 
dialog box. Enter information to connect to external Deployment Server sites 
using an ODBC driver.
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d In the Create a New Data Source to SQL Server dialog box, enter a name and description for 

the data source.
e If an entry for your server already exists, select it from the menu. Otherwise, enter the name 

of the server hosting your remote SQL server in this box. Click Next.
f Click Next in the Create a New Data Source to SQL Server dialog box to accept the default 

settings.
g Click the Change the Default Database to: check box and then select eXpress from the menu. 

Click Next.
h Click Finish. The specifications for the ODBC data source will appear.
i Click Test Data Source... to verify that the source is reachable.
j Click OK. You will return to the main ODBC Data Source Administrator dialog box with 

your new data source listed in the System DSN tab. Click OK.
4 Using the menu in the ODBC Data source name dialog box, select the new Data Source name 

you just created.
5 In the Installation Directory path field enter the full UNC path (or path using any locally mapped 

drive) to the directory of the required Deployment Server, for example:
\\SalesServer\express or H:

6 Click OK.

Rejected Computers
When an unwanted managed client computers attaches to your Deployment Solution system, you 
can click right-click it in the Computers pane and select Advanced > Reject Connection. You can then 
view these rejected computers by clicking View > Rejected Computers. 

The rejected computers are prohibited from being active in the Deployment Database. They are 
identified and rejected by their MAC address. 

You can remove computers from the Rejected Computers list by selecting it and clicking Accept 
Computer(s). This allows the computer to attach again and be managed by the Deployment Solution 
system.

Refresh Deployment Solution
You can refresh the Deployment Server Console by clicking View > Refresh (or pressing <F5>) to 
update data from the Deployment Database. You can also click View > Refresh clients (or 
press Ctrl+<F5>) to disconnect and reconnect all managed computers in a Deployment Server system.

When you refresh the managed client computers, you will be asked if you want to disconnect all 
computers. Click Yes. This will tell the Deployment Agent to shut down and restart. It will also 
create additional network traffic when all computers connect and disconnect. By refreshing the 
managed client computers, you ensure that you are viewing the current status and state of all 
computers resources in your system.
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Managing Computers

From the Computers pane of a Deployment Solution console, you can identify, deploy, and manage 
all computer resources across your organization, including desktop computers, notebooks, 
handhelds, network and web servers, and network switches. You can quickly modify any computer’s 
configuration settings or view its complete management history. Or you can take on big projects, 
like completely re-imaging the hard drive, restoring software and migrating personality settings for 
a whole department. You now have management of all your computer resources available from a 
Windows or web console from any location.

All computer resources can be accessed and managed as single computers or organized into 
computer groups with similar hardware configurations or deployment requirements, allowing you to 
run deployment jobs or execute operations on multiple computers simultaneously. You can use 
search features to locate a specific computer in the Deployment Database, or set filters to sort 
computers by type, configuration, OS, or other criteria.

Manage with Computer icons. Major computer types are identified by a computer icon in the 
console, with a listing of scheduled jobs and operations associated with each computer. In the 
Deployment Console, you assign and schedule deployment jobs to computers or groups by dragging 
the computer icon to a job in the Jobs pane, or vice versa. See “Viewing Computer Details” on 
page 112.

Add new computers. Deployment Solution allows you to add new computer accounts and set 
configuration properties for new computers before they are recognized by the Deployment Server 
system. Preset computer accounts will automatically associate with new computers when they start 
up, or can be associated with virtual computers. See “Adding New Computers” on page 113.

Deploy to groups of computers. Organize computers by department, network container, hardware 
configuration, software requirements, or any other structure to meet your needs. You can then 
deploy and provision computers on a mass scale. To filter computers in a computer group to 
schedule jobs only to the appropriate computer types, see “Computer Filters and Job Conditions” on 
page 103.

Configure Computer Agents. See the property pages for modifying Deployment Agent settings. 
See “Deployment Agents” on page 120.

   

Computer icons appear in the Computer pane of the Deployment console where 
they can be organized into groups. To assign and schedule a computer in the 
Deployment Server Console, drag a computer icon or group icon to a job icon. 

 

Click the New Computer button on the console to create a new computer account. 
You can also click File > New > Computer or right-click in the Computers pane 
and select New Computer.
When the new computer starts up you can assign it a preset account.

 

Click the New Group button on the console to add a new group in the Computers 
pane of the Deployment console. You can also click File > New > Computer Group 
or right-click in the Computers pane and select New Group. 
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View and configure computer properties. You can modify computer settings for each computer 
from the console. See “Computer Configuration Properties” on page 116. Or you can view the 
Computer Properties page for detailed access to a computer’s hardware, software, and network 
property settings. See “Computer Properties” on page 133.

Run remote operations from the console. Perform operations quickly in real-time from a 
Deployment console. Restore a computer to a previous state, configure property settings, send a file, 
remote control, chat, set security, run deployment jobs or select from additional management 
commands. See “Remote Operations” on page 136.

Build and schedule jobs. Build deployment jobs with one or more management tasks to run on 
selected computers. Create jobs and add tasks, then assign the job to computer groups. Jobs can be 
organized and assigned for daily tasks or to handle major IT upgrades. See “Building and Scheduling 
Jobs” on page 152.

Manage Handhelds. Deployment Solution manages handheld computers (aka PDAs). See 
“Deployment Agents for Pocket PC” on page 128.

Manage Servers. Deployment Solution also manages network or web servers to administrate high-
density server farms or server network resources across your organization. See “Deploying and 
Managing Servers” on page 145.

Viewing Computer Details
In Deployment Solution, a computer resource is identified in the console with a distinctive icon to 
display the computer type — Windows desktop or notebook, handheld, server, or Linux OS — and 
its current status. These computer icons change to convey the state of the computer, such as the log 
on status, server waiting status, or user with a timed license status. You can also view the status of 
the jobs assigned to the selected computer in the Details pane of a Deployment console (see 
“Viewing Job Details” on page 152). 

The following is a sample list of computer icons displayed in each Deployment console identifying 
computer type and state.

Managed Computers

 
Computer connected to the Deployment Server with a user logged in. 

 
Computer connected to Deployment Server but the user is not logged in.

 
Computer with a time-limited user license and a user logged in.

 
Computer not currently connected to the Deployment Server but known to the 
Deployment Database.

 

A virtual computer with values defined in advance using the New Computer feature. As 
soon as the computer connects and the Deployment Server recognizes the new 
computer and changes the icon. See “Adding New Computers” on page 113.

 

A client computer waiting for user interaction before running deployment tasks. This 
icon appears if the Workstations box is selected on the Advanced tab of Initial 
Deployment. See “Advanced” on page 180.

 
A connected handheld computer.
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See also “Deployment Agents” on page 120.

Adding New Computers
Computers can be added to the Deployment Database using three methods:

• Install the Deployment Agent for Windows or Linux. If you install the Deployment Agent for 
Windows or the Deployment Agent for Linux to a computer with the operating system already 
installed, then the computer will be added automatically to the Deployment Database at startup. 
New computers with the Deployment Agent installed will be added to the All Computers groups 
(unless otherwise specified in the Deployment Agent configuration). You can then move the 
computer to another group if desired. See “Installing Deployment Solution Agents” on page 65. 

• Use Initial Deployment to configure and deploy new computers booting up in DOS. Starting 
up a new computer with the Deployment Agent for DOS (BootWorks) allows you to image the 
hard drive, assign IP and network settings, distribute personal settings and software, and install 
the Deployment Agent for new computers. Using Initial Deployment you can associate new 
computers with pre-configured virtual computer accounts. These newly configured computers 
will appear in the New Computers group. See Initial Deployment (page 178).

• Create or import computer accounts from the Deployment console. You can add new 
computers using the New Computer feature or import computers using a delimited text file. You 
can pre configure computer accounts by adding names and network settings from the console. 
See “Creating a New Computer Account” on page 114.

About New Computers
When a new computer starts up, if Deployment Server recognizes the MAC address provided in a 
New Computer account or import file, it will automatically associate the user account at startup with 
the New Computer icon. If this value is not provided, then the computer will be displayed as a virtual 
computer, allowing you to associate it to a new computer.

 
A managed server connected to the Deployment Server with a user logged in. 
Additional icons identify different states of server deployment. 

 

A managed Linux computer connected to the Deployment Server with a user logged in. 
Additional icons identify different states of Linux computer deployment.

Blade Servers - physical view

 

Physical view of Rack/Enclosure/Bay components for high-density server 
systems. These icons will appear as physical representations to allow 
management of different levels of the server structure. In addition, server icons 
identify logical server partitions. See “Bay” on page 135 for properties and 
rules to deploy Rack/Enclosure/Bay servers.

Computer Groups

 

Select the New Computers or All Computers groups to run jobs or operations for these 
default groups identified by an icon in the Computers pane. 

 

Additional computer groups can be added to the Computers pane to organize similar 
computer types or to list computers of similar departments or locations. Click the New 
Group button or select New > Computer Group to create a new group.

Managed Computers
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A virtual computer account can be associated with a new computer using the Initial Deployment 
feature. You can create multiple virtual computer accounts and then associate the account with a new 
computer when it boots up in DOS. At startup the configuration settings and jobs assigned to the 
virtual computer can be associated with the new computer.

Virtual Computers
Deployment Solution provides features to create a virtual computer to pre-define a computer’s 
configuration settings and assign customized jobs to that computer even if you don't know that 
computer's MAC address. This type of computer is known as a virtual computer.

Virtual computers offer a great deal of power and flexibility, especially when you need to deploy 
several computers to individual users with specific needs. The virtual computer saves you time 
because you can configure the computer before it arrives on site. You can set up as much 
configuration information (computer name, workgroup name, and IP address, for example) that you 
know about the computer and apply it to the new computer as it comes online. You can also prepare 
jobs prior to the arrival of the new computer to deploy the computer using customized images, MSIs 
and RIPs based on a user's specific needs.

For example, a user might request Windows 2000 with Office 2000 and virus scanning software 
installed on the new computer. The user also might request that his or her personality (customized 
user settings, address books, bookmarks, familiar desktop settings) be migrated from the old system. 
You can build any job, including any of the available tasks, and assign it to a virtual computer.

When the new computer finally arrives, you will be ready to deploy it because you've done all the 
work ahead of time. Just set the managed computer option in PXE or BootWorks and the new 
computer will connect to the server as a managed computer. The virtual computer that you created 
now turns into a managed computer in the console. 

Creating a New Computer Account  
You can create computer accounts for individual computers or for computer groups. When creating 
new accounts for computer groups, you can automatically assign new names and associate them with 
existing computer groups or the New Computer group.

To create a new computer account
1 Click Add. 
2 Enter names and configuration settings for each new computer account using the Computer 

Configuration screens. See “Computer Configuration Properties” on page 116 for a description 
of the configuration settings.

3 (optional) Click Import to add new computers from a delimited text file (see “Importing New 
Computers from a Text File” on page 115).

4 Click OK. 

 

The New Computer icon displays for a new computer if the MAC Address is 
provided when creating a new computer account using any import or new 
computer account feature. 

 

A virtual computer icon displays if specific hardware data (MAC Address) is not 
known. As soon as the computer starts up and is associated with a virtual 
computer account, then Deployment Server recognizes the new computer and 
the icon changes.

 

Click the New Computer button on the console to create a new computer account. 
You can also click File > New > Computer or right-click in the Computers pane 
and select New Computer.
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A virtual computer icon will appear in the Computers pane. 

When a new computer starts up, you can assign it to this preset account. 

To create and associate multiple computer accounts
You can create computer accounts and automatically assign predefined names. These computer 
accounts can then be associated with computers in a selected computer group.

1 Select a computer group, including the New Computers group (empty groups cannot access 
features). Right-click and select the Configure command. 

2 Enter names and configuration settings for each new computer account using the Computer 
Configuration screens. See “Computer Configuration Properties” on page 116.

3 (optional) Click the Microsoft Networking category and click the Define Range button. 
k In Fixed Text box, type a base computer name. For example, enter Sales.
l Type a numeral or letter in the Range Start box to add to the Fixed Text name. This will create 

a unique name for a group of computers starting with the specified character. The range of 
numerals and letters will be assigned to the computer name. For example, enter 3.

m Select Append to add the range of numerals after the computer name. Clear the box to add 
names before the computer name. 
The example computer names will begin with Sales3 and end with Sales7.

n Click OK.
4 Click the Associate button. You can now associate computers in a group (including the New 

Computers group) with the multiple computer accounts.
5 Click OK. 

Importing New Computers from a Text File
You can import computer configuration data using delimited text files (TXT, CSV, or IMP files) to 
establish multiple computer accounts in the Deployment Server database. This file contains all 
configuration data for a new computer, including all settings displayed in the Computer Properties 
of a selected computer.

1 Click File > Import/Export > Import Computers.
A dialog box will open allowing you to select import files. These files can have TXT, CSV, or 
IMP extensions. 

2 Select the import file. Click Open.
If a correctly formatted computer import file is selected, then a message box will appear 
informing you that the computer import is complete and identify the number of computers added. 
Click OK on this message box.
New computers will display as virtual computers in the Computers area of the console (as single 
computers or in groups), and any jobs imported from the import file will be listed in the Jobs 
area. 
Note Jobs can be added to the import file. They can be created and associated with the new 
computers.
If the computer import file is incorrectly formatted, a warning will appear stating that the 
computer import file is incorrect.

3 Edit computer settings by selecting a computer from the list and clicking the Properties button. 
4 The Computer Properties sheet opens to edit or add values not set in the import file, such as 

computer name, TCP/ IP settings, user name, and other configuration settings.
5 Click OK.

The imported computers will appear in the Computers pane of the Deployment console. 
You can also import a computer to be placed in a sub-folder in the Computers pane and create a job 
to be associated with the imported computer. See the sample import file for additional information.
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Referencing the Sample Import File 
When creating an import file, use either the ImportComputers55.txt file or the 
ImportComputers55.xls file in the Samples folder of the Client Access Point. The 
ImportComputers55.txt file provides a sample import template you can access to test the Import 
feature. The ImportComputers55.xls file is a Microsoft Excel spreadsheet that allows you to add 
values to each identified column and then save the file as a delimited TXT file to import to the 
Deployment Database. The sample import file places a computer (DB Computer 1) in a computer 
group (Test Group) and adds a job (Test Job) that is associated with the imported computer. 

Note Altiris Deployment Solution 5.5 and later uses the 5.5 format for importing computers. 
Previous versions of Deployment Solution use the 4.0 format.

Deploying New Computers on a Mass Scale
If you need to deploy large numbers of computers (100 to 5,000), consider using a barcode scanning 
system to collect user information (names, OS and application needs) and computer information 
(MAC address, serial numbers, asset tags). You can save this information to a file, which can then 
be imported into the New Computers List View. Depending on the number of incoming computers, the 
amount of information you have about those computers, and the needs of individual users, you can 
use either the virtual computer method (best for smaller numbers of new computers) or the Initial 
Deployment job (best when deploying generic setups by departments or groups).

If you are using an import file, make sure you know primary lookup key. This is the piece of 
information that Deployment Server needs to set up a unique computer. The primary lookup key can 
be Serial Number, Asset Tag, UUID, or MAC address.

 Computer Configuration Properties
These computer property settings can be viewed, set, and modified when performing the following 
computer management operations:

• Adding New Computers (page 113).
• Modifying Configuration (page 171). Create or edit property settings in a deployment job.
• Initial Deployment (page 178) configuration settings.
Click the configuration group icons to set additional computer property values. After you edit these 
computer property settings, the computer will be restarted so that the changes can take effect:

Computer Configuration Properties

General Configuration Settings Set the most important value from this property sheet. It 
includes the name of the computer in Deployment 
Solution, the NetBIOS name of the computer, the MAC 
address and other settings.

Microsoft Networking Configuration 
Settings

Set the Windows name of the computer and the 
Workgroup or Domain settings.

TCP/IP Configuration Settings Set the TCP/IP addresses for one or more network 
adapters.

NetWare Client Configuration 
Settings

Set Novell Directory Services client login options.

OS Licensing Configuration Settings Set the registered name and view the hashed installation 
license key for the installed operating system.

User Account Configuration Settings Set the local Windows user account values.
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General Configuration Settings

Name. Provides a name that appears in the Deployment console (not the BIOS name of the 
computer).

MAC address. The unique identification address of the network adapter. 

Serial Number. The serial number of the computer’s motherboard. 

Asset Tag. The asset tag of the computer, if available. 

Computer Name. The Windows name of the computer.

IP Address. Current IP address of the computer. Multiple IP addresses are listed in this box. 

Registered User. The name of the user who registered the operating system software.

License key. The hash value rendered from the OEM key or 25-digit license key required when 
installing the operating system.

User name. The user name for the local Windows user account.   

Full name. The full name for the local Windows user account.

Password. The password for the local Windows user account.

See also “Computer Configuration Properties” on page 116.

Microsoft Networking Configuration Settings

Use the SIDgen or SysPrep utilities to generate unique SIDs. This can be done by manually running 
either or both of these utilities or selecting these features while installing the Deployment Agent.

Computer Name. This is the NetBIOS name for the computer. The name must be unique in the 
network and is limited to 15 characters.

Define Range. Click to create a sequential range of computer names. You can identify a root name 
and automatically increment its associated number. This option is available when selecting groups 
of computers.

Note When setting name ranges, do not set names using multiple Modifying Configuration tasks and 
then assigning the names by Setting Conditions for Task Sets. If you set up two separates name 
ranges to be assigned by separate conditions, then the computer names will increment irrespective 
to the base name.

Workgroup. Click and enter the name of the workgroup to place the managed computer.

 

The General category provides access to important property settings that are also 
listed in other configuration categories. Click other category icons to view and 
set additional configuration properties.

 

Enter the computer name and workgroup or domain property settings for the 
managed computer. If you are using Active Directory, you can add computers to 
a domain and a specified organizational unit (OU). 
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Domain. Enter either the fully qualified domain name, the DNS domain name, or the WINS domain 
name. You can enter the fully qualified domain name (for example, mjones.yourcompany.com), 
and specify the organizational unit (OU) using this format: OU/newOU/users. The complete entry 
to place the computer in the users OU is the following:

 mjones.yourcompany.com/OU/newOU/users

internal.myServer.org/New Corporate Computer OU/Mail Room/Express Mail 
Servers

Computer Name Range
For new computers, set a range of names for multiple new computers: 

Fixed text. Enter the text portion of the name which you want associated with each computer, for 
example: Marketing.

Range start. Enter a whole number to add to the fixed text, for example: 1. 

Append. Select this check box to add the range after the fixed text in the computer name. If you clear 
this box then the number will be added as a prefix to the fixed text. 

Result. View an example of the selected names that will be assigned to each computer, for example: 
Marketing...Marketing6.

Associate. Click to match new computer accounts with new computers. After setting the fixed text 
and a range of numbers to automatically generate computer names for new computer accounts, you 
can associate the new computer accounts with new computers logging in to the network. Select 
any Target Computer and associate it with an Available Name. Click Auto Assign to generate all listed 
target computers with all available computer names. 

See also “Computer Configuration Properties” on page 116.

TCP/IP Configuration Settings

Hostname. The Windows name of the managed computer hosting Deployment Server. 

Network Adapter. A list of all network adapters installed in the selected computer.

The network adapter with the lowest bus, device, and function number will be the first listed (NIC0 -
zero based). If the bus, device, and function information cannot be determined for a network 

adapter, it will be enumerated in the order it is detected.

When configuring multiple network adapters, make sure that one network adapter is not using an 
Intel Universal NIC driver (commonly called UNDI driver) to connect to Deployment Server. If one 
network adapter uses the native driver and one uses an UNDI driver, then your computer will display 
twice in the console.

Add. Enter new settings for additional network adapters installed on the client computer.

You can add “virtual” network adapter settings to send a job to a computer group containing 
computers with varying numbers of network adapters. If a computer in the group has only one 
network adapter, then it will be configured only with the IP settings listed first. If IP settings are 
provided for additional network adapters not present in the computer, then they will be disregarded.

 

Enter TCP/IP settings for one or more network adapters. Click Advanced to setup 
IP interfaces, DNS, and WINS. For computer groups, click Associate to assign 
a range of pre-defined IP addresses. 
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MAC Address. The MAC address is a unique number assigned to the network adapter by the 
manufacturer. You are unable to change this number. The MAC address appears in this box when 
viewing computer configuration settings. This box is shaded when creating a Modify Configuration 
task. 

Domain Suffix. Enter this to add domain suffixes to the root address.

Use DHCP to obtain an IP address. Select this to obtain an address from a DHCP server.

Assign a static IP address. Select this to set static IP address values.

See also “Computer Configuration Properties” on page 116.

TCP/IP Advanced Options - IP interfaces 
IP Interfaces (Linux and NT type only). Click Add to set named interfaces for this network adapter. 
Use this tab to add TCP/IP addresses to an existing network adapter card on Linux or an NT type 
operating system.

Common IP Information

IP Address. Enter or modify the IP address common to all interfaces.

Subnet mask. Enter the appropriate subnet mask.

Linux Specific 

Interface Name. Establish Linux-specific IP interface settings. Make sure you use the “eth” syntax 
when naming new interfaces, for example: eth0:1 or eth0:new interface.

Broadcast Address. Enter the Broadcast address for the specified IP interface.

Interface state. The default value of the interface state is Up, which denotes that the named interface 
is operating. You can shut down the named interface by selecting Down.

See also “Computer Configuration Properties” on page 116.

TCP/IP Advanced Options - Gateway/DNS/WINS 
Click Add to set a new Gateway, DNS, or WINS address. Click Modify a edit an existing IP address. 
Use the up and down arrows to move the address to a top of the list to act as the primary address.

Gateway. Add additional gateways for this network adapter.

DNS. Add additional Domain Naming Servers (DNS) for this network adapter.

WINS. Add additional WINS settings for this network adapter.

See also “Computer Configuration Properties” on page 116.

NetWare Client Configuration Settings

Ignore NetWare settings. Select to disregard all Novell NetWare client settings for this computer.

Preferred server. Click and enter the name of the NetWare server, for example: \\OneServer. This 
is the primary login server for the NetWare client. 

 

Set Novell NetWare client values for a new or existing computer. Select whether 
you want to log in directly to a NetWare server or to a NetWare tree in the Novell 
Directory Service (NDS). You can then specify the preferred tree, server name, 
and NDS context. 
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Preferred tree. Click and enter the name of the NDS tree. 

NDS User name. Click and enter the name of the user object for the NetWare client.

NDS Context. Click and enter the organizational unit context for the user. 

Run login scripts. Select this option to run the NetWare client login scripts.

See also “Computer Configuration Properties” on page 116.

OS Licensing Configuration Settings

Registered user. Enter the name of the registered user and the Organization.

License key. Enter the alpha-numeric license key. This is the hash value rendered from the OEM key 
or 25-digit license key required when installing the operating system.

See also Computer Configuration Properties (page 116).

User Account Configuration Settings

User name. The user name for this local Windows user account.   

Full name. The full name for this local Windows user account.

Password. The password for this local Windows user account.

Groups. Specify the Windows groups that this user will belong to as a comma-delimited list, for 
example: Administrators, Marketing, Management 

User must change password at next logon. Select to force the user to change the password after setting 
the configuration properties.

User cannot change password. Prohibit the user from changing their password at any time.

Password never expires. Select to maintain the user password.

See also “Computer Configuration Properties” on page 116.

Deployment Agents
To remotely manage computers from a Deployment console, a Deployment Agent is installed on each 
computer in the Deployment Server system. Deployment Agents are provided for various computer 
types, including Windows, Linux, DOS, and PPC Handhelds. 

  

Enter or view the license information for your Windows operating system 
software (Windows 95, 98, NT, 2000, XP, and 2003 Servers). 

 

Set up local user accounts for the newly imaged computer or when running a 
configuration task. Enter a user name, full name, and password, then set standard 
Windows login options.
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The following Deployment Agents reside on the client computer and communicates with 
Deployment Server. For installation details, see “Installing Deployment Solution Agents” on 
page 65.

Install Deployment Agent to add a managed computer
When Deployment Agent is installed on a computer, it will search across the network for a 
Deployment Server to attach to. When a Deployment Server is located by the Deployment Agent, 
then the client computer will be added as a record to the Deployment Database.

 

To set or modify Deployment Agent settings from the Deployment Server 
Console, right-click a computer or group and select Change Agent Settings. 
To set or modify agent settings for new computers, click Tools > Options, then 
click Agent Settings. For handhelds, tap the Pocket PC Client icon in the system 
tray and select Properties.

Deployment Solution Agents

Deployment Agent for Windows The Deployment Agent running on Windows computers, 
including desktops, notebooks, and servers. This is previously 
referred to as AClient. See “Deployment Agent Settings for 
Windows and Linux” on page 122. 
For installation, see “Installing Deployment Agent for 
Windows (AClient)” on page 66. 

Deployment Agent for Linux This Deployment Agent running on different types of Linux 
servers and desktops. See “Deployment Agent Settings for 
Windows and Linux” on page 122.
For installation, see “Installing Deployment Agent for Linux” 
on page 70.

Deployment Agent for DOS This Deployment Agent is used when booting to DOS on both 
Windows and Linux computers. This is referred to previously 
as BootWorks. See “Deployment Agent Settings for DOS 
(BootWorks)” on page 127.
For installation, see “Installing Deployment Agent for DOS 
(BootWorks)” on page 72. 

Deployment Agent for Pocket PC This Deployment Agent runs on the host computer for a 
handheld running the Pocket PC operating system. See 
“Deployment Agents for Pocket PC” on page 128.
For installation, see “Installing Deployment Agent for 
PocketPC” on page 73. 

Deployment Client for Pocket PC This agent runs on the handheld computer. 
Deployment Agent for CE .NET This agent runs on the HP T5000 computer devices running the 

CE .NET 4.2 operating system.  See “Deployment Agent for 
CE .NET” on page 131.

Notification Server Client The NS client is an Altiris agent that runs on computers 
supported by Notification Server. This agent runs on the 
Deployment Server computer when running Deployment 
Solution on Notification Server. 
See the Deployment Solution Planning Guide.

Deployment Server Agent This agent runs on the Deployment Server computer when 
running Deployment on Notification Server. 
See the Deployment Solution Planning Guide.
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Automatically update to newer version of Deployment Agent
At times, Altiris may update versions of the Deployment Agent to enhance features. For best 
performance, it is suggested that all managed computers run the latest version of the Deployment 
Agent. When a new version of the Deployment Agent is saved to the Client Access Point file server, 
the managed computers will automatically update the Deployment Agent.

1 From the computer where Deployment Server is installed, click Start > Program > Altiris > Altiris 
eXpress > Deployment Server > Configuration. The Deployment Server Configuration utility will 
open.

2 Click Options.
3 Click Transport.
4 Select the Automatically update clients option.

Deployment Agent Settings for Windows and 
Linux
You can set or modify Deployment Agent for Windows and Deployment Agent for Linux properties 
from the same dialog box.

Right-clicking the AClient icon gives you access to the following options:

View status. Bring up the Altiris Client Service box to observe the current status of AClient. You 
can also see computer name, deployment server connected to, IP address, multicast address, and 
MAC address. You can also watch AClient communicate with the Deployment Server. Clicking 
the Properties button will allow you to edit the AClient properties. Passwords will protect this 
option.

About. Display the version and licensing statement for AClient. Passwords have no effect on this 
option.

View log file. View the AClient log file, if you have chosen the option to create a log file. 
Passwords have no effect on this option.

Shutdown for imaging. Make an image of a computer without using a job. This will make the 
required preparatory changes to the computer before an image is made. Failure to do this will 
break the reconfiguration phase when deploying the image using a job. Passwords will protect 
this option 

 
When the Deployment Agent is running on a computer, the user will see a small icon 
in the system tray. When the icon is blue, then the client computer running the 
Deployment Agent is connected to the Deployment Solution system. 

 

When the Deployment Agent icon is clear, it shows that the client computer is not 
connected to the Deployment Solution system. The agent may be configured 
incorrectly, the Deployment Server is down, or other network problems exist.

 

To set or modify agent settings in the Deployment Server Console for Windows or 
Linux clients, right-click the computer and select Change Agent Settings > Windows/
Linux Agent.
To set or modify agent settings for new Deployment Agent for Windows or Linux 
clients, click Tools > Options, then select Agent Settings and click Change Default 
Settings.

 
To view or modify settings from the Windows client, right-click the AClient icon in 
the system tray (or double-click the client icon in the system tray and click Properties).
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Change name in console. Change how this computer is listed in the deployment server console. 
This option does not change the NetBios name of the computer or the name of the computer in 
the database, but only changes the name of the computer displayed in the Computers window. 
Passwords will protect this option.

Remove. Uninstall AClient from the computer. Passwords will protect this option.

Exit. Stops all AClient services from running but does not uninstall AClient. AClient will load 
normally the next time you boot the computer. Passwords will protect this option.

Properties. Quickly go to the Properties page to view or make changes. Passwords will protect 
this option.

Show Network Interfaces. View what network cards are in your computer. Passwords will protect 
this option.

Notification Server settings. If Notification Server has been installed, you can view and configure 
its settings. 

The following configuration properties (organized using tabs in the dialog box) are included in the 
Windows/Linux Agent Settings dialog box.

Log File
The Log File property page controls how data is logged and saved in a Deployment Server system, 
allowing you to save different types and levels of information to the log files. You can save a text 
file with log errors, informational errors, and debugging data using this dialog box.

If the log exceeds the specified size then older data will be dropped from the files. You can maximize 
the size of the log file to save all selected data.

Save log information to a text file. Click to save information to a log file.

File name. Enter the name and path of the log file. The default is to save the log file to the \Program 
Files\Altiris\AClient\AClient.log file.

Maximum size. Enter the maximum number of bytes for each log file.

Log Errors. Select this option to save only the errors returned when running a job or operation 
between the Deployment Server and the Deployment Agent.

Log informational messages. Select this option to save a list of procedural steps run on the client 
computer. 

Log debugging information. Select this option to list comprehensive debugging information in the text 
file.

See also “Deployment Agents” on page 120.

Security
The Security properties page allows you to secure data between the Deployment Server and the 
Deployment Agent, or to set a password so that the user on the client computer can only view and 
modify the User Properties of the Deployment Agent properties on the managed computer.

Deployment Agent property settings

Log File Remote Control
Security Connection
Transport Blockout
User Prompts Proxy
BootWorks Other
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Password protect Admin properties. Select to allow users on the managed computer to access the 
Admin properties only if they enter the set password. If the box is selected and the user doesn’t know 
the password, then they will only have rights to open the User Properties, which includes only the 
User Prompts and Remote Control tabs on the Deployment Agent Properties dialog box. 

Hide client tray icon. Select to hide the Deployment Agent icon in the system tray of the managed 
computer. If you hide the icon then you will be required to run AClient.exe -admin to view and 
modify the complete administration properties from the managed client computer.

Encrypted sessions
You can set options to allow or require encrypted sessions between the client computer and the 
Deployment Server. Set up the encryption rights on the managed client computer using this dialog 
box (in the Security tab of the Client Service Properties). Set up additional encryption rights on the 
Deployment Server using the Configuration tool accessed from the Control Panel of the Deployment 
Server computer. 

Encrypt sessions with the server. Select to ALLOW encryption from this managed client computer to 
the Deployment Server. This allows encrypted data transmissions between the Deployment Server 
and the Deployment Agent on the client computer. If selected, then the client computer can connect 
(but is not required to connect) using encryption. 

• To enable encryption protocols, you must open the Deployment Configuration tool and select the 
Transport tab. Select Allow encrypted sessions to allow Deployment Server to transmit using 
encryption protocols.

Require encrypted sessions with the server. Select to REQUIRE encryption between the managed 
client computer and the Deployment Server. If this option is selected and the option to allow 
encryption in the Deployment Configuration tool is not selected, then the Deployment Server will 
not communicate with the Deployment Agent on the managed client computer.

Note Selecting encryption options will slow down the communication path between AClient and the 
Deployment Server, so do not use encryption unless it is necessary for high security environments.

See also “Deployment Agents” on page 120.

Transport
The Transport property page allows you to locate and connect to a Deployment Server system using 
multicasting or by connecting directly to the server’s IP address.

Use TCP/IP to locate a Deployment Server. Managed computers can use the multicast address if they 
are on the same segment as the Deployment Server or if multicast is enabled on the network routers. 
Ensure that the multicast address and port match those set up on the Deployment Server. Try using 
defaults on both the client and Deployment Server if you are having problems connecting.

Group Address. Enter the group multicast address. 

Port. Enter the port number distributing the multicast address.

TTL. Specifies the number of “hops” or routers the multicast request is allowed to pass 
through.Change this setting if you need to find a Deployment Server that is more than 32 routers 
away (default setting) or if to restrict the search to a smaller number of routers, making it easier to 
find the closest Deployment Server.

Server name. Enter the BIOS name of the computer running the Deployment Server.

Use TCP/IP to connect to a Deployment Server. Click to connect directly to Deployment Server by 
identifying the IP address and port for the computer running Deployment Server.

Address/Hostname. Enter the IP address of the Deployment Server computer.

Port. Enter the port number communicating with Deployment Server.
Deployment Solution Product Guide 124



 Managing Computers Deployment Agents

 

Managed computers should use the Deployment Server IP address if multicasting is disabled on the 
network routers or if they are not on the same network segment as the Deployment Server. The port 
number must match the number set on the Deployment Server. Otherwise, your clients will not be 
able to connect.

Note If you make changes to these settings and you have BootWorks installed locally on the 
computers, the Deployment Agent for Windows will automatically update the settings in BootWorks 
for you. (If you are using PXE, you must change the BootWorks settings at the PXE Server.) If you 
do not want BootWorks transport settings synchronized with the Deployment Agent for Windows, 
then you must clear the options in the BootWorks tab. In most cases, let the Deployment Agent 
manage these settings.

See also “Deployment Agents” on page 120.

User Prompts
Set these commands to control how the client can handle requests from the server. 

Shutdown and restart commands. Select for the user to be prompted before shutting down or 
restarting the computer. This feature overrides the Power Control option from the Deployment 
Server to Force applications to shut down without a message.

Program execution and file copy commands. Select for the user to be prompted before running a 
program or executing file copy commands.

Remote control commands. Select for the user to be prompted before running the Remote Control 
commands.

You can set a default time before running or aborting the commands. Select the time for the user to 
respond and then either continue with the operation or abort the operation.

If you don’t respond to the prompt, wait _____ seconds then: If one of the User Prompt options is 
selected and the user is not at the computer to respond, you need to decide whether to continue or 
abort. Select the amount of time you want to wait for a response, and then select one of the following:

Continue the operation. Click to continue without receiving a response from the user.

Abort the operation. Click to not continue without receiving a response from the user.

See also “Deployment Agents” on page 120.

Remote Control
Set Remote Control options for managed computers. 

Allow this computer to be remote controlled. Select to allow the administrator to remote control the 
selected computer. The default setting is to NOT allow the computer to be remote controlled.

Enable NT keyboard and mouse drivers. Select to stop the user from operating the keyboard or mouse 
for computers running the Windows NT 4/2000/XP/2003 operating systems. You must reboot the 
managed computer after changing the settings on this option.

See also “Deployment Agents” on page 120.

Connection
Set bandwidth restrictions and connection options. Decide if you want to remain connected at all 
times (recommended) or to only reconnect to check for new deployment tasks. You can also decide 
not to connect or send files if the bandwidth is beneath a specified threshold.   

Remain connected to the server. Click to keep the managed computer always connected to the 
Deployment Server. When the Deployment Agent starts up, it will attempt to maintain a continuous 
connection to the Deployment Server. If the network goes down, the client may not realize it in some 
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cases. If you select the Refresh connection after idle times of ___ seconds option, then Deployment 
Server will close the connection after the specified time and immediately try to re-open the 
connection. This will force the client to realize the network is down.

Refresh connection after idle times of ______ seconds. Check for updates periodically for a connected 
computer. The default of 28800 seconds or 8 hours. It is recommend keeping this setting above 
28800. Do not set this option too low--reconnecting to the Deployment Server increases bandwidth 
when connecting. If this option is set too low you can run into problems where it takes longer for 
your clients to connect than to refresh their connections.

Remain mostly disconnected from the server. Click to shut down the computer except for periodic 
queries for new deployment tasks.

Reconnect to check for work every ______ seconds. Start up the managed computer and check for 
new jobs or configuration tasks.

If there is no work, disconnect after ______ seconds. After starting up to check for new tasks, stay 
up for the entered amount of time. 

If you have a client that is disconnected you can choose Power Control > Wake Up from the console. 
This will cause the client to reconnect immediately.

Don’t transfer files if the rate is slower than ______ Kbps. Select this option if you do not want to run 
deployment tasks on slow connections, or if you are sharing bandwidth and want to run deployment 
tasks only when the download time reaches an optimal speed.

See also “Deployment Agents” on page 120.

Blockout
Set properties to prohibit the Deployment Agent on the client computer from connecting to the 
Deployment Server.

The block connection options allow you to specify a start time and end time each day when your 
clients will always remain disconnected from the server. For example, if you don’t want to manage 
your clients during working hours, you can check Monday through Friday, 8:00 AM to 5:00 PM. 

Note If you choose an end time that is before the start time, the block will end on the following day. 
For example: if Monday is selected, 5:00 PM is selected for the start time, and 8:00 AM is selected 
for the end time, the block will last from Monday at 5:00 PM until Tuesday at 8:00 AM.

See also “Deployment Agents” on page 120.

Proxy
Typically, remote networks on the other side of a router or switch cannot receive multicast or Wake 
On LAN packets from the Deployment Server. Setting the managed computer as a proxy client 
computer will forward or re-create the multicast packets. A managed client computer set up as a 
multicast proxy will simply act as a Deployment Server and advertise the server’s name and IP 
address through multicasting. Or you can set the managed computer as a proxy to send Wake On 
LAN packets.

Set these options to control how the managed computer will act as a proxy agent, identifying the type 
of traffic this managed computer will forward from the server.

This client is a Wake on LAN proxy. Select if you would like this managed computer to forward Wake-
on-LAN packages.

Advertise the server this client is connected to through multicasting. Select if you want to advertise the 
Deployment Server to client computers on another LAN segment or if the client computer is on the 
other side of the router.

Send multicast advertisement every _____ seconds. The default is 900 seconds (15 minutes). 

See also “Deployment Agents” on page 120.
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BootWorks
Set BootWorks options. Synchronize settings between the Deployment Agent for Windows 
(AClient) and the Deployment Agent for DOS (BootWorks). 

Enable direct disk access to BootWorks. Allows the agent to update BootWorks when changes are 
made to the transport settings or the client computer’s IP settings.

Synchronize transport (IP/multicast) settings. If you change how you connect to the Deployment 
Server through the Transport tab, this option will update Bootworks with the new settings.

Synchronize TCP/IP (static IP, netmask/DHCP) settings. Update BootWorks if you change the client 
computer’s TCP/IP settings.

This setting allows you to configure when (or if) you would like to be prompted for a BootWorks 
boot disk when the method of obtaining BootWorks cannot be determined, using the following 
options:

• Never prompt me.
• Always prompt me.
• Only prompt is BootWorks is not detected.
• Only prompt if PXE is not detected.
• Only prompt if neither BootWorks nor PXE is detected.

See also “Deployment Agents” on page 120.

Other
Force applications to close when shutting down. Shut down applications when using Power Control 
features. The user will still be prompted to Abort or Continue the shutdown. 

My boot drive is: ____. Specify the drive that the client computer will boots from. The default is C:

Synchronize this system’s date/time with the Deployment Server. Set the managed computer’s clock to 
the same time as the clock on the Deployment Server computer.

See also “Deployment Agents” on page 120.

Deployment Agent Settings for DOS (BootWorks)
You can configure property settings for the Deployment Agent for DOS (BootWorks) for specified 
computers or computer groups. You can remotely maintain important agent settings and update 
settings as required from the console.

When a new client computer connects, it will receive the default agent settings from Deployment 
Server for drive mappings, authentication, and LMHost entries. Each client computer will still have 
the capability to maintain its unique settings for the Deployment Agent for DOS as set in the Boot 
Disk Creator.

Deployment Agent Settings include the following property settings:

Drive Mappings (page 128)

Authentication (page 128)

 

To set or modify agent settings for a specific computer, right-click the computer 
icon and select Change Agent Settings > BootWorks Agent in the Deployment 
Server Console.
To set or modify agent settings for ALL computers, click Tools > Options, then 
click Agent Settings > Change Default Settings for BootWorks.
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Network (page 128)

Drive Mappings
Set drive mappings used by the Deployment Agent for DOS (BootWorks) to access hard disk image 
files and other packages from a specified network drive. It is required that the F Drive be mapped to 
the Client Access Point. You can also map other file server directories when storing large numbers 
of image files or deployment packages.

Drive Mapping. Enter the drive letter and volume of a shared folder, for example: 
F: \\WebDeploy\Image files.

Note You must select a shared folder in this field. From the browse window you are allowed to 
select any type of folder, but BootWorks will only map to and access files from a shared folder. 

Path. Enter a UNC path.

See also “Deployment Agents” on page 120.

Authentication
Provide the login credentials that Deployment Agent for DOS (BootWorks) requires to map network 
drives. The associated credentials for each network drive must have the rights that the Deployment 
Agent for DOS (BootWorks) requires administrative rights to access files. 

Domain/Workgroup. Enter the name of the Domain or Workgroup of the user BootWorks will login 
as to map the network drives. 

User name. Enter the user name of the user BootWorks will login as to map the network drives. 

Password. Enter the password.

See also “Deployment Agents” on page 120.

Network
These settings allow you to match the IP address with the computer name, as maintained in the 
LMHosts file in the Deployment Agent for DOS (BootWorks) partition. 

1 Click Add. The Add LMHOsts Entry dialog box will open. 
2 Enter the Computer Name. Enter the name of a computer to associate with an IP address.
3 Enter the IP Address.

or
Click the Lookup IP button. This will automatically populate the field with the IP address of the 
entered computer name.

4 Click OK. 
See also “Deployment Agents” on page 120.

Deployment Agents for Pocket PC
Deployment Solution manages handheld computers (PDAs) running the Pocket PC operating system 
and the Pocket PC Client on these Windows CE devices:

• Compaq iPAQ H3100, H3600 series
• HP Jornada Pocket PCs
• Casio Cassiopeia Pocket PCs
See “Installing Deployment Agent for PocketPC” on page 73 for additional steps to install and 
configure the Pocket PC Agent and Pocket PC Client.
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Managing Handhelds from a Deployment Console
When a handheld has the Pocket PC Client installed, the handheld is installed in the Deployment 
Server Database and will appear as a unique computer in the Deployment Server console (see 
“Viewing Computer Details” on page 112):

Like all other managed computer in the Deployment Server system, you can perform remote 
operations on the handheld from a Deployment console (see “Remote Operations” on page 136) and 
inventory properties.

Gather and report inventory. Gather inventory information, such as applications, services, devices, 
TCP/IP, hardware, and more.

View computer properties. Gather basic properties such as installed applications, devices, device 
type, and basic configuration information.

Set configuration properties. Configure TCP/IP information and computer name. Many of the 
normal configuration options do not apply to the Pocket PC.

File Copy. Download files to the local device file system. If the file transfer is interrupted, it will be 
able to resume the file transfer where it left off.

Software Delivery. Send EXE files or CAB files to be launched or installed on the Pocket PC.

Time Synchronization. Synchronize the handheld’s date and time with the Deployment Server.

Remote Control. Perform any task on the handheld from the Deployment Server Console as if you 
were physically working on the handheld. Control a single client or group.

Reboot. Reboot Compaq iPAQs from the Deployment Server Console. At this time, this feature is 
unavailable on other handhelds.

Name/Location/Email/Phone user settings. Set the owner information. If you choose the 
advanced option in the console to prompt for these items, the user on the Pocket PC will not be 
prompted, but instead the items will be taken from the owner information.

Not all management tasks are available when managing handhelds. These tasks are currently NOT 
available for handhelds:

• Create Quick Disk Image
• Change Client Settings
• Power Control 
Note The reboot option works on Compaq iPAQs, but not others.

 

To set or modify agent settings for the Pocket PC Agent on the host computer (to 
manage in a cradle, attached cable, or wireless NIC), double-click the Pocket PC 
Agent icon in the system tray. See “Pocket PC Agent” on page 130.

 
To set or modify agent settings on the Pocket PC Client on the handheld 
computer, tap the Pocket PC Agent icon in the system tray of the handheld. See 
“Pocket PC Client” on page 131.

 A blue arrow indicates an active connection for the handheld device.

 
A grayed icon indicates an inactive connection for the handheld device.
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If you select an unsupported task, you will receive an error stating that the feature is not available 
for handhelds.

See also “Connections to the Handheld” on page 130, “Pocket PC Agent” on page 130, and “Pocket 
PC Client” on page 131.

Connections to the Handheld
You can connect your handheld to a host computer using the connect cable and/or the cradle shipped 
with your handheld device. Or if you have a network adaptor for your handheld, you can connect 
directly with the Deployment Server from the handheld computer so it will be managed like any 
other client computer on the network. 

When you install the Pocket PC Agent (PA) on a host computer, it will automatically install the 
Deployment Client on the handheld (see “Install a Pocket PC Agent from the Deployment Console” 
on page 74). This allows you to run jobs and update inventory data when the handheld is “docked” 
to the host computer. The Pocket PC Agent uses Microsoft ActiveSync on the host computer to 
communicate between the Pocket PC Client (PC) on the handheld and the Deployment Server. 
ActiveSync provides the IP stack that the Pocket PC Agent uses to communicate with the handheld.

Many handhelds support direct network connections through a modem or LAN adapter (see “Install 
Pocket PC Client on the Handheld” on page 75). Handhelds with a direct connection to the network 
can then be managed by Deployment Server. The Pocket PC Client will first try to connect to a 
Pocket PC Agent. If that fails, it will try to connect directly to the Deployment Server. 

Important The Pocket PC Client on a handheld using a cradle and ActiveSync 3.1 cannot directly 
communicate with the Deployment Server and must use the Pocket PC Agent. However, if using 
ActiveSync 3.5, the Pocket PC Agent is not required once the Pocket PC Client is installed. The 
Pocket PC Agent is still useful for installing the Pocket PC Client onto the handheld, loading the 
client, and managing client settings.

See also “Deployment Agents for Pocket PC” on page 128.

Pocket PC Agent
You can configure the Pocket PC Agent settings on the host computer. For a list of command-line 
options when executing the PPCAgent.exe, see “Command-line options for the Pocket PC Agent” 
on page 137. 

To view or configure the Pocket PC Agent properties
1 Double-click the Altiris Pocket PC Agent icon in the system tray of the host computer. The status 

of the connection between the handheld and the host computer will be displayed.
2 Click Properties.
3 Select the General tab and modify settings.

Hide Tray icon. Select to not place the Pocket PC Agent icon in the host computer’s system tray. 
If selected, you can view the status and properties windows by launching the ppcagent.exe 
program in C:\Altiris\PPCAgent\PPCAgent.exe (default location).

4 Select the Transport tab and modify settings. 
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Pocket PC Agent Properties
Agent Port. This is the port that the Pocket PC Agent is listening on for Pocket PC connections. 
The agent port is updated each time the handheld connects.
Pocket PC Client Properties
Set server IP and port equal to AClient. If you are running from a cradle or cable, select this option.
Let me specify the server IP and port. If the handheld is connected directly to the network, enter 
the IP address of Deployment Server.
Set Pocket PCs server IP and port upon cradle connection. Select this option to assign the handheld 
the entered IP address and port number each time the handheld connects through the agent.

5 Click OK.
The host computer may require you to restart.

See also “Deployment Agents for Pocket PC” on page 128.

Pocket PC Client
You can the set properties on the Pocket PC Client program running on the handheld computer by 
clicking the Pocket PC Client icon in the system tray. 

To view or configure the Pocket PC Client properties
1 From the handheld, tap the Altiris Pocket PC Client icon in the system tray.
2 Tap Properties.

3 Tap the General tab and select if you want to synchronize time settings with Deployment Server. 
4 Tap the Security tab to select options to be prompted before running actions on the handheld. 
5 Tap the Transport tab to view or change settings (see settings details below).
6 Click OK.

To restart the Pocket PC Client 
1 Tap Start > Programs > File Explorer.
2 Tap My Device.

3 Tap Windows > StartUp > AClient.
If the handheld is attached to the cradle, you can restart the Pocket PC Client by restarting the Pocket 
PC Agent or by reconnecting the handheld to the cradle.

See also “Deployment Agents” on page 120.

Deployment Agent for CE .NET
Deployment Solution manages Hewlett-Packard T5000 computer devices running the 
Windows CE .NET 4.2 operating system. These computer devices ship with the Deployment Agent 
for CE .NET already installed and will display in the Deployment Console as managed computers 
when attached to the network.

The Deployment Agent performs the following limited tasks on the Windows CE .NET platform:

• Modify Computer Configuration (the computer name and TCP/IP Setting only)
• Distribute software (.cab and .exe files)
• Execute and run scripts (DOS and WIN batch files) *no VBS support
• Copy files and directories
• Create disk images
• Distribute disk images
• Remote Control clients (24 bit color depth only. No chat or send file features)
• Power Control (restart/shutdown/wake up jobs)
• Set computer properties
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• Create conditions to run jobs and filter computers
• Modify client properties via Windows and Linux agent settings
Additional features included with other Deployment Agents are not supported in the Deployment 
Agent for CE .NET. 

To install the Deployment Agent for CE .NET if deleted
If the Deployment Agent for CE .NET is deleted on the managed computer, it can be installed from 
the Deployment Server \ Agents \ CEAgent folder in the Client Access Point. 

Note You will need to modify the install executable and .dll files and include the correct installation 
path and settings before installing the CE .NET agent. These files must be renamed to 
CEClient.exe and ADCService.dll before running the installation program. 

From the managed computer you can then access the Client Access Point and launch the file to 
install the agent. For example, type this command from the client computer:

\\express\Agents\CEAgent\CEClient.exe -AClient.inp

You will need to correct the installation path and settings in the AClient.inp file before installing the 
CE .NET agent. Without adding the parameter to use the AClient.inp file, the agent will install to 
the Client Access Point rather than to the client computer.

Notes for Deployment Agent for CE .NET
The default image on a CE .NET Thin Client with 32 MB of flash RAM leaves 4 MB free disk space. 
When trying to install an Embedded BootWorks package using the Distributing Software task, you 
may get the following Error 112: Not enough disk space for package. 

• If you select Start > Settings > Control Panel > System > Memory tab and move the slider to 
allow more than half of the memory to be allocated to Storage Memory, then you will be able to 
execute a job that copies the Embedded BootWorks Package to the \Temp folder on the CE .NET 
device and execute a Windows Run Script task containing Start \Temp\<Embedded 
BootWorks Package.exe>. This will install Embedded BootWorks and leave 1 MB of free 
disk space on the device. If the slider shows less than half the memory available allocated to 
Storage Memory, then Windows CE may not restart.

• Another option for freeing up additional disk space is to uninstall the pre-installed HP 
applications, allowing you to free up to as much as 10 MB of disk space, which should allow you 
to install the Embedded BootWorks Package through a Distribute Software task. Again, if the 
slider is not placed around the middle of the Memory tab, then an Error 112 may occur.

See also Deployment Agents (page 120).

Managing Client Connections
The following utilities are provided for managing transmissions between the Deployment Server and 
Deployment Agents running on the managed client computers. 

Reset a Client Connection
Resetting the connection that a managed computer has with the Server simply disconnects and 
reconnects the computer. This is useful for troubleshooting or if you suspect there is a bad 
connection.

To reset a client connection, right-click a computer and click Advanced > Reset connection. When the 
computer disconnects, its icon will turn gray. The computer should then reconnect and its icon color 
will return to its original active status color.
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Reject or Retrieve a Rejected Computer
If a computer that you do not want to manage connects to your Deployment Server, you can reject 
it. This removes the unwanted computer from the Computers pane in the console. Further attempts 
by the computer to connect will be denied. Although the computer is not deleted, any history or 
schedule information associated with the computer is deleted.

1 Right-click the computer you want to reject from connecting to the Deployment Server.
2 Click Advanced > Reject Connection.
3 Click OK.
Rejected computers are stored in a Rejected Computers list. Select View > Rejected Computers to 
view this list.

Accept a Previously Rejected Computer
If you now want to accept a previously rejected computer, you can retrieve it and reconnect it to the 
Deployment Server. 

1 Click View > Rejected Computers.
2 From the list, select the computer you want to retrieve.
3 Click the Accept Computer(s) button to remove the computer from the rejected list (this doesn’t 

delete the computer, just removes it from the list of rejected computers).
4 Click Yes to confirm the action, then click Close.
This client computer may now be managed from within the Computers pane. Connection requests 
from this client computer will now be allowed.

See also “Deployment Agents” on page 120.

Computer Properties
View and edit the computer properties for each managed computer.

 

View and edit computer properties by double-clicking a computer icon in the 
Computers pane, or right-clicking and selecting Properties, or clicking the icon 
in the toolbar. 

General Services                
Hardware Devices
Drives Location
Network Configuration Bay
TCP/IP Lights-Out
Applications
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General 

See also “Computer Configuration Properties” on page 116.

Hardware 

See also “Computer Configuration Properties” on page 116.

Drives 

See also “Computer Configuration Properties” on page 116.

Network Configuration 

See also “Computer Configuration Properties” on page 116.

TCP/IP 

See also “Computer Configuration Properties” on page 116.

 

View or change the name of the computer as it appears in the console. View 
logged in user name, operating system installed, name of the Deployment 
Server, whether or not BootWorks is installed, version of the Altiris Windows 
Client (AClient), and other client information.

 

View processor make and type, processor count, RAM installed on the 
computer, display configuration, manufacturer, model, product name, MAC 
address of each network adapter installed, serial number, asset tag, UUID, and 
whether or not Wake On LAN and PXE are installed and configured.

 

View information about each drive on the computer. If you have multiple drives, 
you can select a drive from the list box to view its settings, such as capacity, 
serial number, file system, volume label, and number of drives installed.

 

View Microsoft Networking, Novell Netware settings, and user information for 
the selected managed client computer.

 

View TCP/IP information, including a list of all installed network adapter cards 
(up to eight) for the selected computer. Click Change to open the configuration 
window allowing you to modify settings (see “Configuring Computers” on 
page 138).
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Applications 

See also “Computer Configuration Properties” on page 116.

Services 

See also “Computer Configuration Properties” on page 116.

Devices 

See also “Computer Configuration Properties” on page 116.

Location 

See also “Computer Configuration Properties” on page 116.

Bay 

 

View the applications that are installed on the computer, including description, 
publisher, version number, product ID, and systems components.

 

View the services installed on the computer as well a description, start type, and 
path for each service.

 

View the devices installed on the computer, including display adapters, disk 
drives, ports, storage volumes, keyboards, and other system devices.

 

View and edit user-specific properties such as contact name, phone number, e-mail 
address, department, mail stop, and site name. As the administrator, you can enter 
this information manually or you can let the user populate this screen using Prompt 
User for Properties.

  

View location information and other properties for Rack / Enclosure / Bay 
components for high-density and blade servers. Set rules for automatic re-
deployment of blade servers based on physical location changes.
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Server Deployment Rules
From the Bay property page, you can select rules to govern actions taken when a new blade server 
is detected in a selected bay. These rules are described below:

See also “Computer Configuration Properties” on page 116.

Lights-Out 

Note This feature is currently only available for selected HP Integrated Lights Out (ILO) and 
Remote Insight Lights-Out Edition (RILOE) features.

See also “Computer Configuration Properties” on page 116.

Remote Operations
The Operations menu in the Deployment console provides a variety of commands to remotely 
manage all computers in your site or network segment. Some operation commands, such as Restore, 
automatically create and schedule deployment jobs and place them in the Systems Jobs folder in the 
Jobs pane. Other commands, like Chat or Remote Control, open utility programs to access and 
remotely manage computers.

Rule Action
Re-Deploy Computer Restore a blade server using deployment tasks and configuration settings 

saved from the previous server blade in the bay. This allows you to replace 
new blades in the bay and automatically run deployment tasks from its 
deployment history. (See “Restoring a Computer from its Deployment 
History” on page 138.)
All deployment tasks in the bay's history will be executed starting from the last 
Distributing a Disk Image task or Scripted OS Install task, or from any script 
(in a Run Script task) with this command: rem deployment start.

Run Predefined Job The server will process any specified job. Select a job to run automatically 
when a new server is detected in the bay.   

Ignore the Change This option allows you to move blades to different bays without automatically 
running jobs. The server blade placed in the bay is not identified as a new 
server and no jobs are initiated. If the server existed in a previous bay, the 
history and parameters for the server are moved or associated with the new 
bay. If the server blade is a new server (never before identified), then the 
established process for managing new computers will be executed.

Wait for User 
Interaction

(default) No job or tasks are performed (the Deployment Agent on the server 
blade is instructed to wait). The icon on the console changes to reflect that the 
server is waiting.

 

View information about the remote management hardware installed on the 
selected computer (most often a server) used to power up, power down and 
restart the computer remotely, or to check server status. You can also enter the 
password for the remote management hardware by clicking Password. 

 

Open the computer operations menu by right-clicking a computer icon in the 
Computers pane, clicking Operations on the menu bar, or clicking the icons in the 
toolbar.
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Computer Operations
Restore      Reconfigure your computer to a former state. Select from a list of 

previous deployment tasks and select to restore only the ones you want. 
See “Restoring a Computer from its Deployment History” on page 138.

History      View, print, and save to file a history of deployment tasks. See 
“Viewing a Computer’s History” on page 138.

Configure Set network and local configuration properties for each computer, 
including computer name, IP address, domains, Active Directory 
context. See “Configuring Computers” on page 138.

Quick Disk Image Select a computer and image its hard disk. This will create and store the 
image to distribute now or later. See “Quick Disk Image” on page 139. 

Power Control Wake up, restart, shut down, and log off remotely. See “Power Control” 
on page 139.

Remote Control Open a remote control window directly to a selected client machine. 
Investigate problems directly from your console. See “Remote Control” 
on page 140.

Execute Type and run commands remotely. See “Execute” on page 143.
Copy File to Copy selected files, directories, or entire directory structures and send 

them to the selected computer(s). See “Copy File to” on page 174.
Chat Start an individual chat session with one or more selected client 

computers. Communicate actions or query for symptoms during 
administration. See “Chat” on page 143.

ADVANCED >

Clear Status Clear computer status as shown in the title bar of the List View.
Prompt User for 
Properties

Query the user for personal information. This feature sends a form to the 
user to fill out. See “Prompt User for Properties” on page 144.

Reset Connection Disconnect and reset the connection between Deployment Server and 
the Deployment Agent on the selected computer.

Install BootWorks Embed BootWorks onto the selected computer’s hard disk to enable a 
managed computer to run DOS-specific tasks. See “Installing 
Deployment Agent for DOS (BootWorks)” on page 72.

Get Inventory Update property settings for a selected computer. These inventory 
settings can be viewed in “Computer Properties” on page 133. Select it 
to ensure that you have the latest inventory of the computer. 
Set the timeout value in the General tab of the Deployment Server 
Configuration utility (in the Control Panel). 

Reject Connection Refuse communication with the selected computer.
Install BIS Certificate Install a BIS certificate for the selected computer.
Remove BIS 
Certificate

Remove a BIS certificate from the selected computer. 

Apply Regular License Apply a permanent license if a client computer is using a time-limited 
license or requires an updated license. 

New Job Wizard Open this to schedule deployment jobs for the selected computer. See 
“New Job Wizard” on page 153.

New Group Click to create a new computer group in the Computers pane.
New Computer Create a new computer account. See “Adding New Computers” on 

page 113.
Rename Assign the computer or group a new name in the console. Right-click a 

computer or group to edit in the Computer pane.
Delete Delete a computer, a computer group, or any combination of computers 

and groups from the database.
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Restoring a Computer from its Deployment History 
Occasionally it is necessary to restore a computer to its original settings based on operations or 
deployment jobs previously executed on the computer. A computer’s past deployment history is 
displayed in the Restore Computer dialog box, where you can restore a computer by selecting tasks 
displayed from its history file. You can then rerun the deployment tasks to restore the computer.

1 Right-click a computer and click Restore.
The Restore Computer dialog box will open with a list of previous tasks with check boxes. 

2 (optional) Click the Show only list box and select only the type of tasks that you want displayed. 
Click the Since list box to filter tasks by date. 

3 Click Next to view a summary of tasks selected to reschedule.
4 Click Next to schedule the job (See “Scheduling Jobs” on page 158).
5 Click Finish. 
When you finish this computer operation, a new job will appear in the Jobs pane of the Deployment 
console under the System Jobs > Restoration Jobs folder. The job name will have a generic format of 
Restore: <computer name>. 

Viewing a Computer’s History
You can view a history of deployment tasks for a specific computer. 

1 Right-click a computer and click History. 
The History of <Computer Name> dialog box will open with a list of previous tasks, including 
when the task was scheduled, its deployment status and other deployment information.

2 (optional) Click Save As to save the file as a TXT or LOG file. 
3 (optional) Click Print to print the History file. 
4 Click Close. 
See also “Remote Operations” on page 136.

Configuring Computers
From the Operations menu you can enter and modify configuration settings for computers. See 
“Computer Configuration Properties” on page 116 for complete information about configuration 
settings.

1 Right-click a computer and click Configure. 
The Computer Configuration Properties dialog box will open.

Change Agent 
Settings

Update property settings for the Deployment Agent running on selected 
computer(s). See “Deployment Agents” on page 120.

Security View security settings for the selected computer(s). See general 
Security settings.

Properties View computer configuration and network properties. See “Computer 
Properties” on page 133.

 

Restore a computer by right-clicking a computer icon in the Computers pane and 
selecting Restore, clicking Operations > Restore on the menu bar, or clicking the 
icon in the toolbar. You can restore a computer using Remote Operations or by 
creating and scheduling a job using the New Job Wizard.

Computer Operations
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2 Set basic configuration values in the General configuration group (default view). 
3 Click other configuration group icons in the left pane to set additional values. 
4 Click OK.
See also “Remote Operations” on page 136.

Quick Disk Image
This computer operation creates a disk image of the selected computer. This option is a quick and 
easy way to create a disk image of a selected managed computer from the Deployment console.

To run a disk image job you must have BootWorks or a PXE Server set up to run this DOS-based 
task.

1 Right-click a computer and click Quick Disk Image.
The Schedule Computers dialog box will open. See “Scheduling Jobs” on page 158.

2 Schedule the job to run immediately or at a later time. You can also click the option to not 
schedule the job (this option places the job in the working area and will not run until you 
manually drag it to a selected computer and reschedule it). 

3 Click OK.
When you finish this computer operation, a new job will appear in the Jobs pane of the 
Deployment console under the System Jobs > Image Jobs folder. The job name will have a 
generic format of Create Image: <computer name>. 

See also “Remote Operations” on page 136.

Power Control
This computer operation allows you to wake up a computer, restart a computer, shut down, or log 
off as the current user for a selected managed computer. You can also power a computer on if Wake-
On-Lan is supported.

1 Right-click a computer and select Power Control.
A secondary menu will open with these options:

 

Restore a computer by right-clicking a computer icon in the Computers pane and 
selecting Power Control, clicking Operations > Power Control on the menu bar, or 
clicking the icon in the toolbar. 
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2 Select a Power Control option. A Confirm Operation dialog box will open. Select the Force 
application to close without a message box to shut down users without a warning. If you do not 
select Force application to close without a message, the user will be prompted to save any work 
before the power operation is continued.

3 Click Yes.
See also “Remote Operations” on page 136.

Remote Control 
Remote Control is a computer management feature built in to the Deployment Server Console. It 
allows you to control all types of computers to view problems or make immediate changes as if you 
were sitting at the managed computer’s screen and using its keyboard and mouse.

Before you can remote control a managed computer:

• The managed computer must have the Altiris Agent for Windows installed and properly set up.
• The client must have the appropriate Remote Control option checked in Altiris client properties.
• The client and Deployment Server Console must be able to communicate to each other through 

TCP/IP.

To remote control a managed computer
1 Right-click a computer and click Remote Control. 

This opens the Remote Control window displaying the managed computer’s screen.

Power Control options
Wake Up       The Wake Up feature is hardware-dependent and is only available for inactive 

computers. Select this command to start a computer that has been turned off. 
Notes
Your operating system and network adapter must be capable of recognizing 
and processing the wake-on-lan packets. Non-embedded network adapters 
must be properly configured. For example, 3Com NICs have an extra header 
cable that enables Wake on LAN. Check the documentation that came with 
your network adapter for more information about Wake-on-LAN. 
For NICs and operating systems that support Wake-on-LAN Power 
Management features, you need to go to Properties of the network adapter 
driver and select the Power Management tab. Click the Allow this device to bring 
the computer out of standby option for this device to bring the computer out of 
standby status. 
Note Some computers have to enable this feature in their BIOS.

Restart...      Click to reboot the selected managed computer. Select Force Applications to 
close without a message box to restart immediately without prompting the user.

Shut down... Click to shut down the selected managed computer. Select Force Applications 
to close without a message box to shut down immediately without prompting 
the user.

Log off... Click to log off of the selected managed computer. Select Force Applications 
to close without a message box to log off immediately.

 

 

When a managed computer is being remote controlled, the Deployment Agent 
icon in the managed computer’s system tray flashes alternate icons. 
Remote Control also provides Chat, Copy File to, and Ctrl+Alt+Del features to 
assist in administrating managed computers from the console.
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Note If the selected managed computer does not allow a remote control operation, you can 
change this client setting using the Remote Control options in the Change Agent Settings 
command. The default setting is to not allow remote control of the managed computer. See 
Deployment Agent “Remote Control” on page 125 options.

2 From the Remote Control window you can execute the following commands:

3 To end a Remote Control session, click Control > Close Window in the Remote Control window.

Send Files during Remote Control  
Click to send files to the managed computer being remotely controlled. Enter the name of the source 
file to be copied and the destination path on the managed computer. Select required compression and 
encryption options.

If you are controlling multiple clients within a single window, this dialog will send a file to the 
master client only.

Source filename. Enter the name of the file to be sent.

Destination path. Enter the path where you want the file to reside on the managed computer.

Compress Data. Select to compress the file during the copy process to decrease network traffic.

Encrypt Data. Select to encrypt data package for security.

You can also drag entire folders from the Console computer to the remote control window, which 
will copy the files to the remote client computer.

Remote Control options

Toolbar
Chat      Click to open a chat session with the selected managed computer. This starts 

a chat session between the console computer and the managed computer. The 
chat session opens a chat window that allows you to send messages back and 
forth between the Console and the managed computer. If you are controlling 
multiple computers in a single window and start a chat session, the chat 
session is only between the Console and the master client.

Refresh   Click to update the screen view of the managed computer.
Ctrl+Alt+Del Click to select restart or logon options for the managed computer. 

Note The managed computer must be running Windows NT/2000/XP/2003 
and have the keyboard and mouse driver installed for this feature to be 
available.

Send File See “Send Files during Remote Control” on page 141.
Toggle Control Click to change between control access of the managed computer (default) or 

view access only of the managed computer. 
Control menu
Disable Input from 
the Client

Click to prohibit the user of the managed computer from using the keyboard 
or mouse during the remote control session.

Close Window Click to close the remote control window of the managed computer.
View menu
Refresh Click to refresh the view of the screen.
Fit to Window If this option is selected, the client display image becomes the same size as the 

Remote Control window. If not, the image is the size of the client display.
Color Depth See “Remote Control Properties” on page 142.
Properties See “Remote Control Properties” on page 142.
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Remote Control Properties
Color Depth. Click to specify the color depth (number of colors) used by the Remote Control window. 
This setting applies only to the Remote Control window at the console, not the display of the 
managed computer. There is no benefit to setting a color depth on the Remote Control window 
greater than that of the managed computer. The benefit of lower colors is improvement in speed.

Use specific image resolution. Click to specify the width and height of the image that represents the 
client display.

Update interval. Select to specify how often the image in the Remote Control window is updated (in 
milliseconds). The more frequently the display is updated, the more bandwidth is required.

Only update foreground window. Select to refresh only the selected window in the remote control 
session.

Set Remote Control Permissions
Deployment Solution provides multiple features for ensuring privacy and security when a managed 
computer is remotely controlled. Before a managed computer can be remotely controlled, the 
Remote Control preferences on the Deployment Agent for Windows must be set to allow remote 
control access.

You can also lock the keyboard and mouse of the managed computer or provide a message to the 
user asking for permission to initiate a remote session. This provides an opportunity for the user to 
allow or reject the request. In certain environments, such as a lab or classroom, using a prompt to 
ask for permission might not be preferred. 

To remotely set security options on each managed computer, use Change Agent Settings from the 
console or open Properties on the Deployment Agent on the client computer (you must access Admin 
properties).

1 After opening the Deployment Agent property page, select the Remote Control tab.
2 Select Allow this computer to be remote controlled to provide access from the Deployment Server 

Console.
3 (optional) To lock the user from using the keyboard and mouse during a remote control session, 

select the Enable NT keyboard and mouse driver box.
This option works only on Windows NT/2000/XP/2003.
Important After selecting this option (either enabling or disabling the keyboard and mouse) you 
must restart the managed computer. This can be done using a Power Control operation.

4 (optional) If you want the user to be prompted before a remote control session begins, click the 
User Prompts tab.
a Under the Choose the commands you would like to be prompted before executing options, select 

the Remote Control commands option.
b Specify the number of seconds that you want the prompt to wait. Also, specify what will 

happen after the prompt time is up. Click either Continue the operation or Abort the operation. 
5 Click OK.

Enable Keyboard and Mouse Drivers
If you have a Windows NT/2000/XP/2003 managed computer, you can perform a Ctrl+Alt+Delete 
operation and ignore input from the keyboard and mouse as long as you enable a special keyboard 
and mouse driver from within the AClient properties. A reboot is required to enable this setting.

If you have a Windows 98 or ME client, you can only ignore input from the keyboard and mouse, 
but you cannot perform a Ctrl+Alt+Delete. You do not need to install a special driver to do this.

If you have a Windows 95 client, you cannot remotely perform a Ctrl+Alt+Delete operation or 
ignore input from the keyboard and mouse.
Deployment Solution Product Guide 142



 Managing Computers Remote Operations

 

Start Multiple Sessions
You can manage multiple computers using the Remote Control feature. However, the more 
computers you include in the session the larger the bandwidth over the network.

• Open a separate Remote Control window for each managed computer. Right-click each 
computer and select Remote Control. A new window will open for each selected computer.

• Open a Remote Control window for a group of managed computers. Right-click a computer 
group icon and select Remote Control.
The Remote Control Options dialog box will open with options to Control each client separately in 
its own window or to Control all clients together. If you select to control clients separately, then 
individual windows will open for each computer. If you select to control clients together, then 
you will be asked to select a master computer. 
The master computer is the computer that will appear in the Remote Control window, however 
all actions taken from the console will also run on the other computers in the group. All 
computers in the group should be similar in configuration to work properly.
Note If you are controlling multiple computers in a single window, you can send a file only 
between the console and the master client. If you want to send a file to multiple clients at the 
same time, use the Copy File to feature (see “Copy File to” on page 174.)

6 To end a Remote Control session, click Control > Close Window.
See also “Remote Operations” on page 136.

Execute 
Send a command from the Deployment console as if you were entering a command from the 
command-line prompt on the client computer.

1 Type a command that you would like executed on the remote computer(s) selected, or select from 
a list of previously run commands. For example, type regedit to open the Registry on the 
computer. 

2 To run the command as another user on the managed computer, click the User button and enter 
the user name and password.

User Account
Use this dialog to run a script using another local user account. You can log in with another user 
name and password with rights to run an execute command.

Run with default security credentials (default). This option runs with the current user credentials.

Run with the following credentials. Click this option to log in with another user name and password.

See also “Remote Operations” on page 136.

Chat 
You can communicate with managed computers using the Chat text messaging system. From the 
Deployment Server Console, select an individual computer or a group of computers to open an 
individual chat session with each logged-in user.

 

Execute a command to a client computer by right-clicking a computer icon in the 
Computers pane and selecting Execute, clicking Operations > Execute on the 
menu bar, or clicking the icon in the toolbar.
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1 Open a chat session. The Chat with <computer name> window will open identifying the computer 
you are sending messages to. 

2 Type a message in the lower text box. 
3 Click Send or press <Enter>.

The exchange of text messages will appear in the upper text box.
See also “Remote Operations” on page 136.

Prompt User for Properties 
This feature allows an administrator to prompt a user for computer location and user information. 
The information supplied in this form will appear in the Location properties in the Computer 
Properties dialog.

To prompt a user for location properties:

1 In the Computers pane of the Deployment Server Console, right-click a computer and click 
Advanced > Prompt User for Properties. You can also select a computer and click on the Prompt 
User for Properties icon in the toolbar or click on Operations > Prompt User for Properties.
A dialog box will open in the Deployment Server Console with a list of properties.

2 Select the properties to prompt the user. The properties selected in this dialog box will be active 
on the property form sent to the user, allowing the user to type information for the selected 
properties.
Note All properties will be selected by default; you must deselect the properties you don’t want 
included when the client is prompted.

3 Click OK.
The properties form will appear to the logged-in user of the computer asking for location 
properties.

When the user enters information and selects OK, the Location properties in the computer 
properties fields will be updated for the selected computer. If the user changed the computer 
name, then the name in the Computers pane of the Deployment console will also change. These 
settings are stored directly to the Deployment Database.

See also “Chat” on page 143 and “Remote Operations” on page 136.

 

Open text messaging with a user by right-clicking his or her computer icon in 
the Computers pane and selecting Chat, or clicking the icon in the Remote 
Control window.
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Install BootWorks
When running DOS-specific deployment tasks, you can embed BootWorks on the local hard disk 
and boot to DOS using the boot files provided during Deployment Server installation. These files 
will be installed to a hidden partition of your hard disk (see “Installing Deployment Agent for DOS 
(BootWorks)” on page 72). If you are running the PXE Server, you will not need to install 
BootWorks.

Right-click a computer and click Advanced > Install BootWorks. This will run an embedded 
BootWorks installation on the managed computer and reboot the computer. You can now run DOS-
specific deployment tasks on this computer.

Change Agent Settings
This feature allows you to modify most agent settings for a selected computer or computer group.

From the Computers pane, right-click a computer and select Change Agent Settings. Select Windows/
Linux Agent to edit “Deployment Agent Settings for Windows and Linux” on page 122, or select 
Bootworks Agent to edit “Deployment Agent Settings for DOS (BootWorks)” on page 127. 

Deploying and Managing Servers
Deployment Solution provides additional features to remotely install, deploy and manage network 
and web servers. From the Deployment Server Console, you can configure new server hardware, 
install operating systems and applications, and manage servers throughout their life cycle. And 
because servers are mission-critical, you can set up a system to quickly deploy new servers or 
automatically re-deploy servers that have failed. Features like rules-based deployment, support for 
remote management cards, and quick server restoration from a deployment history give you new 
tools to manage all servers throughout your organization.

Manage Servers from the Console. The Deployment Server Console includes features specifically 
designed for deploying and managing servers, such as enhanced task logging and history tracking 
features to let you recall administrative actions and quickly redeploy mission-critical servers. See 
“Server Management Features” on page 145.

Set Server-specific options. Servers are essential to any organization and require special planning 
and management strategies. Deployment Server provides server-specific features to automatically 
deploy new servers and maintain existing servers. See “Server Deployment Options” on page 146. 

Server Management Features
Deployment Server provides various features for deploying and managing servers. These features 
are supported for client and handheld computers as well, but are essential in deploying servers.

 

Servers are identified in the Computer pane with distinctive server icons. Like all 
managed computer icons, the icons change to identify the status and state of the 
computer, such as user logged on or Server Waiting. 
Note Servers are recognized by their operating system (such as Windows 2000 Advanced 
Server, Windows Server 2003, or any Linux OS), multiple processors, and specific 
vendor server models.
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Server icons. The Deployment consoles display icons to identify servers across the network. Like 
other computer icons in the console, server icons can be selected to view server properties or assign 
specific jobs and management tasks

Run Scripted Installs. Execute scripted, unattended installs across the network for both Microsoft 
Windows and Linux servers. Follow steps to create answer files and set up OS install files using a 
wizard. See “Scripted OS Install” on page 163.

Support for multiple network adapter cards. Because servers may require more than one network 
interface card, Deployment Server provides property pages to access and configure multiple network 
adapters remotely from the console. See “TCP/IP Configuration Settings” on page 118.

Synchronized server date and time. Deployment Server automatically sets the server’s date and 
time after installing or imaging (as part of the configuration process). Deployment Agents include 
an option to disable this feature (it is off by default).

Enhanced scripting capabilities. You can deploy multiple tasks per deployment job and boot to 
DOS multiple times when configuring and deploying a clean server. Deployment Server also lets 
you view and debug each step in the deployment script, and track each job to provide a history of 
tasks for redeploying a server.

Server Deployment Options
Deployment Server includes features to automatically reconfigure and redeploy new servers. If you 
are using Initial Deployment to automatically re-image new servers or run installation scripts, you 
can (1) safeguard against mistaken disk overwrites, or (2) run automatically for every server not 
identified as a managed computer in the database. These contrasting settings are based on polices 
that you define for managing servers in your organization.

For example, if you rely on PXE to boot the new server and you want to deploy new servers 
automatically without halting the process, you must change the default settings in the PXE 
Configuration Utility. In contrast, if you want to ensure that the server waits before being deployed 
(or waits a set time before proceeding) to avoid erroneous re-deployment, you need to set the options 
in the Advanced section of Initial Deployment.

Halt the Initial Deployment of Servers
When a server boots from the PXE server or from BootDisk (if the option is set), Deployment Server 
recognizes it as a new computer and will attempt to configure the computer with Initial Deployment. 
Initial Deployment includes a feature to prohibit servers from being deployed automatically.

1 Click Initial Deployment and select Properties.

2 Click the Advanced tab.

3 Click the Servers check box and click OK.

Initial Deployment will not run for any computer identified in the console as a server.

Icon Description

  
Indicates a server is active and a user is logged in.

 
Indicates a server is disconnected from the console.

 
Indicates a server is in a waiting state.
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Change PXE Options for Initial Deployment
If installing a server using a PXE Server, the server will attempt to install but will not run 
automatically using default settings. It will wait until a boot option is selected from the client 
computer. You can change the default setting in the PXE Configuration Utility to allow Initial 
Deployment to run automatically and not sit at the prompt.

1 Click on Start > Programs > Altiris > PXE Services > PXE Configuration Utility.

2  Click Altiris BootWorks (Initial Deployment). Click Edit.

3 Select Execute Immediately. 

Initial Deployment will run automatically for every identified server.
4 Click OK.

Clear BootWorks Prompt for Remote Install
When you run a deployment job on a computer where the Deployment Agent has been remotely 
installed, a message will appear stating that no BootWorks partition or PXE stamp is found. The 
message will stay open until the user clicks OK on the message dialog, which delays executing the 
scheduled job as part of an automated redeployment process. To fix this delay:

1 Select Tools > Options.The Altiris Program Options dialog will open.

2 Select the Agent Settings tab. 
3 Select the Change Default Settings button.
4 Select the BootWorks tab.
5 In the lower section, select Never prompt me from the list.
6 Click OK. 
Following these steps will assure that the BootWorks message will not come up and things will move 
forward when a job is scheduled.

Managing Server Blades
Deployment Solution allows you to manage high-density server blades with Rack/Enclosure/Bay 
(R/E/B) hardware and properties. From the Deployment Console you can deploy and manage these 
space-efficient server blades using the physical view to assign jobs to the Rack, Enclosure, or Bay 
level of the server cluster, or you can manage each server blade directly from the logical view. See 
“Bay” on page 135 for properties and rules to deploy Rack/Enclosure/Bay servers.

Using Deployment Solution, you can employ “rip and replace” technology that allows you to insert 
a new server blade and automatically configure and deploy it exactly like the previously installed 
server blade, allowing you to replace any downed server and get it back on line quickly. Altiris 
provides fail-safe features to ensure that no server is mistakenly overwritten and ensures that all disk 
images, software, data, and patches are applied to the new server from the history of jobs assigned 
to the previous server blade. 

Managing New Server Blades
Deployment Solution allows you to automatically deploy, configure and provision new server blades 
using a variety of features, including Initial Deployment, Virtual Bays, and Server Deployment 
Rules.
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New Server Blades in Newly Identified Bays
When new blades are identified in a Bay that has not been used previously (if it has been used 
previously then the Bay object will be identified in the physical view), then both the Initial 
Deployment and Virtual Bays features can be set up to automatically run configuration tasks and 
deployment jobs. 

To Create Virtual Bays: Set up Virtual Rack/Enclosure/Bays for Hewlett-Packard Rapid 
Deployment Pack installations of Deployment Solution.

Initial Deployment set up: Clear the Servers check box in the Advanced dialog box.

If both new computer features are set up and a new server blade is installed in a Bay not previously 
identified by the Deployment Server, then the Create Virtual Bay feature will execute and Initial 
Deployment will not execute.

New Server Blades in Identified Bays
If a new HP server blade is installed in an identified Bay (one that has already had a server blade 
installed and is visible from the Deployment Console), then both Initial Deployment and Server 
Deployment Rules can be set up. However, when both are set up then the Server Deployment Rules 
will execute and Initial Deployment will not execute.

Hewlett-Packard Server Blades
Hewlett-Packard high-density blade servers can be deployed and managed from the Deployment 
console. The following HP server blades are supported:

HP blade servers allow you to employ all features provided in the Deployment Console when you 
install the HP Proliant Essentials Rapid Deployment Pack (see www.hp.com/servers/rdp), including 
the Virtual Blade Server feature. The name of each Rack for an HP Server is displayed along with 
the assigned name for the Enclosure and Bay. These names are collected from the SMBIOS of the 
server blade and displayed in both the physical and server views within the Computers pane of the 
Deployment console.

For HP blade servers in the physical view the Rack name can be a custom name in the console, with 
all subordinate Enclosures and Bays also identified. For example:

<rackName>

<enclosureName>
<bayNumber>

See also “Server Management Features” on page 145 and “Server Deployment Options” on 
page 146.

Virtual Bays  
Hewlett-Packard blade servers now have a Virtual Bay feature similar to the Virtual Computers 
feature, allowing you to pre-assign deployment jobs to the Rack, the Enclosure, or to a specific 
server in the Bay. Any HP blade server can have predefined deployment jobs and configuration tasks 
associated with it to execute automatically upon installation. (This feature requires that the Hewlett-
Packard Rapid Deployment Pack is installed.) The Virtual Rack/Enclosure/Bay icons will change 
from virtual icons to managed server icons in the Deployment console as live blade servers are 
inserted and identified by Deployment Solution.

Rack name. Enter or edit the name of the Rack.

Enclosure name. Enter or edit the name of the Enclosure.

HP Proliant™ BL e-Class HP Proliant™ BL p-class
 Proliant™ BL 10e Proliant™ BL 20p
 Proliant™ BL 10e G2 Proliant™ BL 20p G2
 Proliant™ BL 40p
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Enclosure type. Select the type of HP server blade from the list.

Initial Job. Select an existing job to run when the virtual computer is associated with a new server 
blade.

Server Change rule. Select the Server Deployment Rules to run on the Bay when a new server blade 
is installed.

Note: If you create Virtual Bays for an enclosure (such as the BL e-class with 20 bays) and then if 
another model of server blade with an enclosure containing fewer bays is connected (such as the 
BL p-class with 8 bays), then the excess virtual bays will be truncated automatically. Conversely, if 
you create Virtual Bays with fewer bays (8) and then install an enclosure with additional bays (20), 
you will need to recreate the virtual bays in the enclosure (right-click the enclosure name in the 
physical view and click New Virtual Bays).

See also “Managing New Server Blades” on page 147.

Dell Server Blades
Dell high-density blade servers can be deployed and managed from the Deployment console. All 
Dell Rack Servers are supported by Deployment Solution, but the server blades can also be managed 
from the physical view in the Rack/Enclosure/Bay view. The following servers are supported: 

For Dell blade servers in the physical view, the Rack name will always be Dell. All subordinate 
Enclosures and Bays are identified with custom names under the Dell rack name. For example:

Dell

<enclosureName>
<bayName>

See also “Server Management Features” on page 145 and “Server Deployment Options” on 
page 146.

Fujitsu-Siemens Server Blades
Fujitsu-Siemens high-density blade servers can be deployed and managed from the Deployment 
console. All Fujitsu-Siemens Rack Servers are supported by Deployment Solution, but the server 
blades can also be managed from the physical view in the Rack/Enclusure/Bay view. The following 
servers are supported:  

For Fujitsu-Siemens blade servers in the physical view, the Rack name will always be Fujitsu-
Siemens. All subordinate Enclosures and Bays are identified with custom names under the Fujitsu-
Siemens rack name. For example:

Fujitsu-Siemens

<enclosureName>
<bayName>

See also “Server Management Features” on page 145 and “Server Deployment Options” on 
page 146.

Dell Rack Servers Dell Server Blades
All PowerEdge™ rack servers PowerEdge™ 1655MC

Fujitsu-Siemens Rack Servers Fujitsu-Siemens Server Blades
All Primergy™ rack servers Primergy™ BX300 blade servers
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Find a Computer in the Database 

This search filter allows you to type a string and query specified database fields for specific 
computer properties. You can search for user or computer names, licensing or location information, 
or primary lookup keys: MAC address, serial number, asset number, or UUID. This search filter 
queries property values displayed in the “Computer Properties” on page 133 pages.

 

1 In the Search For box, type all or part of the computer’s property values that you would like to 
search for. This alpha-numeric string will be compared with specified database fields. 

2 In the In Field box, select the field that you want to search in the Deployment Database. 
For example, to find a computer by searching for its IP address, type the address in Search For 
field and then select IP Address from the In Field drop down list.

The computer you are looking for will be displayed and highlighted in the Computers window in the 
console.

Note This search is not case-sensitive and allows wildcard searches using the *.

See also “Computer Filters and Job Conditions” on page 103.

Using Lab Builder 
Use the Lab Builder to set up jobs under the Lab folder in the Jobs pane to set up a classroom or lab 
environment.

You can set up jobs to: 

 

Click <Ctrl> F or click the Find Computer button on the console toolbar to search 
the Deployment Database for computers by property settings. 
The computers that match the search will be highlighted in the Computers pane.

Name BIOS name of the computer.
Computer Name Deployment Solution name of the computer.
MAC Address 0080C6E983E8, for example.
IP Address 192.168.1.1, for example.
ID The computer ID. 5000001, for example.
Serial Number Serial number installed in BIOS. A primary lookup key.
Asset Tag Asset number in BIOS. A primary lookup key.
UUID A primary lookup key.
Licensed User Name Name entered when OS was installed.
Licensed Key Licensed Key for the operating system
Logged On User Name of user currently at the computer.
Physical Bay Name The actual bay number: 7x, for example.

 

Click the Lab Builder button on the console toolbar or click 
File > New > Lab Builder to set up jobs specifically created for managing multiple 
computers in a lab environment. 
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• Create Disk Image
• Deploy Lab
• Restore Lab
• Update Configuration
• Upload Registries
Each of these jobs contains a default list of tasks. Lab Builder places these five new jobs under a 
folder (which you name) located under the Lab folder. All of the tasks in the jobs have been assigned 
default paths and file names that allow them to use the same images and configuration information, 
registry data, etc. It is suggested that you do not change the file names and paths. If you change the 
default settings (for example, changing the image name), you must change it in all of the jobs where 
the image is used.

To use Lab Builder
1 Click the Lab Builder icon on the toolbar, or choose File > New > Lab Builder.
2 Enter the name of the lab setup.

Note The lab name must be unique because the program creates a default image file name based 
on the name, and the image file name must be unique. The default image name is synchronized 
in all of the lab jobs, so if you change the name later you must change it in all the jobs that use 
the image. 

3 (optional) Enter a lab description to help you differentiate the lab from others. This field is 
optional. Click OK.

4 Identify an image in the Create Disk Image job.
5 Set computer names and addresses in the Update Configuration job.

The following information describes the default jobs. To run one of these jobs, simply drag it to the 
computer or computer group that you want it applied to.

Create Disk Image. This job uploads an image of a computer to the server and an image name is 
created automatically based on the lab name. However, there is no actual image in the job until you 
drag the image source computer to this job.

Deploy Lab. This job has three default tasks: Deploy image, Apply configuration settings, 
and Back up registry files. The image that is uploaded using the Create Disk Image job is deployed 
when you use this job. The configuration settings you specify in the Update Configuration job are 
applied to the computers, and then the computer registry files are uploaded to the Deployment 
Server. 

Restore Lab. This job restores the image and registry files to a computer where a lab was previously 
deployed. You can quickly get a computer running again by restoring the lab on that computer. 

Update Configuration. This job allows you to set unique configuration information (such as computer 
names and network addresses) for client computers. When a lab is deployed, each computer has an 
identical image, but not the same configuration settings. This means you don't have to visit each 
computer to reset IP addresses and other settings when you deploy an image. 

Upload Registries. This job backs up computer registry files to the Deployment Server.
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Building and Scheduling Jobs

A job represents a collection of predefined or custom deployment tasks that are scheduled and 
executed remotely on selected client computers. You can build jobs with tasks to automatically 
create and deploy hard disk images, back up and distribute software or personality settings, add 
printers, configure computer settings, and perform all aspects of IT administration. Jobs can be run 
immediately for a specific computer, or stored and scheduled for daily or long-term administrative 
duties on multiple computer groups.

The New Job Wizard guides you through common deployment and management jobs. It’s an easy 
way to set up new users or migrate users to new computers, create and distribute images of 
computers on the network, distribute software packages, restore computers, and more.

Jobs include one or more Deployment Tasks. You build jobs by adding tasks to a job and then 
customizing the task for your specific needs. You can add tasks to capture and distribute images, 
software packages, and personality settings. Or you can write and run a script task, or run scripted 
installs, configure settings, copy files and back up registry settings. You can also modify existing 
jobs by adding, modifying, or deleting tasks to fit your needs. See “Building New Jobs” on page 156.

Set conditions on jobs to run only on computers with properties that match the criteria that you 
specify. You can build one job to run on different computer types for different needs, and avoid 
mistakes by ensuring that the right job runs on the right managed computer. See “Setting Conditions 
for Task Sets” on page 157.

Initial Deployment allows you to run predefined jobs and configuration tasks on new computers 
when they start up. You can automatically deploy new computers by imaging and configuring TCP/
IP, SIDs, and other network settings and then installing basic software packages. See “Initial 
Deployment” on page 178.

Sample jobs are installed with Deployment Solution and appear in the Samples folder of the Jobs 
pane. You can run many sample jobs as they are, or you can set environmental variables and run. 
See “Sample Jobs in Deployment Solution” on page 181.

Viewing Job Details
As jobs are assigned, scheduled and executed, it is helpful to know specific details about their status 
and assignments. The Deployment Server Console provides job icons to show state and status of the 
job in the Details pane:

• Job status icons that update to display the state of the job in running deployment tasks. These 
icons are graphical symbols in the Deployment console used to identify the status of an assigned 
job.

 

Job icons appear in the Jobs pane of the Deployment console. To assign and 
schedule a job in the Deployment Server Console, drag the job icon to selected 
computer icons. Job status icons also appear in the Details pane of the Deployment 
Server Console to indicate various deployment states. See “Viewing Job Details” 
on page 152.
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.

• A description of the job, if available. You can also use the Add or Modify buttons in the main 
window to edit the description as well.

• The currently applied conditions displayed in a list box with a Setup button to add conditions to 
different task sets for different computer properties within a job. Conditions specify 
characteristics that a computer must have before the job will execute. See “Setting Conditions 
for Task Sets” on page 157. 

• A list of tasks assigned to the job and task descriptions are also be displayed. Change the order 
of the task execution with the arrow buttons. Tasks are executed in the order they are listed. See 
“Deployment Tasks” on page 159. 

• Features to add, modify, and delete tasks for each job.
• A list of assigned computers and its deployment history. 
To sort jobs or computer details, just point and click on the category in the Details bar. For example, 
click the Status column heading to organize and display the progress status of the job.

See also “Viewing Computer Details” on page 112.

New Job Wizard
The New Job Wizard provides integrated features to build, assign, and schedule common 
deployment jobs. It helps you build the most common jobs, and guides you through additional steps 
to assign and schedule the jobs to selected computers. It allows you to quickly build image files and 
deploy new computers, distribute software packages, migrate users, and more. 

1 Select a job option:
Create an image. This wizard guides you through the steps required to create an image of a 
computer’s hard disk and schedule the job. See “Creating a Disk Image” on page 160.
Deploy and configure computers. This wizard guides you through the steps required to lay down 
a new disk image on a selected computer and then install software and personality settings. See 
“Distributing a Disk Image” on page 161.
Deploy software packages. This wizard guides you through steps required to install software 
packages. You can set conditions, select packages, assign to computers, and schedule the job. 
See “Distributing Software” on page 167.
Restore a computer. This wizard guides you through the steps required to restore a computer to a 
known working state by re-imaging the hard drive and reinstalling software packages, 

 

Indicates that a job is scheduled to run on a computer or computer group.

 

Indicates that a job is in progress. 

 

In the Details pane, indicates that a job has executed successfully.

 
Indicates that a job is associated with a computer or group of computers but is not 
scheduled. 

 

Create a new job by clicking the New Job Wizard button on the Deployment 
Server Console, clicking File > New > Job Wizard, or right-clicking in the Jobs 
pane of the Deployment Server Console and selecting New Job Wizard. The New 
Job Wizard will open to guide you through basic deployment jobs.
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personality settings, and defining configuration values. This option reschedules jobs saved in 
each managed computer’s history record, which contains all deployment tasks previously 
processed. See “Restoring a Computer from its Deployment History” on page 138. 
Migrate computers This wizard guides you through the steps required to move a computer hard 
disk image, applications, and personality settings from a source computer to a destination 
computer. You can perform one or more migration operations using provided options. 

2 Give the job a unique name. You can type a name with up to 64 characters. 
3 Follow the steps in each wizard to create a job (some New Job wizards build multiple jobs).

After creating a job, it will appear in the Jobs pane of the Deployment console with deployment 
tasks listed in the Tasks list for each job selected.

Note You cannot define return codes when using the New Job Wizard. See “Building New Jobs” on 
page 156 to build customized jobs and set up return codes. 

See also “Modifying Tasks in a Job” on page 176.

Migrating Computers 
From the New Job Wizard you can select Migrate computers to quickly distribute hard disk images, 
software, and settings from a user’s current computer to a new computer. You can image a new 
computer’s hard disk with a new operating system and then install software and personality settings. 
Or perform different levels of migration to distribute only software or to simply capture and 
distribute personality settings to the new computer.

Migrate one computer to another separate computer
Click this option to migrate a user from a source computer (old computer) to another destination 
computer (new computer). Capture personality settings, distribute a new hard disk image, distribute 
software and then redistribute the saved personality settings from the source computer to the new 
destination computer.

Click the option alone to migrate only personality settings to one or more computers. Additionally, 
select Prepare destination computer with a disk image to distribute a disk image to the new computer 
and select Install software packages prior to applying the personality on the destination computer to 
install software packages on the new computer.

Note This option will create two jobs that will appear in the Jobs pane: Job (Capture) and Job 
(Distribute).

Job (Capture) includes a Capture Personality Settings task (see “Capturing Personality Settings” on 
page 169) to capture the personality of the source computer and a Modify Configuration task to 
rename the source computer to avoid naming conflicts (see “Modifying Configuration” on 
page 171). The source computer will be named computerName (Old).

Job (Distribute) includes a Deploy Image task (see “Distributing a Disk Image” on page 161) if 
selected, a Modify Configuration task to update settings to the destination computer, and one or 
more Install Package tasks to update software (if selected) and migrate personality settings (see 
“Distributing Software” on page 167). 

Migrate the same computer to another operating system 
Click this option to upgrade the operating system on a computer and then reinstall personality 
settings and software packages on the same computer. It will create jobs and tasks to capture the 
personality settings, distribute a new disk image, distribute software packages, and then migrate the 
personality settings.

Click the option alone to deploy a disk image and migrate personality settings to the computer. 
Select Install software packages prior to applying the personality on the destination computer to install 
software packages on the computer.

Note This option will create two jobs that will appear in the Jobs pane: Job (Capture) and Job 
(Distribute).
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Job (Capture) includes a Capture Personality Settings task (see “Capturing Personality Settings” on 
page 169) to capture the personality of the source computer. 

Job (Distribute) includes a Deploy Image task (see “Distributing a Disk Image” on page 161) and one 
or more Install Package tasks to update software, if selected (see “Distributing Software” on 
page 167). 

Simply capture the personality of the computers
Click this option to capture and save, but not distribute, the personality settings of the selected 
computer(s). You can choose a personality template and save Personality Packages to the Client 
Access Point, allowing you to distribute these personality settings later to new computers. 

Note This option will create a single job with a Capture Personality Settings task (see “Capturing 
Personality Settings” on page 169).

See also “New Job Wizard” on page 153.

Selecting Computers in the New Job Wizard 
The New Job Wizard provides steps to select and assign computers to the jobs created in the wizard, 
rather than requiring you to create a job and then assign it to computers when Building New Jobs. 
The jobs created in the New Job Wizard will appear in the Jobs pane, and can be saved and assigned 
to other computers at a later time. You can also schedule jobs for the specified computers in the 
wizard (see “Scheduling Jobs” on page 158).

Apply Computers to a Job
When deploying software in the New Job Wizard, you can select computers to assign the 
Distributing Software job created in the wizard. You can also select an option to simply store the job 
and use it at another time without scheduling the job. Regardless of the scheduling option selected, 
the job will appear in the Jobs pane to use at another time.

New Computers. Open an Adding New Computers dialog box to create new user accounts to assign 
the job.

See also “Scheduling Jobs” on page 158.

Associating Destination Computers
Use this dialog box to associate source computers with destination computers when migrating 
personality settings. Depending on the computers selected in the previous Select Computers dialog 
box, you can migrate personality settings captured from the source computers to new destination 
computers. 

Right-click a computer in the Source column to replace it with another source computer. Right-click 
a computer in the Destination column to replace it with another destination computer and assign it to 
a new source computer. To automatically assign multiple computers, click Automatic to assign 
source computers with destination computers using an alpha-numeric order. The associated 
computers will share personality settings after running the jobs.

See also “Migrating Computers” on page 154.

Setting up Conditions in the New Job Wizard
The New Job Wizard also provides steps to set up conditions, a step usually performed 
independently for each job during its build phase. Setting conditions allows you to run selected tasks 
only on computers matching defined criteria (see “Setting Conditions for Task Sets” on page 157).

Click Setup conditions for this set of tasks to open the Define Conditions dialog box from the New Job 
Wizard.
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Install Software Packages
The New Job Wizard provides steps to install software packages to the selected computer(s). You 
can install any type of software to the managed client computer, including MSIs, RIPs, and 
Personality Packages. If the selected package is not a RIP or Personality Package, then a message 
box will open asking if you want to continue (See “Distributing Software” on page 167 for additional 
information).

Summary of Options
After selecting options in the New Job Wizard, you can view a summary of job names, assigned 
computers, conditions, and other selected choices. To change any options, click Back to return to 
previous dialog boxes. Click Finish to complete the steps in the wizard. 

See also “New Job Wizard” on page 153 and “Job Scheduling Wizard” on page 157.

Building New Jobs 
A job can be a single task to distribute software or change computer property settings, or a job can 
be a series of tasks sequenced to migrate hard disk images, set post-installation TCP/IP and SID 
values, and install software packages and personality settings.

1 Create a new job. Enter a unique name and description for the job. You can type a name with up 
to 64 characters. 
A new job will be added to the Jobs pane in the Deployment console. You can group and 
organize jobs, and then access and apply them to computers or computer groups from an index 
of prebuilt jobs.

2 (Optional) Set conditions to apply the job to specified computers meeting defined criteria. Order 
multiple conditions to run jobs on computers that match the first applicable condition. See 
“Setting Conditions for Task Sets” on page 157.

3 Click Add to add open a list of possible deployment tasks to add to each job. See “Deployment 
Tasks” on page 159.

4 Set task options using the provided wizards. 
After you complete the steps to create a task, it will be added to the task list box. Click Add to 
add another task. Use the arrow buttons to change the order of execution of the tasks in the Task 
list box.
Tasks are executed in the order that they appear in the task list. As a result, make sure you do not 
run a task that will override previous tasks. For example, list Distribute Disk Image above 
Distribute Software or Distribute Personality, allowing the hard disk to be imaged before installing 
applications and settings.

5 (optional) Set Return Codes. The last action in each task wizard allows you to set return codes 
for each deployment task. See “Setting Up Return Codes” on page 177. 

6 After adding tasks, click OK.
7  To schedule the job, drag it to a computer or computer group. The Schedule Jobs dialog box will 

open. See “Scheduling Jobs” on page 158.
See also “Importing and Exporting Jobs” on page 176.

 

Create a new job by clicking the New Job button on the Deployment Server 
Console, clicking File > New > Job, or right-clicking in the Jobs pane of the 
Deployment Server Console and selecting New Job. You can modify jobs by 
double-clicking the job or right-clicking and selecting Properties. Add tasks to 
each job using the Setup commands.
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Job Scheduling Wizard

The Job Scheduling Wizard provides features to assign jobs to selected computers and computer 
groups, and to then schedule the jobs to run without using a mouse. This new feature meets Section 
508 requirements to improve disability access and allows integration of voice activation software 
and other user interface features.

Select Job(s)
Select the job(s) or group(s) of jobs to assign to computers or computer groups. Use the <Shift> and 
<Ctrl> keys to select multiple jobs or job folders. Click Next.

Select Computer(s) or Computer Groups
Select the computer(s) or group(s) of computers to assign the jobs selected in the previous dialog 
box. Use the <Shift> and <Ctrl> keys to select multiple computers or groups. Click Next.

New Computers. Click this button when Adding New Computers.

Creating Jobs Using Copy and Paste
Occasionally you may want to create a job that is very similar to a job you’ve already created. You 
can do this using standard Copy and Paste features. After copying and pasting an existing job, you 
can edit it to add the tasks necessary without having to create a new job.

To create a new job using Copy and Paste, complete the following steps:

1 Right-click the source job and select Copy.
2 Right-click the folder where you want the job to be placed and select Paste.
Important You cannot paste a job while a current job is highlighted.

Setting Conditions for Task Sets
Setting conditions on a job allows you to run selected tasks only on computers that match defined 
criteria. As a result, you can create a single job with tasks defined for computers with varying 
properties, including OS type, network adapters, processors, free drive space and other computer 
properties. You can then create task sets for each job that will apply only to the computers matching 
those conditions.

1 Select a job in the Jobs pane of the Deployment Server Console.
2 Click Setup next to the Condition box. A menu will open with options to create a New condition, 

Modify a condition, or Delete a condition.
To reorder conditions, click Order and reorder them using the Up or Down buttons. See “Order 
Condition Sets” on page 158.

3 Click New in the menu to open the Condition Settings dialog box. Enter a name for the condition 
up to 64 characters.

4 Click Add to open the Condition dialog box.
Click the Field list and select a data field heading from the list. You can define conditions based 
on common client features such as OS, software and hardware version, hard drive space, RAM, 
and other characteristics.
Click Operation and select a compare statement. In the Value box, type a string to search for in 
the selected database field. You can set conditions based on computer properties stored in fields 
in the Deployment Database. For example, you might want to set a condition to match a 
particular asset tag, Altiris agent version, or IP address. You can use wildcard characters and 
AND/OR operators. 
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5 To set up custom conditions based on Custom Tokens, select User Defined Tokens from the Field 

list.
6 Click OK.
The task set you create will appear in the Task list for each condition. When you select a new 
condition, the tasks for that condition will appear.

You can set Condition A to distribute the XPImage.img file to Windows XP computers using a 
Deploy Image task. You can then set Condition B to distribute the W2KImage.img file to Windows 
2000 computers using another Deploy Image task. When the job is applied to a computer group, the 
conditions will be evaluated for each computer and the appropriate task will execute on the 
appropriate computer.

Note When using User Defined Tokens to set conditions for some client property values, you may 
be required to use the decimal value rather than the hex value. For example, when setting conditions 
based on the NICS table on the nic_device_id and nic_vendor_id columns, you are required to use 
decimal values.

 See also “Deployment Tasks” on page 159.

Order Condition Sets
By specifying and ordering different sets of conditions, you can determine when a task executes 
based on defined computer properties. Each condition is processed in sequence until the computer 
matches the condition defined within a set. If the computer does not meet any of the defined 
conditions, it will run the default condition. Once a match is found, the set of tasks for this condition 
set is processed.

See also “Setting Conditions for Task Sets” on page 157.

Scheduling Jobs
After a job has been created, assign it to computers or computer groups. The Schedule Job dialog 
box will open automatically, allowing you to schedule the job to run immediately, at a scheduled 
interval, or assigned but not scheduled.

To schedule a job
1 Drag a job to a computer or computer group. The Schedule Job dialog box will open.
2 In the Schedule Job dialog box, select appropriate options:

Do not schedule. This option allows you to apply jobs to computers but does not run the job until 
you return to the Schedule Job dialog box and set a run time.
Run this Job immediately. This option allows you to run the job now.
Schedule this Job. This option allows you to type the date and time to run the job at a specified 
time and date. To run it at regular intervals, specify a time and date to repeat.
Repeat this job every x. A job can be scheduled to execute by minute(s), day(s), hour(s), week(s).
Allow this job to be deferred for up to x. A job can be deferred when the server is busy executing 
other jobs, setting a lower priority for particular jobs. By default all jobs are deferred up to five 
minutes.
Schedule in batches of x computers at y minute intervals. This option allows you to schedule 
computers in batches to maximize efficiency.

3 Click OK.

To reschedule a job
1 From either the Computers or Jobs panes in the Deployment console, select a job or computer 

that has been previously scheduled. 
A job icon will appear in the Details pane identifying the computers assigned or the name of the 
job. 
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2 Select the job icon, click the scheduled computers in the Details pane, right-click and then click 

Reschedule.
If you selected a computer icon, click the job icon in the Details pane, right-click and then click 
Reschedule. The Schedule Jobs dialog box will open.

3 To immediately start a scheduled job that has not yet run, right-click the job icon and select Start 
Now. 

4 To stop a repeating job, right-click the job in the Details pane and click Discontinue Repeat. 
Schedule a new time to run the job or click the Do not schedule option.

To remove computers from a scheduled job
You can complete this task by removing a job assigned to a computer or removing a computer 
assigned to a job. 

To remove tasks from a job
You can remove tasks assigned to a job by double-clicking the job and opening the Job properties 
dialog box. (Edit features will also open in the Details view of the Deployment Server Console when 
you select the job from the Jobs pane). 

1 Select one of the assigned tasks in the Task list.
2 Click Delete.

To remove scheduled jobs from a computer 
1 Click the computer.
2 Select the scheduled job in the Details window, and click Delete. To remove multiple jobs, hold 

down the Shift or Ctrl key while you select the job(s), then press Delete.
The icon for a scheduled job is yellow. 

To remove a computer from a scheduled job
1 Click a job in the Job pane.
2 Click a computer in the Details view and press Delete.

To run a job immediately from the Resources view
If you have a batch file, image file, RIP, MSI, or executable file assigned to a job or stored in the 
Client Access Point, then these files and packages will be displayed in the Resources view (see 
“Shortcuts and Resources View” on page 100). You can drag these files and packages from the 
Resources view to a computer or computer group to automatically create and run a job (or you can 
drag computers to a file or package in the Resources view). A job will be created automatically for 
each assigned package in the Systems Jobs > Drag-n-Drop folder.

See also “Building New Jobs” on page 156 and “Modifying Tasks in a Job” on page 176.

Deployment Tasks
A task is a subordinate element or action of a job. One or more tasks is required to build a job, with 
each task executed according to their order in the task list for each job. The Deployment Server 
Console has multiple tasks available from the Add menu, including:

Create Disk Image. Create a disk image from a reference computer and save the image file (IMG or 
EXE files) for later distribution. See “Creating a Disk Image” on page 160.

Distribute Disk Image. Distribute previously created disk images (IMG or EXE files) or create a disk 
image from a reference computer on the network and simultaneously distribute it (IMG or EXE) to 
other managed computers on the network. See “Distributing a Disk Image” on page 161. 

Scripted OS Install. Run scripted (unattended) installs using answer files to install computers 
remotely over the network. See “Scripted OS Install” on page 163.
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Distribute Software. Distribute RIPs, MSI files, scripts, personality settings and other package files 
to computers or groups. See “Distributing Software” on page 167.

Capture Personality. Capture the personality settings of a selected computer on the network using the 
PC Transplant software. PC Transplant ships as a part of Deployment Server. See “Capturing 
Personality Settings” on page 169.

Distribute Personality Package. Send a Personality Package to computer or groups. It identifies valid 
Altiris packages and assign passwords and command-line switches to Personality Packages. See 
“Distributing Personality Settings” on page 170.

Change Configuration. Modify the IP address, computer and user name, domains and Active 
Directory organizational units, and other network information and computer properties. See 
“Modifying Configuration” on page 171.

Back up Registry Files. Back up an individual registry file for a selected computer and save it to a 
selected directory. See “Backing up and Restoring Registry Files” on page 171.

Restore Registry Files. Restore registry settings previously saved for a selected computer. This allows 
you to recover from a hard disk crash or other disaster. See “Backing up and Restoring Registry 
Files” on page 171.

Run Script. Create custom commands using scripts to perform jobs outside the bounds of the pre 
configured tasks. Use the Run Script dialog box to select or define a script file to run on specified 
computers or groups. See “Run Script” on page 172.

Copy File to. Copy a file from the Client Access Point or another source computer to a destination 
computer. See “Copy File to” on page 174.

Shutdown/Restart. Perform power control options to restart, shutdown, power off, and log off. See 
“Power Control” on page 175.

Tasks are listed for each job in the task list box. Each task will execute according to its order in the 
list. You can change the order using the up and down arrow keys.

Creating a Disk Image 
Create an image of computer’s hard disk and saves the image as an IMG or EXE file.

 

Note Imaging a computer requires that you boot to DOS, which requires that you set up PXE Server 
or BootWorks. 

1 Enter the path and name to store the image file. You can store image files to access later when a 
managed computer is assigned a job that includes the image file.
The default file name extension is IMG. Saving image files with an EXE extension makes them 
self-extracting executable files (it adds the run-time version of RapiDeploy in the file).

2 (optional) Click Local image store if you want to store the image file locally on the client 
computer's hard drive. Be sure to enter the path relative to the managed computer (for example, 
c:\myimage.img). 
When you store an image locally on a computer instead of a file server, you save server disk 
space and decrease network traffic. If you are imaging multiple computers or if you image 
computers frequently, there is a strong advantage in storing images locally.
Prerequisite Make sure you have a hidden BootWorks partition installed on the computer’s hard 
disk with enough disk space to hold the images you want to store. 

 

Create an image file using the New Job Wizard or adding the task when Building 
New Jobs. You can distribute the disk image file to managed computers using 
the Distributing a Disk Image task. This task will run Altiris RDeploy.exe from 
the console to capture and migrate hard disk images.
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Note When imaging computers where labs are cached, do not use the option to remove the 
BootWorks partition unless you want to clear the lab from the computer. 

3 Type a description to help identify the task. 
4 (optional) Click Advanced to select Media Spanning and additional options. See “Create Disk 

Image Advanced” on page 161. 
5 Click OK (if you are using the New Job Wizard).

or 
6 Click Next.
7 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
8 Click Finish. The task will appear in the Task list for the job. 
Troubleshooting Tip If an imaging Job fails on a managed computer, the Deployment agent 
configuration screen will appear on the client with a prompt asking if the user wants to configure the 
client or restore the original settings. Select Cancel > Restore Original Settings on the client screen.

See also “Deployment Tasks” on page 159.

Create Disk Image Advanced
Media Spanning

Maximum file size. The Maximum file size supported is 2 GB. To save an image larger than 2 GB, 
Deployment Server will automatically break it into separate files regardless of your storage capacity. 
From the Maximum file size list, select a media type. 

Specify ___ MB. If the preferred type is not on the list, enter the file size you want in the field. 

Additional Options

Do not boot to Windows. Select this option to create an image of the hard disk while booted to DOS 
without first booting to Windows to save network settings (TCP/IP settings, SID, computer name, 
etc.). If you select this option, these network settings will not be reapplied to the computer after the 
imaging task, resulting in network conflicts when the computer starts up. 

Note This check box should be selected when imaging Linux computers.

Compression. Compressing an image is a trade-off between size and speed. Uncompressed images 
are faster to create, but use more disk space. 

Select Size to compress the image to the smallest file size. Select Speed to create a larger compressed 
image file with a faster imaging time. The default setting is a balance between Size and Speed.

Additional command-line switches. You can add command-line switches specifically for the 
RapiDeploy program to execute imaging tasks. See the Altiris RapiDeploy Product Guide located in 
the Docs folder in the Client Access Point.

Distributing a Disk Image
Distribute an IMG or EXE file to managed computers to lay down a previously created hard disk 
image.
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1 Click Select a disk image file to select a stored image file. This allows you to lay down a new 
image file from a previously imaged computer. This is a common way to distribute an image file.

2 (optional) Select Local image store if you stored the image file on the client computer’s hard 
drive. With local image store, the image file is stored on a partition on the computer being imaged. 
Consequently, the server cannot validate the image when a local image store is used. 

3 (optional) If you want to image a source computer on the network, click Select a computer on the 
network. Enter the name and location of the source computer to both create an image and 
distribute the newly created image file.
This option saves an image of a selected computer’s hard disk in its current state each time the 
job executes. You can schedule the job to image a specified computer every time it runs, allowing 
the image to be updated each time.
Note Network mapping must exist on the source computer before imaging. UNC paths are not 
supported in DOS. 
Select the Save the disk image as a file while distributing option to save the newly created image 
file to a specified disk drive. If you use a reference computer as the image source, you can also 
choose to save the image as a file for later use. Select the box to save the image and type in or 
browse for the location where you want to store the file. 

4 (optional) Click Automatically perform configuration tasks after completing this imaging task to 
boot the computer again and push down configuration settings to the newly imaged computer. 

5 Click Advanced to resize partitions and set additional options. See “Distribute Disk Image-
Resizing” on page 162. Click OK.

6 Click OK (if you are using the New Job Wizard).
or 

7 Click Next.
8 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
9 Click Finish.
See also “Deployment Tasks” on page 159.

Distribute Disk Image-Resizing
By default, whenever you deploy an image, you have the option to resize the partition to take 
advantage of the available disk space. Drive Size gives you information about the size of the image, 
so you can determine if you need to change partition sizes. Minimum indicates the amount of space 
the image will use on the target computers. Original indicates the image source disk size. 

Fixed Size. Select this option and enter the desired partition size. 

Percentage. Select this option and enter the percentage of free space that you want the partition to 
occupy.

Min. View the minimum size of the partition.

Max. View the maximum size of the partition.

Note FAT16 file systems have a 2 GB limit and cannot be resized larger (although it can be sized 
smaller than the minimum value). Compaq partitions remain a fixed size. 

 

Distribute a hard disk image using the New Job Wizard or adding the Distribute 
Disk Image task when Building New Jobs. You can create the disk image file 
using the Creating a Disk Image task. This task will run Altiris RDeploy.exe 
from the console to capture and migrate hard disk images.
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Distribute Disk Image-Additional
Remove BootWorks Partition. Select this option if you want to remove the partition from the computer 
or if you have an updated partition in the image and you want it to overwrite the old one.

Warning If the image you are deploying includes BootWorks, the new copy of BootWorks will 
replace the old one. If you use local image storing, you will lose the image stored in the existing 
partition.

Remove Compaq System Partition. Select this option if you have an older model Compaq with a 
system partition and you don’t want it deployed to the other computers. 

Command line switches. You can add command-line switches specifically for the RapiDeploy 
program that runs imaging tasks. See the Altiris RapiDeploy Product Guide located in the Docs 
folder of the Client Access Point.

Note The checkdisk command-line switch should not be used from a Deployment console. The 
post-configuration task will fail after an image restore.

See also “Deployment Tasks” on page 159.

Scripted OS Install
The Scripted OS Install task performs remote, automated, and unattended operating system 
installations over the network using answer files to input configuration and installation-specific 
values. Scripted installs allow you to deploy server and client computers across the network from 
installation files, and then perform post-installation configuration tasks. You can run scripted installs 
for Windows or Linux computers.

Important Scripted Install requires either a BootWorks boot disk or PXE Server. Using embedded 
BootWorks will cause the DOS image to load and then halt. It will not allow the scripted install to 
run.

When running a Scripted OS Install task, you can identify the type of OS to install for supported 
languages, run the scripted install, and update with service pack installations. This task provides 
easy-to-use features to create an answer file for each scripted installation.

Scripted installs are flexible in performing post-configuring tasks, but much slower and bandwidth 
intensive. Complete network and web server installation and configuration tasks profit most from 
scripted installs.

Windows. Use complete unattended install features to copy Windows OS source files quickly to the 
Client Access Point and easily create an answer file. Configured OS install sets can then be reused 
to build and run scripted install jobs as needed. See “Scripted Install for Windows” on page 163.

Linux. Run scripted install jobs to remotely install different versions of Linux. You can customize 
sample scripted install jobs installed with the Deployment Server system and create a kickstart 
answer file to remotely run a scripted install. See “Scripted Install for Linux” on page 167.

Scripted Install for Windows
1 After selecting Add > Scripted OS Install, click the Windows option.
2 Select the type of Windows operating system to install. See “Select OS Version and Language” 

on page 164. Click Next.
3  Select source files. Click the list to select Windows OS source files already copied to your 

Deployment Server Client Access Point. See “Installation Source Files” on page 164.
4 Click Add New from the list box to set up new OS installation files. See “Operating System-

Source Files” on page 165.
Click OK after entering a unique name and the path to the OS installation source files. The source 
files will be copied over to the Deploy folder in the Client Access Point directory. The first 
source files added will be given a generic name of WinOS001, with additional OS source folders 
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named to WinOS002, WinOS003 and so on. Service Pack source files will also be stored as an 
WinSP00x.img file.
This process could take a few minutes. Because the installation source files are copied over to 
the Client Access Point, when running subsequent scripted installs you will not need to add new 
source files for this version of Windows. They can be selected from the list of installation source 
files. See “Installation Source Files” on page 164.
Note When importing Scripted Install jobs, you must edit the job files to point to the installation 
source files on the new Deployment Server system. This requires you to run the Scripted Install 
for Windows wizard and modify the path and name of the folder for the Installation Source Files 
for the exported jobs. This is required for both the main installation and service pack installation 
files. See also “Importing and Exporting Jobs” on page 176.

5 After the source files are copied, select the newly created OS source name from the Installation 
Source Files list. Click Next.

6 Click to distribute a DOS disk image (default), or continue without distributing a DOS image and 
partition and format the hard disk of the destination computer using custom scripts or setup 
utilities. Click Advanced to set partition size, delete hidden partitions or set RapiDeploy 
command-line parameters. Click Next. See “Operating System-Source Files” on page 165.
Note Before running a scripted install, you must install DOS. However, DOS is not required if 
you are using your own scripts or utilities to partition and format the client machine. 

7 Import an answer file to the Deployment Database. See “Import an Answer File” on page 165. 
Click Next.

8 Create the Answer file. See “Answer File Setup” on page 166. Click Next.
9 Set command-line switches for cmdlines.txt files and for the WINNT installation program. See 

“Command-line Switches for Scripted Install” on page 167. Click Next.
10 View and modify the Deployment Agent for Windows configuration file from the dialog box. 

See “Deployment Agent Settings for Scripted Install” on page 167. Click Next.
11 View summary of selected options. See “Scripted Install Summary” on page 167. Click Next.
12 Set up return codes for the Scripted Install task. See “Setting Up Return Codes” on page 177. 

Click Finish.
See also “Scripted OS Install” on page 163.

Select OS Version and Language
Identify the operating system version to run in a scripted install. The selected version and language 
must correspond to your Windows installation files.

Select the OS version. Select the Windows operating system you want to install from the list. 
Click Template if you want to install another version or language of a Windows operating system not 
provided in the list.

Select the OS language. Select the language version of the operating system to install. The language 
must correspond to the OS source files. If you selected the Template option, then only the Multilingual 
language option can be selected (this is a generic language option).

See also “Scripted Install for Windows” on page 163.

Installation Source Files
If you copied installation files to the Client Access Point for previous scripted installs, then the name 
of this install source configuration will appear in the list box for each OS type and language. To 
create new source configuration sets for additional OS installs, select Add new source files from the 
list box. 

Select or add new OS source files. Select the assigned name for each OS source configuration in the 
list box, or select Add new source files from the list to create a new install task. Previous scripted 
install jobs will create a WinOS00x.img file in the Deploy directory of the Client Access Point.

The Operating System-Source Files dialog allows you to identify the version of Windows install files 
and enter the path to the files (on the CD or other medium).
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Select or add new service pack source files. Run service pack updates immediately after installing the 
operating system during the scripted install process. Previous scripted install jobs will create a 
WinSP00x.img file.

See also “Scripted Install for Windows” on page 163.

Operating System-Source Files
Name OS source configuration, identify path and automatically copy Windows installation files to 
the Client Access Point.

Enter a unique name for the OS source files. Enter a name for the OS source configuration files to 
assign an alias to associate with the install files for a specific OS version and language. 

Enter path to OS installation source files. Enter the path to the I386 folder on the CD where the 
Windows installation programs and support files are stored. For example, browse to the CD drive 
and select I386\WINNT.exe. Click Open.

The Windows OS identified previously in the Installation Source Files dialog box must match the 
source files selected here. If the name and language of the OS does not match the installation files, 
then you will receive an error.

Click OK and the files will copy from the source CD (or other volume) to the 
Deployment Server\Deploy directory in the Client Access Point. This process will take a few 
minutes.

Enter a short description (optional). Enter a description of the Windows OS source configuration, for 
example: W2K Advanced Server SP3 English.

See also “Scripted Install for Windows” on page 163.

Partition and Format Disk
Select a DOS disk image to distribute to the client computers before starting the Windows scripted 
install. A DOS image is provided in the Images directory in the Client Access Point (default path 
in the Name field). 

Select a DOS disk image. Click this option to distribute a DOS image from the Deployment Server 
Client Access Point. The Deployment Server system includes a DR DOS image file that is selected 
by default. You can create your own MS DOS image from your 95 or 98 CD and build a job.   

Advanced. Select advanced options to set the size of the partitions, or to remove hidden partitions 
and add command-line switches. See “Create Disk Image Advanced” on page 161 and “Distribute 
Disk Image-Resizing” on page 162.

Continue without distributing DOS image. Click this option to not install a DOS image from 
Deployment Server. Skip this step if you are installing DOS using custom procedures for your 
environment.

See also “Scripted Install for Windows” on page 163.

Import an Answer File
Reference a previously created answer file for a Windows scripted install. You can also view a 
summary of the OS source configuration. 

Import existing unattend.txt. Select to import a previously created answer file to the Deployment 
Database. Values for the answer file will be imported from the delimited text file and displayed in 
the Answer File Setup dialog box. 

You can enter a path and select an answer file with any name. The answer file will be imported to 
the database, edited in the console (if required), and then distributed as an unattend.txt file to the 
client computer.

See also “Scripted Install for Windows” on page 163.
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Answer File Setup
Use these dialog boxes to enter values to create an answer file for a scripted install. These values are 
stored in the Deployment Database. An answer file is then generated from the database 
(unattend.txt) and distributed to each managed computer when the job executes. 

In the Answer File Setup, select a value (a row) in the table. A pop-up list will appear in the Values 
column to change values for each entry. You can add new variables to each section by selecting the 
bottom row named Add new Variable. To add a new section to the answer file, click the right arrow 
button until the Add new Section tab appears (the last tab on the right).

Required answer file values will be selected automatically in the dialog box with a gray check (you 
cannot clear these variables). Optional but selected values will have a green check. Other optional 
values will be cleared. Select these optional values if you want to add them to the answer file when 
it is generated.

The various tabs in the Answer File Setup dialog box correspond to general answer file sections. See 
the Microsoft Windows Unattended Setup Guide for specific values for an unattended setup file.

See also “Scripted Install for Windows” on page 163.

Add a New Variable Value or Section
Use this dialog box to add new values to each variable or to add new variable sections to the answer 
file. 

Enter a name for the value or section. If you add a value, then this name will appear in the pop-up list 
and entered in the cell if selected. If you are adding a section, then this name will appear in the new 
tab in the Answer File setup dialog box.

Enter a value to be displayed instead of the real value. Enter an alias that will appear in the cell or on 
the tab.

See the Microsoft Windows Unattended Setup Guide for your specific operating system values for 
an unattended setup file. 

See also “Scripted Install for Windows” on page 163.

Add a New Variable
Use this dialog box to add new variables to the answer file. This variable will appear as a row in the 
Answer File Setup dialog box.

Name of the variable. Select a variable name.

Type of new variable. Select a variable data type. The Default value and Displayed value boxes will 
be activated depending on the variable type selected.

Default value of the variable. Enter values for a list, text, password, or IP address types.

Displayed value of the variable. Enter an alias for list item types to be displayed instead of the real 
variable value.

Description. Enter comments to describe the new variable. It will be displayed in the Description 
column of the Answer File Setup dialog box.

See also “Scripted Install for Windows” on page 163.
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Command-line Switches for Scripted Install
Use this dialog box to enter Windows NT commands that are executed from the cmdlines.txt file. 
You can also add WINNT scripted install command-line switches.

Switches. Add or edit switch commands to this line for the WINNT install program for the scripted 
install.

Additional commands in the cmdlines.txt file. Enter additional Windows scripted install commands in 
this dialog box. The commands will execute in the order they are listed. The provided command 
installs the Deployment Agent for Windows (AClient) during the Install Component phase of the 
installation. You can view and edit Deployment Agent settings in the next dialog box.

See also “Scripted Install for Windows” on page 163.

Deployment Agent Settings for Scripted Install 
View or edit Deployment Agent for Windows settings in this dialog box. You can change agent 
settings using this text edit dialog box. See “Deployment Agent Settings for Windows and Linux” 
on page 122 for a list of the Deployment Agent properties.

See also “Scripted Install for Windows” on page 163.

Scripted Install Summary
View a summary of the selected options for the scripted install. Click Back to change any of these 
settings or click Finish to complete the Scripted Install task.

See also “Scripted Install for Windows” on page 163.

 Scripted Install for Linux 
The Scripted OS install for Linux provides a wizard to help set up Linux installation files and run 
Sample jobs. Follow steps in the wizard to identify the type of scripted install and locate the answer 
files. You can also modify and run Sample deployment jobs to remotely run a scripted install on 
Linux servers and workstations. For complete information, see the Deploying Linux chapter in the 
Deployment Solution Product Guide located in the Docs folder of the Client Access Point.

Directory. Browse to or enter the path and name of the Linux answer file (Kickstart file).

Command-line. Enter command-line switches.

See also “Scripted OS Install” on page 163 and “Scripted Install for Windows” on page 163.

Scripted Install Summary
View a summary of the selected options for the scripted install. Click Back to change any of these 
settings or click Finish to complete the Scripted Install task.

See also “Scripted Install for Linux” on page 167.

Distributing Software
Send RapidInstall Packages (RIPs), MSI, CAB, EXE, and other package files to selected computers 
or computer groups, including EBS, and RPM files for Linux computers. This task identifies valid 
Altiris packages and assigns passwords and command-line switches.
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1 Enter the name and location of the package to distribute in the Name field. 
Note Information about the package will be displayed in the Description area for valid packages. 
If no description is displayed, then the file is not a RIP or a Personality Package.

2 For RIPs, if you set the password option when you created the RIP, you must enter the password 
for the package to run.

3 Select Run in quiet mode to install the package without displaying the RapidInstall and PC 
Transplant screens. 

4 Specify the users to associate with the RIP or the Personality Package.
• Click Apply to all users to run the package for all users with accounts on the computer.
• If sending the package to a managed computer with multiple users and if you only want it 

installed for certain users with a unique password, clear the Apply to all users box. 
For example, to install a RIP for a specific user accounts on a computer add values to the 
Additional command-line switches field: 
-cu:”JDoe;TMaya;Domain\BLee”

Note The command-line switches are specific to any package you are distributing that 
supports command-line options, such as RIPs and Personality Packages. For a complete list 
of command-line switches, see the Altiris RapidInstall Product Guide and the Altiris PC 
Transplant Pro Product Guide.

5 If distributing an install package or other types of packages with associated support files, you can 
click Copy all directory files to install all peer files in the directory. Click Copy subdirectories to 
distribute peer files in the directory and all files in associated subdirectories.

6 Click Advanced to specify how files are distributed to the managed computer. You can copy 
through Deployment Server, or copy and run directly from the Client Access Point or from 
another file server. See “Distribute Software Advanced” on page 168. Click Next.

7 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
8 Click Finish.
Notes

• When a RIP or Personality Package is executed through Deployment Server, the quiet mode 
command-line switch is applied. This means the user will not be able to interact with the user 
interface on the managed computer. 

• If the Personality Package is configured to run only if a particular user is logged in and only if 
the user has an account on the managed computer, the package will run the next time that user 
logs in. If the user does not have an account, the package aborts and sends an error back to the 
console via the Deployment Agent. If the package is not run through Deployment Server, a 
message is displayed on the managed computer and the user is prompted to abort or continue.

See also “Modifying Tasks in a Job” on page 176.

Distribute Software Advanced
Copy files using Deployment Server. (default) Click this option to distribute packages through 
Deployment Server to the managed computer, requiring two file copy transactions if the Client 
Access Point is on another file server. This option is run for Simple installs. 

Copy directly from file source. Click this option to copy packages directly from the Client Access 
Point if this data store is located on another server (a Custom install). It will copy the file and then 
run it, avoiding running through Deployment Server and diminishing processor output.

Run directly from file source. Click this option to run files remotely from the Client Access Point or 
another selected file server. 

 

Distribute software packages to managed computers using the New Job Wizard 
or adding the Distribute Software task when Building New Jobs. 
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File Source Login. Enter the user name and password for the client computer and the Client Access 
Point. Both must have the same user name and password (this is not an issue if both are on the same 
domain).

Note Windows 95/98/ME computers have security limitations when copying files directly from the 
source to the Deployment Agent using the UNC path name. It is suggested that you use the Copy files 
using Deployment Server option for these types of computers or plan a proper security strategy for 
direct copying. 

 Capturing Personality Settings 
The Capture Personality task allows you to save personal display and user interface settings defined 
in the OS for each user. You create a Personality Package that can be saved and distributed when 
migrating users. This task will run Altiris PC Transplant from the console to capture and distribute 
settings.

1 After creating a job, click Add > Capture Personality.
2 Enter the name of a personality template. A default personality template is included in the PCT 

folder of the Client Access Point (DEFAULT.PBT). 
The personality template lets you define the settings, files, and options to be captured during run 
time. Click Template Builder to open a wizard to build a custom template.   

3 In User account and folder login, enter the login credentials for the managed computer from which 
the personality settings will be captured, and the file server where the Personality Package will 
be stored. 

4 In Package login, enter a password for the Personality Package. This is a run time password that 
is required when the Personality Package runs on the destination computer.

5 Click Advanced to specify additional features.
6 Set Advanced options and click OK. Click Next.
7 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
8 Click Finish. You have now captured a personality setting and saved it as PCT file in the selected 

location (most often in the PCT folder on the Deployment Server shared directory on the Client 
Access Point). The Capture Personality task will now appear in the Task list. See “Distributing 
Personality Settings” on page 170.
Notes
• To capture a personality on a Windows 95, 98, or ME computer, make sure that all users have 

Write access to the Deployment Server share (by default at C: Program 
Files\Altiris\eXpress\Deployment Server in a Simple install). Also, make sure 
that the User account and folder login boxes are blank. A user must also be logged in at the 
client computer to capture the client profiles. An error will be returned if you attempt to 
capture personality settings on Windows 9x computers that are not authenticated. It is 
recommended that you don't capture personalities for mixed groups of Windows 9x and 
Windows NT/2000/XP/2003 computers. 

• Set the conditions on the job for either Windows 95/98/ME or Windows NT/2000/XP/2003 
computers to ensure that the appropriate Capture Personality task runs on the appropriate 
computers.

Capture Personality Advanced 
Domain users. Select this option to capture personality settings for all domain users on the computer.

Local Users. Select this option to capture personality settings for all local users on the computer. 

 

Capture personality settings using the New Job Wizard or adding the Capturing 
Personality task when Building New Jobs. See Distributing Personality Settings 
to migrate settings to another user.
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Custom. Specify users or groups to capture personality settings. Select the Custom check box and 
enter the Users or Groups you want to capture personality settings. Also, instead of specifying 
names, you can also select users that have been either created or last accessed in a specified number 
of days. 

Additional command-line switches. You can add command-line switches specifically for the PC 
Transplant program that migrates personality settings. See the Altiris PC Transplant Guide in the 
docs folder of the Client Access Point.

Distributing Personality Settings 
The Distribute Personality task allow you to save personal display and user interface settings defined 
in the OS for each user. You will distribute Personality Packages to migrate personality settings. 
This task will run Altiris PC Transplant from the console to capture and distribute settings.

1 In the Name box, enter the file name and location of the PCT file.
Note Information about the Personality Package will be displayed in the Description area for 
valid Personality Packages (PCT files). If no description is displayed, then the file is not a valid 
package. 

2 In the Password box, enter the password set for the PCT file when created.
3 Select Run in quiet mode to install the package without displaying the PC Transplant screens. 
4 Specify the users to associate with the Personality Package.

• Click Apply to all users to run the package for all users with accounts on the specified 
computer.

• If sending the package to a managed computer with multiple users and if you only want it 
installed for certain users with a unique password, clear the Apply to all users box. 
For example, to install a Personality Packages for a specific user accounts on a computer, add 
values to the Additional command-line switches field: 
-user: JDoe; TMaya; BLee

Note The command-line switches are specifically for Personality Packages. For a complete 
list of command-line switches, see the Altiris PC Transplant Pro Product Guide.

5 (optional) Click Advanced to specify how Personality Packages are copied to the managed 
computer. You can copy through Deployment Server, or copy and run directly from the Client 
Access Point or from another file server. See “Distribute Personality Advanced” on page 171.

6 Set Advanced options and click OK.
7 Click OK (if you are using the New Job Wizard).

or 
8 Click Next.
9 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
10 Click Finish.

 

Distribute personality settings using the New Job Wizard or adding the Distribute 
Personality task when Building New Jobs. See Capturing Personality Settings to 
create a Personality Package.
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For more information about capturing a computer's personality settings, see the Altiris PC 
Transplant Pro Product Guide.

See also “Distributing Software” on page 167 and “Modifying Tasks in a Job” on page 176.

Distribute Personality Advanced
Copy files using Deployment Server. (default) Click this option to distribute software packages 
through Deployment Server to the managed computer, requiring two file copy transactions if the 
Client Access Point is on another file server. Use this option for Simple installs to take advantage of 
security rights defined by Deployment Server.

Copy directly from file source. Click this option to copy packages directly from the Client Access 
Point, sending only one copy across the network. It will copy the file and then run it and avoid 
running through Deployment Server and diminishing processor output. Because the Deployment 
Agent doesn't recognize shared rights and is not guaranteed to have a mapped drive to the data 
source, you will need to identify a user name and password for the data share computer from the 
target computer. This option also requires a full UNC path name in the Source Path field in the Copy 
File dialog box.

Run directly from file source. Click this option to run files remotely from the Client Access Point or 
another selected file server. 

File Source Credentials. Enter the user name and password for the client computer and the Client 
Access Point. Both must have the same user name and password (this is not an issue if both are on 
the same domain). 

Modifying Configuration
You can add a task to configure or modify the configuration of computer property settings using the 
Modify Configuration dialog box. The Deployment Agent will update the property settings and then 
restart the computer for changes to take effect.

1 After creating a job, click Add > Modify Configuration.
2 Enter or edit the property settings in the Configuration dialog box. Click the category icons in the 

left pane to set additional values for each property setting group. See “Computer Configuration 
Properties” on page 116.

3 Click Next.
4 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
5 Click Finish.
See also “Modifying Tasks in a Job” on page 176.

Backing up and Restoring Registry Files  

Copy registry files of selected computers using the Back up Registry task and save the registry file 
settings to a selected directory. You can also create a Restore Registry task to copy the registry 
settings to a managed computer.

1 Enter the directory path to back up or restore registry files.
2 Click Advanced if Windows was installed on client computers in a directory other than the 

default. Enter the correct path to the root of the Windows directory. 

 

Copy registry settings by adding the Back up Registry task when Building New 
Jobs. Restore registry settings by adding the Restore Registry task.
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3 Select Include registry information for all users to back up registry keys for all user accounts.

Note If you clear this check box, then only the Administrator and Guest user accounts will be 
backed up or restored.

4 Click Next.
5 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
6 Click Finish.
See also “Modifying Tasks in a Job” on page 176.

Run Script 
Select an existing script or write a new script file to run on selected managed client computers.

1 If you have a script file defined, click Run the script from file and then browse from the folder icon 
to select the file. To read or edit the script file, click Modify. 

2 To create a new script, click Run this script. Type the script in the provided text box, or click 
Import and select a script file to import. When a script is imported you can modify it in the text 
box.

3 Specify whether the script should be run from DOS, Windows, or Linux. 
4 Click Advanced to specify additional features. See “Advanced Script Options” on page 172. 
5 Click Next.
6 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
7 Click Finish.

Notes 
• When a computer is in DOS mode using BootWorks, it does not see DOS partitions. To run a 

script from BootWorks, use FIRM (File-system Independent Resource Manager) commands. 
FIRM can only copy files and delete files; it cannot run code on a drive. 

• Deployment Server assumes a return code of zero (0) as a successful script execution. Some 
programs return a code of one (1) to denote a successful script execution. If a program returns a 
one (1), you will see an error message at the Deployment console even though the script ran 
correctly. To modify the return codes, you can edit the script file to return a code that the console 
interprets correctly.

See also “Modifying Tasks in a Job” on page 176.

Advanced Script Options 
Execution Location. Click an option to run the script on a selected managed computer or to run the 
script on the Deployment Server computer. 

On the client computer. The option runs the script on the managed computer to which you assign the 
job.

Locally on the Deployment Server. This option runs a server-side script on the Deployment Server of 
the managed computer. In most cases you will want to create a server-side script task that runs in 
context with other tasks. For example, you can add a task to image a computer and then add a task 
to execute a server-side script to post the imaging return codes to a log file stored on the Deployment 
Server computer. 

 

Run script files on client computers by adding the New Script task when Building 
New Jobs. See Advanced Script Options to identify how the script will appear, 
script security, and an option for server-side execution of the script.
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Use the -id switch for running scripts on Deployment Server when using the WLogEvent and 
LogEvent utilities. See “Using LogEvent and WLogEvent in Scripts” on page 173.

Important Scripts requiring user intervention will not execute using this feature. The script will run 
on the Deployment Server of the managed computer, but will not be visible. For example, if you run 
a DOS command locally on the Deployment Server, the Command Prompt window will not open on 
the Deployment Server computer when the script executes.

When running the script on the Deployment Server, it will execute specifically for the assigned 
managed computer. For example, if you create a job with a script to run locally on the Deployment 
Server and assign the job to 500 computers, then the script will run on the Deployment Server 500 
times. 

Security Context. This identifies the security options for running scripts. 

Default. Use the network security account established to administrate all managed computers.

Enter a user name and password. If you have selected to run the task on the local Deployment Server, 
you are required to enter an administrator user name and password for that Deployment Server 
account. (In most cases Deployment Server does not have the Deployment Agent installed, 
prohibiting it from using a network security account.)

Script Window. Select how you want the script window to appear: minimized, normal, maximized, 
or hidden.

Example Script
The process to convert NT4 from FAT16 to NTFS normally returns a 1 after a successful 
completion. Here is an example of the file that is modified to return a code of 0 (which is the success 
code recognized by the Altiris Console and utilities). You can make similar changes to your script 
files as needed.

CONVERT /FS:NTFS
if ERRORLEVEL 1 goto success
goto failure
:success
set ERRORLEVEL = 0
goto end
:failure
echo Failed
set ERRORLEVEL = 1
goto end

:end

Using LogEvent and WLogEvent in Scripts
The logging features, LogEvent and WLogEvent, accommodates detailed logging to help debug 
complex scripts. These utilities include the following features:

• Logging will be stored in the database instead of a log file.
• A DOS-based tool can be called from any script file to log status and error codes.
• The console displays and works with the new status messages.
LogEvent posts status messages back to the Deployment Server Console, allowing you to view the 
status of the script. It is a light-weight reporting tool that can log both status strings and status codes 
to the history file and the console.

LogEvent — Use the LogEvent utility for DOS and Linux scripts.

WLogEvent — Use the WLogEvent utility for Windows scripts.

The LogEvent and WLogEvent utilities are command-line driven only — there is no user interface. 
Use both utilities with the following switches.

LOGEVENT -c:code -id:%ID% -l:level -ss:”message” 

code is any number for a return code level.
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id is used for server-side scripting only. For server-side scripts you must add the -id:%ID% switch.

See the Locally on the Deployment Server option on Advanced Script Options to select a server-side 
script.

level is the severity level. The following levels are used:

1 = Information message

2 =Warning message

3 = Critical failure message. Only this level can be used to set up a return code. See “Setting Up 
Return Codes” on page 177. The response will not execute for a return code unless a level 3 is 
specified when using the LogEvent and WLogEvent command in a script.

message is the status string. If spaces exist in the message, then the string must be contained in 
quotes. Specifying a severity level of 3 will cause the script job to fail.

Example Scripts
REM Bootwork unload
Set ImageName=F:\Images\XPIntel.img
rdeploy -mu -f%ImageName% -p1logevent -l:1 -ss:”Created %ImageName.”

REM Execute WLogEvent.exe from CMD script
REM This script requires WLogevent.exe to reside on the client
REM in the temp directory.\WLogevent.exe -c:0 -l:1 -ss:"Running Dir on %NAME%"dir.\WLogevent.exe -c:0 -l:1 -ss:"Finished with the DIR command on %NAME%"

Copy File to 
Copy all types of files to managed computers. You can send selected files or directories to a 
computer or computer group.

1 Click either the Copy File or Copy Directory option. Click Copy Subdirectories to copy all 
subdirectories.

2 Enter the directory path and name of the file or directory. The Source path defaults to the Client 
Access Point, but you can type or browse to a file or directory. 
To copy files or directories through Deployment Server from the Client Access Point, you can 
enter a relative path in this field. To copy files or directories directly from the Client Access Point 
to the managed computer, you must enter the full UNC path name (see “Copy File to Advanced” 
on page 175 features).
Note When entering the source path for copying files through the Deployment Server, you can 
only access the shared directories through an established user account. Specifically, you can only 
use UNC paths when you have sufficient authentication rights established.

3 Type the destination path. The Destination path field automatically enters a sample path, but you 
can enter the directory path that you require. If the destination path does not exist on the 
destination computer it will be created.

4 Click Advanced to specify additional features to copy files through Deployment Server or 
directly from a file server. See “Copy File to Advanced” on page 175.

5 Click Next.
6 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
7 Click Finish.

 

Send files to client computers by adding the Copy File to task when Building New 
Jobs. Use the Copy File to operation (see the Remote Operations menu) to copy 
files quickly from Computers pane in the console. 
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See also “Modifying Tasks in a Job” on page 176.

Using Location Variables
Location variables are being added to Deployment Server for the Copy Files feature, allowing you 
to enter a token variable rather than requiring a complete location path when copying files to a 
managed computer (a client computer running the AClient agent). The current variables include:

Temp. Enter Temp in the Destination path to set the Temp directory (identified in the system path) 
for the managed computer. For example, instead of entering C:\windows\temp\setup.exe in the 
Destination path, just enter temp:setup.exe.

Copy File to Advanced
Select options to copy files directly from the Client Access Point. This option is for files stored on 
another network server in a distributed Deployment Server installation. 

Copy files using Deployment Server. (default) This option distributes software packages through 
Deployment Server to the managed computer, requiring two file copy transactions if the Client 
Access Point is on another file server. Use this option for Simple installs to take advantage of 
security rights defined by Deployment Server. You can use a relative path name entered in the 
Source Path box in the Copy Files dialog box.

Copy directly from file source. Click this option to copy packages directly from the Client Access 
Point, sending only one copy across the network. It will copy the file directly to avoid running 
through Deployment Server and diminishing processor output. Because the Deployment Agent 
doesn't recognize shared rights and is not guaranteed to have a mapped drive to the data source, you 
will need to identify a user name and password for the data share computer from the target computer. 
This option also requires a full UNC path name in the Source Path field in the Copy File dialog box.

File Source Credentials. Enter the user name and password for the client computer and the Client 
Access Point. Both must have the same user name and password (this is not an issue if both are on 
the same domain). 

Note Windows 95/98/ME computers have security limitations when copying files directly from the 
source to AClient using the UNC path name. It is suggested that you use the Copy files using 
Deployment Server option for these types of computers or plan a proper security strategy for direct 
copying.

Power Control 
Start the computer using Wake-on-LAN or run standard power control options to restart the 
computer, shut down, or log off the current user.

1 Select a single computer or group of computers.
2 Right-click on the computer and select a power control option (Wake up, Restart, Shutdown, Log 

off). See “Power Control” on page 139.
3 To force applications to close without saving unsaved data, select the Force applications closed 

without prompting check box. 
If you use this option, any unsaved data in open applications will be lost. If you do not use this 
option, open applications with unsaved data will not close until the user chooses to save or not 
save the data. As a result, the managed computer will not complete the selected power option 
until the user makes a selection.

4 Click Yes, No, or Cancel.

 

Wake up, shut down or log off client computers by adding the Power Control task 
when Building New Jobs. See the Power Control operation to send commands 
quickly from the console. 
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Modifying Tasks in a Job

You can build jobs by adding or modifying deployment tasks. When you modify the tasks in a job, 
any computer already scheduled to run the job will run the modified job.

To add a task to a job immediately
If the task (image, batch file, executable, etc.) is saved in the product directory, it appears on your 
Resources list in the Shortcuts pane. Simply drag it to an existing job and it will be added

To add a task to a job
1 Double-click the job you want to modify in the Jobs pane.
2 Click Add and select another task from the menu. 
3 Follow the basic instructions on each dialog box provided for each task. Select the type of task 

you want to add and follow directions.
4 After finishing task configuration, a new task will appear in the Jobs list.
5 Change the order of the tasks using the Up and Down arrow buttons. The tasks will execute in 

the order listed.

To modify a task in a job
1 Double-click the job you want to modify in the Jobs pane.
2 Select the desired task from the list.
3 Click Modify and follow directions to make your changes. Click OK.

To remove a task from a job
1 Double-click the job you want to modify in the Jobs pane.
2 Select the task you want to remove from the task list.
3 Click Delete. Click OK.

Modifying Multiple Change Configuration Tasks 
If you have scheduled multiple Modifying Configuration tasks to a computer group, you can double-
click Change Configuration in the task list of the Details pane to modify each computer’s 
configuration settings independently.

1 Click the job in the Jobs pane with a Change Configuration task. Double-click the Change 
Configuration task. 
A message box will open. Click YES to modify configuration settings individually for each 
scheduled computer. Click NO to modify the Change Configuration task when the job is 
scheduled again (the current job will send modified configuration files already created).
If you click YES, then a Modify Job wizard will open with a list of each managed computer 
scheduled to change configuration settings. Select one or more computers and click Next.

2 In the Computer Configuration Properties property page, modify settings. Click Next.
3 (optional) Set Return Codes. See “Setting Up Return Codes” on page 177.
4 Click Finish.

Importing and Exporting Jobs
Jobs can be exported to back up Deployment Server data or to share jobs between Deployment 
Server installations. 
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To import jobs
1 Right-click in the Job pane, and select Import

or 
2 Click File > Import/Export > Import Jobs.
3 Browse to or type the path and name of an existing import file (a BIN file).
4 Select Import to Job Folder to import the jobs to an existing folder in the Jobs pane. If you have 

a folder already selected it will appear in the edit field.
5 Select Overwrite existing Jobs and Folders with the same name to replace identical jobs and folders. 
6 Select Delete existing jobs in folder to overwrite and replace all jobs in the selected Jobs folder. 

Click OK to import the job(s).

To export jobs
1 Right-click the job or Jobs folder you want to export and select Export

or 
2 Click File > Import/Export > Export Jobs.
3 Select the destination folder and enter a file name.
4 Click the Export subfolders button to export all folders subordinate to the selected job folder. 

Click OK.

Setting Up Return Codes 
When you create a task in a job, you can define a response to specific return codes generated from 
that task after it runs. You can determine the response if the task runs successfully or if the task fails. 
You can also set up custom return codes generated from scripts or batch files that are unique to your 
environment or deployment system.

Note Return code handling cannot be set up for jobs created in the New Job Wizard. 

When creating a task, the Return Codes dialog box will open to allow you to set a response if the 
task was successful or to determine a default response if the task failed. Because Deployment Server 
returns a 0 (zero) if the task runs successfully, any other return code value denotes some type of 
failure in running the task. As a result, in the Success list box you can select an action if the return 
code is 0 (zero), or select an action in the Default list box if the return code is not a 0 (zero).

Note If Using LogEvent and WLogEvent in Scripts, you can only generate return codes when the 
level 3 message is specified. Specifying a severity level 3 will cause the script job to fail and allow 
you to respond using this return code feature.

Return Code Actions
For both successful tasks (in the Success list box) and failing tasks (in the Default list box), you can 
determine these specific actions:

Stop. This action will stop the job after the task runs. Subsequent tasks will not run.

Continue. This action will continue with subsequent tasks in the job after the task runs.

Select a job. This action will allow you to select existing jobs to run after the task.

These actions also apply to custom return codes designed specifically for your system.

Custom Return Codes
In the Other return codes area, you can view custom return codes set specifically for your system. 
Type a custom code in the Code box and then select a response action in the Response list box. These 
custom codes can respond to any return codes set up in scripts or batch files in the Run Scripts task, 
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or these custom codes can respond to system return codes thrown from Deployment Server or 
external codes generated when distributing applications, personality settings, or disk images. Any 
task can have custom codes that respond to different return code values.

Return codes are first evaluated to be successful (zero) or failed (non-zero). If the task returns as 
successful, then it will run the action in the Success list box. If it is not successful, then it will be 
determined if the return code has been assigned a custom code value. If the return code is defined as 
a custom code, then the selected action for that custom code will be executed. If no custom code is 
assigned to the return code, then the action set in the Default list box will be executed.

To set up return codes
To set up return codes, you need to determine how to respond to the Deployment Server success 
return code (zero) in the Success list box, how to respond to a failure return code (a non-zero) in the 
Default list box, and how to respond to a custom or externally generated return code defined in the 
Other return codes box. 

The example below describes how to set up a simple process to deal with custom and system return 
codes:

1 In the Success list box, keep the default value Continue. This allows the job to continue running 
additional tasks in the job after successfully completing this task.

2 In the Code box, enter a value of 1 (one). 
3 In the Response box, click Continue. This allows tasks that return a 1 (one) when successfully 

running a task to continue executing the job.
4 In the Default list box, click the Select a job command. 

The Select a Job dialog box will open, allowing you to select an existing job that runs if the task 
returns a failed system return code (non-zero) or a return code not defined as a custom return 
code. 
For example, from the Default list box you can run a job with a Run Script task that executes a 
script or batch file that modifies or fixes the conditions that led to a failure of the original task.

5 Click Finish. 
See also “Deployment Tasks” on page 159.

Initial Deployment
Initial Deployment is a default job designed to aid in the process of setting up computers that do not 
yet exist in the Deployment Server Database. Initial Deployment allows you to define how 
computers are initially set up after being identified by Deployment Server. 

You can define various computer configuration sets and deployment jobs to present to the user 
during startup, allowing the user to select the computer settings and hard disk images, software, and 
personality settings for their specific needs and environment. New computers will appear in the New 
Computers group in the Computers pane of the Deployment Server Console.

Note Initial Deployment is ideal for small-scale deployments (1 to 10 computers). This feature is not 
recommended for large deployments (10 to 100 computers) or mass deployments (100 to 5,000) 
where you would use virtual computers, customized jobs, and the computer import feature.

Note Although Initial Deployment is most commonly used on computers that support PXE, you can 
also configure a boot disk to run Initial Deployment. In this case, the image deployed must include 
BootWorks partitions of some type to allow any post imaging tasks that may require BootWorks to 
be completed and to allow any future management of the computers requiring BootWorks. 

 

To access Initial Deployment features, double-click Initial Deployment in the 
Jobs pane of the Deployment Server Console, or right-click Initial Deployment 
and select Properties.
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Important To completely deploy and configure a computer using Initial Deployment, you must 
define at least one Configuration and one Job.

Initial Deployment consists of three dialog boxes with separate features to deploy new computers: 

• Configurations
• Jobs
• Advanced
See also “Disabling Initial Deployment” on page 180.

Configurations 
Click the Configurations tab in Initial Deployment to configure different sets of computer properties. 
Each configuration set will be presented to the user in a menu. The user will be able to select the 
configuration set designed for their environment. Compare the Configuration tab with the Jobs tab.

Important If you do not create any configuration sets, the deployment process will automatically set 
TCP/IP information to use DHCP and will name the computer to match the computer’s asset tag, 
serial number or MAC address (in that order, depending on what it can find). 

1 Double-click Initial Deployment.
2 Click the Configurations tab.
3 Click Add. Enter values into the Configuration dialog box to set computer and network properties 

for new computers. See “Modifying Configuration” on page 171 for a list of property categories. 
After setting properties, click OK to return to the Initial Deployment dialog box.

4 Name the configuration set by selecting the Rename button. You will want to provide a 
descriptive name that identifies the configuration set for the user. 

5 Click Add again to configure another set of property settings. You can add multiple configuration 
sets for the user to select from a menu after connecting to Deployment Server. Add as many 
different configuration sets as required.

6 From the Default menu choice list, select the configuration set that you want to be the default 
choice.

7 (optional) Click Timeout after ___ seconds and proceed so that the default job runs automatically 
after a specified amount of time. The default setting is 300 seconds.

8 To set up more precise scheduling of Initial Deployment, click Advanced.
• Select Process this job as each client becomes active if you want to run the job as soon as the 

computer connects to the Deployment Server. Use this option for imaging 1 to 5 new 
computers.

• Select Process this job in batch mode if you want to run the job once a certain number of 
computers connect to the Deployment Server. You can set a timeout deadline so that the job 
will not run if the number of computers you specify fail to connect during a certain amount 
time. Multicast technology sends the image over the network once, and all of the computers 
“listen” for and accept the image, reducing network traffic and increasing speed.

• Select Hold all clients until this time if you want to process the job on all computers at a 
particular time of day. All clients are held before the task sets. The message states: 
“Deployment server has instructed BootWorks to wait.”

9 Click OK, or click the Jobs tab to define a task.
See also “Initial Deployment” on page 178.

Jobs 
Click the Jobs tab in Initial Deployment to add existing jobs or create new jobs to run on the new 
computer. The jobs you add or build using this dialog box will be listed in a menu and presented to 
the user during startup. The user will be able to choose deployment jobs to image the computer and 
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install applications and personality settings. Compare the Jobs tab with the Configurations tab. 
Conditions on jobs are limited to the data that can be accessed at the DOS level (i.e., serial number, 
manufacturing number, NIC information, manufacturing name, etc.).

1 Double-click Initial Deployment.
2 Click the Jobs tab.
3 Click Add Existing to add existing jobs. These jobs will be presented to the user in an Initial 

Deployment menu at startup. You can add any jobs built or imported in your Deployment Server 
system. 

4 Click New to build a new job. See “Building New Jobs” on page 156.
5 Select a default job to run using the Default menu choice list box.
6 Select Timeout after ___ seconds and proceed and type the number of seconds to wait before the 

computer will automatically start the default job. The default setting is 300 seconds.
7 Click OK, or click the Advanced tab to stop either servers or workstations from running 

configuration task sets and jobs automatically.
See also “Initial Deployment” on page 178.

 Advanced 
Click the Advanced tab to set options to stop Initial Deployment from running the default 
configuration task sets and jobs automatically. This will avoid accidental re-imaging or overwriting 
of data and applications for either workstations (desktop, laptop, handheld computers) or servers 
(web and network servers identified by Deployment Server). 

When a computer not yet known to the Deployment Server database is first detected, it will be placed 
in the New Computers group and run an Initial Deployment configuration set and job. However, in 
many cases you do not want web or network servers to be automatically re-imaged without 
confirmation from IT personnel.

Server. Stop servers from automatically running Initial Deployment configuration jobs. Servers are 
identified as those managed computers running multiple processors or identified as a specific server 
model from specific manufacturers. For example, both a Compaq Proliant and a Dell computer with 
multiple processors will be identified as a server. (Identifying a computer as a server by OS cannot 
be accomplished for new computers until the server OS has been installed.)

Select Workstation to force desktop, laptop, and handheld computers to stop before automatically 
running Initial Deployment.

See also “Initial Deployment” on page 178.

Disabling Initial Deployment
If you do not want to risk accidentally re-imaging a computer, you can disable Initial Deployment 
by completing the following steps:

1 Open the PXE Configuration Utility. From a Deployment Server Console, select Tools > PXE 
Configuration. Use the pull down menu to select the applicable PXE server and click OK.

2 Edit the Altiris BootWorks (Initial Deployment) menu item and disable PXE. From the PXE 
Configuration Utility screen, select the Boot Configuration tab.

3 Select the Altiris BootWorks (Initial Deployment) menu item and select Edit. Place a check mark 
in front of the Disable Initial Deployment option and click OK.

4 Close the PXE Configuration Utility by clicking on the OK button.
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Sample Jobs in Deployment Solution

Sample jobs are installed with each Deployment Server system, allowing you to quickly modify or 
add parameters, or to run the sample jobs as they are. During installation, jobs are automatically 
imported from the samples.bin file to the Deployment Server system where they can be viewed 
in the Samples folder in the Jobs area of the Deployment console. Click each job and identify its 
features in the Description field of the Details pane.

Jobs in each folder marked with an asterisk (*) require input parameters or other minor modifications 
added before running on your system. These modifications allow you to add parameters to the job, 
such as user name and password or other required data for the job to be functional. Jobs requiring 
input parameters or customizing will not function properly if you do not edit the job with the 
information specific to your environment.

All files without an asterisk (*) can be used to perform the identified functions without modification. 
However, if the job conditions are not met or are not consistent with the computer type, then you 
may get an error. For example, if the Repair Office XP job runs on a computer without MSOffice XP, 
then you will get an error when running the job.

Note When upgrading versions of Deployment Solution, it is suggested that you copy and rename 
modified sample jobs to avoid overwriting with new sample jobs.
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Sample Jobs

Sample jobs are shipped and installed in the Client Access Point (<DS install 
path>\Altiris\eXpress\Deployment Server\Samples) to assist in various deployment 
tasks. During installation, jobs are automatically imported from the samples.bin file into 
Deployment Solution where they can be viewed in the Samples folder in the Jobs area of the console. 
The Samples folder contains subfolders for Imaging, Simple Tests, Migrations, Miscellaneous Jobs, 
Pocket PC, Scripted OS Installs, Scripts, and XP Embedded.

Jobs in each folder marked with an asterisk (*) require input parameters or other minor modifications 
added before running on your system. These modifications allow you to add parameters to the job 
such as user name and password, or other required data to allow the job to be functional. These jobs 
will not function properly if you do not edit the job task with the information specific to your 
environment.

All files without an asterisk (*) can be used to perform the identified functions without modification. 
However, if the job conditions are not met or are not consistent with the computer type then you may 
get an error. For example, if the Repair Office XP job runs on a computer without MS Office XP then 
you will get an error when trying to run the job. 

Note It is suggested that you copy the desired sample job and change the name to avoid overwrites 
if you reinstall Deployment Solution. 

Sample files are provided to help create jobs and other files for use in your specific environment. 
These files portray possible solutions and configurations, and can be modified and rewritten. Each 
of these jobs can also be created in the Deployment Server Console and executed with the same 
effectiveness to meet your specific needs. Because of continually changing market conditions and 
specific requirements for your organization, Altiris cannot guarantee the effectiveness of these 
sample files working in your environment. 

See sample jobs in these categories:

Imaging (page 182)

Simple Tests (page 183)

Migrations (page 184)

Misc Jobs (page 185)

Pocket PC (page 189)

Scripted OS Installs (page 190)

Scripts (page 195)

XP Embedded (page 198)

Imaging
Use these sample jobs for basic imaging tasks:

Create Disk Image (page 183)
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Distribute Disk Image (page 183)

Create Disk Image
Description Creates a disk image.

Additional files required None.

What this task does This task will create a disk image using the name of the computer as the image 
filename.

Steps to use Assign the job to a computer or computer group.

Distribute Disk Image
Description Distributes a disk image.

Additional files required None.

What this task does This job will distribute the disk image using the name of the computer as the 
image filename.

Steps to use Assign the job to a computer or computer group.

Simple Tests
Run simple commands and install software packages using these jobs:

DIR Command at DOS (page 183)

DIR Command at Windows (page 183)

Distribute RapidInstall Package (page 184)

DIR Command at DOS
Description Runs the DIR command in DOS

Additional files required None.

What this task does This task runs the DIR command at the DOS prompt. If the managed computer 
is running in Windows, it will tell AClient to restart the computer to automation and the computer 
will reboot. When the computer starts, the BootWorks application runs and the DIR command 
executes. After the DIR command runs, the computer will boot back to the production status. This 
task also uses the Logevent application to send the scripting status back to the Deployment Server.

Steps to use Assign the job to a computer or computer group.

DIR Command at Windows
Description Runs the DIR command in Windows from a command prompt

Additional files required None.

What this task does This task runs the DIR command in Windows from a command prompt.

Steps to use Assign the job to a computer or computer group.
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Distribute RapidInstall Package
Description Runs the shwnm.exe RapidInstall package.

Additional files required: None.

What this task does This package includes a utility that displays the computer name in a window. 
A shortcut is created in the startup group so that every time the computer is started the window will 
display the computer name.

Steps to use Assign the job to a computer or computer group.

Migrations
With the aid of PC Transplant, capture various user settings using these jobs:

Capture User Application Settings (page 184)

Capture User Desktop Settings (page 184)

Capture User Microsoft Office Settings (page 185)

Capture User Printer Settings (page 185)

Capture User Application Settings
Description Collects the user’s application setting using PC Transplant.

Additional files required None.

What this task does This task will use PC Transplant and a supplied PCT template to gather the 
application settings for all of the users that exist on the computer. The client computer will execute 
the PC Transplant Wizard using the specified template and create a file (computername.exe) at 
the specified location.

Steps to use 

1 Edit the job.
2 Assign the username and password for use with Windows NT/2000/XP/2003 based systems. If 

you are using this job on Windows 9x computers, then the logged-in user must have rights to the 
specified location for the template and package creation. 

3 Assign the job to a computer or computer group. 

Capture User Desktop Settings
Description Collects the user’s desktop setting using PC Transplant

Additional files required None.

What this task does This task will use PC Transplant and a supplied PCT template to gather the 
desktop settings for all of the users that exist on the computer. The client computer will execute the 
PC Transplant Wizard using the specified template and create a file (computername.exe) at the 
specified location.

Steps to use 

1 Edit the job.
2 Assign the username and password for use with Windows NT/2000/XP/2003 based systems. If 

you are using this job on Windows 9x computers, then the logged-in user must have rights to the 
specified location for the template and package creation. 
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3 Assign the job to a computer or computer group. 

Capture User Microsoft Office Settings
Description Collects the user’s Microsoft Office setting using PC Transplant

Additional files required None.

What this task does This task will use PC Transplant and a supplied PCT template to gather the 
Microsoft Office settings for all of the users that exist on the computer. The client computer will 
execute the PC Transplant Wizard using the specified template and create a file 
(computername.exe) at the specified location.

Steps to use 

1 Edit the job.
2 Assign the username and password for use with Windows NT/2000/XP/2003 based systems. If 

you are using this job on Windows 9x computers the logged-in user must have rights to the 
specified location for the template and package creation. 

3 Assign the job to a computer or computer group. 

Capture User Printer Settings
Description Collects the user’s printer setting using PC Transplant

Additional files required None.

What this task does This task will use PC Transplant and a supplied PCT template to gather the 
printer settings for all of the users that exist on the computer. The client computer will execute the 
PC Transplant Wizard using the specified template and create a file (computername.exe) at the 
specified location.

Steps to use 

1 Edit the job.
2 Assign the username and password for use with Windows NT/2000/XP/2003 based systems. If 

you are using this job on Windows 9x computers the logged-in user must have rights to the 
specified location for the template and package creation. Assign the job to a computer or 
computer group. 

Misc Jobs
Misc jobs can be executed on computers, including installation and repair of Office XP, computer 
power control, and SQL service and installation:

Install Office XP from Mapped Drive (page 186)

Install Office XP from UNC Source (page 186)

SQL 2000 Unattended Install (page 186)

SQL 2000 Unattended Install Using a RIP (page 187)

Copy WLogevent to Client (page 187)

Install MSI 2.0 Runtime (page 187)

Repair Office XP (page 188)

Restart Computer (page 188)
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Shutdown Computer (page 188)

Start SQL Server Service (page 188)

Stop SQL Server Service (page 188)

Uninstall Office XP (page 189)

Wake up Computer (page 189)

Install Office XP from Mapped Drive
Description Installs Microsoft Office XP.

Additional files required Microsoft Office XP setup files located on the network share that will be 
used in the drive mapping.

What this task does This script maps a network drive and installs Microsoft Office XP Professional 
with Front Page from it.

Steps to use 

1 To customize the script, change the UNC that the drive is being mapped to, as well as the 
username and password. 

2 To change the username, go into the advanced settings of the script. Note that the client computer 
must be in the domain if you are using domain authentication. 

3 Assign the job to a computer or computer group.
Note It is strongly recommended that you follow Microsoft's guidelines for preparing Office XP to 
be deployed. The setup should be customized using the proper tools, and an administrative install 
should be performed to place the setup files on the network share. For more details, consult the 
Office XP Resource Kit.

Install Office XP from UNC Source
Description This task will install Microsoft Office XP.

Additional files required Microsoft Office XP setup files located on the network share that will be 
used in the script.

What this task does This script runs a Microsoft Office XP Professional with Front Page install 
directly from a UNC.

Steps to use 

1 To customize the script, change the location of the setup files, as well as the username and 
password. Note that the client computer must be in the domain if you are using domain 
authentication. 

2 To change the username, go into the advanced settings of the script.
3 Assign the job to a computer or computer group.
Note It is strongly recommended that you follow Microsoft's guidelines for preparing Office XP to 
be deployed. The setup should be customized using the proper tools, and an administrative install 
should be performed to place the setup files on the network share. For more details, consult the 
Office XP Resource Kit.

SQL 2000 Unattended Install
Description This script will do an unattended install of SQL Server 2000.

Additional files required The files from the SQL Server 2000 disk.
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What this task does This script will copy all of the files and directories from the SQL setup to the 
client computer, then execute an unattended install using the specified silent install script 
(sqlins.iss).   

Steps to use 

1 Copy the files from the SQL 2000 CD into the .\samples\misc\sql2000 directory. Edit the 
sqlins.iss file located in the .\samples\misc\sql2000 directory to include your CD key.

2 Assign the job to a computer or computer group.

SQL 2000 Unattended Install Using a RIP
Description This script will do an unattended install of SQL Server 2000 using a RapidInstall 
Package to copy the files on the computer and execute the setup using a post install script.

Additional files required The files from the SQL Server 2000 disk inserted into the 
sql2000pkg.exe RapidInstall package.

What this task does This script will copy all of the files and directories from the SQL setup to the 
client computer using a RapidInstall package, then execute an unattended install using the specified 
silent install script (sqlins.iss) in a post install script.

Steps to use 

1 Start RapidInstall Editor and open the sql2000pkg.exe located in the 
.\samples\misc\sql2000 directory. 

2 Edit the sqlins.iss file in the TempPath\SQL2000 directory in the RIP. 
To edit the file, select the SQL2000 directory in the Files view and right click the file listed to 
the right and choose Open With. Choose Notepad as the associated program. Replace the CDKey 
entry in the file and save the file. Close Notepad. Choose OK in the Edit File dialog to reinsert the 
changed file into the RIP.

3 Copy the files and directories from the SQL 2000 CD into the SQL2000 directory in the RIP by 
dragging and dropping them onto the SQL2000 folder. 

4 After the files have been added to the RIP, save it by choosing File>Save. Close the RapidInstall 
Editor. 

5 Assign the job to a computer or computer group.

Copy WLogevent to Client
Description Copy the wlogevent.exe to the windows client computer for use with script logging.

Additional files required None.

What this task does This job will copy the wlogevent.exe from the Deployment Server directory 
to the client computer in the temp directory. This file is used for logging status in windows scripts. 

Steps to use Assign the job to a computer or computer group. 

Install MSI 2.0 Runtime
Description Installs the Microsoft Installer runtime files.

Additional files required None.

What this task does This task uses conditions to determine the OS of the computer and installs the 
appropriate MSI 2.0 runtime files. 

Steps to use Assign the job to a computer or computer group. 
Deployment Solution Product Guide 187



 Sample Jobs

 

Repair Office XP
Description This script will force Microsoft Office XP Professional with Front Page to be repaired 
on the client computer.

Additional files required The source that Office XP was originally installed from must be 
accessible in order for the repair to function successfully.

What this task does This script will force Microsoft Office XP Professional with Front Page to be 
repaired on the client computer. You can substitute the Product ID of any MSI (Windows Installer) 
installed application in this sample.   

Steps to use Assign the job to a computer or computer group. 

Restart Computer
Description Restarts the client.

Additional files required None.

What this task does Restarts the client if restart is supported. 

Steps to use Assign the job to a computer or computer group. 

Shutdown Computer
Description Shutdown the client.

Additional files required None.

What this task does Shuts down the client if shutdown is supported. 

Steps to use Assign the job to a computer or computer group. 

Start SQL Server Service
Description This script will start the SQL Server service.

Additional files required None.

What this task does This script will send the NET START MSSQLServer command to the 
computer.

Steps to use 

1 If you run the SQLServerAgent you need to remove the REM on the line that starts the agent 
service. 

2 Assign the job to a computer or computer group.

Stop SQL Server Service
Description This script will stop the SQL Server service.

Additional files required None.

What this task does This script will send the NET STOP MSSQLServer and NET STOP 
SQLServerAgent command to the computer. This job will stop the agent service because the SQL 
server will not stop if this is running from the command line.

Steps to use Assign the job to a computer or computer group. 
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Uninstall Office XP
Description This script will force Microsoft Office XP Professional with Front Page to be 
uninstalled on the client computer.

Additional files required The source that Office XP was originally installed from must be 
accessible in order for the uninstall to function successfully.

What this task does This script will force Microsoft Office XP Professional with Front Page to be 
uninstalled on the client computer. You can substitute the Product ID of any MSI (Windows 
Installer) installed application in this sample.   

Steps to use Assign the job to a computer or computer group. 

Wake up Computer
Description Wake up a computer.

Additional files required None.

What this task does Sends a Wake On LAN packet to the computer. If the client supports Wake On 
LAN, then this will succeed. 

Steps to use Assign the job to a computer or computer group. 

Pocket PC
These jobs are used to install agents and CAB files to manage handheld devices in Deployment 
Solution:

Distribute Software (page 189)

Install Altiris Pocket PC Agent (page 189) 

Distribute Software
Description Installs a simple application that displays the name of the Pocket PC. 

Additional files required None.

What this task does This job allows you to set a condition for a MIPS, ARM, or SH3 processor for 
your handheld device. Once a condition is set then it will install the correct CAB file from the 
Samples directory.   

Steps to use Assign the job to the handheld device displayed in the Computers section of the 
Deployment Server Console. 

Install Altiris Pocket PC Agent
Description Installs Pocket PC Agent on the host computer (the computer with the handheld cradle) 
for the handheld device. This job sets a condition to check if ActiveSync is installed on the host 
computer. If ActiveSync is installed, the Pocket PC agent will install. If ActiveSync is not installed, 
then an error will appear stating that your condition is not met on the selected computer.

Additional files required Microsoft ActiveSync on the host computer.

What this task does This job places the Pocket PC agent on the host computer to manage a 
connected handheld device.   
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Steps to use Assign the job to a managed computer acting as host (with Microsoft ActiveSync 
installed) for a handheld device.

Scripted OS Installs
These imported jobs allow you to run scripted, unattended installs on both Windows and Linux 
servers. These jobs are used for both Network installs and Hard Disk installs. To do a network 
scripted install of Windows, use the Scripted OS install task type in a job:

Create W2K Install Disk Image (Target HD) (page 190)

W2K Scripted Install (Target HD) (page 191)

Create RH7 Install Disk Image (Network) (page 192)

Create RH7 Install Disk Image (Target HD) (page 192)

RH7 Scripted Install (Network) (page 193)

RH7 Scripted Install (Target HD) (page 194)

Create RH8 Install Disk Image (Network) (page 194)

RH8 Scripted Install (Network) (page 195)

Create W2K Install Disk Image (Target HD)
Description This job creates a disk image to be used for installing Windows 2000 using files from 
the local hard drive. This method is not supported from the Scripted OS install task. This process can 
be repeated for XP and .NET as well. This job is only used once to set up the image that will be 
repeatedly called from the "W2k Scripted Install (Target HD)" job.

Additional files required

• < DS install path >\IMAGES\DOS_ONLY.IMG. Image file containing a simple bootable 
partition that is provided during the product install.
Windows 2000 installation files (I386 directory from the Windows CD). These files need to be 
copied from the Windows CD to the OS files directory. The default directory is <DS install 
path>\DEPLOY\WIN\W2K\I386 directory. 

• < DS install path >\Deployment Server\ 
\SAMPLES\SCRIPT~1\WINDOWS\W2KSETUP.BAT. DOS batch file that the job calls to copy 
the AClient agent, other DOS utilities, and the Windows OS files needed for the target HD 
install. 
If you need to supply drivers that are not included with the Windows installation you will need 
to create a $OEM$ directory under the i386 directory.
If you have hardware or other devices that are not supported in the OS distribution, you can add 
the drivers needed in the $OEM$ directory that is supported by the unattended install process.
In our examples we have added drivers for Intel display, network and chipset. The $1 specifies 
the root of the %SYSTEMDRIVE% variable. You will need to verify that the directories are included 
in the OemPnpDriversPath value in the Unattended section of the unattended.txt file. 
Note The Windows unattended install process requires that all drivers in $OEM$ be fully 
extracted. Zip files cannot be used. See the "Microsoft Windows 2000 Guide to Unattended 
Setup" for more information. This guide is named unattend.doc and is in the deploy.cab 
file in the \Support\Tools folder of the Windows 2000 installation CDROM.

What this task does This job creates a hard drive image that can later be used for installing 
Windows 2000 through the hard disk install method. It downloads the DOS_ONLY image to the 
selected client. This creates a 2 GB, FAT16 DOS bootable partition. It reboots the client so that DOS 
will recognize the newly created DOS partition. It calls the w2ksetup.bat file to copy the AClient 
agent, and the AClient input file (aclient.inp) as well as various other DOS utilities to facilitate 
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a Windows scripted install. It also copies the Windows OS files (usually from the I386 directory) to 
the target's hard drive in the C:\I386 directory. It runs rdeploy.exe to create a disk image of the 
now populated DOS partition.

Steps to use 

1 Make a copy of the sample job.
2 If you want to create your own DOS_ONLY.img with MSDOS instead of using the supplied DR 

DOS image, you will need to manually create the image. To create your own DOS image, use a 
DOS boot floppy to run fdisk.exe to create a 2GB partition on a reference computer. Format 
the partition to be a system drive. Copy the appropriate DOS files needed (e.g., himem.sys, 
smartdrv, xcopy, etc.). Create an autoexec.bat file that runs smartdrv to speed the 
installation and then looks for a file called install.bat. Install.bat will be used in our 
examples to initiate the unattended installation.
Example Autoexec.bat file:
@echo off

smartdrv

IF NOT EXIST c:\install.bat goto no_install

call c:\install.bat

goto done

:no_install

echo No Install File

:done

Be sure to include smartdrv in the batch file. This command starts SMARTDrive, which 
creates a disk cache in extended memory. A disk cache will significantly speed up the imaging 
process. After the above tasks have been performed, create an image of the drive named 
MS_DOS.img. Once the MS_DOS image is created, copy the i386 folder of the Windows CD 
(along with the $OEM$ folder if supplemental drivers will be required) to the DOS computer. 
Now create another image of the drive and name it W2K_AS.img. This image will be used for 
hard drive scripted OS installs to provide the OS files needed for the Windows installation. A 
total of two DOS images should be created with the second image containing Windows install 
files in a C:\i386 folder. If you use the MS_DOS.img then edit the task and replace 
DOS_ONLY.img with MS_DOS.img.

3 Edit the last Run Script task, Create Windows Install Disk Image, and change the SET 
ImageName=F:\IMAGES\W2K_HD.IMG line to the name of the image you wish to create.

4 If you copied the Windows OS files to a location other than <DS install 
path>\DEPLOY\WIN\W2K\I386, edit the second Run Script task, Copy Windows Files to Hard 
Drive, and specify the location on the SET OSFilesPath= line.

5 Change the name of the job to reflect the desired purpose (optional).
Note After this job finishes, it will leave the client computer in an unmanageable state.

6 Assign the job to a computer or computer group.

W2K Scripted Install (Target HD)
Description Deploys the Windows 2000 operating system using the Target HD scripted install 
model. This will use the image we created with the Create W2K Scripted Install (Target HD) job.

Additional files required 

• <install path>\IMAGES\W2K_HD.IMG. This is the image file created by the Create W2K 
Install Disk Image (Target HD) job described above. You may have changed the name. This image 
file contains a DOS bootable partition with the Aclient agent and other various DOS utilities 
along with the Windows OS files that are required for a Windows unattended install.

• <install path>\IMAGES\Install.bat. File that executes the scripted install.
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• Windows unattended answer file. A sample provided by the product installation located in the 

<DS install path>\SAMPLES\SCRIPTED OS INSTALL\WINDOWS directory.
What this task does This job starts a Windows unattended OS install on a client using the hard disk 
install method. It downloads the W2K_HD image (or whatever you have named it) to the selected 
client. This creates a 2 GB, FAT16 DOS bootable partition with the OS files to do a Windows 
unattended install. It then reboots the computer to get the new partition and format information. It 
uses a script to get the unattended answer file copied to the client. It then reboots the client. Upon 
reboot, the DOS partition is booted and the OS install is automatically started with the 
autoexec.bat that is called in the image.

Steps to use 

1 Make a copy of the sample job. 
2 Edit the Deploy Image task and change the name of the image file to the name you created with 

the Create W2K Install Disk Image (Target HD) job described above. 
3 Edit the answer file to specify the product key and other information. 
4 Change the name of the job to reflect the desired purpose (optional).
5 Assign the job to a computer or computer group.

Create RH7 Install Disk Image (Network)
Description Creates a disk image to be used for installing RedHat Linux v7.1 through the Network 
install method. The Network method copies the RedHat files from an FTP server during OS 
installation. See the user guide for instructions on setting up an FTP server for this purpose.

Additional files required 

• <DS install path>\IMAGES\DOS_ONLY.IMG. Image file containing simple bootable 
partition. Provided during the product install.

• <DS install path>\SAMPLES\SCRIPT~1\RedHat\RH7SETUP.BAT. DOS batch file that 
the job calls to copy the basic RedHat files needed for the Kickstart install such as LOADLIN, 
VMLINUZ, etc.

What this task does This job creates a hard drive image that can later be used for installing RedHat 
Linux through the network install method. It downloads the DOS_ONLY image to the selected client. 
This creates a 2 Gig FAT16 DOS bootable partition. Then it reboots the client so that DOS will 
recognize the newly created DOS partition. It then calls RH7SETUP to copy the basic RedHat files 
that facilitate a RedHat Kickstart install. It then runs RDeploy to create a disk image of the now 
populated DOS partition.

Steps to use 

1 Make a copy of the sample job. 
2 Edit the last Run Script task, Create Red Hat Install Disk Image, and change the SET 

ImageName=F:\IMAGES\RH71_FTP.IMG line to the name of the image you wish to create. 
3 Change the name of the job to reflect the desired purpose (optional).
4 Assign the job to a computer or computer group.

Create RH7 Install Disk Image (Target HD)
Description Creates a disk image to be used for installing RedHat Linux (v7.1 or later) through the 
hard disk install method (where files are installed from the local hard drive).

Additional files required 

• <DS install path>\IMAGES\DOS_ONLY.IMG. DOS_ONLY.IMG is an image file containing 
a simple bootable partition provided during the product install.
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• RedHat OS files (REDHAT and DOSUTILS directories from the RedHat CD). These files need 

to be copied from the RedHat CD to the <install 
path>\DEPLOY\CDS\REDHAT\RH71\REDHAT and <install 
path>\DEPLOY\CDS\REDHAT\RH71\DOSUTILS directories, respectively.

• <DS install path>\SAMPLES\SCRIPT~1\REDHAT\RH7SETUP.BAT. DOS batch file that 
the job calls to copy the RedHat OS files needed for the target hard drive install.

What this task does: This job creates a hard drive image that can later be used for installing RedHat 
Linux v7.1 through the Hard Disk install method. It downloads the DOS_ONLY image to the selected 
client. This creates a 2 Gig FAT16 DOS bootable partition. It reboots the client so that DOS will 
recognize the newly created DOS partition. It calls RH7SETUP.bat to copy the basic RedHat files 
that facilitate a RedHat Kickstart install. It also copies the RedHat OS files to the target's hard drive 
in the C:\REDHAT directory. It runs RDeploy to create a disk image of the now populated DOS 
partition.

Steps to use 

1 Make a copy of the sample job. Edit the last Run Script task, Create Red Hat Install Disk Image, and 
change the SET ImageName=F:\IMAGES\RH71_HD.IMG line to the name of the image you 
wish to create. 
If you copied the RedHat OS files to a location other than <DS install 
path>.\DEPLOY\CDS\REDHAT\RH71, edit the second Run Script task, Copy RedHat Files to 
Hard Drive, and specify the location on the SET OSFilesPath= line. 

2 Change the name of the job to reflect the desired purpose (optional).
3 Assign the job to a computer or computer group.

RH7 Scripted Install (Network)
Description This job deploys the RedHat Linux operating system using the Network scripted install 
model. The network method copies the RedHat files from an FTP server during OS installation. See 
the Deployment Solution User Guide for instructions on setting up an FTP server for this purpose.

Additional files required 

• <DS install path>\IMAGES\RH71_FTP.IMG. This is the image file created by the Create 
RH7 Install Disk Image (Network) job described above. You may have changed the name. This 
image file contains a DOS bootable partition with the basic RedHat files that facilitate a RedHat 
Kickstart install.

• RedHat Kickstart answer file. A sample is located in the \SAMPLES\SCRIPTED OS 
INSTALL\REDHAT directory.

What this task does This job starts a RedHat Kickstart OS install on a client using the Network 
install method. It downloads the RH71_FTP image (or whatever you have named it) to the selected 
client. This creates a 2 Gig FAT16 DOS bootable partition with files to facilitate a RedHat Kickstart 
install. It reboots the client so that DOS will recognize the newly created DOS partition. It uses a 
Scripted OS Install task to start the unattended install on the client. This task contains the location of 
the OS install files located on the FTP server as well as the Kickstart file to be used for the OS install.

Steps to use 

1 Make a copy of the sample job. 
2 Edit the Deploy Image task and change the name of the image file to the name you created with 

the Create RH7 Install Disk Image (Network) job described above. 
3 Edit the Scripted OS Install task and change the location of the Kickstart answer file. 
4 Change the hard drive ID in the Command Line edit box to the proper ID for the target system. 

The default is ks=hd:hda1/ks.cfg where hda1 is the default hard drive ID. 
5 Change the name of the job to reflect the desired purpose (optional).
6 Assign the job to a computer or computer group.
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RH7 Scripted Install (Target HD)
Description This job deploys the RedHat Linux operating system using the Hard Disk scripted 
install model.

Additional files required 

• <DS install path> \IMAGES\RH71_HD.IMG. This is the image file created by the Create 
RH7 Install Disk Image (Target HD) job described above. You may have changed the name. This 
image file contains a DOS bootable partition with the RedHat OS files that are required for a 
RedHat Kickstart install.

• RedHat Kickstart answer file. A sample is located in the \SAMPLES\SCRIPTED OS 
INSTALL\REDHAT directory.

What this task does: This job starts a RedHat Kickstart OS install on a client using the Target HD 
install method. It downloads the RH71_HD image (or whatever you have named it) to the selected 
client. This creates a 2 Gig FAT16 DOS bootable partition with the OS files to do a Kickstart 
unattended install. It uses a Scripted OS Install task to get the Kickstart answer file copied to the 
client. This task contains the location of the answer file to be used for the OS install. It reboots the 
client. Upon reboot, the DOS partition is booted and the OS install is automatically started.

Steps to use 

1 Make a copy of the sample job.
2 Edit the Deploy Image task and change the name of the image file to the name you created with 

the Create RH7 Install Disk Image (Target HD) job described above. 
3 Edit the Scripted OS Install task and point it to the desired Kickstart answer file. 
4 Change the hard drive ID in the Command Line edit box to the proper ID for the target system. 

The default is ks=hd:hda1/ks.cfg where hda1 is the default hard drive ID.
5 Change the name of the job to reflect the desired purpose (optional).
6 Assign the job to a computer or computer group.

Create RH8 Install Disk Image (Network)
Description Creates a disk image to be used for installing RedHat Linux v8.0 through the Network 
install method. The Network method copies the RedHat files from an FTP, NFS, or HTTP server 
during OS installation. See the RedHat User guide for instructions on setting up a source server for 
this purpose.

Additional files required 

• <DS install path>\IMAGES\DOS_ONLY.IMG. Image file containing simple bootable 
partition. Provided during the product install.

• <DS install path>\SAMPLES\SCRIPT~1\RedHat\RH8SETUP.BAT. DOS batch file that 
the job calls to copy the basic RedHat files needed for the Kickstart install such as LOADLIN, 
VMLINUZ, etc.

What this task does This job creates a hard drive image that can later be used for installing RedHat 
Linux through the Network install method. It downloads the DOS_ONLY image to the selected client. 
This creates a 2 Gig FAT16 DOS bootable partition. It reboots the client so that DOS will recognize 
the newly created DOS partition. It calls RH8SETUP to copy the basic RedHat files that facilitate a 
RedHat Kickstart install. It runs RDeploy to create a disk image of the now populated DOS partition.

Steps to use

1 Make a copy of the sample job.
2 Edit the last Run Script task, Create Red Hat Install Disk Image, and change the SET 

ImageName=F:\IMAGES\RH80_FTP.IMG line to the name of the image you wish to create.
3 Change the name of the job to reflect the desired purpose (optional).
4 Assign the job to a computer or computer group.
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RH8 Scripted Install (Network)
Description This job deploys the RedHat Linux operating system using the Network scripted install 
model. The network method copies the RedHat files from an FTP, NFS, or HTTP server during OS 
installation. See the Deployment Solution User Guide for instructions on setting up an FTP server 
for this purpose.

Additional files required 

• <DS install path>\IMAGES\RH80_FTP.IMG. This is the image file created by the Create 
RH8 Install Disk Image (Network) job described above. You may have changed the name. This 
image file contains a DOS bootable partition with the basic RedHat files that facilitate a RedHat 
Kickstart install.

• RedHat Kickstart answer file, located in the \SAMPLES\SCRIPTED OS INSTALL\REDHAT 
directory.

What this task does This job starts a RedHat Kickstart OS install on a client using the Network 
install method. It downloads the RH80_FTP image (or whatever you have named it) to the selected 
client. This creates a 2 Gig FAT16 DOS bootable partition with files to facilitate a RedHat Kickstart 
install. It reboots the client so that DOS will recognize the newly created DOS partition. It uses a 
Scripted OS Install task to start the unattended install on the client. This task contains the location of 
the OS install files located on the FTP server as well as the Kickstart file to be used for the OS install.

Steps to use

1 Make a copy of the sample job.
2 Edit the Deploy Image task and change the name of the image file to the name you created with 

the Create RH8 Install Disk Image (Network) job described above.
3 Edit the Scripted OS Install task and change the location of the Kickstart answer file.
4 Change the hard drive ID in the Command Line edit box to the proper ID for the target system. 

The default is ks=hd:hda1/ks.cfg where hda1 is the default hard drive ID.
5 Change the name of the job to reflect the desired purpose (optional).
6 Assign the job to a computer or computer group.

Scripts
These jobs are provided to give some ideas of things that can be accomplished by scripting. The 
scripts have been divided into scripts for Windows and scripts for Linux: 

Send Email if Disk Space Low (Linux) (page 196)

Logevent Script (Linux) (page 196)

Restart HTTPD Service (Linux) (page 196)

Move Computer to Default Container (Windows) (page 196)

Move Computer to Specific OU (Windows) (page 197)

Send Error Email (Windows) (page 197)

Server-side Embedded VBScript (Windows) (page 197)

WLogevent CMD Script (Windows) (page 197)

WLogevent VB Script (Windows) (page 198)
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Send Email if Disk Space Low (Linux)
Description This script will send an email specifying that the computer had less free space than 
specified threshold. 

Additional files required None.

What this task does This script will send an email notifying the specified user of the computer that 
has less than the specified threshold of disk space free.

Steps to use

1 Edit the embedded script to specify the email username to send to and the threshold percentage. 
2 Assign this job to a computer or computer group.

Logevent Script (Linux)
Description This script shows how to use the logevent utility to send status back to the console while 
running a Linux script. 

Additional files required None.

What this task does This job sends a status message to the console then executes an ls command, 
then sends another message to the console.   

Steps to use Assign the job to a computer or computer group. 

Restart HTTPD Service (Linux)
Description This script will restart the HTTPD service. 

Additional files required None.

What this task does This script will check to see if a page can be loaded from the http server. If it 
cannot be loaded, then the script will restart the httpd service.   

Steps to use Assign the job to a computer or computer group.

Move Computer to Default Container (Windows)
Description This script will take the specified computer and move it to the specified domain default 
computer container. 

Additional files required None.

What this task does This script will take the specified computer and move it to the specified domain 
default computer container.

Steps to use

1 Edit the movecomp_cn.vbs to specify the domain that you want to use for the computer to be 
moved in. 
This script will not create the computer account in the domain. If it is not already a member of 
the domain, this event will fail. 

2 Assign the job to a computer or computer group.
Deployment Solution Product Guide 196



 Sample Jobs

 

Move Computer to Specific OU (Windows)
Description: This script will take the specified computer and move it to the specified domain OU. 

Additional files required None.

What this task does This script will take the specified computer and move it to the specified domain 
OU.

Steps to use 

1 Edit the movecomputer.vbs to specify the domain and OU that you want the computer to be 
moved into. 
This script will not create the computer account in the domain. If it is not already a member of 
the domain, this event will fail. 

2 Assign the job to a computer or computer group.

Send Error Email (Windows)
Description This script will send an email specifying that the computer had an error. 

Additional files required None.

What this task does This script will send an email using the job name and computer name to 
identify the client that had an error. This script is run on the Deployment server and can be used as 
a job to be run when having a specific error occurs.

Steps to use

1 Edit the sendmailscript.vbs to specify the SMTP server and the user to have the email sent 
from and to. 

2 Assign the job to a return code handler on another task. (See "Setting up Return Codes" in help 
for more details). 

3 Assign the calling job to a computer or computer group. If you have the error then this job (Send 
Error Email) will be called.

Server-side Embedded VBScript (Windows)
Description This script will log an event to the event log. 

Additional files required None.

What this task does This script will log an event to the application event log under the WSH 
module.   The text will read Deployment Server Job complete for <computername>.

Steps to use Assign the job to a computer or computer group.

WLogevent CMD Script (Windows)
Description This script shows how to use the Wlogevent utility to send status back to the console 
while running a Windows CMD script. 

Additional files required None.

What this task does This job will copy the WLogevent.exe to the Windows client, then sends a 
status message to the console, then executes a dir command, then sends another message to the 
console.

Steps to use Assign the job to a computer or computer group.
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WLogevent VB Script (Windows)
Description This script shows how to use the Wlogevent utility to send status back to the console 
while running a Windows VB script. 

Additional files required None.

What this task does This job will copy the WLogevent.exe to the Windows client, then sends a 
status message to the console, then executes a dir command, then sends another message to the 
console.

Steps to use Assign the job to a computer or computer group.

XP Embedded
These jobs are provided to give samples when working with XP embedded that have the Enhanced 
Write Filter enabled:

Create Disk Image (page 198)

Disable Enhanced Write Filter (page 198)

Distribute Disk Image (page 198)

Enable Enhanced Write Filter (page 199)

Distribute RapidInstall Package (page 199)

Create Disk Image
Description Creates a disk image.

Additional files required None.

What this task does This job will disable the Enhanced Write Filter, create a disk image using the 
name of the computer as the image filename, then enable the Enhanced Write Filter.

Steps to use Assign the job to a computer or computer group.

Disable Enhanced Write Filter
Description Disable the Enhanced Write Filter.

Additional files required None.

What this task does This job will disable the Enhanced Write Filter and reboot the client computer.

Steps to use Assign the job to a computer or computer group.

Distribute Disk Image
Description Distributes a disk image.

Additional files required None.

What this task does This job will disable the Enhanced Write Filter, distribute the disk image using 
the name of the computer as the image filename, and then enable the Enhanced Write Filter.

Steps to use Assign the job to a computer or computer group.
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Enable Enhanced Write Filter
Description Enable the Enhanced Write Filter.

Additional files required None.

What this task does This job will enable the Enhanced Write Filter and reboot the client computer.

Steps to use Assign the job to a computer or computer group.

Distribute RapidInstall Package
Description Runs the shwnm.exe RapidInstall package after disabling the Enhanced Write Filter.

Additional files required None.

What this task does This job will disable the Enhanced Write Filter, and then install a package that 
includes a utility that displays the computer name in a window. A shortcut is created in the startup 
group so that every time the computer is started the window will display the computer name. After 
installing the RIP, the Enhanced Write Filter will be enabled.

Steps to use Assign the job to a computer or computer group.
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Deploying Linux

Deployment Solution allows you to deploy and manage Linux computers from a Deployment 
console, providing features to image hard disks, copy files, and accomplish deployment and 
management tasks on a Linux managed computer similar to tasks performed on a Windows managed 
computer. In addition, the Deployment Server Web Console lets you deploy and manage computers 
from Web browser on a Linux server. 

From the Deployment Server Web Console you can configure computers remotely and assign and 
schedule deployment tasks for groups of computers. You can also access the Deployment Server 
Web Console from a client computer and download setup files to install agent software for Linux 
systems.

See the following sections for Linux deployment and management information:

• Deployment Agent for Linux (page 201)
• Deployment Server Web Console (page 204)
• Scripted Installs for Linux (page 210)

Supported Linux Versions
RedHat 7.2, 7.3, 8.0, 8.1

RedHat Advanced Server 2.1

United Linux 1.0
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Deployment Agent for Linux

The Deployment Agent for Linux is agent software that runs on managed Linux computers. The 
agent collects and sends data from the managed computer to the Deployment Server system, 
executes deployment tasks sent from the server, installs packages, and runs management processes 
as directed from a Deployment console.

A Linux managed computer is identified in the Deployment console by unique Linux icons 
reflecting deployment and process status. The following is an example of a connected Linux 
managed computer displayed in a Deployment console:

The Deployment Agent for Linux allows you to deploy and manage computers just like the 
Deployment Agent for Windows (AClient), with the following exceptions:

Installing Deployment Agent for Linux
The Deployment Agent for Linux is installed by downloading and running the Deployment Agent 
for Linux installation file, a RedHat Package Manager (RPM) file, on the client computer. 

Supported Features of Client Software for Windows and Linux
Deployment Task Deployment Agent for 

Windows (AClient)
Deployment Agent for 
Linux

Create Disk Image Yes Yes
Distribute Disk Image Yes Yes
Scripted OS Install Yes Yes
Distribute Software Yes Yes
Capture Personality Yes No
Distribute Personality Yes No
Change Configuration Yes Yes
Backup Registry Files Yes No
Restore Registry Files Yes No
Run Script Yes Yes
Copy File Yes Yes
Shutdown/Restart Yes Yes

Linux computers (both servers and 
 desktop versions) are identified with
a unique Linux icon in a Deployment 
console. 
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Note One of the easiest ways to access the installation file for the Deployment Agent for Linux is to 
access the Deployment Server Web Console from the client computer and download the install file 
to a local hard disk. The Deployment Server Web Console can be set up for any Deployment Server 
installation. See Deployment Server Web Console (page 204) for complete information.

Downloading Deployment Agent for Linux
Access the Deployment Server Web Console to download the Deployment Agent for Linux 
installation file. Then install and configure the agent from the client computer. 

1 Open a browser and type <computer name or IP address> / webconsole in the address field.
2 Type the computer name of the computer where the DeploymentWebConsole.MSI is 

installed.
If you don’t have a DNS server properly running and resolving names to IP addresses, you may 
have to enter the static IP address of the server, for example: 192.168.1.1/webconsole. The 
login page for the Deployment Server Web Console will open.

Note You can also distribute the Deployment Agent for Linux installation file using e-mail, 
saving it to an accessible file server directory, posting to an intranet or FTP site, or employing 
some other method of file distribution. You can locate the RPM file (altiris-adlagent-
<version numbers>.i386.rpm) in the Program Files > Altiris > eXpress > Deployment Server 
shared directory on the Deployment Server (or the location of the Deployment Server’s client 
access directory).

When downloading the installation file from the Deployment Server Web Console, if multiple 
RPM files exist then they will be displayed on the download page. You can then select the correct 
RPM file for download and installation. 

3 Click Install Agent Software in the left pane of the login screen. 
The Install Client Software page will open:

4 Click the Deployment Agent for Linux installation file (altiris-adlagent-<version 
numbers>.i386.rpm) and save it to the a local directory on the client computer. 

Download the 
Deployment Agent 
for Linux 
installation package
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 Installing the Deployment Agent for Linux
1 After downloading the RPM file to a local directory, you can install from the command line or 

use a Package Manager application shipped with your Linux OS.
• To install from the command line, drive to the directory where you saved the RPM file and 

type: RPM -i <file name> 
• To install using the Package Manager shipped with Linux, you need to associate the RPM 

file with the Package Manager application.
The Deployment Agent for Linux will be installed in the /opt/altiris/deployment/
adlagent directory.

2 After installing the Deployment Agent for Linux, you can change settings in the configuration 
file by making direct edit changes to the adlagent.conf file, or running a script from the/
opt/altiris/deployment/adlagent directory where the adlagent.conf file is located.
• To run the script to change settings for the adlagent configuration file, drive to the /opt/

altiris/deployment/adlagent directory from the shell and type the following:
./configure

You will then be prompted to select Multicast options to identify a Deployment Server to manage 
the current client computer, or you can select a specific Deployment Server by setting the 
Multicast option to false and adding the IP address of the desired Deployment Server. 
To edit the configure file directly, open the adlagent.conf file located in the /opt/altiris/
deployment/adlagent directory and make setting changes to the configuration document.
In many cases, you may want to edit the configuration file to change functionality or properties. 
For example, you can open the adlagent.conf file in an editor and scroll to the 
[Transport] section and the UseMcast line. Change UseMcast=true to 
UseMcast=false. Then type the IP address of the specific Deployment Server you want to 
manage the client computer into the TCPAddr=<IP address> line. Additional configuration 
settings can also be identified and edited in the configuration file.

3 After making edits to the configuration file, restart the Deployment Agent for Linux. 
To start and stop the Deployment Agent for Linux, you must enter the full path name or drive to 
the /etc/rc.d/init.d directory (with administrator/root rights) and use the 
adlagent stop and adlagent start commands, or the adlagent restart command. 
You can also use the Package Manager installed with Linux to restart the Deployment Agent for 
Linux.

By stopping and starting the Deployment Agent for Linux, the service will update the changes 
made in the adlagent configuration file.

4 You can now view the Linux managed computer from a Deployment console. 
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Deployment Server Web Console

The Deployment Server Web Console remotely administrates a Deployment Server installation from 
a web browser. It deploys and manages Windows and Linux computers (both client and server 
editions) in real-time with many of the features present in the Deployment Server Console (the 
Win32 application).

See Installing the Deployment Server Web Console (page 204) for requirements and setup 
procedures. To install Deployment agents (either Deployment Agent for Windows (AClient) or the 
Deployment Agent for Linux) to manage computers, see Installing Deployment Agent for Linux 
(page 201).

Managing from the Deployment Server Web Console
To deploy and manage computers from the Deployment Server Web Console, follow these basic 
steps to select computers and computer groups, assign jobs to selected computers, and then schedule 
the jobs. 

1 Selecting Computers (page 206)
2 Assigning Jobs (page 206)
3 Scheduling Jobs (page 208)
To view options for refresh rates and custom links, see Setting Options for the Web Console (page 
209). 

Installing the Deployment Server Web Console
The Deployment Server Web Console can be installed on any computer running the Microsoft IIS 
Server, including a computer running Deployment Server, Notification Server, or a remote computer 
running only Microsoft IIS. After installation, the Deployment Server Web Console requires you to 
enter the name of an installed Deployment Database to access the desired Deployment Server 
installation.

Note When installing Deployment Server (see Deployment Server Installation (page 55)), the 
Deployment Server Web Console will install automatically if the MS IIS Server is installed on the 
local computer.

Supported Operating Systems
• Microsoft Windows 2000 Professional*, Windows 2000 Server, Windows 2000 Advanced 

Server, Windows XP Professional*, Windows 2003 Server
Note Because Microsoft Windows XP Professional and Windows 2000 Professional only 
support 10 network connections, some Linux browsers may use all connections when accessing 
the Deployment Server Web Console.

Supported Web Browsers
• Microsoft Internet Explorer 5.5 or newer
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• Netscape 4.78 (shipped with RedHat and SuSE 7.2) and Netscape 4.79 (shipped with RedHat 

7.3) 
• Mozilla (versions shipped with RedHat 7.2 and 7.3)

 Install the Deployment Server Web Console
1 Install Microsoft IIS server. 

Windows 2000 Server/ Windows 2000 Advanced Server/ Windows Server 2003 automatically 
installs Microsoft IIS. Microsoft Windows 2000 Professional and Windows XP Professional 
requires you to install Microsoft IIS.

2 Double-click the DeploymentWebConsole.msi file.
The DeploymentWebConsole.msi file is included with Deployment Server components and 
copied to the Deployment Server shared directory (Program 
Files\Altiris\eXpress\Deployment Server) during installation. 

3 Follow installation directions in the provided wizard. 
The Deployment Server Web Console will be installed on the local hard drive.

4 To open the Deployment Server Web Console, select click Start > Programs > Altiris > Altiris 
eXpress > Deployment Server > Deployment Server Web Console. 
You can also open a Web browser and type <computer name> / webconsole in the address 
field to open the Deployment Server Web Console. Type the name of the computer where the 
DeploymentWebConsole.msi was installed to open the login page for the Deployment Server 
Web Console.

Note Authentication routines allow you to log in to the Deployment Server Web Console using 
NT authentication, MS SQL Server authentication, and Deployment Solution role-based 
authentication. Rights are checked and verified in this order. 

5 Enter the name of the Deployment Database to access and manage a specific Deployment Server 
installation.

6 Click Enter. 
The Computers page of the selected Deployment Server installation will open listing all managed 
computers for the selected site or network segment.

Uninstalling the Deployment Server Web Console
To uninstall the Deployment Server, double-click and run the DeploymentWebConsole.msi 
installation program and select the Remove option on the Program Maintenance dialog box, or 
uninstall the Altiris eXpress Deployment Server Web Console from the Add/Remove Programs 
feature in Windows. 

Important If you are reinstalling the Deployment Server Web Console, you can uninstall and then 
reinstall using the DeploymentWebConsole.msi installation program. If other users have logged 
on or accessed your Deployment Server Web Console, then reboot the server to update the view for 
all connected users. 
Deployment Solution Product Guide 205



 Deploying Linux Deployment Server Web Console

 

Selecting Computers 
The Deployment Server Web Console allows you to view and configure all computers in a 
Deployment Server installation. From this page you can select the computers or groups to run an 
operation or job. 

To run an operation on a selected computer
1 Select Computers from the left pane.
2 Click the check box to select the desired computers. 

Note To select All, click the check box by the Name title.

When you select a computer, the Select Operation drop-down list will open. 

The names of the selected computers will also appear on the page.

3 Select an operation to perform on the selected computers.
If you select the Schedule Job menu item, the All Jobs page will open. For more information on 
selecting and scheduling jobs, see Assigning Jobs (page 206). 

Assigning Jobs
You can first select a computer or group of computers and then select and assign the job, or select 
the job first and then select the computers to apply the job. You can select the Jobs page from the 
left pane or from the Select Operation drop-down list on the All Computers page. 
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Note You cannot create jobs in the Deployment Server Web Console, only apply and schedule 
existing jobs (jobs created or imported in the Deployment Server Console). 

To select Jobs
1  Click Jobs in the left pane. 

The All Jobs page will open with a list of existing jobs.

2 Click the check box to select single or multiple jobs.
Note: To select multiple jobs located in different directories, use the jobs directory path links that 
appear above the All Jobs heading to traverse the job directory structure.   

If you first select an job and then select Schedule Job without selecting the computers, the 
Deployment Server Web Console will open the All Computers page automatically to allow you 
to apply the job to the desired computers. 

3 Click the Schedule button to schedule the jobs.
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Scheduling Jobs
After identifying and selecting both computers and jobs, you can then schedule when you want the 
computers to execute the jobs. 

1 Select Schedule Job.
The selected computers and jobs are listed under the Scheduling Job/Task heading. 

2 Select the Scheduling options.
3 Click Apply.

Two Apply buttons are provided to eliminate the need to scroll in small screens.
Deployment Solution Product Guide 208



 Deploying Linux Deployment Server Web Console

 

Setting Options for the Web Console
The Options page allows you to set the refresh rate to update the list of managed computers. It also 
provides features to place links to important Notification Server pages when implementing a 
comprehensive Altiris eXpress system.

Setting the refresh rate
• To set the refresh rate for updating the current page, set a value in the Auto-refresh computer 

status every ______ seconds field.
• Click the Do not auto-refresh page check box to keep a static view of the current page.
• Click the Prompt me before performing operations in computers check box to activate a warning 

message when performing major operations on managed computers. This warning helps ensure 
that the administrator will not mistakenly schedule an job or execute a remote computer 
operation.   

• Click the Clear Selections After Scheduling check box to clear the computer names and job names 
listed at the top of the All Computers, All Jobs, and Scheduling Job/Task pages. 
When you click the Computers link and select computers from the All Computers page, the 
computer names are listed under the banner section of the page. When you select an job from the 
All Jobs page, the job names are also added to the banner section. The names of the selected 
computers and jobs also appear on the Scheduling Job/Task page. To clear these names after 
scheduling, click the Clear Selections After Scheduling check box.

Setting Notification Server Links
From the Options page, you can set links to the Deployment view on Notification Server pages (see 
Deployment on Notification Server (page 306)). Notification Server scales your Deployment Server 
system by allowing you to manage computers, schedule jobs, integrate additional Web applications, 
and generate reports across multiple Deployment Server installations. These links will allow you to 
access the Deployment view on Notification Server and other Notification Server solutions from the 
Details page on each computer.

• To set a link to the Notification Server console, enter the URL of the Notification Server page, 
for example: http://<computer name>/AeXNS. This will set a link on the Computers page 
to the desired Notification Server page.

• To set a link to the Deployment view on Notification Server, click the Deployment Solution 
installed as a Notification Server solution check box. This will place a link on the Computers page 
to an integrated view of Deployment Servers available from Notification Server. 
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Scripted Installs for Linux

Scripted installs allow you to perform remote, automated operating system installations from the 
Deployment Server Console using Kickstart files (answer files) and Deployment Server sample jobs. 
The steps required during manual installs are executed remotely through scripts in prebuilt jobs, with 
input values referenced from a prebuilt Kickstart file. These installation methods can be used for 
desktop computers, but meet additional requirements specific to Linux servers. 

Important: It is beyond the scope of this documentation to present all of the features, commands, 
and options available with scripted OS installations for Linux. See the appropriate Linux 
documentation for in-depth information about populating the Kickstart file and other features for the 
scripted install for Linux computers.

Supported Operating Systems for Scripted Installs
Currently, Deployment Solution supports these operating systems for scripted installs:

• RedHat 7.2, 7.3, 8.0, 8.1
• RedHat Advanced Server 2.1
• United Linux 1.0

Linux Scripted Install References
Access this for a more detailed instruction for the Linux unattended installation:

http://www.linuxdoc.org/HOWTO/KickStart-HOWTO.html

Types of Scripted Installs
Linux operating systems can be installed using scripted OS installation features from across the 
network or using images of OS installation files copied to each client’s hard disk:

Scripted Installs over the Network 
Deploy servers across the network from installation files and a kickstart file using FTP, HTTP, or 
NFS protocols.

For the network-based scripted OS install model, the operating system files are stored on a network 
resource, in most cases an FTP directory designated on the Client Access Point. The managed 
computer makes a connection to the Deployment Server, the Kickstart file is copied to the target 
system, and the OS installer program is launched. The OS is installed on the managed client 
computer across the network.

The network-based model is the simplest to setup, but the slowest to install since each OS file is 
copied across the network for each target system being installed.
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To run a scripted install over the network
To run scripted installs over the network, the OS files and answer file reside on a designated 
directory and install across the network to a defined managed computer. Pre-configured jobs allows 
you to easily deploy the servers.

1 Set up directories and copy files to the Client Access Point.
See Setting Up Directories for Scripted Installs (page 212). 

2 Modify or create the Kickstart file. Sample kickstart files are provided in the <install 
path>\Altiris\ eXpress\Deployment Server\Samples\Scripted OS Install 
directory. 
For Linux, you will need to modify the answer file entries for the Network install KickStart file 
(the ks_ftp.cfg file located in the Samples directory), including these settings:
• Root password (rootpw)
• FTP server IP address or DNS name
• FTP directory (optional)
• Volume sizes (optional)
• Timezone (timezone)
• Packages to be installed

See Creating a Kickstart File (page 213).
3 Insert variable tokens into your answer file to set custom configurations for each server. 

See System Tokens (page 347).
4 Modify and run the sample job:

Create RH7 Install Disk Image (Network)
5 Modify and run the sample job:

RH7 Scripted Install (Network)

Scripted Installs from the Local Hard Disk
Use a combination of scripting and imaging features to deploy an image of installation files to each 
managed computer’s hard drive, and then run the install locally on each managed computer.

In the hard drive scripted install model, the operating system files are stored on the target system's 
hard drive in a temporary directory or volume. The target system makes a connection to the 
Deployment Server, the Kickstart file is copied to the target computer, and the OS installer program 
is launched.

This model is more difficult to set up than the network-based model, but is generally much faster 
since all files are already stored on the target's hard drive. The OS files are placed on the target's hard 
drive through an image deployment process, which provides the ability to multicast the image to 
several target systems simultaneously.
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To run a scripted install from the hard disk
To run scripted installs from the hard disk, OS files and the kickstart answer file are copied down to 
each computer and run from each computer’s hard drive. Pre-configured sample jobs and sample 
Kickstart files are provided to allow you to easily deploy computers from the Deployment Server 
Console.

1 Set up directories and copy files to the Client Access Point. See Setting Up Directories for 
Scripted Installs (page 212).

2 Modify or create the Kickstart file. Sample answer files are provided in the <install 
path>\Altiris\ eXpress\Deployment Server\Samples\Scripted OS Install directory. Sample files 
exist for both Microsoft (unattend.txt) or Linux (ks_hd.cfg for Hard Disk installs). 
For Linux, you will need to modify the answer file entries for the Hard Disk install (the 
ks_hd.cfg file located in the Samples directory)KickStart file, including these settings:
• Root password (rootpw)
• Target HD ID and volume number

Default = hda1
Be sure to change all instances of “hda1”,
or “hda” to the new ID and volume number.

• Volume sizes (optional)
• Timezone (timezone)
• Packages to be installed
• Mount point for the converted volume

Default = /home/temp

See Creating a Kickstart File (page 213).

3 Insert variable tokens into your answer file to set custom configurations for each server. 
See System Tokens (page 347).

4 Modify and run the sample job: 

See Create RH7 Install Disk Image (Target HD). There are additional sample jobs for other 
Linux operating systems.

5 Modify and run the sample job:

See RH7 Scripted Install (Target HD).  There are additional sample jobs for other Linux 
operating systems.

Setting Up Directories for Scripted Installs
Deployment Solution requires that you create specific directories to organize and access the required 
files for a scripted install. In this directory structure you can store scripts, disk images, answer files 
and CD installation files for different variations of servers and OS types.

Within the Deployment Solution shared directory (in Program Files > Altiris > eXpress > 
Deployment Server for the default location of a Simple installation), you can create a Deploy 
directory with subdirectories for the files required for a scripted OS installation, including CD, 
Images, Scripts, and Tools subdirectories.

Note: Deployment Solution ships with pre-configured jobs for scripted installs. These jobs access 
files relative to the default directory structure. If your Client Access Point is in a different location 
than the default installation, then you must modify the sample jobs to locate the required files. 

• The CD directory can include the installation files from the installation CD. 
• The IMAGES directory can contain imaged operating system files, along with hard drive images 

created using Deployment Server.
• The SCRIPTS directory can contain batch files, unattended install files, and other Deployment 

Solution text files.
• The TOOLS directory can contain utilities including the SMARTDRV.EXE utilities for 

Windows.
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In most cases, the CD, IMAGES and SCRIPTS directories will contain subdirectories for the 
different operating system files. 

Set Up OS Files for Linux
The Network scripted install for Linux requires that you install an FTP, NFS, or HTTP directory to 
copy files over the network where they are accessed from the target computer during the OS 
installation.

Follow these instructions to create and store files on an FTP server on the Client Access Point for a 
Simple install for Network scripted installs. An FTP/HTTP/NFS directory residing on another server 
can also be used.

1 Set up an FTP server.

a Run the Programs > Administrative Tools > Configure Your Server program or Control Panel > 
Add/Remove Programs > Add/Remove Windows Components to install the necessary IIS 
components.

b Click on Start > Programs > Administrative Tools > Internet Services Manager

c Click on the “+” next to the server name.
d Right-click on Default FTP Site
e Select New > Virtual Directory

f Click Next to advance in the wizard.
g Enter the alias “Deploy” and click Next.

This alias path requires that you include the IP address of the FTP server and the directory 
path in the answer file. The default line in the KickStart file is 
url --url ftp://10.10.10.1/deploy/cds/redhat/rh71. This value can be 
modified to access your FTP server.

h Click Browse and go to the \DEPLOY directory (for example, where the Deployment Server 
was installed at C:\Program Files\Altiris\eXpress\Deployment Server\Deploy).

i Click Next.
j Click Next. Read permissions are sufficient rights for this setup. 
k Click Finish.

2 Copy files to the FTP server.
Copy the Red Hat 7.1 system files to your FTP server. Copy all of the files and subfolders from 
the “REDHAT” directory on both CD’s to the RedHat shared folder. The default is
Installed directory\ Altiris\eXpress\Deployment Server 
\DEPLOY\CDS\REDHAT\RH71\<REDHAT directory> on the FTP server.

Creating a Kickstart File
Most Linux operating systems support scripted installs through a script that accesses a kickstart file, 
a text file that contains answers to the questions presented during a normal operating system 
installation. Most Linux operating systems provide wizard-based tools to generate the Kickstart file. 

The Kickstart file is used with the operating system installer to bypass normal installation prompts. 
It is useful when all settings for the installation are known beforehand and when you want to install 
the OS without going through the interface. Deployment Solution requires you to create a Kickstart 
file and identify its location on the server directory. The default names for the kickstart file is ks.cfg.

In addition, Altiris Deployment Solution provides tokens that automatically insert values required 
during the install. An answer file token is a type of variable used with scripted operating system 
installations. A token is a text name enclosed in the percent symbol (%). The Deployment Server 
looks for these special tokens and replaces them with values from the Deployment Database. Tokens 
allow you to use one answer file yet still get different installation results. See System Tokens (page 
347).
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To create a Kickstart file in Linux
The Red Hat Linux generation tool is called the “Kickstart Configurator.” To use Kickstart 
Configurator, you must be running the X Window system. 

1 Start the wizard using one of the following methods:
• GNOME desktop—go to Main Menu Button > Programs > System > Kickstart Configurator.
• KDE desktop—go to Main Menu Button > Red Hat > System > Kickstart Configurator.
Note: If you do not see these menu options, you will need to install the ksconfig-1.2-
1.noarch.rpm RPM package located on the second CD in \REDHAT\RPMS\ KSCONFIG-1.2-
1.NOARCH.RPM

Use the Kickstart File Wizard to create answer file values.
2 Follow the wizard and answer all the appropriate questions. 

a Select the desired Language, Keyboard, Mouse, Time Zone, and Root Password.
b Choose the desired LILO location.

Network install  choose MBR
Target HD install. Choose None (we will change this later to Partition)

a Select the desired Authentication.
b Choose the install source.

Network install. Choose “FTP.”
Specify the FTP server's.IP address or DNS name
Specify the directory (such as /DEPLOY/CDS/REDHAT/RH71)
Target HD install. Choose “Hard Drive.”
Enter the drive partition that contains the OS files. This should be the drive identifier and 
partition number 1 (i.e. hda1) The drive identifier may vary from one computer hardware 
model to another. If you do not know the drive identifier for your system, you can (KEVIN 
FIND THIS INFO). IMPORTANT: Remember this identifier. You will use to when 
modifying the Kickstart file later.
Enter the Directory. This should be “/” for this example.

c Select YES for Clear Master Boot Record.
d Choose the partitions to remove.

Network Install - choose “All.”
Target HD install - choose “Linux.”

e Make any desired changes in the partition definitions.
f Use the Networking, Authentication, Firewall, and Packages screens to enter the desired 

values for these sections.
3 Click Save to save the Kickstart file.
4 Copy the answer file from the Linux system to a directory under the Deployment Server share 

(EXPRESS). For example, \DEPLOY\CDS \REDHAT\RH71\KICKSTART\KS.CFG
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Generate a Unique Answer File with Token Variables
Deployment Solution uses a token replacement process to generate unique answer files for each 
target system being deployed. 

A “base answer file” is any answer (or kickstart) file that has been edited such that special tokens 
have been placed in strategic locations. A token is a text string enclosed in the percent symbol ('%'). 
Deployment Solution looks for these special tokens and replaces them with values from the 
Deployment Database. 

Deployment Solution looks for these special tokens and replaces them with values from the 
Deployment Database. Tokens allow you to use one answer file yet get different installation results. 
For example, in the sample answer file listed above, the Altiris token of %NAME% is being used 
to supply the computer name for the installation.

Important Tokens will only work if the computer you are installing already exists in the Deployment 
Database and data is available for the token you are using. Keep in mind that even new computers 
using PXE will be automatically added to the Deployment Database when BootWorks runs. This 
will add will allow you to use the NAME and NICyIPADDR tokens. 

When using tokens, it is best to enclose the token in quotes marks (““) to accommodate any spaces 
in the value substituted by the token. The Deployment Server does a replacement of the actual token 
only. For example, suppose you wanted to use the following token:

FullName=%USER_NAME%
If the value substituted for %USER_NAME% was John Doe, then the end result would be:

FullName=John Doe
This is an invalid parameter because it contains a space. However, when you place the token in 
quotes,

FullName=“%USER_NAME%” the result is FullName=“John Doe”. This is a valid parameter 
because the name is encased within quotes.

The allowable tokens are listed at System Tokens (page 347).

For example, a section of the answer file generated by the SETUPMGR utility might be:

[UserData]
ComputerName=FOOBAR
FullName=FASTRACK
OrgName=ACME
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ProductID= KRJQ8-RQ822-YRMXF-6TTXC-WONDR

To have Deployment Server generate unique answer files that contain unique Computer Names, Full 
Names, and Product Ids, the following tokens can be inserted in to the answer file:

[UserData]
ComputerName="%NAME%"
FullName="%USER_NAME%"
OrgName=ACME
ProductID="%PROD_LIC%" 

Note Notice that the tokens are placed within quotes (“ “). Deployment Solution does a replacement 
of the actual token only. There may be times when the value in the database is more than one word. 
For example, if %USER_NAME% = John Doe, the above example without quotes would be 
FullName=John Doe which is an invalid answer file value because it contains a space. However, 
FullName="John Doe" is a valid answer file value because the name is encased within quotes.

Edit the answer file created from the steps above with any tokens deemed appropriate for the OS 
deployment.
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Managing Switches

To administer roles and configurations for network servers, it is necessary to discover and modify 
the network switch settings for the connected network servers. Deployment Solution provides the 
Switch Add-On program to discover and manage Virtual Local Area Networks (VLAN) settings on 
a LAN switch or to run commands from the command-line. This utility allows you to directly 
discover and provision the port settings of a LAN switch.

Switch Management Features
Typically, a VLAN setting is port based — it is a LAN switch port that can be configured as a 
member of a specific VLAN. As such, client and server computers connected to that LAN switch 
port are members of the VLAN and can communicate with other member client and server 
computers of that VLAN. By changing the VLAN setting of a switch port, you can move client and 
server computers between logical VLAN groupings without actually changing the physical network 
infrastructure.

Often, when modifying server roles or configurations, it will be necessary for you to change the 
grouping or VLAN for the server’s network. This can be accomplished by changing the VLAN 
setting on the switch port that the server is connected to. 

The Deployment Solution Switch Add-On allows you to perform the following functions:

• Discover the LAN switch MIB II system information (command-line and GUI)
• Discover the switch ports of a LAN switch (command line and GUI)
• Discover the VLAN setting for each switch port (command line and GUI)
• Modify the VLAN setting of a switch port (command line and GUI)
• Assign physical connectivity of a workstation/server to a switch port (GUI)

About Switch Add-On for Deployment Solution
Switch Add-On will assume port-based VLANs (not MAC-based VLANs), managing only VLANs 
for a specified port setting on the switch. For this release, it will assume only one VLAN per port. 
(Switch Add-On will not perform any type of VLAN trunking management in its initial release.) 
Deployment Solution Switch Add-On will only support VLAN management based on the list of 
supported devices in LAN Switch Support List (page 218). 

Deployment Solution Switch Add-On will only support SNMP v1. You will need the SNMP read 
community name to discover a LAN switch (along with its port/VLAN mappings) and the SNMP 
write community name to manage the port/VLAN settings.

All discovered switch information will be kept in a local database file (SwitchMngtDb.txt). To 
ease installation and support, this file will be text based and be located in the directory from which 
the Deployment Solution Switch Add-On applications are executed. 

 

To open the Switch Management tool, click Tools > Altiris Tools > Switch 
Management. This will open the Deployment Solution Switch Add-On utility tool. 
Network switches will be identified in the left pane. Click the star button to Add 
New Switches.
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Notes 

• If a LAN switch supports the 802.1Q VLAN standard, Deployment Solution Switch Add-On will 
only provide PVID management on a port.

• Since most vendors do not support VLAN Add/Edit/Delete through SNMP, Deployment 
Solution Switch Add-On will not provide these features.

• All devices that are to be managed must support SNMP v1.

LAN Switch Support List
Deployment Solution Switch Add-On supports these specific vendors with the following LAN 
switches:

• Cisco Catalyst 1900/2820 series switches
Models: All models (OS Versions 8.XX and up - Enterprise Edition)

• Cisco Catalyst 2900 series switches
Models: WS-C2900, WS-C2926 (OS versions 3.1 and later)
Models: WS-C2948G, WS-C2980G and WS-C2980GA (All OS versions)

• Cisco Catalyst 2900 XL / 2900 XL LRE series switches
Models: All models (IOS versions 11.2(8) SA3 and later)

• Cisco Catalyst 3500 XL series switches
Models: All models (IOS versions 12.0(5) XP and later)

• Cisco Catalyst 4000 series switches
Models: WS-C4003, WS-C4006, WS-C4912G (All OS versions)

• Cisco Catalyst 5000 series switches
Models: WS-C5000, WS-C5002, WS-C5500, WS-C5505, WS-C5509, WS-C5509E (OS 
versions 3.1 and up)

• Cisco Catalyst 6000 series switches
Models: WS-C6006, WS-C6009, WS-C6506, WS-C6509, WS-C6509NEB, WS-C6513 (All 
OS/IOS versions)

• Compaq
Models: BL eClass Interconnect Switch (802.1Q PVID management only)

• Dell
Models: PowerEdge 1655MC Integrated Switch (802.1Q PVID management only)
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Using Deployment Solution Switch Add-On
The Deployment Solution Switch Add-On program is a stand-alone application that displays a 
graphical view of the all switches that have been discovered along with their respective switch ports.

The following are port attributes displayed in the Details pane of the program:

Switch The switch to which the port belongs

Port The name of the port (vendor-specific port names will be shown when available)

Description The description of the switch port

VLAN The VLAN assignment for the switch port

Connectivity Any user assigned mapping of clients or servers to the switch port

By selecting a device in the tree view pane, the switch port display will be updated to show its 
respective ports. By selecting Network in the tree view, all switch ports that have been discovered 
will be shown in the switch port view. You can sort on attributes by selecting the appropriate 
column.

Adding a Switch Device
To add a switch to the Deployment Database 

1 Press the Add icon on the toolbar  

Or, right-click Network in the tree view. 
2 From the pop up menu that opens, click Add Device.
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Note When the device is available and the SNMP communities are correct, the application will read 
the MIB II system information from the device and add the device to the tree view. If not, an error 
message be displayed.

Discovering a Device
Once a device has been added to the database, all of the properties for that device can be discovered. 
By selecting the device in the tree view and right clicking, the following menu will open:

Click Discover Device to discover all the switch device properties and store these values in the 
Deployment Database. Once the discovery process is complete, the switch ports for that device will 
be seen in the port view.

Deleting a Device
A device can be deleted in two ways:

1 Press the Delete icon on the toolbar:  

Or, right-click and select Delete.

Viewing and Setting Device Properties
Select and view Properties for a switch device by right-clicking its name in the tree view. The system 
information for the selected device will display. This dialog box will allow you to make any 
necessary modifications to the SNMP read and SNMP write community strings (passwords).

Setting the VLAN for a Switch Port
To set a switch port to a specific VLAN, right-click on a switch port in the switch port view and click 
Click Set VLAN to display all available VLANs on the switch. Select a VLAN from the list. 

The Deployment Solution Switch Add-On application will then use the supplied SNMP community 
strings (passwords) and attempt to change the VLAN setting on the port. If successful, the VLAN 
column will be updated. 
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Note It is possible to select more than one port in the port view and assign all selected ports to a 
particular VLAN in one operation. However, due to the number of operations required to change 
VLANs on some switching devices, this operation can be time consuming.

Assigning Connectivity to a Switch Port
From the switch port view, right-click any switch port and click Assign/View Connectivity to 
determine what client or server computers are connected to a particular switch port. This dialog box 
will open:

The Assign/View Connectivity dialog box displays all visible devices, including the MAC addresses 
that are being forwarded by the switch. It also displays any previous connectivity mapping, such as 
an X in the Connected column). You can add a hostname to a specific MAC address by right-clicking 
the appropriate MAC address. A menu will open. Click Add/Edit Host Info to enter the hostname on 
the dialog.

Note If the IP address and Hostname columns are blank for a MAC address, the application does not 
have enough information about the global network to display an IP Address/Hostname binding to 
that MAC address. 

You can assign connectivity to a particular switch device by selecting the device (or MAC address) 
in the list and clicking Assign Connectivity to Port. This will mark the MAC address as connected to 
this port. You can remove connectivity by selecting the MAC address that you want to remove from 
connectivity and clicking Remove Connectivity from Port. When the dialog is closed, the client and 
server computers can be seen in the Connectivity column of the switch port view.

Command-line Parameters
The following command line parameters can be supplied to the Deployment Solution Switch Add-
On program to launch the program with the appropriate 

-d=<switch IP address>: By supplying the IP address of the switch, the Switch Add-On program will 
launch and automatically select the supplied device in the tree view (thereby, showing all of its ports 
in the port view).

-e=<end node MAC address>: By supplying the MAC address of a client or server computer, the 
Switch Add-On program will launch and automatically select the switch and port that the client or 
server computer is connected to (if the connectivity has been previously assigned).

GUI Tools
The Switch Management Console includes a Tools menu, providing a Ping IP Range command to 
assist in "pinging" a specified IP range in order to generate traffic to a range of devices that might 
otherwise be inactive. From this dialog box you can specify the starting and ending IP addresses to 
ping. Success or failure messages will appear in the list. 
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The Ping IP Range tool can be used to lookup the MAC address of the device being pinged. To be 
successful, SNMP must be enabled on the end device. The user can supply an SNMP Read 
community name to perform this operation. Otherwise, the user may clear the SNMP MAC Lookup 
box to ping only the end device.

Note If a device is inactive, the forwarding tables in the switch will not show the MAC address of 
the client or server computer. The Ping IP Range tool can be used to refresh the forwarding table in 
the switch. 

Deployment Solution Switch Add-On (Command 
Line Options)
Along with the Deployment Solution Switch Add-On graphical program, a command-line interface 
is provided that will support the command line arguments listed below. This program file is named 
switchcfg.exe. It will be executed from the same directory that the database file 
(SwitchMngtDb.txt) is located.

Command-line Interface Parameters
By executing the switchcfg.exe without any arguments, you will see displayed the usage of the 
CLI application as below.

The following is a description of the available command line arguments and how they are to be used:

-m=<mode> This indicates the mode of the operation to be performed. The two possible values are: 
1) discover, and 2) set (as in set VLAN).

-d=<target ip> This indicates the switch (by IP address) to perform the operation on.

-r=<read community> The SNMP read community name (password) to use to discover the switch.

-w=<write community> The SNMP write community name (password) to use to perform any set 
operations on the indicated device.

-p=<port name> The name of the switch port the user is attempting to configure.

-v=<VLAN number> The VLAN number to set the switch port to (or).

-n-<VLAN name> The VLAN name to set the switch port to.
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-e=<end node MAC address> The MAC address of the workstation/server that you want to be put in 
a particular VLAN. In order for the utility to perform this operation correctly, the connectivity of the 
MAC address must have already been assigned using the GUI application. When using this option, 
the user must only supply the SNMP write community (password) and the VLAN (name or number) 
to put the workstation/server in. The CLI application will use its database to lookup the appropriate 
(bound) switch and switch port to provision.

-c=<SNMP retry count> The number of attempts that SNMP should attempt before giving up.

-t=<SNMP timeout>  The SNMP timeout value in milliseconds.

Note Prior to executing any command to provision a switch, that switch MUST be discovered. 
Otherwise, the program will report errors.

Command-line Examples
Discover a Switch
switchcfg.exe -m=discover -d=<target IP> -r=<SNMP read>

Set VLAN on a Switch/Port
switchcfg.exe -m=set -d=<target IP> -w=<SNMP write> -p=<port name> -n=<VLAN 
name>

Set VLAN for a Workstation/Server (End Node)
switchcfg.exe -m=set -w=<SNMP write> -e=<MAC address> -n=<VLAN name>
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Deployment Server Configuration Utility

The Deployment Server Configuration Utility provides general preferences for the Deployment 
Server. You can use the Deployment Server Configuration Utility to: 

• Set up an account for Deployment Server. See Logon Account (page 225).
• Stop, start, and restart Deployment Server.
• View server activity and statistics.
• Map drives to file servers in your Deployment Server system (if you have images stored in more 

than one place). See Drive Mappings Option (page 226).
• Set the communications protocol (multicast or TCP) and set the imaging multicast threshold. See 

Transport Option (page 227).
• Filter connections from the Deployment Server by IP addresses or network adapter interface. 

Connections Option (page 229).
• Set debug and log file options in the Debug Option (page 229).
 

From the main view of the Deployment Server Configuration Utility, you can view Deployment 
Server statistics, start and stop the Deployment Server, access Deployment Server configuration 
options and more.

Log in to the Deployment Server you want to manage. Open the Deployment Server 
Configuration Utility by clicking Start > Programs > Altiris > Altiris eXpress > 
Deployment Server > Configuration. 

Item Description
Server activity 
and statistics

Lists the number of Deployment Server sessions (clients) and Deployment 
Server Consoles currently running on the network.

Start Starts the Deployment Server on the local computer.
Stop Stops the Deployment Server on the local computer.
Restart Restarts the Deployment Server on the local computer.
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Logon Account 
This Service Logon Account dialog is used to set up the user account used by Deployment Server.

To specify or change the Deployment Server service account

1 Open the Deployment Server Configuration Utility in the Control Panel of the Deployment 
Server computer.

2 Click Account.
3 Choose whether you want to use the LocalSystem account or a user-defined account. If you 

choose a user-defined account, you must enter the username and password.
4 Click OK.

General Option 
The General tab provides features to set inventory polling and the timeout value when updating 
connections of managed computers.

Update Inventory. Set the polling intervals to inventory each managed computer for basic hardware 
and software properties. The default value of 24 hours will inventory each computer no more than 
once a day. Set the value to 0 to turn polling off and retain only the values already in the database 
for each managed computer.

Account Opens the Server Login Account dialog box, which allows you to specify the 
account used by the Deployment Server service.
The LocalSystem account requires a simple install that runs Deployment 
Server services on the local computer, prohibiting access to network shares or 
components.
With the LocalSystem account selected, you can click the Allow service to 
interact with desktop box to place an icon in your system tray. This icon allows 
you to quickly shut down the Deployment Server services or to view server 
statistics (just as you can do from the Manage > Services and 
Applications > Services > Altiris eXpress Server service).
 The default setting is to provide a user name and password during installation. 
With this option you can install the service on different computers and access 
components across the network. 

Options Opens the Deployment Server Options dialog, which allows you to specify 
Deployment Server options. 

Item Description
Use the Local System account Specifies that the LocalSystem account should be used by the 

Deployment Server service. You can use this option if your 
Deployment Server directory is located on the same computer 
as the Deployment Server and if you don't need to access any 
other file servers.

Use the following account and 
password

Specifies that a user-defined account should be used by the 
Deployment Server service. If this option is selected, you must 
supply the appropriate username and password. The account 
must have Administrator equivalent rights on the Deployment 
Server computer. You must use this option if your Deployment 
Server directory is located on a different server than the 
Deployment Server.
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An inventory is only executed when the Deployment Agent starts up on the managed computer. As 
a result, if the computer is not restarted for a period of days then no inventory will be taken during 
that time even though the update inventory value is set to 24 hours. When the computer is restarted 
and if the Update Inventory interval has elapsed, then an inventory will be run on the managed 
computer.

Ping Time-out. Set the time-out value when using the Operations > Update all agent connections 
feature or when automatically updating connections (Deployment Solution will automatically 
update connections to client computers after 60 minutes if no activity has occurred). The console will 
send out a packet to the IP address of each managed computer and wait for a response for the length 
of time entered.

Drive Mappings Option 
The Drive Mappings tab is used to add, edit, and delete drive mappings used by the Deployment 
Server. Any drive mappings used to reference files need to be duplicated here. 

For example, if you create a job that distributes software packages from a drive on another file server 
using a mapped G: drive, then you will need to create a G: drive mapping on the Deployment Server 
using this dialog box.

To create a drive mapping

1 Open the Deployment Server Configuration Utility in the Control Panel of the Deployment 
Server computer.

2 Click Options and select the Drive Mappings tab.
3 Click Add.
4 Specify the Drive Letter and UNC Path.
5 Click OK.Click OK.
6 Click Yes to restart the service.

To edit a drive mapping

1 Open the Deployment Server Configuration Utility in the Control Panel of the Deployment 
Server computer.

2 Click Options and select the Drive Mappings tab.

Item Description
Drive Letter and 
UNC Path

Displays the drive mappings with the mapped drive letters and the 
corresponding UNC paths.

Add Opens the Map Drive dialog, which allows you to create a drive mapping.
Driver Letter. Drive letter to which the drive mapping is mapped.
UNC path. UNC path to which the mapped drive points.

Modify Opens the Map Drive dialog, which allows you to edit the drive letter or UNC 
path of the selected drive mapping.

Remove Removes the selected drive mapping.
Data store path Specifies the path to stored packages and files and other DS functions (such as 

license verification). The default path is C:\Program 
files\Altiris\express\Deployment Server.
Note Do not use this setting to change the path to the Client Access Point. 
Modifiying this setting does not automatically allow you to use another shared 
directory other than the express share. To change the Client Access Point 
shared directory, run a Custom install to establish another location for the 
Client Access Point.
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3 Select the drive mapping you want to edit and click Edit.
4 Modify the Drive Letter and UNC Path as desired.
5 Click OK.Click OK.
6 Click Yes to restart the service.

To remove a drive mapping

1 Open the Deployment Server Configuration Utility in the Control Panel of the Deployment 
Server computer.

2 Click Options and select the Drive Mappings tab.
3 Select the drive mapping you want to remove and click Remove.
4 Click Yes to confirm your decision. Click OK.
5 Click Yes to restart the service.

Transport Option 
The Transport tab allows you to specify settings for the Deployment Server transport protocols.

To specify the Deployment Server transport

1 Open the Deployment Server Configuration Utility in the Control Panel of the Deployment 
Server computer.

2 Click Options, and select the Transport tab.
3 Do one of the following, depending on the transport you want to use:

• If you want to use multicast, do not select the Disable multicast support checkbox.
• If you want to use TCP, select Disable multicast support and supply the Multicast Address, 

Multicast Port, Multicast TTL, and TCP Port.
4 Click OK.

Item Description
Disable multicast support 
(agents must connect using 
TCP)

Disables multicast support, which means clients must connect to the 
Deployment Server using TCP.

Multicast Address The multicast address. This is used only if multicast is not disabled.
Multicast Port Port used for the multicast. This is used only if multicast is not 

disabled.
Multicast TTL Specifies the number of "hops" or hubs that the client can go through 

to multicast. This is used only if multicast is enabled.
TCP Port The TCP port. This is used whether multicast is enabled or disabled.
Automatically update 
clients

Automatically updates the Altiris Client for Windows on managed 
computers if there is a difference (older or newer) between the client 
available in the Deployment Server directory and the managed client.

Allow Encrypted Sessions Allows encrypted sessions between the Deployment Agent and 
Deployment Server. If the Deployment Agent data encryption is 
turned on, then this Deployment Server option must also be turned on 
to pass encrypted data between client and server.
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Disk Imaging Option 

The Disk Imaging tab allows you to specify when image multicasting is used and how much 
bandwidth is used during multicasting.

Note When multicasting a disk image using the PXE Server, the boot disk on the PXE Server cannot 
be configured with an Intel Universal NIC driver (also known as an UNDI driver). The multicasting 
feature will be disabled for multicasting because of continued data corruption problems inherent 
with the Intel Universal NIC driver. This unreliability results in random files being corrupted in the 
image file, a problem that may appear immediately or go undetected until accessing the files later. 
As a result, if the computers being imaged are booting to PXE boot files configured with an Intel 
universal driver, then multicasting is disabled and all computers will be imaged using direct 
connections. 

To set when multicasting is used

1 Open the Deployment Server Configuration Utility in the Control Panel of the Deployment 
Server computer.

2 Click Options and select the Disk Imaging tab.
3 Select one of the following depending on when you want to use multicasting:

• If you do not want to use multicasting, select the Use disk image multicast threshold of n clients 
checkbox and set n to 0.

• If you want to use multicasting whenever there is more than one client, do NOT select the 
Use disk image multicast threshold of n clients checkbox.

• If you want to use multicasting only when there are more than a specific number of clients, 
select the Use disk image multicast threshold of n clients checkbox and set n to the number of 
clients there must be more than before multicasting is used.

4.Click OK. 

To set the maximum bandwidth used during multicasting

1 Open the Deployment Server Configuration Utility in the Control Panel of the Deployment 
Server computer.

2 Click Options and select the Disk Imaging tab.
3 Select the Limit each disk image multicast to n Mbps checkbox and set n to the maximum 

bandwidth you want a multicasting operation to use.
4 Click OK.

Item Description
Use disk image multicast 
threshold of n clients

Specifies the number of clients that must be involved in a job before 
image multicasting is used. If the number of clients is less than or 
equal to the number specified, multicasting is not used. Set this value 
to 0 to disable multicasting. If this option is not selected, multicasting 
will be used whenever there are two or more clients.When 
multicasting is not used, all clients become Masters and will read 
from the image server independently. This option might be used if 
your clients can read an image file from the server faster than trying 
to coordinate masters and clients.

Limit each disk image 
multicast to n Mbps

Limits the bandwidth used in a multicasting session to a user-defined 
number of Mbps. This option prevents the multicasting operation 
from using all of the available bandwidth on a network, so other 
network traffic can take place at a reasonable rate.
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Authentication Option 

The Authentications tab allows you to authenticate to an existing SQL Server database and to the 
NetWare Server as a file access point.

Database Authentication

To access and authenticate to a specified Microsoft SQL Server database:

1 Click the Use SQL Server account authentication check box.
2 Enter the user name for the specified database.
3 Enter the password.

NetWare Server Authentication

To access and authenticate to a Novell NetWare Server:

1 Enter the user name for the selected server.
2 Enter the password.

Connections Option 
The Connections tab allows you to allow or reject connections from the Deployment Agents based 
on the IP subnet, IP address, and local interfaces.

Define Subnets 

Select the Allow/reject agents based on their IP subnet box and click the Define Subnets button. 
Click Add or Modify to enter or edit a network IP address and the corresponding mask.

Define IP Addresses 

Select the Allow/reject agents based on their IP address box and click the Define IP Addresses button. 
Click either the Allow or Reject option. Click Add or Modify to enter or edit a specific a range of IP 
addresses to connect to the Deployment Server.

Define Interfaces

Select the Allow/reject agents based on their IP address box and click the Define IP Addresses button. 
Select from the list of network adapter cards to allow or reject when connecting to Deployment 
Server.

Debug Option 
The Debug tab allows you to set debug options for Deployment Server and communication between 
managed computers.

Engine Debug Logging. Select this option to set the name and location of the logging report and the 
logging level for Deployment Server. The Engine Debug Log is a single report that captures debug 
information for Altris support personnel.

Log File Name: Set the path and name for the log text file. The default name is axengine.log in the 
Deployment Server shared directory.
Max File Size: Set the size of the text file by entering the maximum file size allowed.
Logging Level: Enter the logging level. This number can be from 1 to 9, with nine the deepest  
logging level and one the most cursory logging level. Altiris support will instruct you on the 
required logging level for your issue.
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Log Agent Communication with Engine. Select the directory path and name to log error messages 
between managed computers and the Deployment Server.

Log Directory. Set the path of the folder to collect the client error messages. Each managed 
computer will have its own log file in this directory named <the computer ID of the managed 
computer>.log.
Max File Size. Set the size of each log file by entering the maximum file size allowed.
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Imaging with PXE and BootWorks
Deployment Solution provides features to image, or clone, a reference computer or an installed client 
computer’s hard disk and then distribute the image file to another destination computer. This section 
discusses all of the technologies, utility tools and processes used to boot to DOS (required when 
imaging) and run DOS-specific tasks during the imaging process.

 Quick Links

Imaging, PXE Server and 
BootWorks (page 232)

Learn about the basics of imaging, PXE Server, BootWorks, and the 
utility tools and technologies used to run DOS-specific deployment 
tasks.

Using RapiDeploy (page 
252)

Learn the features and details of the RapiDeploy utility tool 
(rdeploy.exe). For reference information, see RapiDeploy 
Technical Reference (page 358).

PXE Configuration Tool 
(page 291)

Learn the features and details of setting up the Altiris PXE Server 
using the PXE Configuration utility tool (PXEConfig.exe). See 
Boot Integrity Services (BIS) (page 238) to set up security for the 
PXE Server.

Boot Disk Creator (page 
275)

Learn the features and details of creating boot disk packages for 
BootWorks (bootwiz.exe).

Altiris ImageExplorer (page 
298)

Learn how to edit image files before distributing to a destination 
computer. 



 

Imaging, PXE Server and BootWorks

Deployment Solution provides patented technologies and utility tools to image managed client 
computers from a Deployment console. Imaging — the process of cloning a hard disk, saving it to a 
file, and restoring all hard disk data to another computer — is performed from DOS, requiring the 
managed computer to boot to DOS before overwriting, or imaging, its hard drive. Deployment 
Solution provides the PXE Configuration tool to configure the Altiris PXE Server to boot the 
managed computer to DOS across the network It also includes BootWorks to boot computers to 
DOS from embedded or hidden partitions on the local drive, and provides the Boot Disk Creator to 
set up boot files. ImageExplorer allows you to edit image files before distributing and restoring a 
destination hard drive.

Imaging is performed using the Altiris RapiDeploy (RDeploy.exe) utility tool, which is accessed 
automatically when running deployment jobs from a Deployment console. For an overview of the 
imaging process, see Imaging (page 232). For an overview of the RapiDeploy utility tool, see Using 
RapiDeploy (page 252).

The Altiris PXE Server allows client computers to boot up to DOS over the network and run DOS-
specific deployment jobs for computers that support Intel's PXE (Pre-boot Execution Environment) 
technology. This eliminates the need to have an operating system or BootWorks on the hard drive 
or to visit each managed computer with a DOS floppy disk. To run PXE Server you must also install 
a DHCP Server. For an overview of PXE and the Altiris PXE Server, see Pre-boot Execution 
Environment (PXE) (page 235). For in-depth information about the PXE Configuration utility 
program used to manage and configure the PXE Server, see the PXE Configuration Tool (page 291). 

Altiris BootWorks is a patented technology that allows you to boot to DOS from a partition on the 
local drive. From the BootWorks partition you can install the Deployment Agent for DOS 
(bootworks.exe) on the on the local drive to manage the client computer when imaging the hard 
drive and assigning deployment jobs in DOS (see Installing Deployment Agent for DOS 
(BootWorks) (page 72)). BootWorks allows the client computer to log in to a file server to download 
packages and run DOS-specific deployment jobs. For an overview of BootWorks, see BootWorks 
(page 240). For in-depth information about the Boot Disk Creator utility program used to manage 
and configure BootWorks technologies, see the Boot Disk Creator (page 275).

Altiris ImageExplorer is an editing tool for image files. After capturing an image of a hard drive, you 
can save it as an IMG or EXE file and then edit the image file by adding or deleting content files. 
See Altiris ImageExplorer (page 298) for in-depth information.

Imaging 
Imaging technology allows you to capture the complete contents of a hard disk — including its 
configuration settings, data and applications — into an image file and store it on the Client Access 
Point (or another file server, CD, or the local hard drive). When the same or another computer needs 
to be set up using the same hard disk contents, Deployment Solution converts the image back to its 
original form on the selected client computer. From a Deployment console you can remotely boot 
the computer to DOS using PXE or BootWorks technologies, distribute the image file, and deploy 
the hard disk image.

Imaging is fast. A Windows 2000 Professional on a computer using an image can take only about 8 
to 10 minutes. Installing the same OS using the standard installation methods, such as a scripted 
install or a conventional installation process, takes over one hour. Imaging from a Deployment 
console takes full advantage of multicasting technologies to deploy multiple computers 
simultaneously.
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Setting up and deploying servers through an imaged installation speeds server deployment because 
it lays down data quickly using sector placement technology. Also, images can include more than 
just the operating system, but also print drivers, applications, data files, configuration settings of all 
types and more. After the image is deployed, the computer can be fully functional and ready for use 
after post-configuration operations.

You can easily manage most imaging tasks from the Deployment Server Console. However, you can 
also image at the client computer from DOS running RDeploy.exe. See Using RapiDeploy (page 
252).

Imaging Basics
Imaging a computer overwrites the hard disk of the destination computer with the contents of an 
image file, which was created by capturing a hard disk image of a source computer. It makes a 
“clone” of one computer’s hard disk and transplants it to another computer’s hard disk, regardless 
of the existing partition configuration. You can capture hard disk images from a source or reference 
computer and then distribute the image to other client computers. This allows you to quickly deploy 
new computers or restore existing managed computers.

When you save an image of a source computer, the operating system, applications, and all data is 
included in the image file (an IMG or EXE file), including registry settings, IP address, computer 
name and configuration settings. Likewise, all of that data is included when the disk image is 
restored to a destination computer, including the settings and configurations of the source computer. 
To ensure that newly-imaged destination computers have their own unique settings, you can easily 
set up a simple post-configuration task to set a unique IP address, name, and other settings on the 
newly-imaged client computers.

By default, images are multicast to managed client computers. See Multicasting to Deploy Images 
(page 234) for more information about multicasting.

How Hard Disks Are Read
Hard disks are imaged differently depending on the file system. In each instance, the source disk and 
partitions remain unaltered.

FAT 12, 16, 32, and NTFS. Imaging is file-based. Data is copied file by file, resulting in a clean, 
defragmented image that can be resized and restored to a drive of a different size.

NetWare. Imaging is done sector by sector. NetWare images can be optimized if you first run an 
NWPREP module at the NetWare console. Running NWPREP before creating an image also makes 
downloads faster. This prepares all of the volumes currently mounted on the server.

• Use NWPREP.NLM for NetWare 4 and NetWare 5 servers
• Use NWPREP3.NLM for NetWare 3 servers
To use an NLM, copy it to a disk or to a file on the server and follow the normal procedure for 
running an NLM. For example, if you have the module on a disk, insert it at the NetWare console 
and type:

load a:nwprep

Other file formats. For HPFS (OS/2), UNIX and other file systems, the disk is read sector by sector, 
regardless of which sectors are in use. The image mirrors the contents of the hard disk. These formats 
are not resizable. The partition you image must be the same size as the original image or larger. Post-
configuration is not available for these images. 

Images created from FAT, NTFS, and NetWare file systems are drive geometry independent. Other 
file systems, such as UNIX and HPFS, are drive geometry dependent. This means that the disk size, 
number of heads, cylinders, and sectors of the client computers must be the same as the imaged hard 
disk.
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How Partitions Are Managed
You can capture an image of a partition, a group of partitions, or an entire hard drive. The partition 
size percentage of the client computers will be the same as the image source. For example, if you 
image a 1 GB hard disk where 40 percent (400 MB) of the drive is a Windows NT partition and 60 
percent (600 MB) is a Windows 98 partition, a client computer with a 2 GB drive will use the same 
percentages. The size of the Windows NT partition will be 800 MB and the Windows 98 partition 
will be 1200 MB.

Note The only exception to this is the Bootworks partition. If a BootWorks partition is part of the 
image, it will retain its original size.

When a client computer is imaged, all existing partitions are overwritten by default except two:

• BootWorks partition
• COMPAQ system partition
You can overwrite either of these partitions by selecting the appropriate option in the Deployment 
Server Console when you create the imaging job.

Partition slots on the client computers will be the same as the image source. A partition occupying 
slot 3 in the image file will be in slot 3 on the clients.

Image Files
When you create an image file, you can make either a regular image file or a self-extracting 
executable file. You can name the image file with the appropriate extension (IMG) when you create 
the image file, or you can use RapiDeploy to convert an existing image file to an executable (EXE) 
file.

For computers connected to your network a regular image file (IMG) works well. For computers that 
are not connected to your network, such as notebooks and desktops in branch offices, create a self-
extracting image file (EXE). You can copy it to a bootable media, and remote users can use the 
executable image file to configure their computers. The EXE file include a run-time version of 
RapiDeploy. You can edit image files using the Altiris ImageExplorer (see Altiris ImageExplorer 
(page 298).

Using Command-line Switches with Executable Images
In rare cases, you might need to use switches with executable image files. Valid switches are: -sz, -
d, -r, and -b. Multiple switches can be used on the same command line and their order does not 
matter. As with other switches, you can use them on the command line or in a batch file.

In addition, you can use the -force switch, which bypasses the default screen that prompts the user 
before imaging begins. 

Example If you named your self-extracting file BASEIMAG.EXE when you created it, you would 
type the following on the command line or in your autoexec.bat file:

baseimag.exe -force

You can combine this switch with any of the other switches. See Running RapiDeploy from the 
Command-line (page 359).

Multicasting to Deploy Images
The imaging programs use multicasting to deploy images to groups of computers. When a multicast 
session is started, one of the client computers is designated to be the Master computer. The Master 
computer manages the multicast session. It downloads an image from a file server (or uses the image 
on its hard drive) and manages the simultaneous imaging of the client computers.

Note The Master computer is any client computer running ibmaster.exe; clients are any 
computers running ibclient.exe. The Deployment Server assigns a computer to be the Master 
when a multicast session is started.
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How Multicasting Works
• The multicast transmission is synchronized by the Master computer, so it will only go as fast as 

the slowest computer in the group.
• If a computer fails, it will drop out of the session and the session will continue. The computer’s 

status will show that the job did not complete successfully.
• You determine when multicasting is used by setting the number of computers needed to start a 

multicast session. When imaging is started, the Master computer waits 5 minutes for clients to 
connect. If fewer than the minimum number of computers connect within 5 minutes, the clients 
will be imaged via direct downloads from the server.

• You can only multicast to computers on the same network segment, because most routers and 
switches do not allow multicasting. To image computers on another segment, run a separate job 
on that segment and connect the clients directly to the Deployment Server instead of multicasting 
to connect.

Pre-boot Execution Environment (PXE)
Pre-boot Execution Environment (PXE) technology allows computers to boot up through the 
network adapter card using Intel Wired for Management technology. PXE uses industry-standard 
protocols (TCP/IP, DHCP, and TFTP) to create a channel that communicates between the managed 
client computer and a PXE Server at startup. Deployment Solution includes the PXE Server to 
manage computers in a DOS environment to image hard disks, save registry settings, and perform 
other DOS-specific operations scheduled from a Deployment console. See PXE Server (page 58) for 
additional information.

Wired for Management requires special system-compliant components such as motherboards, 
network adapters, BIOS, Power Supplies, and SMBios. Most of the newer commercial computers 
sold today are Wired for Management compliant.

With PXE, the network adapter card becomes a boot device like a hard drive, floppy, or CD-ROM 
can be a boot device. Since most new computers ship as PXE-compliant systems, you can have 
immediate access to the network regardless of the contents of the computer’s hard drive. PXE 
protocols provide a channel of communication between the PXE Server and a PXE client using the 
network adapter card. This channel can then be used to send needed information to the computer 
even in the absence of any data on the hard drive.

PXE is designed to work using industry-standard Internet protocols and services widely 
implemented in the industry today, including TCP/IP, DHCP, and TFTP.

Important If you install BootWorks to the hard drive of a computer instead of using PXE to 
download BootWorks, you must disable PXE on that computer before installing BootWorks to the 
hard drive. Failure to do so could corrupt the master boot record. If you are using PXE on a client, 
do not install BootWorks on the hard disk.

Support for Wake On LAN and PXE
The Altiris Deployment Server is fully enabled for PXE and Wake On LAN. PXE downloads the 
needed files (including BootWorks) to the RAM of the computer that creates a virtual floppy disk. 
After it boots to DOS you can perform all of the work needed to image the computer. Client 
computers that support the Wake On LAN functionality can also be powered on from a Deployment 
console. If a computer has been set to use PXE, this wake up will initiate the PXE process.

For example, from a Deployment console you can schedule a job for a specific time. When the time 
arrives for the job to start, Deployment Server sends a wake-up packet (magic packet) to the 
computer. This wake-up packet turns the computer on and runs the job.

To set security on PXE, see Boot Integrity Services (BIS) (page 238). 

PXE Requirements
For PXE to function properly in an Deployment Server system, you must meet the following 
requirements:
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• The Altiris PXE Server(s) must be able to communicate with the client computers that intend to 

use PXE.
• A DHCP server must be available to all client computers. 
• Although a DHCP server must be able to assign IP addresses to the computers being managed 

while they are in a DOS mode for PXE to function, the computers being managed can use static 
IP addresses while they are in a Windows mode. 

• The client computers must be PXE-compliant, and in most cases you will need to go into the 
computer’s BIOS settings and enable this feature (set PXE to be the primary boot option). Since 
all computers are not the same, check your computer’s hardware setup manual for details on how 
to enable PXE.

• PXE Server can only be installed on a Microsoft NT server operating system: NT v4, Windows 
2000 Server and Advanced Server, and Microsoft Server 2003 Server. 

PXE Configuration Utility
The PXE Configuration Utility runs on the Altiris PXE Server, allowing you to change server 
settings or modify the PXE boot files. This utility program allows you to perform the following:

• Modify the PXE boot files (network driver, IP information, etc.) used by managed and new 
computers.

• Manage boot menu options.
• Control which client computers your PXE Server will respond to (for installations with several 

Deployment Server systems on the same network).
Note Configuration changes to the PXE Server cannot be done remotely. They must be performed 
from the PXE Configuration tool on the PXE Server.

See PXE Configuration Tool (page 291) for detailed instructions.

How PXE Works
When a PXE-enabled computer boots, it requests and obtains an IP address from a DHCP server. It 
also receives information (a boot strap program and menu) from a PXE Server enabling the PXE-
enabled computer to be managed.

PXE steps of execution
1 The PXE-compliant computer boots and the PXE agent in the network card initializes its TCP/

IP stack in RAM and sends a DHCP packet with its MAC address requesting an IP address. Some 
PXE client data is included in the DHCP optional identifier field.

2 The DHCP server replies to the DHCP request with an IP address and Netmask.

The “PXE Client” data is
added to the optional identifier
field In the DHCP request

DHCP request + options1

The “PXE Client” data is
added to the optional identifier
field In the DHCP request

DHCP request + options1

The “PXE Client” data is
added to the optional identifier
field In the DHCP request

DHCP request + options1

IP Address sent to Computer2 IP Address sent to Computer2

PXE Menu Sent and Bootstrap
program sent and executed3 PXE Menu Sent and Bootstrap
program sent and executed3PXE Compliant

Computer
PXE
Server

DHCP
Server
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3 The PXE Server also hears and responds to the DHCP request but only sends the PXE menu (no 

IP address). This menu is stored in the RAM of the PXE-enabled computer. 
A boot strap program called Bstrap.0 is also sent and executed. This program tells the PXE-
compliant computer to read and use the PXE menu. The PXE menu is displayed on the client 
computer’s screen if the computer does not exist in the Deployment Database. If the client computer 
is in the Deployment Database, one of the PXE menu options is automatically selected.

The PXE Menu
When using PXE Server, there will be times that you will see a PXE menu displayed on the screen 
of a computer that has just been turned on. This menu gives you the ability to perform different tasks 
on this computer according to your needs; therefore it is important to understand when and why you 
will see this menu and what to do when it is displayed.

PXE Menu Display Options
The PXE boot menu automatically displays on a managed client computers screen if:

• The managed computer supports PXE.
• PXE has been set as the primary boot option for the client computer.
• The client computer is not currently registered in the Deployment Database.
• Initial Deployment has not been disabled and has not been changed from the default setting.
The PXE boot menu can be displayed manually if you press a Boot from the network key when 
prompted. This is available on most computers and is typically the <F12> key.

If the PXE client is in the Deployment Database, then the appropriate PXE menu option is selected 
automatically and the menu is never displayed. This means that the Local Boot option will be chosen 
when no jobs have been assigned to the computer. If a job has been assigned to the computer, then 
the Altiris BootWorks (Managed PC) option will be selected.

Intel UNDI, PXE-2.0 (build 071)
Copyright © 1997,1998,1999   Intel Corporation
DHCP MAC ADDR: 00 00 1b 32 33 87
CLIENT IP: 11.11.11.1 MASK: 255.0.0.0 DHCP IP: 

11.11.11.30

Press [F8] to Select a boot option
Altiris BootWorks (Initial Deployment)
Local Boot
Altiris BootWorks (Managed PC)
Install BIS Certificate

Intel UNDI, PXE-2.0 (build 071)
Copyright © 1997,1998,1999   Intel Corporation
DHCP MAC ADDR: 00 00 1b 32 33 87
CLIENT IP: 11.11.11.1 MASK: 255.0.0.0 DHCP IP: 

11.11.11.30

Press [F8] to Select a boot option
Altiris BootWorks (Initial Deployment)
Local Boot
Altiris BootWorks (Managed PC)
Install BIS Certificate

– The computer supports 
PXE

– PXE has been set as the 
primary boot option

– The computer is not 
currently registered in the 
Deployment Server 
Database

– The Altiris eXpress PXE 
Server has been installed

• A PXE menu is displayed on a PXE 
compliant computer when:
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With the menu displayed, the following options are available:

• Altiris BootWorks (Initial Deployment)
• Local Boot
• Altiris BootWorks (Managed PC)
• Install BIS Certificate

Altiris BootWorks (Initial Deployment)
When this option is chosen, the computer will execute Initial Deployment (page 178) if the computer 
is not in the Deployment Database. By default, Initial Deployment is empty and must be configured 
by the administrator before any tasks are executed through this option.

Local Boot
When this option is chosen, the computer is booted from the operating system currently installed on 
the computer’s hard drive. If an operating system does not exist, an error message is displayed.

Altiris BootWorks (Managed PC)
This option assumes the computer is in the Deployment Database, and when chosen will execute any 
job assigned to it. If no matching computers are found, all virtual computers created will be 
displayed. Selecting a virtual computer will tell the Deployment Server to perform any pre-assigned 
tasks.

Virtual computers are computers that exist in the Deployment Server Database but may or may not 
physically exist. Virtual computers can be created so you can pre-assign jobs to them in anticipation 
of their arrival.

Install BIS Certificate
This options allows you to complete the BIS (Boot Integrity Services) installation process. Choose 
this option only after you have completed the first part of the BIS installation. See Boot Integrity 
Services (BIS) (page 238) for additional information. 

Boot Integrity Services (BIS)
Pre-boot Execution Environment (PXE) (page 235) is potentially vulnerable to hackers, especially 
in security-conscious business and government settings not willing to risk network boot ups unless 
safeguards are in place. For example, it is important ensure that the boot image comes from a trusted 
source and has not been tampered with in transit. You can also designate and enforce which boot 
images can be installed on selected groups of platforms. Boot Integrity Services (BIS) addresses 
these security needs for Altiris. 

Intel UNDI, PXE-2.0 (build 071)
Copyright © 1997,1998,1999   Intel Corporation

DHCP MAC ADDR: 00 00 1b 32 33 87
CLIENT IP: 11.11.11.1 MASK: 255.0.0.0 DHCP IP: 11.11.11.30

Press [F8] to Select a boot option
Altiris BootWorks (Initial Deployment)
Local Boot
Altiris BootWorks (Managed PC)
Install BIS Certificate
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BIS enhances the network boot environment by providing mechanisms to validate the source and 
integrity programs and data downloaded over the network prior to the time an operating system is 
installed. Using BIS firmware built into the client computer, BIS can validate (before executing a 
boot image) that the image came from a trusted source and was not tampered with en route.

Deployment Server supports the BIS technology. However, the BIS support from Altiris is only 
applicable when the computers being managed also supports BIS. Even if BIS is configured from 
the Deployment Server console, BIS will not work unless the physical computer supports it. At the 
present time, there are very few computers that support BIS.

If you are using PXE boot files to manage your computers and you want to secure the computers so 
they accept only certified images, you can set up BIS configuration boot files and certificates to do 
this. BIS allows you to "sign" boot files stored on the PXE Server with a certificate. Managed 
computers can be set up to accept only boot files that have the correct certificate.

Warning Once a certificate is installed, managed computers will require boot files with the 
certificate they are assigned. If you delete the certificate from the PXE Server, the client will not 
boot. If you want to remove a certificate, you must uninstall it from the managed computer before 
deleting it from the PXE Server.

Requirements
• Your hardware (managed computers and PXE Server) must be PXE and BIS compliant.
• PXE must be installed in your Deployment Server system.
• You can have only one PXE Server on your network.
• You must have a Deployment Server Console installed on the PXE Server. 

Create a BIS configuration Boot File on the PXE Server
1 Start the Boot Disk Creator on the PXE Server.
2 Click Tools > Create BIS Config Image.
3 The Create Image screen appears, showing the path where the file will be created. (The path and 

filename are not modifiable.) 
4 Click Next to create the BIS boot file.

Set up the Certificate/Signature on the PXE Server
1 From the Console on the PXE Server, choose Tools > BIS Configuration.
2 Enter your password and choose Create.
3 Click Sign Boot Images > Close.

Install the certificate on managed computers
1 Reboot the managed computer.
2 When prompted to Select boot option (F8 for menu), press F8.
3 From the boot menu, choose Install BIS certificate.
4 At the Console on the PXE Server, locate and select the computer in the Computers list.
5 Select Advanced > Install BIS certificate from the menu.

The Boot Integrity Services (BIS) tool can be launched by clicking its icon 
on the toolbar of the Deployment Server Console or by clicking the Tools > 
BIS Configuration command.
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Disabling BIS Support
If BIS technology is not being used, the Deployment Server console can be configured to not load 
the BIS module, reducing the amount of time it takes to load the Deployment Server console. 

This is accomplished by renaming or deleting the AltBIS.dll file located in the Deployment 
Server directory on the Client Access Point.

Trying to configure BIS after it has been disabled using this method will result in the following error:

To re-enable BIS, restore the AltBIS.dll file to its original place or name.

BootWorks
BootWorks, like PXE Server, overcomes one of the major disadvantages when imaging computers: 
Instead of physically visiting each client computer and manually booting with a floppy disk to clone 
disk images and restore registry or data files to destination computers, you can perform these types 
of tasks remotely from a Deployment console.

Important If you install BootWorks to the hard drive of a computer instead of using PXE to 
download BootWorks, you must disable PXE on that computer before installing BootWorks to the 
hard drive. Failure to do so could corrupt the master boot record. If you are using PXE on a client, 
do not install BootWorks on the hard disk.

BootWorks is often referred to in one of two ways:

As a Program. BootWorks is an executable program that allows a remote computer to check with 
the Deployment Server to see if any work has been assigned to it. This is the Deployment Agent for 
DOS (BootWorks). See Installing Deployment Agent for DOS (BootWorks) (page 72) and 
Deployment Agent Settings for DOS (BootWorks) (page 127).

As a Process. In most cases, when someone is using the term BootWorks, they are usually referring 
to a suite of programs and steps enabling the bootwork.exe program to function to its full extent. 
For the purpose of this section, BootWorks will be referred to using this definition.

When to Install BootWorks on a Hard Drive
Installing BootWorks on a hard drive is only needed when you can not or choose not to use the PXE 
process or if you want to store images in a BootWorks partition.

For example, if your computers are old and do not support PXE, you will have to install BootWorks 
on the hard drive, usually using the embedded BootWorks method. As another example, if the 
computers being managed are spread throughout a large diverse network, with many routers and 
perhaps many different types of network cards, you may find it easier to install Bootworks on the 
hard drive instead of using PXE. BootWorks can easily be installed (remotely) to all of your 
computers that are running Windows.

When you are setting up a new hard drive that does not have a Windows operating system installed 
and you are not using PXE, you will need to use a BootWorks boot disk or install an operating 
system and BootWorks before the computer can be fully managed.

Note: For Windows NT, embedded BootWorks partions will not boot if the partion starts at a size 
larger than 2 GB. In most cases you will not want to use a hidden Bootwork partition with Windows 
NT.
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Using BootWorks Partitions
You will normally only use a BootWorks partition when you want to save images to this partition.

How Does the BootWorks Process Work?
BootWorks acts like a virtual floppy disk allowing a computer to load all of the needed files and 
complete all of the needed steps to allow the computer to check with the Deployment Server to see 
if a job has been assigned to it. If needed, the BootWorks process helps the computer log in to a file 
server to download any needed programs or files needed to complete the assigned job.

BootWorks is needed when you are creating or deploying images and/or when you are backing up 
or restoring a computer’s registry file. To fully and remotely manage a computer with the 
Deployment Server, you must use BootWorks.

Note You cannot use Window ME when providing the DOS information for BootWorks. Altiris 
suggests that you use Windows 98 DOS.

Deployment Agent for DOS (BootWorks) and Deployment Agent for Windows (AClient) perform 
a few of the same types of functions. For example, as with the Deployment Agent for Windows 
agent, the Deployment Agent for DOS will add a computer to the Deployment Database if the 
computer does not already exist in the database. It will also locate and communicate with the 
Deployment Server.

BootWorks can be executed on a managed computer from: 

• The RAM of the managed computer after being downloaded using PXE.
• A BootWorks boot disk.
• An embedded area of an operating system on the client’s hard drive.
• A BootWorks partition on the client’s hard drive.

The BootWorks Boot Process
When BootWorks is installed on a computer’s hard drive, that computer will boot differently when 
a job has been assigned to it because the computer will need to run the BootWorks process in order 
to complete the job. This is sometimes referred to as “booting to BootWorks.”

The following is a description of how a computer determines if it should boot to BootWorks.

When a computer is turned on or rebooted, it checks the master boot record to see what partition it 
should boot from. When BootWorks has been installed on a computer’s hard drive, that computer 
could boot from a BootWorks partition, embedded BootWorks (also referred to as a BootWorks 
partition), or from the production partition (such as a Windows partition). 

The production partition is defined as the partition the computer would normally boot from if 
BootWorks was not installed on its hard drive. The production partition is normally a Windows 
partition, but could be a DOS, NetWare, or any number of other types of operating system partitions.

Deployment Agent for Windows has the responsibility to configure the computer to boot to the 
correct partition. This is accomplished by changing the master boot record. When a computer boots 
to Windows and the Deployment Agent for Windows is started, it checks to see if any jobs are 
assigned to this computer. 

When A Job Has Been Assigned
When a job has been assigned to the computer, Deployment Agent for Windows changes the master 
boot record, instructing the computer to boot to BootWorks the next time it is started. The computer 
is then restarted, the computer boots to Deployment Agent for DOS, and the BootWorks process is 
started.
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When No Job Has Been Assigned
When no job has been assigned to the computer, Deployment Agent for Windows changes the 
master boot record, instructing the computer to boot to the production partition the next time it is 
booted. The next time the computer is rebooted or is turned off and powered back on, it will boot to 
the production partition instead of the BootWorks partition.

How BootWorks Connects to Deployment Server
If a client computer is booted with a BootWorks disk, all drivers are loaded and a full login takes 
place, regardless of the work assigned. The boot disk maps a drive to the Deployment Server and 
runs Deployment Agent for DOS, which connects to the Deployment Server to check for work.

If a computer boots from a BootWorks partition, the process is slightly different. Only the required 
LAN drivers are loaded and communicate with the Deployment Server (from the autoexec.bat 
file), then Deployment Agent for DOS will run. It registers the client’s MAC address, computer 
name, IP address, etc., and checks for work from the Deployment Server.

• If no work is assigned, Deployment Agent for DOS exits and the computer boots to Windows. 
• If work is assigned, Deployment Agent for DOS exits and the rest of the network drivers load. 

Deployment Agent for DOS is reloaded, registered with the Deployment Server, and the user 
login is completed. Deployment Agent for DOS receives and processes the assigned tasks. When 
all tasks are completed, the Deployment Agent for DOS logs out and the computer boots to 
Windows.

How BootWorks Processes Jobs
The following steps outline the basic process of how a computer will boot when Deployment Agent 
for Windows has instructed the computer to boot from Deployment Agent for DOS after a job has 
been assigned to the computer:

The following steps assume that the computer being managed is in the Deployment Database and 
that BootWorks has been installed on the client computer’s hard drive either as a partition or using 
the embedded method.

• A job is assigned to a computer and the computer is then rebooted, or powered on.
During this process, Deployment Agent for Windows changes the master boot record of the 
computer, allowing it to boot from BootWorks (a BootWorks partition or Embedded 
BootWorks) as described above. The production partition is marked as a non-DOS partition.

• The DOS operating system, network drivers and TCP/IP are loaded from the BootWorks 
partition or from Embedded BootWorks (bad block area).

When you installed Deployment Solution, you were asked to provide a bootable DOS diskette or 
Windows CD. The version of DOS used during this process is dependent on the files provided at that 
time. 

1 BootWorks.exe is executed and the Deployment Agent for DOS checks with the Deployment 
Server (using a socket connection) to see if there is work to do. If there is work to do, Deployment 
Agent for Windows is installed and the computer loads a few more networking programs, 
allowing the computer to log on to the Deployment Server Client Access Point.

2 Deployment Agent for DOS is executed again and downloads the programs and/or files needed 
to perform the tasks assigned to the computer from the file server and executes these programs 
(such as RapiDeploy).

3 Deployment Agent for DOS communicates with the Deployment Server and confirms success or 
failure of the task and the Deployment Server console is updated.

4 The BootWorks partition is marked as a Non-DOS partition and the production partition is 
marked as the bootable partition.

5 The computer now reboots to the production partition. 
6 If you are at a client computer and want to force it to boot to Bootworks, turn on your computer 

and look for the word BootOrg to be displayed in the upper right-hand corner of the screen (this 
happens very quickly, so watch closely). When you see BootOrg, then press the Ctrl + Alt + Del 
keys to force a reboot. On the next boot, Deployment Agent for DOS will now run.
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Create and Install BootWorks Boot Files

To install BootWorks using an existing configuration, follow these steps. To install BootWorks 
remotely on Windows NT or 2000 computers using defaults, right-click on a computer or group at 
the Deployment console and click Advance > Install BootWorks. This installs BootWorks using 
default configuration information (entered when you installed Deployment Server), and settings 
from Deployment Agent for Windows running on the computer. 

1 From the dialog box that appears after you create a configuration, select the type of boot files you 
want to make. 
or, 
From the task bar, choose the media/boot file type you want to create (disk, boot file, or windows 
install package) and then choose the configuration file you want to use. Configuration files are 
somewhat dependent on the boot file type; configurations do not work with all boot file types.
Note If you have not created a configuration yet, choose New Configuration from the taskbar and 
complete the steps in “Create a New Configuration,” above.

2 Follow the prompts to create the boot file.
• To install BootWorks on Windows 95, 98, or Me computers, create boot disks to install locally.
• To install BootWorks boot files for PXE, create PXE files on the computer that is your PXE 

Server.
• To install BootWorks on Windows NT/2000/XP/2003 computers, you can create a Windows 

Install Package and include it in a deployment job that you deploy from the console. 

Accessing BootWorks Through PXE
If your computers are PXE-compliant and enabled to boot to PXE first, then BootWorks does not 
need to be installed on the client computer’s hard drive. Instead, the BootWorks data or image is 
created and stored on the PXE Server. This is accomplished automatically when you install 
Deployment Solution and choose to install a PXE Server. This method of accessing BootWorks is 
the easiest and preferred method of accessing BootWorks.

BootWorks will be executed on a PXE enabled client in one of two ways, automatically through 
PXE, or manually through a menu.

Running BootWorks Automatically Through PXE
If the client computer is in the Deployment Database and a job has been assigned or scheduled for 
that computer, then BootWorks will automatically be downloaded and executed from the RAM of 
the client’s computer as needed. If no jobs have been scheduled for the computers in the Deployment 
Database, then PXE will boot to the local operating system instead of downloading BootWorks.

BootWorks
Image

BootWorks
Image

eXpress
PXE Server

Downloaded to 
computers as needed

PXE Enabled Client

Initial Deployment
Local Boot
Managed PC
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Manually Through a Menu
If the client computer is not in the Deployment Database, then a PXE menu will be displayed on the 
client computer. The PXE menu consists of the following four options: 

• Altiris BootWorks (Initial Deployment).
• Local Boot.
• Altiris BootWorks (Managed PC).
• Install BIS Certificate.

BootWorks Boot Disks
You will only access BootWorks using this method when PXE Server is not installed. BootWorks 
can be executed from a floppy disk in one of two ways:

• From a BootWorks disk.
• From a BootWorks boot disk set to run Initial Deployment.

Starting up from a BootWorks Disk
The floppy disk method can be used any time you want; however, it is typically used only when you 
need to re-image a computer where the hard disk does not contain BootWorks and/or PXE is not 
available. 

For example, if the hard drive on an existing non-PXE managed computer (a computer in the 
Deployment Database) goes bad, you would need to replace it with a new one. After the hard drive 
had been replaced and a re-imaging job had been assigned to the computer, you can boot this 
computer from a BootWorks boot disk. When the computer is turned on, the BootWorks floppy disk 
functions as if BootWorks had been installed on the hard drive (or as if you were using PXE Server), 
allowing the computer to be re-imaged. After the drive has been re-imaged, the floppy disk is taken 
out and the computer is then booted to its normal Windows operating system. 

Running Initial Deployment from a Floppy Disk
This type of boot disk works just like the normal BootWorks boot disk, except it can only be used 
on computers that are not in the Deployment Database. As the name implies, this type of disk will 
automatically run Initial Deployment (page 178). Initial Deployment is a default job that will always 
be on your system. By default this job is not configured; therefore you must set or determine what 
you want this job to do (what job or task you want the computer to perform) before you use this type 
of disk.

How To Edit the BootWorks Autoexec.bat File
1 Press <F8> while the computer is booting to break into the boot process. The DOS Startup menu 

appears.
2 Select Step by Step confirmation on the menu.
3 Type N at the prompts until you get to the BootWorks files.
From BootWorks, use a DOS editor to edit the autoexec.bat file.

Embedded BootWorks
BootWorks can be installed in a small area of an existing Windows operating system. This is referred 
to as Embedded BootWorks. You will only access BootWorks using this method when you cannot 
or choose not to use PXE.

When installed, this area is marked as a bad sector. As a result, disk utilities such as FDISK.exe or 
the NT disk administrator cannot see into, access, or remove this area after it has been installed. This 
area is formatted with a DOS version of your choice such as (Windows 98) and functions like a 
normal floppy disk would (a virtual floppy disk).
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When installed, the computers can be managed from the Deployment Server console and can be re-
imaged without the need to visit the computers.

Methods of Installation
The embedded BootWorks area can be remotely installed on the client computers from a 
Deployment console as long as Deployment Agent for Windows has been installed on the computer 
where BootWorks is being installed. Embedded BootWorks can also be installed through other 
methods such as using e-mail, login scripts, or using a floppy disk.

The size that the embedded BootWorks area will take will vary a little depending on they type of 
drive you have. Typically, it is about 5 MB is size.

BootWorks Partitions - Local Image Store
You will only access BootWorks using this method when you cannot or choose not to use PXE and 
you want to store images on the client’s local hard drive.

BootWorks can be installed as a semi-hidden partition on the hard drive. This methods allows you 
to enlarge the size of BootWorks up to 2 GB. This allows you to save data, usually images, to this 
partition. When you create a job to save or retrieve an image from the BootWorks partition, the 
BootWorks partition is referred to as the Local Image Store. The Local Image Store is an area where 
you store images that is different than the original Client Access Point. 

A Semi-Hidden Partition
When the computer has booted to its normal operating system, the BootWorks partition is semi-
hidden. Semi-hidden means that a user, while in their Windows operating system, cannot access the 
BootWorks partition. If they were to open a DOS box, they would not see a drive letter assigned to 
this partition.

FDISK or the NT Disk Administrator can see the partition, but it is listed as a non-DOS partition. 
When a BootWorks partition has been installed, the computers can be managed from the 
Deployment Server console and can be re-imaged without the need to visit the computers.

Local Image Store
Sometimes a computer is used by many people as a temporary work station. The Local Image Store 
method is a great way to ensure that this computer is always in good working order without using 
any bandwidth.

For example, you may have a computer set up in your area (like in a hotel room or library) that 
visiting employees, students, or customers could use. After the visiting person is done using this 
machine, you may want to quickly re-image the computer to ensure that the next visitor finds the 
computer in good working order. A job can easily be created that could be executed when needed to 
perform this task.

The advantage of this method is that while the computer is being imaged, there is no network traffic.

This method is most useful when bandwidth is an issue and/or the file server where you store your 
images is only available through a slow connection, such as a dial-up connection.

BootWorks and Imaging
When imaging computers where BootWorks is involved using the embedded BootWorks method 
(see Embedded BootWorks (page 244)) or when using a BootWorks partition (BootWorks Partitions 
- Local Image Store (page 245)), the following rules apply:
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• When an image is created of a computer that has BootWorks installed, BootWorks will not be 
included in the image unless the -pb switch is used. When using a job to make an image of a 
computer, this switch is automatically used but is not seen in the GUI interface used to create the 
job. 

• When an image is deployed to a computer that already has BootWorks installed on it, the existing 
BootWorks information on the destination computer will not be overwritten unless the -rb switch 
is used. The -rb switch is used when the Remove BootWorks Partition option is checked.

• When an image containing a BootWorks partition is deployed to a computer that does not have 
BootWorks installed on it, the BootWorks information will be installed and will work correctly 
as long as the BootWorks information contained in the image is correct for the type of network 
interface card (and other BootWorks information) that is on the computer the image is being 
deployed to.

• When an image is deployed using the -nobw switch, the destination computer will not contain 
any BootWorks information (after the imaging has been completed) regardless of whether the 
image or the destination computer contained BootWorks before the image was deployed.

See also Bootworks Command-line Switches (page 336).

Command-line switches can be added to the applicable imaging job by selecting the Advanced button 
and adding the switch to the Additional command-line switches/options box as shown. 

BootWorks MBR

Embedded 
BootWorks

BootWorks MBRBootWorks MBR

Embedded 
BootWorks

The -pb switch will include 
BootWorks in the image
The -pb switch will include 
BootWorks in the image

The -nobw switch remove  
BootWorks from the destination 
Drive whether the image has 
BootWorks in it or not

The -nobw switch remove  
BootWorks from the destination 
Drive whether the image has 
BootWorks in it or not

BootWorks MBRBootWorks MBR

Server

The -rb switch will remove 
BootWorks or allow exiting 
BootWorks to be overwritten

The -rb switch will remove 
BootWorks or allow exiting 
BootWorks to be overwritten

Images
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Troubleshooting BootWorks
The following section provides help in locating and fixing BootWorks problems. 

BootWorks Diagnostic Utility
The BootWorks Diagnostic Utility allows you to locate and fix BootWorks problems in DOS. 

1 At the computer that is not working properly, boot to DOS and start BootWorks.
2 Watch for the prompt, Press <F2> to go into diagnostic mode. The program pauses at this prompt 

for three seconds. If you locked the screen and keyboard, you will have to disable the lock before 
you can access the DOS screen.

3 Press the F2 key to go to the Main Menu. From the menu you can do all of the tasks described in 
this section.

Creating ImagesCreating Images

The –pb switch is used by default
but is not shown. Additional 
command-line switches can be 
added here.

The –pb switch is used by default
but is not shown. Additional 
command-line switches can be 
added here.

Deploying ImagesDeploying Images

Use the check box or the 
command-line switch to 
remove a BootWorks partition
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Check the DOS Network Connection
If you want to make sure the network adapter is working and if you have a valid IP address, you can 
“ping” the Deployment Server or another client.

1 From the main menu, choose Diagnostic menu > IP diagnostics > Ping.
2 Enter the IP address of the Deployment Server or computer you want to ping.

Fix The Client IP Connection to the Deployment Server
Follow these steps to isolate and solve BootWorks connection problems on new and managed 
computers. This test determines if the client computer can connect to the Deployment Server with a 
direct IP connection. Use the Diagnostic Menu option on the Main Menu to complete these tasks.

1 Determine if IP initializes.
Choose IP Diagnostics > Initialize IP. If you are using DHCP, you can watch IP initialize on the 
screen to see if the client computer gets an IP address from the DHCP server. (If you are using 
static IP addresses, you will not see the initialization.)

2 Get client information.
From the IP Diagnostics menu, choose Display IP Address. Check the information to see if the 
client’s addresses are valid and the BootWorks version is correct. You will get the following 
information:

• BootWorks and the packet shim versions.
• IP gateway, subnet, and MAC addresses.
• Bootworks type (embedded or separate partition).

3 Connect to the Deployment Server.
From the IP Diagnostic Menu, choose Connect to Deployment Server. Enter the Deployment 
Server’s IP address and then check the Deployment Server Console to see if the computer 
connects. If the connection is successful, the client’s icon and name will appear in the Computers 
list on the Deployment Server Console. (The icon will be gray.)

4 Update or register the client with the Deployment Server.
• If the client is a managed computer, choose Update with Deployment Server from the IP 

Diagnostics menu. On the Deployment Server Console, see if the computer updates with the 
database. If it updates correctly, the client’s icon on the Deployment Server Console will turn 
blue. Choose Disconnect from Deployment Server from the IP Diagnostics menu.

• If the client is a new computer, choose Get initial deployment list from the IP Diagnostics menu. 
The Deployment Server Console sends a list of pre-defined jobs to the client. To register the 
new computer with Deployment Server, choose the name assigned to it (when the computer 
was defined in the “virtual computer” list at the Deployment Server Console) and choose the 
task set that you want the computer to run. The client will register and run the assigned tasks, 
and then boot to Windows.

5 To continue troubleshooting, go back to the Main Menu and choose a new option.
To continue the BootWorks boot program without making changes, choose Continue with normal 
operation.
To exit the diagnostic utility, choose one of the following:
• To use modified settings when BootWorks reboots, choose Set MBR to reboot to BootWorks. 
• To exit BootWorks and start the Windows boot process, choose Exit BootWorks.

Fix the Client Multicast Connection to the Deployment Server
Follow these steps to isolate and solve multicasting problems on new and managed computers.

1 Choose the Diagnostics Menu option on the Main Menu.
2 Verify that the client can communicate via multicast by joining a session and sending packets to 

the session.
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• To see if the client connects to the multicast session. choose Multicast Diagnostics > Join 

Multicast Group. Watch the status on the screen.
• To see if the client can send packets successfully, choose Multicast Diagnostics > Send 

Multicast Packet.
• To disconnect the client from the session, choose Multicast Diagnostics > Leave Multicast 

Group. 
If the client multicast is working correctly, the problem might be caused by network traffic. You 
can adjust this by setting the number of packets sent in a burst and the delay time.

3 To check the traffic and adjust packet settings, set up one client as a sender and one as a receiver 
as follows:
• At the client computer that will send the test packets, choose Multicast Diagnostics > Sender 

and enter the IP address, port number, and TTL for the sender and receiver. Also enter the 
packet settings you want to test.

• At the client computer that will receive the test packets, start the diagnostic utility and choose 
Multicast Diagnostics > Receiver. Enter the IP address, port number, and TTL for the sender 
and receiver. You can watch the packet status to see if they are being received correctly.

4 To continue troubleshooting, go back to the Main Menu and choose a new option.
To continue the BootWorks boot program without making changes, choose Continue with normal 
operation.
To exit the diagnostic utility, choose one of the following:
• To use modified settings when BootWorks reboots, choose Set MBR to reboot to BootWorks. 
• To exit BootWorks and start the Windows boot process, choose Exit BootWorks.

Check the Client Settings
Sometimes problems occur when the client settings do not match the settings saved in the 
Deployment Server Database. This can happen if configuration changes are made at the Deployment 
Server Console and they are not deployed to the client.

Use the Diagnostic Menu option on the Main Menu to view the settings.

1 Choose System Information to view the following:
• Computer name.
• Operating system and version.
• BootWorks and packet shim versions, sizes, and dates.
• SMBIOS settings (such as manufacturer, asset tag, and serial number).

2 Compare these settings with those recorded for the computer in the Properties page on the 
Deployment Server Console.
If there are discrepancies, you can update software or change configuration settings as necessary 
to synchronize the information. 
To change some settings you might need to edit the protocol.ini or system.ini files. Use the Edit 
option on the Main Menu and enter the name of the file you want to edit.

3 To continue troubleshooting, go back to the Main Menu and choose a new option.
To continue the BootWorks boot program without making changes, choose Continue with normal 
operation.
To exit the diagnostic utility, choose one of the following:
• To use modified settings when BootWorks reboots, choose Set MBR to reboot to BootWorks. 
• To exit BootWorks and start the Windows boot process, choose Exit BootWorks.
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Fix the DHCP Address
If you are using DHCP to assign IP addresses, you can use this option to see the address that was 
assigned and make sure it is valid. If the address is not good, you can delete it and have another one 
assigned. 

Use the Diagnostic Menu option on the Main Menu to check the address.

1 To see the address assigned to the computer by the DHCP server, choose Display Microsoft DHCP. 
2 If the address assigned is not valid, or if you want the DHCP server to assign the computer a new 

one, choose Delete Microsoft DHCP.
To continue troubleshooting, go back to the Main Menu and choose a new option.

To continue the BootWorks boot program without making changes, choose Continue with normal 
operation.

To exit the diagnostic utility, choose one of the following:

• To use modified settings when BootWorks reboots, choose Set MBR to reboot to BootWorks. 
• To exit BootWorks and start the Windows boot process, choose Exit BootWorks.

View System Messages While BootWorks is Running
Use this option to set the messages you want to see while BootWorks is running.

1 Choose the Set Debug Message Level option on the Main Menu. You can:
• Turn on/off debug messages.
• Turn on/off DHCP messages.
• Turn on/off IP messages.

2 Press Enter to turn the messages on or off. 
3 To continue troubleshooting, go back to the Main Menu and choose a new option.

To continue the BootWorks boot program without making changes, choose Continue with normal 
operation.
To exit the diagnostic utility, choose one of the following:
• To use modified settings when BootWorks reboots, choose Set MBR to reboot to BootWorks. 
• To exit BootWorks and start the Windows boot process, choose Exit BootWorks.

View BootWorks Autoexec.bat File Settings
Use this option to see the contents of the BootWorks autoexec.bat file. 

To look at the file, choose the BootWorks Settings option on the Main Menu.

Edit The Bootworks Autoexec.bat File
If you have problems with BootWorks, you might need to change some settings in the 
autoexec.bat file to correct them. For more information about command-line parameters and 
options for BootWorks (bootwork.exe) and BootWorks install (bwinst), see Bootworks 
Command-line Switches (page 336).

1 Use the BootWorks Diagnostic Utility. When the computer boots and the BootWorks screen 
appears, press F2.

2 Choose Edit from the Main Menu and then enter the filename autoexec.bat.
3 Make the changes.
4 Save the changes by pressing Alt+S.

Note: Any changes you make will apply only to the computer where you run the utility. 
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To changed an autoexec.bat file used by multiple computers
1 In the Boot Disk Creator, expand the Configurations list by clicking on the plus sign.
2 Select the autoexec.bat file.
3 Make the changes.
4 Save the changes.
5 Make disks or BootWorks Installation Packages.
Note You might want to reinstall or reboot the computers that use the configuration so they have the 
updated version.

Uninstall BootWorks
There are three ways to uninstall BootWorks.

• Using BootWorks install disks (if you used floppy disks to install BootWorks originally).
• Using a Windows Uninstall Package from the console or the Boot Disk Creator.
• Using an uninstall disk.
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Using RapiDeploy

RapiDeploy’s imaging and network multicasting technology lets you deploy complex operating 
systems such as Windows 95, 98, ME, NT, 2000, XP or 2003 to ten, twenty, or even hundreds of 
computers simultaneously.

Easy-to-use wizards guide you through the process of creating image files, sending them to the 
computers of your choice, and personalizing them with unique names, IP addresses, and more. 
RapiDeploy is a valuable tool in your computer lab or organization, accomplishing in minutes what 
used to take hours or days.

This section provides information on the following topics:

• Features and Benefits (page 252)
• RapiDeploy Components (page 254)
• RapiDeploy Usage Overview (page 255)
• Installing RapiDeploy (page 255)
• How Imaging Works (page 258)
• Preparing Computers for Imaging (page 260)
• Creating, Uploading, and Sending Images (page 264)
• Restoring, Downloading, and Receiving Images (page 269)
• Making Self-Extracting Image Files (page 273)
• Managing Images (page 274)

Features and Benefits
RapiDeploy lets you to do the following:

• Create Images - RapiDeploy creates a single image file containing all information from a hard 
disk partition, a group of partitions, or an entire hard disk. Image files are saved on a file server 
(or network share) for later use. You can also send the image directly to other computers.

• Deploy Images to One or More Computers - You can deploy an image to one computer or use 
network multicasting to send an image file to multiple computers simultaneously. You can 
deploy an image file that has been saved or you can send an image directly from a computer 
being imaged.

Standalone and DS versions of Altiris RapiDeploy
Altiris RapiDeploy is used most often as an integrated component of Deployment Solution, where 
it is launched automatically when performing imaging jobs that include Create Disk Image or 
Distribute Disk Image tasks. However, RapiDeploy also ships as a standalone version to be used 
in a limited capacity to capture, store, and distribute computer disk images for individual 
computers without using the automated management features provided with Deployment 
Solution.
This document describes the basic features of both the standalone and integrated Deployment 
Solution versions of Altiris RapiDeploy.
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• Personalize Imaged Computers - Because images can contain a generic operating system and 

settings, you may want to set options specific to each computer you deploy the image to. 
RapiDeploy can configure unique settings including TCP/IP address, OS license, computer 
name, unique SID, and user account settings. 

• Create Self-Executing Image Files - When you create an image file, you can save it as either a 
regular image file (*.img) or an executable file (*.exe). Executable image files are useful for 
configuring computers that are not connected to the network, such as laptops and computers in 
branch offices.

• Span Media - RapiDeploy lets you “span media” or store images across multiple media. For 
example, you can “split” an image into several files and store them across several CD-RWs, 
Iomega Jaz™ or ZIP™ drives, or other removable media. You can save the image file directly 
to removable media (if supported by the media or server), or you can save all of the split image 
files to a file server directory and then transfer them to the media later.

• Backup/Recovery - Images contain a disk or partition’s exact configuration information 
providing backups for easy disaster recovery.
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RapiDeploy Components
Components Description

Image File - When RapiDeploy creates an image, the data is stored in a single image file. Image 
files are saved to a file server or network share for later use. You can save image files as either a 
regular image file (*.img) or an executable file (*.exe).

File Server - The file server (or a computer with a shared folder) is where you store image files. 
The file server is generally where you install RapiDeploy (for more information, see “Installing 
RapiDeploy” on page 255). The file server should have plenty of storage space for image files.

Master PC - The Master PC is the computer that you will make an image of or deploy an image 
to. A Master PC that will be used to make an image from is considered a baseline system. A 
baseline system generally contains only the operating system, applications, settings, and 
configurations you want on other computers. It is best to use a networked computer with a freshly 
installed, lightly configured operating system as well as any standard applications that you use in 
your organization.
You designate a Master PC by booting a computer with the RapiDeploy Master PC boot disk and 
running rdeploy.exe.
Client PCs - When you create an image of or deploy an image to a Master PC, you can also have 
that image sent to other computers at the same time. The other computers that are receiving 
images from the Master PC are called Client PCs.
You designate a Client PC by booting a computer with a RapiDeploy Client PC boot disk and 
running rdeploy.exe with the -mclient option. The Client PC tells the Master PC when it is ready 
to receive an image file.
Boot Disk Creator - To perform imaging and multicasting, RapiDeploy works with computers 
at the DOS level. Boot Disk Creator creates a boot disk that is used to boot computers into DOS 
mode, connect it to a file server (or other network share), and run rdeploy.exe. Boot Disk Creator 
saves boot configurations for later use or editing. For more information, see “Boot Disk Creator” 
on page 275.
Image Explorer - ImageExplorer (imgexpl.exe) is a Windows application that lets you view and 
make changes to RapiDeploy image files. The following options are available:
• Add, modify, or exclude files in the image
• Extract files from the image
• View information about partitions and files contained within an image file
• Search for files stored within an image file
For more information, see “Using ImageExplorer” on page 300.
Deployment Agent (aclient.exe) - RapiDeploy uses the Altiris Deployment Agent for Windows 
(aclient.exe) to apply configurations to a computer after it has received an image file. It also 
allows you to run SIDgen, which generates unique Windows Security IDs (SIDs) for computers 
running Windows NT/2000/XP (see “Using SIDgen” on page 367).
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RapiDeploy Usage Overview

RapiDeploy provides you the following five options when creating and deploying images. 

Installing RapiDeploy
RapiDeploy is available as an individual product and as a component of Altiris Deployment 
Solution. For information on installing Deployment Solution, see the Deployment Solution 
documentation.

RapiDeploy must be installed either on a file server or on a computer with a shared folder that can 
be accessed by any computer you want to create an image of or download an image to. You may 
install RapiDeploy on the file server where you will store the image files or on another computer.

Create (upload) an image file of a Master PC. 
Saves an image of a computer to the network file 
server (or network share). 

Restore (download) an image to a Master PC. 
Restores an image file from the file server to the 
Master PC. This option also lets you set post-
imaging configurations on the Master PC such as 
TCP/IP, OS licensing, networking, and user 
settings, and generate unique SIDs.

Send image of Master PC to Client PCs. Sends an 
image of the Master PC directly to Client PCs 
without saving an image file on the network. This 
option lets you modify post-imaging configurations 
on the Client PCs only.

Create (upload) an image of a Master PC while 
sending it to Client PCs. Saves an image of the 
Master PC on the network and, at the same time, 
sends the image to Client PCs. Post-imaging 
configurations can be adjusted on the Client PCs 
only.

Restore (download) an image to a Master PC 
while sending it to Client PCs. Restores an image 
to the Master PC and, at the same time, sends it to 
Client PCs. In this case, you can set post-imaging 
configurations for both the Master PC and the Client 
PCs.
Deployment Solution Product Guide 255



 Using RapiDeploy Installing RapiDeploy

 

Note Because most routers and switches do not allow multicasting, you can typically multicast only 
to computers on the same network segment. To image computers on another segment, either start a 
Master PC on that segment and connect the Client PCs to the Master PC, or configure the router to 
allow multicast packets to pass through it. The file server where RapiDeploy is installed does not 
have to be on the same segment.

System Requirements
Network protocol
• TCP/IP

Hard Disk space
• 24 MB required for installation
• Additional space for storing image files

CPU
• Pentium 1 minimum 

Memory
• 32 MB of RAM minimum
• Add more RAM for PCs with more files to be imaged. (Approximately 256 MB per 1 million 

files.)

DOS Boot Files
• Unless you are running Windows 95 or 98, you will need access to DOS boot files. For more 

information, see “Get DOS System Files” on page 257.

Install RapiDeploy
You can install RapiDeploy from the Altiris product CD or by downloading it from the Altiris Web 
site at www.altiris.com. RapiDeploy may also be installed as a component of Altiris Deployment 
Solution

1 Verify that your computer meets the system requirements (see System Requirements). 
2 Run rd_setup.exe.
3 Read the License Agreement and then click Yes to accept and continue.
4 Specify the destination folder for the RapiDeploy program files and click Next.

The destination folder selected needs to be shared, so it can be seen on the network.
5  Click Yes to make the folder shared.
6 Select the program folder where you want to install RapiDeploy, then click Next. 

The program files will install. 
7 Click Finish to complete the wizard.
8 Create a user account (such as BootWork) and assign a password so that Master and Client PCs 

can communicate with the file server during the DOS boot process.

amouse.com for mouse support in RapiDeploy GUI
For mouse support in the RapiDeploy user interface, you need to manually load the amouse.com 
driver shipped with RapiDeploy. To add the mouse driver, you will need to edit the 
autoexec.bat file and add the following command after the call startnet.bat line, for 
example:
f:\amouse.com
Launch rdeploy.exe after the network drivers and amouse.com are loaded.
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9 Give the user account you just created full administrator right to the RapiDeploy folders.

Get DOS System Files
The Boot Disk Creator utility creates a bootable disk that you use to boot computers to DOS and 
attach to the network. This bootable disk requires some DOS system files.

Windows versions ME/NT/2000/2003/XP do not include DOS system files. If you are running Boot 
Disk Creator on a Windows ME/NT/2000/2003/XP computer, you will need to provide these DOS 
system files. 

The first time you run Boot Disk Creator you will be required to provide the DOS system files.

You can get the DOS system files from one of the following sources:

• A Windows 95/98 CD 
• A disk formatted with system files on a Windows 95/98 computer
If you are using a formatted disk, you will need the following files:

• Required:
• command.com
• emm386.exe
• himem.sys
• io.sys
• msdos.sys
• smartdrv.exe
• sys.com

• Optional:
• attrib.exe
• edit.com
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• fdisk.com
• format.com
• mem.exe
• mode.com
• xcopy32.mod

When you provide these files, they are stored by Boot Disk Creator and will be used for other boot 
disk creations.

How Imaging Works
Images are created and deployed by using the Rdeploy utility (rdeploy.exe). Rdeploy runs after 
booting to DOS and attaching to a file server or shared folder. Rdeploy creates, uploads, and 
downloads image files. Rdeploy can also send (multicast) images to other computers that are running 
Rdeploy.

Rdeploy can be run in one of two ways:

• Using program wizards
• Running from the command-line with switches
For information on using the program wizards, see “Creating, Uploading, and Sending Images” on 
page 264. For information on running from the command-line with switches, see “Running 
RapiDeploy from the Command-line” on page 359.

How RapiDeploy Reads Hard Disks
Hard disks are imaged differently depending on the file system that is used. The source disk or 
partition is not changed.

FAT, NTFS, EXT2, and EXT3. Imaging is file-based. RapiDeploy copies real data file by file, 
resulting in a clean, defragmented image that can be resized and restored to a disk of a different size. 

Other File Formats. For other file systems, the disk is read sector by sector regardless of which 
sectors are in use. The image mirrors the contents of the disk. These formats are not resizable.

How Partitions Are Handled
When you create an image, you can image a partition, a group of partitions, or an entire hard disk. 
Any partition on a hard disk can be imaged.

Partition Selection
When a computer receives an image, you can select which partitions to download. The default 
setting is to restore all partitions, which would overwrite any existing partitions. To keep an existing 
partition, you can specify which partitions to download and which to ignore. You can also use 
command-line switches to keep existing partitions.

Partition slots on the Client PCs will be, by default, the same as the image source PC. A partition 
occupying slot 3 in the image file will be by default in slot 3 on the Client PCs.

By default, the following partition types will not be overwritten:

• BootWorks partition (used with Altiris Deployment Solution)
• OEM system partitions
The default behavior can be overridden by selecting the appropriate option in the RapiDeploy wizard 
or at the command-line.
Deployment Solution Product Guide 258



 Using RapiDeploy How Imaging Works

 

Partition Size 
When you are restoring an image to a computer, the destination hard disk may be a different size 
than the disk imaged. If there are multiple partitions, the partition size percentage of the Client PCs 
will, by default, be the same as the image source. 

For example, if you image a 1 GB hard disk where 40% (400 MB) of the disk is a Windows NT 
partition and 60% (600 MB) is a Windows 98 partition, a Client PC with a 2 Gigabyte disk will use 
the same percentages. The size of the Windows NT partition will be 800 MB and the Windows 98 
partition will be 1200 MB. 

RapiDeploy also offers a partition resize feature that allows you to manually resize the partitions to 
a size that you specify.

Spanning Media
RapiDeploy lets you “span media” or store images across multiple media. For example, you can 
store one image across several CD-RWs, Iomega Jaz™ or ZIP™ drives, or other removable media. 

Spanning is accomplished by splitting the image into multiple files. For example, if you named your 
image file basepc.img, and the image is split into four files, the following files are created:

• basepc.img
• basepc.002
• basepc.003
• basepc.004 

You can set the split image file size to be between 1-2040 MB.

Important The maximum file size that can be written is 2040 MB. Any image that is larger then 2040 
MB, whether it is spanned or not, will be split into multiple files.

You can span an image in the following ways:

• Save the image file directly to removable media
• Save all of the image split files to a file server directory and then transfer them to the media later

Saving the Image Directly to Removable Media
To save the image file directly to removable media, the media must be accessible by DOS. 

To be prompted to swap media during the image creation process, load rdeploy.exe with the -span 
option. For more information, see -span under “Running RapiDeploy from the Command-line” on 
page 359.

You can specify the split file size either in the Rdeploy wizard or from the command-line. To set it 
from the command-line, add the -split option to the -span option. For more information, see -split 
under “Running RapiDeploy from the Command-line” on page 359.

Saving the Image Files on a File Server for Later 
Use
You can save an image to the file server, split into multiple files of the size that you specify, and then 
later copy those files to other media. For example, if you want to span two CD-RWs, you would 
specify a 640 MB file size. 

The largest file size allowed is 2040 MB (2 GB). You set the desired files size in the Rdeploy wizard 
by selecting it in the Spanned Media File Size box. For more information, see “Creating, Uploading, 
and Sending Images” on page 264.
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Computer Settings Configuration
When you create an image, everything on that computer is included in the image including registry 
settings, IP address, computer name, and so on. All of that information is then included when you 
restore the image file to a computer in the download. 

RapiDeploy allows computers receiving images to be automatically configured with unique settings 
without having to manually change them after imaging. For more information, see “Configuring 
Computers with Post-Imaging Settings” on page 272.

Important To use the post configuration option, make sure that the Deployment Agent (aclient.exe) 
is present on the computer that you will create the image of. For more information, see “Install the 
Deployment Agent For Windows for Post Image Configuration” on page 263.

Multicasting
RapiDeploy uses multicasting to simultaneously deploy images to a group of computers, called 
Client PCs. The Master PC manages the multicast session. The Master PC can multicast images to 
Client PCs in the following three ways:

• While the Master PC downloads an image from a file server and manages the simultaneous 
imaging of the Client PCs

• While the Master PC creates an image on a file server and manages the simultaneous imaging of 
the Client PCs

• While using its own hard disk as the source and sending the contents to Client PCs

How Multicasting Works
• The multicast transmission is synchronized by the Master PC, so it will only go as fast as the 

slowest computer in the group.
• If a single computer fails, it will drop out of the session and the session will continue.
• You can usually multicast only to computers on the same network segment because most routers 

and switches do not allow multicasting. To image computers on another segment, start a Master 
PC on that segment and connect the Client PCs to the Master PC.

Preparing Computers for Imaging
This section includes the following topics:

• Task Overview (page 260)
• Prepare a Baseline System (page 261)
• Create Boot Disks (page 261)
• Install the Deployment Agent For Windows for Post Image Configuration (page 263)
• Name Computers for Domains (page 263)

Task Overview
Before you can create, send, or download an image, you must do the following: 

• Prepare a baseline system (see “Prepare a Baseline System” on page 261).
• Create boot disks for all computers that will be used to create or receive an image (see “Create 

Boot Disks” on page 261).
• (Optional) Install the Deployment Agent For Windows (see “Install the Deployment Agent For 

Windows for Post Image Configuration” on page 263).
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• (Optional) Name computers for Microsoft Domain Controllers (see “Name Computers for 

Domains” on page 263).

Prepare a Baseline System
A baseline system is a computer that you will image and clone to other Client PCs. This computer 
contains only the applications, settings, and configurations you want on other computers. We 
recommend using a networked computer with a freshly installed and lightly configured operating 
system, plus any standard applications that you use in your organization.

Create Boot Disks
To perform imaging and multicasting, RapiDeploy works with computers at the DOS level. 
RapiDeploy uses boot disks to boot the computers to DOS and connect them to the network and run 
the RapiDeploy wizard. 

DOS boot disks are created for the following computers: 

• Master PC (the computer the image is created from or deployed to) 
• Client PCs (other computers that will receive the same image from the Master PC) 
The Altiris Boot Disk Creator creates the Master PC and Client PC boot disks.

Gather Information
Before you create boot disks, collect the following information:

• The type of file server you will store the image on (Windows or NetWare)
• The type of network adapter in the computers that you’re building the boot disks for (3Com, 

Intel, and so on). Boot disks are network adapter-specific. You must create a unique boot disk 
for every computer that has a unique network adapter.

• The IP settings for the computers (DHCP or static IP address)
• The name of your workgroup/domain (for Microsoft networks) or your server name (NetWare)
• The account name and password assigned to the RapiDeploy directory after the software was 

installed (see “Install RapiDeploy” on page 256).

Create a Boot Disk Configuration
Boot Disk Creator uses configuration files that contain settings for client computers (Master PCs or 
Client PCs). These configuration files are used when creating boot disks. You can edit these 
configuration files later or use them again to make additional boot disks.

Boot disks are network adapter-specific. You must create a unique configuration and boot disk for 
every computer that has a unique network adapter.

1 On the computer where you installed RapiDeploy, click Start > Programs > Altiris > RapiDeploy > 
Boot Disk Creator.
Important The first time you run Boot Disk Creator on a Windows NT/2000/ ME/XP computer, 
you will be required to provide DOS system files. For more information, see “Get DOS System 
Files” on page 257.

2 Click New Configuration.
Tip If you already have a configuration similar to the one you are creating, you can copy the 
configuration and then edit it to make the new one. Just right-click on the configuration and 
select Copy, then right-click on the “copy of” configuration and select Edit from the menu.

3 Enter a name for the new configuration file, for example “RDMaster 3C905.”
4 Write a brief description of the file to help you distinguish it from your other configuration files. 

For example, “RD Master PC boot disk with 3C905 driver.” 
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5 Click Next.
6 Select the kind of boot disk configuration file you want to make:

• Master PC boot disk
• Client PC boot disk (to perform a configuration of the computers settings, select the Run 

Client Configuration Wizard check box).
• Network boot disk for troubleshooting or running utilities manually.

7 Click Next.
8 On the File Server Type screen, select the type of file server you have on your network. 

If your computers connect to a Novell NetWare server, click the option that corresponds to the 
type of NetWare clients you have. 

9 Click Next.
10 From the list of network adapter cards, select the type installed in the computers that will use this 

configuration. Click Next to copy the drivers to the configuration file. If your network adapter 
does not appear on the list, see “Network Adapters” on page 280.
Note Configuration files are specific to your network adapter card. You must make a 
configuration file for each computer that has a different type of network adapter. 
You can also choose to build a multiple network adapter configuration. For additional 
information see “Network Adapters (Multi-NIC Setup)” on page 281.

11 Click Next.
12 Select how your computers will use TCP/IP to communicate on the network in DOS. 

(BootWorks runs imaging and registry backup/restore jobs in DOS before computers boot to 
Windows.) If you use DHCP to assign IP addresses, click Obtain an IP address from a DHCP 
server. If you assign IP addresses manually, click Use a static IP address and enter the required 
information. See TCP/IP Protocol Settings (page 281). 
Note If you use static IP addresses, you will need to make a separate boot disk for each computer.

13 Click Next.
14 Enter the Domain or Workgroup (for a Microsoft network) or server (for a Novell network) that 

the client computer will connect with to store and access image files. 
15 Enter the user name and password of the account that has access to the RapiDeploy directory. If 

you did not assign a password to the account, leave the password fields blank. 
16 Click Next.
17 If you want the client computer drive mapping to be part of the autoexec.bat file, click Manually 

create drive maps. (This gives BootWorks access to the files on the server it needs.)
If you are using NetWare and you want the client login scripts to create the drive mapping, click 
Use login scripts to create drive maps. 

18 Click Next.
19 Review your configuration choices. To make changes, click Back to get to the applicable screen. 

To finish the configuration file, click Finish.
You can now use the configuration to create required boot files or BootWorks installation packages. 
For more information creating boot disk configurations, see “Boot Disk Creator” on page 275.

Create Disks
1 If you just created a configuration, a dialog box appears. Click Create floppy disks sets and click 

OK to exit the Boot Disk Creator wizard.
or
From the Boot Disk Creator interface, select the configuration file you want to use and click 
Create Disks from the taskbar.
Note If you have not created a configuration yet, click New Configuration from the taskbar and 
complete the steps to create one.
Deployment Solution Product Guide 262



 Using RapiDeploy Preparing Computers for Imaging

 

2 Insert a blank floppy disk when prompted, and follow the prompts to finish making the boot disk. 

To help yourself keep track of the floppy disks, label each one as it is created.
Important All existing data on the disk will be replaced.

Install the Deployment Agent For Windows for 
Post Image Configuration
You may configure a computer receiving an image to be automatically configured with unique 
computer settings, such as OS license, network, TCP/IP, and user account settings. For more 
information, see “Configuring Computers with Post-Imaging Settings” on page 272. 

To use this feature, you must make sure that the Deployment Agent (aclient.exe) is running on the 
computer that you will create the image of. After a computer has received an image, Deployment 
Agent automatically runs, applies the configurations you set, and reboots the computer so the 
changes take effect. 

Name Computers for Domains
If you use a Microsoft domain controller to manage domains on your network, the computer names 
in your images must be managed in the domain controller. For more information, see “Using 
SIDgen” on page 367.

Before You Upload an Image
Before you create an image of a baseline computer, give the computer a name that will not be 
included in any computer name ranges you might choose later. (The recommended name is Source.) 
You must add the computer to the domain server before you upload the image.

Before You Deploy an Image
When restoring an image, if you select Domain (instead of Workgroup) in the Networking settings 
of the Post-Imaging Configuration wizard page, you must add the computers to the domain before 
you deploy the image. If computers are already domain members, the account must be reset in the 
domain.

To add computers to a Windows 2000 Domain Controller
1 Click Start > Programs > Administrative Tools > Active Directory Users and Computers.
2 Highlight the Computers folder under the domain where you will add the computer.
3 Click Action > New > Computers.
4 Enter the computer name.
5 Select the Allow pre-Windows 2000 computers to use this account box. This box must always be 

selected.

To add computers to a Windows NT Domain Controller
1 Click Start > Programs > Administrative Tools (Common) > Server Manager.
2 Click Computers > Add To Domain.
3 Select the Computer Type (Workstation or Server, or NT Backup Domain Controller). 
4 Enter the computer name. Keep the following rules in mind:

• The name of the image source computer cannot be used as a target computer name.
• Computer names must be newly created entries in the domain.

5 You must add the target computer names to the domain server before you deploy the image.
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Creating, Uploading, and Sending Images 

This section includes the following topics:

• Task Overview (page 264)
• Creating an Image File (page 264)
• Create an Image File While Sending It to Client PCs (page 266)
• Send Image of Master PC to Client PCs (page 267)

Task Overview
When you create an image of a computer, you have three options:

Creating an Image File
The following instructions illustrate how you can save an image of a computer to the network file 
server. Ideally, the Master PC is a baseline system (a computer that contains a fresh, lightly 
configured OS and applications).

1 Choose a computer on your network that has a baseline system you want to image, insert the 
Master PC boot disk into this computer, and reboot. For more information, see “Create Boot 
Disks” on page 261.
The computer boots to DOS, connects to the computer share where RapiDeploy is installed, and 
loads rdeploy.exe.

Create an image file of a Master PC on a file server (see 
“Creating an Image File” on page 264).

Create an image file of a Master PC on a file server and send 
the image to other Client PCs simultaneously (see “Create an 
Image File While Sending It to Client PCs” on page 266).

Send the contents of the Master PC’s hard disk directly to 
other computers without creating an image file (see “Send 
Image of Master PC to Client PCs” on page 267).
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2 Select Create an image file (upload) and click Next.

3 If the computer has more than one hard disk, select the disk that you want to image and click Next.
4 Enter a name and description of the image.
5 (Optional) If you want the image file to be a self-extracting executable file rather than an .img 

file, then select the Make this a self-extracting .EXE check box. 
For more information, see “Making Self-Extracting Image Files” on page 273.

6 Specify the type of compression you want to apply to this image (optimize for smaller Size or 
faster Speed or the default Balanced) or select No Compression.

7 Specify maximum file size in the Spanned Media File Size menu. 
For more information, see “Spanning Media” on page 259. 

8 Click Next.
9 Deselect any partitions that you don’t want to include in the image.
10 Click Finish to start the image creation.

The image file is saved in the shared folder where RapiDeploy is installed, unless a different path 
was specified.

The time it takes to complete imaging depends on the amount of data involved. Imaging is complete 
when you see a DOS prompt that indicates the imaging was successful.
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Create an Image File While Sending It to Client 
PCs
The following instructions illustrate how to save an image of the Master PC on the network and, at 
the same time, send the image to Client PCs. Post-imaging configurations can be adjusted on the 
Client PCs only.

Get Client PCs Ready
1 Boot all of the Client PCs that will receive the image using the Client PC boot disks you created 

earlier (see “Create Boot Disks” on page 261). This runs the RapiDeploy wizard.
2 At each Client PC, use the wizard to set up the configurations (such as TCP/IP, OS licensing, 

networking, and user settings) that you want applied to the computer after it has received the 
image file.

3 Click Finish.
The Client PCs are now ready to receive an image file from the Master PC.

Start the Master PC Image
1 On a baseline computer on your network that you want to create and send an image of, insert the 

Master PC boot disk and reboot.
The computer boots to DOS and connects to the computer share where RapiDeploy is installed, 
and loads rdeploy.exe.

2 Select Create an Image File (upload).
3 Select the Send While Creating check box, and click Next.

4 If the computer has more than one hard disk, select the disk that you want to image and click Next.
5 Enter a name and description of the image for later reference.
6 (Optional) If you want the image file to be a self-extracting executable file rather than an .img 

file, then select the Make this a self-extracting .EXE check box. 
For more information, see “Making Self-Extracting Image Files” on page 273.
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7 Specify the type of compression you want to apply to this image (optimize for smaller Size or 

faster Speed or the default Balanced) or select No Compression.
8 Specify maximum file size in the Spanned Media File Size menu. 

For more information, see “Spanning Media” on page 259.   
9 Click Next.
10 Leave the Session ID field set to “default”. 
11 (Optional) If you are running on a high traffic network, you can limit the bandwidth to a slower 

number of megabits per second (for example, 3 Mbps).
12 (Optional) You can configure the Master PC to wait until a specified number of Client PCs 

connects to it. To use this feature, select the Start After X Clients Connect check box, and specify 
the number.
You can also configure the Master PC to wait until a specified number of minutes. To use this 
feature, enter a value for or after X minutes.

13 Click Next.
14 Deselect any partitions that you don’t want to include in the image.
15 Click Finish to start the image creation.

The image file is saved in the shared folder where RapiDeploy is installed.

The time it takes to complete imaging and multicasting depends on the amount of data involved. 
Imaging is complete when you see a DOS prompt that indicates the imaging was successful. 

16 Eject the boot disks from all the Client PCs and reboot them. 
An Altiris message box will appear indicating that the Client PCs are being reconfigured. The 
computers will automatically reboot into the operating system that was in the image you just 
deployed.

Send Image of Master PC to Client PCs
The following instructions illustrate how you can send an image of the Master PC directly to Client 
PCs without saving an image file on the network. This option lets you modify post-imaging 
configurations on the Client PCs only.

Get Client PCs Ready
1 Boot all of the Client PCs that will receive the image using the Client PC boot disks you created 

earlier. This runs the RapiDeploy wizard.
2 At each Client PC, use the wizard to set up the configurations (such as TCP/IP, OS licensing, 

networking, and user settings) that you want applied to the computer after it has received the 
image file.

3 Click Finish.
The Client PCs are now ready to receive an image file from the Master PC.

Start the Master PC Image
1 On a baseline computer on your network that you want to create and send an image of, insert the 

Master PC boot disk and reboot.
The computer boots to DOS and connects to the computer share where RapiDeploy is installed, 
and loads rdeploy.exe.
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2 Select Send only and click Next.

3 Leave the Session ID field set to “default” unless you are running multiple sessions that need 
separate session IDs.

4 (Optional) If you are running on a high traffic network, you can limit the bandwidth to a slower 
number of megabits per second (for example, 3 Mbps).

5 (Optional) You can configure the Master PC to wait until a specified number of Client PCs 
connects to it. To use this feature, select the Start After X Clients Connect check box, and specify 
the number.
You can also configure the Master PC to wait until a specified number of minutes. To use this 
feature, specify a value for or after X minutes.

6 Click Next.
7 Deselect any partitions that you don’t want to include in the image.
8 Click Finish to start the Master PC.

The time it takes to complete imaging and multicasting depends on the amount of data involved. 
Imaging is complete when you see a DOS prompt that indicates the imaging was successful. 

9 Eject the boot disks from all the Client computers and reboot them. 
An Altiris message box will appear indicating that the Client PCs are being reconfigured. The 
computers will automatically reboot into the operating system that was in the image you just 
deployed.
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Restoring, Downloading, and Receiving Images 

This sections includes the following topics:

• Task Overview (page 269)
• Restoring an Image to a Master PC (page 269)
• Restoring (Download) Image to Master PC While Sending It to Client PCs (page 271)
• Configuring Computers with Post-Imaging Settings (page 272)

Task Overview
You can restore (download) an image file from the file server to one or more computers. You can 
download an image in one of the following ways:

Before downloading images, you can set post-imaging configurations on the computers that will be 
set automatically after the computer is imaged. You can configure OS licensing, networking, TCP/
IP and user settings. For more information, see “Configuring Computers with Post-Imaging 
Settings” on page 272.

Restoring an Image to a Master PC
1 On a computer on your network that you want to download an image to, insert the Master PC 

boot disk and reboot.
The computer boots to DOS, connects to the computer share where RapiDeploy is installed, and 
loads rdeploy.exe.

2 Select Restore an image file (download).

Download an image to the Master PC only (see “Restoring an 
Image to a Master PC” on page 269).

Download an image to the Master PC and Client PCs 
simultaneously (see “Restoring (Download) Image to Master 
PC While Sending It to Client PCs” on page 271).
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3 If you want to automatically modify the computer’s settings after imaging, select the Do post 

configurations check box (default).

4 Click Next.
5 Click Browse and then select the image you want to download and click OK.
6 Click Next.
7 Select the partitions to restore.
8 Click Next.
9 If you selected the Do post configuration option, you are shown the Post imaging configuration 

window. Set any configurations you want to apply to the computer after imaging. For more 
information, see “Configuring Computers with Post-Imaging Settings” on page 272.
Important Post-configuration settings are organized into groups and are available by clicking the 
group name in the left panel. Do not click Finish until all configuration options are set. 

10 Click Finish to restore the image.
The time it takes to complete imaging and multicasting depends on the amount of data involved. 
Imaging is complete when you see a DOS prompt that indicates the imaging was successful.
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Restoring (Download) Image to Master PC While 
Sending It to Client PCs
The following instructions explain how you can restore a previously saved image to the Master PC 
and, at the same time, send it to Client PCs. In this case, you can set post-imaging configurations on 
both the Master PC and the Client PCs.

Get Client PCs Ready
1 Boot all of the Client PCs that will receive the image with the Client PC boot disks you created 

earlier. This runs the RapiDeploy wizard.
2 At each Client PC, use the wizard to set up the configurations (such as TCP/IP, OS licensing, 

networking, and user settings) that you want applied to the computer after it has received the 
image file.

3 Click Finish.
The Client PCs are now ready to receive an image file from the Master PC.

Start the Master PC
1 On a computer on your network that you want to download an image to, insert the Master PC 

boot disk and reboot.
The computer boots to DOS and connects to the computer share where RapiDeploy is installed, 
and loads rdeploy.exe.

2 Select Restore an Image File (Download). 
3 Select Send While Restoring. 
4 If you want to automatically modify the computer’s settings after imaging, select the Do post 

configurations check box (default).

5 Click Next.
6 Select the image file to restore to the Master PC and send to Client PCs.
7 Leave the Session ID field set to “Any”. 
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8 (Optional) If you are running on a high traffic network, you can limit the bandwidth to a slower 

number of megabits per second (for example, 3 Mbps).
9 (Optional) You can configure the Master PC to wait until a specified number of Client PCs 

connects to it. To use this feature, select the Start After X Clients Connect check box, and specify 
the number.
You can also configure the Master PC to wait until a specified number of minutes. To use this 
feature, specify a value for or after X minutes.

10 Click Next.
11 Deselect any partitions that you don’t want to restore in the download.
12 Click Next.

If you selected to Do post configuration, you are shown the Post imaging configuration window. 
Set any configurations you want to apply to the computer after imaging. For more information, 
see “Configuring Computers with Post-Imaging Settings” on page 272.
Important Post-configuration settings are organized into groups and are available by clicking the 
group name in the left panel. Do not click Finish until all configuration options are set. 

13 Click Finish to start the Master PC.
The time it takes to complete imaging and multicasting depends on the amount of data involved. 
Imaging is complete when you see a DOS prompt that indicates the imaging was successful. 

14 Eject the boot disks from all the Client PCs and reboot them. 
An Altiris message box will appear indicating that the Client PCs are being reconfigured. The 
computers will automatically reboot into the operating system that was in the image you just 
deployed.

Configuring Computers with Post-Imaging 
Settings
Because images contain a generic operating system, you will probably want to set up unique 
configurations such as OS license, networking, TCP/IP, and user account settings on each computer 
that receives an image. This section briefly describes the options that are available in the Post-
Imaging Configuration wizard page.

Important To use this feature, you must make sure that the Deployment Agent (aclient.exe) is 
present on the computer that you will create the image from. After a computer has received an image, 
Deployment Agent is automatically run, applies the configurations you set, and reboots the computer 
so the changes take effect. To install Deployment Agent on a computer prior to imaging, connect to 
the RapiDeploy installation directory, run clcfg.exe, and follow the instructions.

Settings Options
At the top of each section, there is a Prompt user for settings check box. If this option is checked, the 
user will be prompted for those settings when the computer is rebooted. 

Also, at the bottom of the section, there is a check box labeled Save these as your default settings. If 
you do not want to save these settings for the next time you run this program, clear this box. 

Post-configuration settings are organized into groups and are available by clicking the group name 
in the left panel (you can also click the TAB and then SPACE keys to select groups). The settings 
groups are summarized below.

License Settings
This is where you enter the license information for the computer’s operating system. You can enter 
the user name, organization name, and license key. 
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Networking Settings
The networking group contains workgroup and domain settings. You can choose either workgroup 
or domain settings. Enter the name of the workgroup or domain along with the computer name. If 
you are using domains, you can also change the Windows Security ID (SID) for that particular 
computer. Each computer in a domain must have a different SID. After imaging, they all have the 
same SID. A new SID will be generated for each computer that has this check box selected. For more 
information, see “Using SIDgen” on page 367.

TCP/IP Settings
This group contains the same settings that you would find in the Windows Networking Properties 
and TCP/IP settings. These settings let you choose between DHCP or static IP addresses. You can 
also set up WINS and DNS options.

NetWare Settings
If the computer will be a Novell NetWare client, this section helps you apply NetWare client settings 
on a newly imaged computer. You can specify the NDS user name, select whether you want to login 
to a tree or a server, the preferred tree or server name, the NDS context, and if you want to run login 
scripts.

Account Settings
Here you can set up Windows user accounts for the newly imaged computer. You can enter the user 
name, full name, password (you must confirm the password by typing it again in the field below it), 
and you can also specify the groups that this user will belong to as a comma-delimited list. For 
example: Administrators, Marketing, Management. You can also determine whether the user must 
change their password the next time they log on, whether they can change their password, and 
whether the password expires.

Making Self-Extracting Image Files
When you create an image file, you can save it as either a regular image file or a self-extracting 
executable file. 

For computers connected to your network, a regular image file (*.img) works well.

For computers that are not connected to your network, such as laptops and computers in branch 
offices, create a self-extracting image file (*.exe). You can copy it to a bootable media, and remote 
users can use the “portable” image to configure their computers at any time.

To create an image file as a self-executing (*.exe) file
When naming the image file in the RapiDeploy wizard, select the Make this a self-extracting.EXE 
check box.
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To save an existing image (*.img) file to a self-executing (*.exe) file
1 Start the RapiDeploy wizard (rdeploy.exe).
2 Select Create a self-extracting image from an .img file option and click Next.

3 Select the .img file you want to turn into an .exe file and click Finish.
The .exe file will be created in the same directory as the .img file you selected.

Managing Images
You can view and make changes to RapiDeploy image files (*.img) using the Altiris ImageExplorer. 
For more information, see “Using ImageExplorer” on page 300.
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Boot Disk Creator 

Boot Disk Creator (BDC) is a Deployment Solution tool used to create and configure boot disk 
images when using BootWorks and PXE Server (see note). Because Deployment Solution provides 
DOS-specific deployment tasks — such as creating and distributing disk images or saving and 
restoring registry files — you can use the Boot Disk Creator tool to create DOS boot configurations 
for different types of computer configurations.

Note PXE Server boot files can only be created and modified by opening BDC from the PXE 
Configuration tool.

  

Create and store configuration files for each type of computer on your network for select hardware 
drivers or OS type. The configuration files are saved to a directory, where they can be reused to make 
additional boot files at any time. See New Configuration Wizard (page 276).

Tasks
You can run tasks to create a new boot configuration or to create boot disks for floppies and PXE 
Server.

New Configurations. Use the BDC wizard to create a new boot disk configuration set. Follow steps 
to select methods for booting to DOS, where you will store your image files, network adapter 
drivers, and additional features required for a complete boot disk configuration. 

Create Disks. Create floppy boot disks from boot disk configurations.

Create PXE Boot File. Create boot configurations for PXE Server. Only the computer running PXE 
Server can create boot files.

Create Windows Install Packages. Create Windows Installation packages to install BootWorks on 
local computers.

Standalone and DS versions of Boot Disk Creator
Altiris Boot Disk Creator is used most often as an integrated component of Deployment Solution, 
where it is launched from the Deployment Console to create boot disks for Altiris BootWorks and 
the Altiris PXE Server when performing imaging jobs. However, BDC can also be used to create 
network boot disks when using the standalone RapiDeploy program that runs independently from 
a Deployment Solution system. As a result, some user interface features common to the BDC 
utility shipped with Altiris Deployment Solution will not appear in the standalone RapiDeploy 
program (installed using the rd_setup.exe program).
This document describes the basic features for both the standalone and DS versions of Altiris 
Boot Disk Creator.

 

The Boot Disk Creator tool can be launched by clicking its icon on the 
toolbar of the Deployment Server Console or by clicking the Tools > Boot 
Disk Creator command.
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Configurations
You can view and edit BDC configurations. These include all files to boot to DOS: batch files, 
config.sys, DOS files, network adapter drivers, and more. Each configuration can be selected and 
viewed from the Configurations pane. The Additional Include Files folder includes files for Windows 
Install Packages.

In the Details pane (on the right) you can view information about the BDC configuration. If you 
select a batch or script file in a BDC configuration you can also edit and save the file in the right 
pane.

New Configuration Wizard
You can create a BDC configuration by following all steps provided in the New Configuration 
Wizard. These instructions include the entire process for using the Boot Disk Creator for the first 
time to make an initial configuration. For subsequent configurations, you might not need to complete 
all of the steps. If the configuration is for PXE boot files, you must run the Boot Disk Creator on the 
computer that is your PXE Server and you must open BDC from the PXE Configuration utility.

Step One: Gather Information
To create configuration files for BootWorks, you need the following information:

• The type of file server you are using on your network (Windows or NetWare).
• The type of network adapter for which you are building boot files (3com, Intel, etc.).
• The static IP address for each client (if not using DHCP).
• The type of Deployment Solution connection the clients will use (multicasting or static IP).
• The name of your workgroup/domain (for Microsoft networks) or your server name (NetWare).
• The account name and password assigned to the Deployment Solution directory.

Step Two: Get DOS System Files (Windows ME/NT/2000/XP/2003)
The Boot Disk Creator requires some DOS system files. If you are running the Boot Disk Creator 
on a Windows ME/NT/2000/XP/2003 computer, you'll need to get them from a Windows 95 or 98 
computer or installation disk, or from a formatted floppy disk.

See Gathering DOS Files for Boot Disk Creator (page 285).

Step Three: Create a Configuration
1 Open the Boot Disk Creator by clicking the icon on the toolbar, or by clicking Start > Programs 

> Altiris >Altiris eXpress > Deployment Server > Boot Disk Creator.
2 Click New Configuration.

Tip If you already have a configuration similar to the one you are creating, you can copy the 
configuration and then edit it to make the new one. Just right-click on the configuration and 
select Copy, then right-click on the “copy of” configuration and select Edit from the menu.

3 Enter a name for the new configuration file. Write a brief description of the file to help you 
distinguish it from your other configuration files (see Name and Describe a New Configuration 
(page 277)). Select Next.

4 On the Client Installation screen, select the kind of configuration file you want to make. Select the 
Client Installation Help button for information about the options, since the location of the boot files 
(where computers run BootWorks) determines the type of configuration you create. See Client 
Installation (page 278).

 

The New Configuration Wizard can be launched by clicking its icon in the left-
pane of the Boot Disk Creator tool, clicking Ctrl+N, or selecting the File >New 
Configuration command.
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5 On the File Server Type screen, select the type of file server you have on your network. If your 

computers connect to a Novell NetWare server, click the option that corresponds to the type of 
NetWare clients you have. See File Server Type (page 279).

6 From the list of network adapter cards, select the type installed in the computers that will use this 
configuration. Click Next to copy the drivers to the configuration file. If your network adapter 
does not appear on the list, see Network Adapters (page 280).
Note Configuration files are specific to your network adapter card. You must make a 
configuration file for each computer that has a different type of network adapter unless you 
choose to build a Multi-NIC configuration. See Network Adapters (Multi-NIC Setup) (page 281) 
for additional information.

7 Select how your computers will use TCP/IP to communicate on the network in DOS. 
(BootWorks runs imaging and registry backup/restore jobs in DOS before computers boot to 
Windows.) If you use DHCP to assign IP addresses, click Obtain an IP address from a DHCP 
server. If you assign IP addresses manually, click Use a static IP address and enter the required 
information. See TCP/IP Protocol Settings (page 281).

8 Select how BootWorks will connect to your Deployment Server.
If you want computers to use multicasting to connect to a Deployment Server, accept the default 
multicast option, IP multicast address, and port number
Click the option to connect directly to the Deployment Server using TCP/IP and enter the server's 
IP address. If you are using the Intel Universal network adapter driver (UNDI) or if your network 
adapter doesn't support multicasting, use this option. See Deployment Server Location (page 
281).

9 Enter the name of the server where image files are stored (for a NetWare network), or enter the 
Domain or Workgroup (for a Microsoft network). See Network Drive Mappings (page 282).

10 Enter the network settings for the managed computer to connect to the file server. Enter the user 
name and password of the account you created when you set up the Client Access Point. See 
Network Connection (page 282).
If you want the computer drive mapping to be part of the autoexec.bat file, click Manually 
create drive maps. If you are using NetWare and you want the client login scripts to create the 
drive mapping, click Use login scripts to create drive maps. Click Next.

11 Review your configuration choices. To make changes, click Back to get to the applicable screen. 
To finish the configuration file, click Finish.

You can now use the configuration to create required boot files or BootWorks installation packages.

Name and Describe a New Configuration
In the BDC Wizard, enter a name and description for your configuration: 

1 Enter a name for the configuration file.
2 (optional) Enter a detailed description of the configuration to help remember which 

configuration it applies to. Include specific information about the network adapter and network, 
and information detailing what the configuration file will be used for.

3 Click Next.
See also New Configuration Wizard (page 276).
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Client Installation
The location of your computer's boot files determines the kind of configuration file that you are 
required to create. Select one of the following BootWorks options to create configuration files that 
correlate to the boot location: booting from a local hard drive, from a floppy disk, or across the 
network.

See also New Configuration Wizard (page 276).

BootWorks Install Advanced Options
Click Use screen lock to prevent users from accessing your network via the BootWorks DOS 
connection while it is running on their computers. This security option disables keyboard input and 
displays a splash screen while BootWorks runs. (The option is cleared by default.)

Note You'll need to clear this option if you are testing a configuration so you can view the screen 
output and use the keyboard for troubleshooting. When you have finished testing and the 
configuration is ready to use, you can lock the screen and keyboard by editing the configuration's 
autoexec.bat file. Just remove the REM statement at the beginning of the KBDSCLK lines. For 
instructions, see Edit BootWorks Network, System, and Batch Files (page 289).

Click Create a BootWorks partition for local image store if you want to install BootWorks in its own 
partition instead of a production partition. If you select this option, BootWorks will be installed to 
the first partition on the hard drive. It will overwrite existing data on that drive.

You need this option only if you want to store hard drive images on a computer's local hard drive. 
For example, if you teach two different classes in the same lab and you need to re-image computers 
between classes, choose this option to install BootWorks in its own resizable partition. 

BootWorks install package. Click this option to install BootWorks on the hard drive 
of the managed computer. With this type of configuration file, you can create a set 
of installation disks or a Windows Install Package to install BootWorks on 
managed computers with a Windows OS.
BootWorks boot disk. Click this option to run BootWorks from the network. You 
can create a disk that loads network files and runs bootwork.exe from a file 
server. Or you can create PXE boot files on the server that are downloaded by a 
computer and run in RAM.
Run Initial Deployment for computers not already in the database. Check this option 
if this boot configuration will be used for new computers (not a managed or virtual 
computer). Initial Deployment will run automatically when a new computer 
connects to the Deployment Server for the first time. 
If you execute Initial Deployment on a managed computer (a computer already in 
the Deployment Database), be aware of the following issues:
• If Initial Deployment is used on computers that are already being managed by 

the Deployment Server, then Initial Deployment will not run. Even if the 
option is checked, Initial Deployment only runs on computers not already 
registered with the server.

• If you use Initial Deployment on existing client computers (production 
computers currently in use on your network but not yet registered in the 
Deployment Database), it may overwrite the computer hard disk if Initial 
Deployment is set up with a new imaging job.

If you create a virtual computer (a computer configuration not yet assigned to a 
client computer) at the Deployment Server Console, you will define custom jobs 
for them to run without using Initial Deployment. 
Network boot disk. Click this option to create a configuration and copy it to a disk. 
You can use the floppy disk to boot a computer to DOS and connect to the network 
at the DOS level. You can use this connection for troubleshooting or running 
RapiDeploy and other DOS utilities manually from the command line.
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File Server Type
Select the type of file server and network connection currently installed on your network.

Note The Deployment Server Client Access Point is the file server where you store image files, 
packages, and data files. It does not have to be the same computer as the Deployment Server. The 
network can be IP or IPX, depending on your type of file server.

• Click Microsoft Windows if you have a Microsoft network and server. (If you are using IPX on 
your Microsoft network, you can select the IPX check box at the bottom of the screen. However, 
we recommend using TCP/IP with this type of network).
Click Create Multi-Network Adapter Configuration to add multiple network adapter drivers to a 
single PXE boot file configuration. This feature allows you to build configuration files to boot 
up multiple computers containing different types of network adapter cards. See About Multi-
Network Adapter Configurations (page 283).
Note If you select the Multi-NIC configuration option, a list of major network adaptor drivers 
will be listed. Boot Disk Creator provides features that allows these drivers to be evaluated and 
matched with the network adapter card in the managed computer. See Network Adapters (Multi-
NIC Setup) (page 281). 

• Click Novell NetWare (VLM) If you have a NetWare server and VLM clients. The IPX check box 
will be selected automatically for you.

• Click Novell NetWare Client 32 if you have a NetWare server and 32-bit clients. If you are using 
IPX, select the IPX check box at the bottom of the screen.

Note If you are running or booting with a NetWare Client 32 boot disk created with the Boot Disk 
Creator, you may get an error saying Context is incorrect. If you add a Wait 100 line to the 
startnet.bat file, then the script will run.

Example copy of Startnet.bat file:

cd A:\client32

A:\client32\NIOS.EXE /l

disable logging

LOAD A:\client32\NBIC32.NLM

LOAD A:\client32\LSLC32.NLM

LOAD A:\client32\CMSM.NLM

LOAD A:\client32\ETHERTSM.NLM

if NOT exist A:\client32\C32SLOT.NLM goto skip

LOAD A:\client32\C32SLOT.NLM -nA:\landrv.bat

del A:\client32\C32SLOT.NLM

:skip

call A:\LANDRV.BAT

LOAD A:\client32\nodipkt b0 t

LOAD A:\client32\IPX.NLM

LOAD A:\client32\TRANNTA.NLM

LOAD A:\client32\SRVLOC.NLM

wait 10

LOAD A:\client32\CLIENT32.NLM

wait 100  <--------------------------- Add this line 
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f:cx users.corp

a:\bwlogin rjones

map F:=corp\vol1:\users\rjones

F:

See also New Configuration Wizard (page 276).

Network Adapters
Select a driver for network adapters to include in the boot configuration. You will need a different 
configuration file for each type of network adapter unless using a Multi-NIC configuration.

Note If you select a specific network adapter, make sure it supports DOS (BootWorks connects to 
the network in DOS). If you have difficulties imaging using the universal driver, select the specific 
driver from the Network adapters list. 

If the network adapter does not appear on the list, use the disk that came with the network adapter.

• Click Advanced to add or change network adapter settings (memory, IRQ, PCMCIA, etc.) to run 
in DOS instead of Windows.

• Click Have Disk if you have a floppy disk or CD with the required drivers for your network 
adapter. Insert the disk and browse to the desired driver files.

See also New Configuration Wizard (page 276).

Advanced Network Card Settings
If you need to specify additional settings for your network adapter to work in DOS, enter them here. 
Below is a list of the settings that you can change. 

Microsoft clients
• EMM386 Memory (config.sys). Append memory address information to this line in the 

config.sys file.
• Advanced settings (protocol.ini). Add parameters to the NIC section of the protocol.ini 

file. 
• Memory (protocol.ini). Add parameters to the network setup section of the protocol.ini 

file.
• IRQ (protocol.ini). Add parameters to the network setup section of the protocol.ini file.

Novell VLM clients
• Emm386 memory (config.sys). Append memory address information to this line in the 

config.sys file.
• Advanced settings (config.sys). Add parameters to the NIC section of the net.cfg file.

Novell Client 32 
• Emm386 Memory (config.sys). Append memory address information to this line in the 

config.sys file.
• Advanced settings (driver command line). Add driver command-line entries to the landrv.bat 

file.
See Troubleshooting Drivers in BootWorks (page 284) for additional information about solving 
common driver problems. You can also find additional driver information in the User Support 
Forum on the Altiris web site. If your driver doesn't work, contact your vendor for information about 
using the driver in DOS.

4 Click OK. Click Next.
See also New Configuration Wizard (page 276).
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Network Adapters (Multi-NIC Setup)
Select multiple drivers for network adapters to include in the boot configuration. Because this is a 
Multi-NIC set up, you can Shift-Click or Ctrl-Click to select multiple network adapter drivers. The 
Network Adapters (Multi-NIC Setup) list includes common drivers that can be used in a Multi-NIC 
configuration. See About Multi-Network Adapter Configurations (page 283).

Notes 

• If you select a specific network adapter, make sure it supports DOS (BootWorks connects to the 
network in DOS). If you have difficulties imaging using the universal driver for PXE, select the 
specific driver from the Network adapters list.   

• Because you can select multiple drivers in this dialog box, the Advanced feature is available for 
every adapter selected to add or change network adapter settings (memory, IRQ, PCMCIA, etc.) 
to run in DOS instead of Windows is not available.

See also New Configuration Wizard (page 276).

Multi-Network Adapter Order
Select a network adapter driver from the list and click the Up or Down buttons to change the order of 
the driver. The drivers will be evaluated in the order they are listed when attempting by find a match 
for the network adapter card.

Place the most commonly used drivers at the top of the list. This will speed the evaluation process 
when matching the right driver with the most commonly installed network adapter card in the client 
computers. 

Advanced. Add or change network adapter settings (memory, IRQ, PCMCIA, etc.) for each adapter 
selected to run in DOS instead of Windows. See Advanced Network Card Settings (page 280). 

See also About Multi-Network Adapter Configurations (page 283) and Network Adapters (page 
280).

TCP/IP Protocol Settings
If you are using DHCP, accept the default option to get computer IP addresses from the DHCP 
server.

Important If you are creating a PXE boot file, you must select this option.

Click Use a static IP address if you want to assign each computer a unique IP address. You will have 
to create a separate boot disk or install package for every managed computer to ensure that each 
computer receives a unique IP address.

Note TCP/IP will be used to connect to the Deployment Server and the file server (if you are not 
using IPX). Deployment Server uses its own IP stack that works on IPX. 

If you have set up WINS and/or gateways on your Microsoft network, enter the address information 
here.

See also New Configuration Wizard (page 276).

Deployment Server Location
These options determine how BootWorks connects to your Deployment Server:

To use multicasting
• If you want computers to use multicasting to connect to a Deployment Server, accept the default 

multicast option, IP multicast address, and port number.
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• If you want to use multicasting but the default port number is already in use on your network, 

change the port number only. You must also change the port number in the Deployment Agent 
(AClient).

To use static IP addresses
• Click the option to connect directly to the Deployment Server using TCP/IP and enter the server's 

IP address in the address field. If you are using the Intel Universal NIC driver (UNDI), the IP 
address is required.

• If your network adapter doesn't support multicasting, use this setting. See your network adapter 
documentation or call the manufacturer for information.

See also New Configuration Wizard (page 276).

Network Connection
These options determine how BootWorks connects to your file server:

1 Enter the name of the file server that the computers will connect to (NetWare). Or, enter the 
Domain/Workgroup (Microsoft).

2 Enter the user name and password you created when you set up the Deployment Server directory. 
(If you did not assign a password, leave the field blank.) 

3 If you use NetWare Directory Services logins, click Advanced and enter the server context. 
The default frame type for NetWare is 802.2. If you use a different type, click Advanced and select it.

See also New Configuration Wizard (page 276).

Network Drive Mappings
If you want the computer's drive mapping to the file server to be part of the BootWorks 
autoexec.bat file, select Manually create drive maps. 

• The Drive Map: field displays the F: mapping to access the Client Access Point (Deployment 
Server shared folder). Edit this if the path is incorrect.

• The Path: field allows you to browse and select the directory where the image files reside, for 
example: 
\\server\share (Windows)
server\volume:directory (NetWare)

You can create multiple drive mappings. However, the first drive must be mapped to the directory 
where the Client Access Point is located. To map additional drives, select another drive letter from 
the Drive Map list and then browse for the corresponding path.

If you are using NetWare and you want the login scripts to create the drive mapping instead, click 
Use login scripts to create drive maps.

See also New Configuration Wizard (page 276).

Summary
Review options selected for the newly-created BDC configuration. Click Back to change selections.

See also New Configuration Wizard (page 276).
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About Multi-Network Adapter Configurations

In the past, DOS Boot disks and PXE Boot Image Files were limited to a single network adapter 
driver. This created difficulties for heterogeneous environments where different computers had 
different network adapters from different vendors. Administrators had to create multiple boot 
diskettes, create different BootWorks install packages, or use the UNDI driver with PXE-enabled 
computers.

All PXE enabled systems are also PCI based systems. The PCI bus can provide vendor and device 
information about the network adapter card installed in the computer. This information can be 
queried and used to modify the necessary startup files to ensure that the correct network adapter 
driver is selected out of several that may exist in the PXE boot image file (or on the boot floppy).

The provided network adapter drivers in the Network Adapters (Multi-NIC Setup) list are commonly 
used drivers with vendor and device information identified, allowing the PXE Server to identify the 
type of network adapter card from the PCI bus of the client computer and associate it with one of 
these drivers. To add another driver to the list, you must ascertain the vendor and device numbers 
for that driver.

See also Network Adapters (Multi-NIC Setup) (page 281) and Multi-Network Adapter Order (page 
281).

Important Recently, it was discovered that the UNDI (NDIS.DOS) driver used in conjunction with 
some PXE-enabled network adapters would cause data corruption during multicast imaging. The 
corruption was detected early in the system because the computer would not boot after imaging. The 
randomness of the failure made it possible to corrupt data on the disk without being aware of the 
corruption until later, if at all. To eliminate this problem, Deployment Solution 5.5 and later 
eliminates multicast imaging when using the UNDI driver. 

Create and Install BootWorks Boot Files
From the Tasks pane, select the media or boot file type that you want to create: Create Disk, Create 
PXE Boot File (if BDC is accessed from the PXE Configuration tool), or Create Install Package. Then 
select the configuration file you want to use. Configuration files are somewhat dependent on the boot 
file type — all configurations do not work with all media or boot file types.

If you have not created a configuration yet, select New Configuration from the taskbar and complete 
the steps in New Configuration Wizard (page 276).

Follow the prompts to create the boot file:

• To install BootWorks on Windows 95, 98, or ME computers, click Create Disks to create boot 
disks to install locally. See Select a Configuration (page 283).

• To install BootWorks boot files for the PXE Server, click Create PXE Boot File.
Note PXE Boot files can only be created or modified using the Make Boot Files feature in the 
Altiris PXE Configuration tool.

• To install BootWorks on Windows NT/2000/XP/2003 computers, click Create Windows Install 
Packages to create a Windows Install package and include it in a Distribute Software task to 
deploy from the console. See Create Windows Install/Uninstall Packages (page 284).

To install BootWorks remotely on Windows NT/2000/XP/2003 computers using defaults, right-
click on a computer or group at the Deployment Server Console and click 
Advanced > Install BootWorks. This installs BootWorks using default configuration information 
(entered when you installed Deployment Server), and settings from the Deployment Agent for 
Windows (AClient) running on the computer.

Select a Configuration
The list of available configurations is specific to what is valid for the media you have selected.

If you don't select a configuration from the list before choosing a task, or if you choose a task that is 
not valid for the media, a list of valid configurations appears for the chosen task. 
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For example, you cannot make a PXE boot file using a BootWorks install configuration. If you select 
this combination, you will get a list of valid PXE configurations to choose from. However, you can 
select a BootWorks install configuration to create Windows Install Packages or install disks.

Create Windows Install/Uninstall Packages
MS Windows Install and Uninstall Packages are self-extracting packages that install or uninstall 
BootWorks from a Windows operating system. You can run these manually by double-clicking the 
package at the client computer, or you can deploy them from the Deployment Server Console.

To install:

• Enter the directory and filename where you want the file to be saved, or accept the default.
• If you want the package to install without prompting the user for any information or 

confirmations, select Run in quiet mode.
• If you want to install the Altiris Windows Client (aclient.exe) on the computer at the same 

time you install the Altiris DOS Client (BootWorks), select Install Altiris Client for Windows. It 
installs with the default settings.

Click Advanced to create an input file (aclient.inp) for installing Deployment Agent (AClient) 
with custom settings.

Boot Disk, File, or Install Package Complete
If you created install disks, you can install BootWorks by inserting disk 1 in the managed computer 
and restarting. If you created boot disks, you can use them to boot computers and run BootWorks 
from a network drive.

If you created a PXE boot file, it is ready for you to run a job from the Deployment Server Console. 

If you created a Windows install package, you can run it from Windows by clicking Start > Run and 
typing or browsing for the executable file.

Extending BootDisk Memory for Large Drivers
BootDisk uses the emm386.exe in situations where large network adapter drivers are required, or 
on notebooks using the PCMCIA card services. This emm386.exe is launched automatically from 
the config.sys file, but is commented out in the default installation of BootWorks. If you require 
additional memory capacity for large network adapter drivers, you can delete the REM of 
emm386.exe using these steps:

To use extended memory in BootDisk
1 Create the new configuration in BootDisk.
2 Expand the directory in the Configurations area for that boot package.
3 Right-click the config.sys file.
4 Delete REM in the line REM DEVICE=C:\DOS\EMM386.EXE NOEMS.
5 Type Ctrl- S to save, or File > Save Text File.

Troubleshooting Drivers in BootWorks
The following are issues when using network adapters in DOS:

• Set your network adaptor card to half duplex. Full duplex does not always work well with DOS.
• Disable Plug and Play OS in the BIOS, if you have this setting.
Deployment Solution Product Guide 284



 Boot Disk Creator Gathering DOS Files for Boot Disk Creator

 

• Look for a music note symbol on the interrupt line of the protocol.ini file. If there is one in 

the line, delete it.
• If you have an ISA NIC, make sure the interrupt and IP address are correct.
• Don't use a network adapter with a DOS driver larger than 70 KB.
• In most cases, modifying your config.sys files improve performance:

DOS= High,UMB 
Buffers = 30,0 
Files = 40 

Note The EMM386 file has been included in the Bootworks configuration file to help resolve memory 
problems for notebooks with PCMIA network adapter cards or network adapters with large drivers. 
However, because running the emm386.exe might cause problems on some computers, it has been 
commented out of the config.sys file. See Extending BootDisk Memory for Large Drivers (page 
284) for more information.

Network adapter drivers sometimes have memory conflicts issues that can be resolved by excluding 
a memory range. You can edit the EMM386 line to solve the problem. (The following setting works 
well in most cases.) 

emm386 auto noems x=D700-D7FF

The Boot Disk Creator automatically detects most card bus service drivers. If the service is not 
detected, enter a command to load it in autoexec.bat and add it to your configuration. The service 
comes from the network adapter vendor. It is not the same for all network adapters. 

For instructions on how to add the executable to your boot file configuration, see Add Files to a 
BootWorks Configuration (page 289). 

If the Boot Disk Creator does not detect a driver or has no listing for your driver type, do the 
following when creating the configuration:

1 Select any driver from the current list.
2 Edit the driver name entry in the applicable files, depending on the client type:

Microsoft: protocol.ini, system.ini (netcard=drivername in [network drivers] 
section)
NetWare VLM: net.cfg, autoexec.bat, startnet.bat, stopnet.bat
NetWare Client 32: net.cfg, autoexec.bat, landrv.bat, stopnet.bat

3 Add the driver file to the configuration. 

Gathering DOS Files for Boot Disk Creator
If you are running a Windows ME or NT/2000/XP/2003 operating system, there are no MS-DOS 
system files available. You'll need to format a disk and copy system files at a Windows 95 or 98 
computer or insert an original installation CD. You only need to do this the first time you run the 
Boot Disk Creator for these operating systems. The system files are copied to the Boot Disk Creator 
(bootwiz) folder, so they are available for all subsequent configurations made on that computer's 
console. 

You can load boot files in these ways:

• Select Use Windows95/98 original CD.
Insert an original Windows 95 or Windows 98 Installation CD to extract DOS files.

• Select Use a formatted floppy disk.
Insert a floppy disk with bootable system files, SMARTDRV.EXE and optional DOS files. 
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Note When upgrading to Deployment Server 5.5 or greater from previous versions, you will be 
prompted to add these DOS files to your existing boot disk files for added functionality. Once loaded 
you will not be prompted in the future. 

You can also clear the No longer prompt for optional files check box, allowing you to proceed without 
the files and to not be prompted again. 

Note SMARTDRV.EXE is required for all computers running a scripted install in Windows XP/2003.

Insert Original Installation CD
You can gather boot files from your original Windows 95 or Windows 98 CD, or you can browse to 
a directory where the CAB files reside.

• Insert an original Windows 95/98 disk and click Next. The files will be located and uploaded 
automatically. 
OR

• Browse to a Windows 95/98 install directory and select the CAB subdirectory on your local hard 
drive or network drive. Click Next.

Note SMARTDRV.EXE is required for all computers running a scripted install in Windows XP/2003.

Gathering Files on a Floppy Disk
Use the following steps to make a floppy disk with the files you need. The Boot Disk Creator will 
prompt you for it later. You will only need to use this disk the first time you run the Boot Disk 
Creator.

1 At a Windows 95 or 98 PC, insert the disk to be formatted.
2 Open Windows Explorer, right-click 3 1/2 Floppy (A:), click Format, select Copy System Files, and 

then click Start.
3 Copy files (found in the Windows directory) to the floppy disk, including

4 Eject the floppy disk.

Boot Disk Creation
If you select the option to use static IP addresses, enter the address of the computer that will use this 
configuration. If you are using the configuration for multiple computers and you want to increment 
the address for each one, select Increment IP address. 

Note You can use the configuration file for more than one computer, but you must create a separate 
boot disk or install package/file for each computer to ensure that the IP addresses are unique.

Required Optional
SMARTDRV.EXE, HIMEM.SYS, 
EMM386.EXE

EDIT.COM, MEM.EXE, ATTRIB.EXE, MODE.COM, 
XCOPY32.MOD, FORMAT.COM, SYS.COM, 
FDISK.EXE

Required Optional
SMARTDRV.EXE, HIMEM.SYS, 
EMM386.EXE

EDIT.COM, MEM.EXE, ATTRIB.EXE, MODE.COM, 
XCOPY32.MOD, FORMAT.COM, SYS.COM, 
FDISK.EXE
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This is the address the computer will use to register with the Deployment Server from BootWorks 
(DOS). After BootWorks shuts down and the Windows boot process starts, the computer will use 
the IP address assigned to it in the Deployment Agent (AClient). These addresses do not have to be 
the same.

Boot Disk Creation Progress
The number of boot disks you need to make depends on whether you use DHCP or static IP 
addresses.

• If you use DHCP, you only need to make one boot disk or boot disk set for the computers using 
this configuration (although you can make multiple copies if desired).

• If you assign TCP/IP addresses to each computer, make one boot disk or boot disk set for each 
computer. You'll be prompted to enter an IP address for every disk or set. If you selected the 
option to increment the addresses, the address will be entered for you and you can click OK to 
continue with the program. 

If you want each user or location to have a copy of the boot disks, you can make multiple copies for 
distribution.

If you are using the configuration to make installation boot disks, selecting 1 makes one set of two 
or more disks (depending on the size of the configuration). Installing BootWorks on a computer 
requires an Install disk and a Data disk. The Install disk works on all computers. As a result, after 
you have made an Install disk you can select the option to create Data disks only. Data disks contain 
the configuration information. The data disk is needed only for installation options.

Appendix
The following are help files for the Boot Disk Creator user interface. 

Welcome to Boot Disk Creator
Create a new configuration. Enter the Altiris Boot Disk Creator wizard to (see New Configuration 
Wizard (page 276)). 

Close this dialog and continue to the Boot Disk Creator interface. Access all features of the Boot Disk 
Creator. From the Boot Disk Creator dialog box, you can select a configuration to create disks, create 
PXE boot files, or create Windows Install packages.

Creating Package, Disk, or Boot File
The boot files (or uninstall files) are being created. The associated tasks are highlighted as each one 
is run, and the progress bar shows the status of the task.

Universal NIC Driver
If you are creating a PXE boot file and using the Intel Universal NIC driver (UNDI), computers must 
connect directly with the Deployment Server using the server TCP/IP address. (You cannot use 
multicasting to connect to a server.)

• If you are running the Boot Disk Creator from the Deployment Server where the computers will 
connect, choose Use this computer's TCP/IP address. The server's address will be entered for you.

• If you are running the Boot Disk Creator from a different computer than the computers will 
connect to, enter the IP address of the Deployment Server. 
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Import Old Configuration Files
If you have configuration files that you used with an earlier version of eXpress Deployment Server, 
you can update them using the import feature. 

Choose the directory where your old configuration files are stored, and then select the configurations 
you want to import. (When you are browsing directories, the OK button will not be active if there are 
no configuration files in the directory.)

Note When you install a new version of Boot Disk Creator over an old one, the program detects the 
configuration files and prompts you to import them. The old files are not saved. If you choose to 
import using File > Import, the old files remain in their existing directory and imported ones are saved 
to a new location.

Create a PXE Boot File
This screen shows you where the PXE boot files will be stored. The paths and filenames should not 
be modified. 

You can have multiple PXE boot files. Three are created by default:

• One for managed computers, named managed.1
• One for new computers, named newcomp.1
• One for computers with BIS functionality, named bis.1.
Select the Force 2.88 image check box to create PXE boot files that are larger than the standard 1.44 
MB boot files. This option allows you to create PXE boot files with large drivers or utility 
applications deployed within the boot file.

Create a BIS Configuration Boot File
This screen shows you where the BIS configuration files will be stored. The paths and filenames are 
not modifiable. If the paths or filenames are changed, BIS will not work.

Additional Novell NetWare Properties
If you are using NetWare Directory Services authentication, enter the server context.

If your frame type is not the same as the default, select your frame type from the list.

Creating BIS Configuration Boot File
The BIS configuration file is being created. The associated tasks are highlighted as each one is run, 
and the progress bar shows the status of the task.

Uninstall BootWorks
There are three ways to uninstall BootWorks:

Use BootWorks Install Disks
If you have the floppy disks that you used to install BootWorks on the computer, you can use them 
to uninstall as well. 

1 Insert the BootWorks Install Disk (disk 1) into the computer you want to uninstall
2 When the prompt appears asking if you want to install BootWorks, type N.
Deployment Solution Product Guide 288



 Boot Disk Creator Appendix

 

3 At the command line, type bwinst -u.

From the Boot Disk Creator
1 Click Tools > Create a BootWorks Windows Uninstall Package.
2 Enter the path and package filename, or accept the default path and name.
3 Click Next > Close.

From the Console
1 Click File > New > Job.
2 Locate the new job in the Jobs list and open it.
3 On the Jobs screen, click Add > Distribute Software.
4 Enter the path and filename of the Windows Uninstall Package. The default path and 

filename is: .\bwpkgs\bwuninstall.exe.
5 Run the job on the computer you want to uninstall. 

Using an uninstall disk
If you haven't yet created an uninstall disk, make one using the Boot Disk Creator:

1 Click Tools > Create a BootWorks Uninstall Disk. When prompted, insert a disk into Drive 
A: and click Next.

2 To use the disk to uninstall BootWorks from a computer, insert the disk into the computer 
and start or restart the computer from the Windows Start menu. When prompted to uninstall 
BootWorks, type Y. 

Edit BootWorks Network, System, and Batch Files
1 From the Configurations list in the Boot Disk Creator, double-click the configuration whose batch 

files you want to edit.
2 Click the batch file you want to edit.
3 Make edits to the file.
4 Type Ctrl-S to save the changes, or click File > Save Batch file.

Add Files to a BootWorks Configuration
You can customize your configurations by adding text files and executable files (such as DOS 
utilities). There are two ways to add these files:

• Add files to a single configuration. 
• Add files by default to all BootWorks install files (Windows install packages and install boot 

floppies).

Add Files to a Specific Configuration
1 From the Configurations list, select the configuration where the file will be added.
2 Click the configuration to view its list of folders.
3 Right-click on the folder where you want to add the file and click Add File from the menu.
4 Browse for the file to add and click Open. The file appears in the list.
5 Add the command to load or run the file to the appropriate BAT or INI file. See Edit 

BootWorks Network, System, and Batch Files (page 289).
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Add Files to All BootWorks Installs

1 Click Additional Include Files > Add File.
2 Enter the path and filename, or select it from the list.
3 Click Open. The file appears in the file list.
4 Add the command to load or run the file to the appropriate BAT or INI file. See Edit 

BootWorks Network, System, and Batch Files (page 289). 

Edit An Existing Configuration
1 Select the configuration you want to edit from the Configurations list.
2 Right-click on the configuration and click Edit Configuration from the menu.
3 Go through the screens and modify the options that you want to change. 
4 Click Finish to save the new settings.

View Configuration Settings
To view information about a configuration, select it in the Configuration list. The description you 
entered when you created it appears in the top pane, and a summary of the settings is listed on the 
right. 

If you need to modify settings, see Edit An Existing Configuration (page 290).

Add DOS Files to Boot Disk Configuration
Add either required or optional DOS files to the Boot Disk Configuration. The missing files are 
listed in the dialog box. 
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PXE Configuration Tool 

Pre-boot Execution Environment (PXE) technology allows computers to boot up through the 
network adapter card using Intel Wired for Management technology. PXE uses industry-standard 
protocols (TCP/IP, DHCP, and TFTP) to create a channel that communicates between the client 
computer and a PXE server at startup. Deployment Solution includes the PXE Server to manage 
computers in a DOS environment to image hard disks, save registry settings, and perform other 
DOS-specific operations from a Deployment console.

 

The PXE Server installed with the Deployment Server system provides the ability to manage 
computers remotely in a DOS environment. Instead of booting up from a floppy disk or installing 
BootWorks on your computer, the PXE Server accesses the required boot files on the server. 

The PXE Configuration tool allows you to change PXE Server settings and modify PXE boot files, 
including:

• Modify the PXE boot files to configure network drivers, IP information, and other DOS-specific 
operations for existing managed computers and new computers.

• Manage boot menu options.
• Control which client computers your PXE Server will respond to (for installations with several 

Deployment Server systems on the same network or to manage only a portion of the computers 
in your system with PXE).

Note Users cannot create PXE Boot Files from within Boot Disk Creator (BDC) unless they go into 
BDC from the PXE Utility.

Boot Configuration
The Boot Configuration tab allows you to set options for booting to PXE Server. This dialog box 
allows you to set menu items presented to the user during the boot process.

Client Boot Menu
Prompt. Edit the text message that appears on the managed computer during the boot process. 
Changing the message does not change the F8 key that must be pressed to select a boot option.

Time-out. Modify the length of time the boot prompt is displayed before the boot process starts. If 
the F8 key is not pressed within the time-out period, the default boot option is run. (the first option 
in the list is the default option)

For example, to pause the Client Boot Menu on the managed computer to allow a user to select the 
Install BIS Certification option, set an appropriate length of time before the default boot option runs. 

The PXE Configuration tool can be launched by clicking its icon on the 
toolbar of the Deployment Server Console or by clicking the Tools > PXE 
Config command. A startup screen will prompt you to identify the PXE 
Server name or IP address that you want to configure.
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Menu Items
Computers booting with PXE will display a list of possible boot options to perform various tasks. If 
the user does not choose an option within the timeout period, the first boot option in the list runs by 
default. See PXE Menu Options (page 292).

Up and Down. Select an option and click the Up or Down button to order boot options. The top boot 
option is the default that runs automatically if no other option is selected from the PXE Server menu.

New. Click to open a dialog box to add a new item to the menu. See Menu Item Properties (page 292).

Edit. Modify properties for new menu items and select default options. 

Delete. Remove menu options (option will not be available for default menu options).

Make Boot Files. Open the Boot Disk Creator utility to create and store boot files for the selected 
option. Use the Altiris Boot Disk Creator to create or edit the configuration for a boot file, or create 
a boot file directly from a floppy disk for new menu options.

Only the boot files on the computer you are running the PXE Configuration tool will be modified.

The PXE boot menu will display only if these conditions are met:

• The client computer supports PXE.
• PXE is set as the primary boot option for client computer.
If the computer is in the Deployment Database, then the appropriate PXE menu option is selected 
automatically after the specified timeout has expired. For example, Local Boot is chosen if no 
deployment jobs have been assigned. If a job has been assigned, then the Altiris Bootworks (Managed 
PC) option will be selected automatically.

If these conditions are met, the menu will appear and wait for the user to select an option during 
Initial Deployment:

• The computer is not registered in the Deployment Database.
• Initial Deployment is not disabled and not changed from the default setting.
Note The PXE boot menu can be displayed manually if you press a Boot from the network key when 
prompted, typically F12 on most computers. This is only necessary on some computers and is usually 
only required if PXE is not first in the boot order.

PXE Menu Options
The following PXE menu options are available:

Local Boot (default). Boot from the operating system currently installed on the computer’s hard drive. 
If an operating system does not exist, then an error message is displayed.

Altiris BootWorks (Initial Deployment). Execute an Initial Deployment if the computer is not in the 
Deployment Server Database. Initial Deployment is configured in the Deployment Server Console 
before any tasks can be executed on new computers logging in.

Altiris BootWorks (Managed PC). Identify the computer that is booting as a managed computer in the 
database. This option will execute a specific job assigned and scheduled for that computer.

Install BIS Certificate. Install Boot Integrity Services (BIS) on the client computer. Select this option 
only after BIS services have been installed and configured on the server side.

Menu Item Properties
This dialog box allows you to identify new menu items in the PXE Configuration tool. It is accessed 
from the Boot Configuration > New. 

Description. Enter a name for the new menu item. 
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When a computer contacts the PXE Server for boot files, Deployment Server determines the 
computer's boot option as follows:

• If the computer is managed (known to the Deployment Database), but no work has been 
assigned, the default boot option is chosen.

• If the computer is managed and a DOS job (such as imaging or a registry task) is assigned, the 
Deployment Server boots the computer with the managed computer boot file.    

• If the computer is new (not known to the Deployment Server Database), the new computer boot 
file is used. By default, it will wait for user interaction before continuing.

Deployment Server
Query Deployment Server for boot. Select another Deployment Server to run DOS jobs for a managed 
computer. Create a menu option that references a second Deployment Server where the selected 
managed computer is identified in the database and a deployment job is set up. (This feature is used 
only in rare circumstances where a client computer is being managed by two Deployment Servers.) 

IP Address. Enter the IP address of the second Deployment Server. 

Port. Enter the port number of the second Deployment Server.

Initial Deployment Properties
The dialog box sets options for the Initial Deployment menu item.

Initial Deployment Timeout 
Disable Initial Deployment. Disable the automatic assignment of deployment jobs for new computers 
attaching to Deployment Server. 

Select Initial Deployment Menu Item. Select the Initial Deployment menu option to run Initial 
Deployment when a new computer not identified in the database logs on.

A computer will not deploy automatically using the Initial Deployment option unless the Wait 
Indefinitely default value is changed. Initial Deployment includes the following options: 

Execute Immediately. Click to have Initial Deployment run immediately without stopping for every 
new computer that logs on and attaches to Deployment Server.

Wait Indefinitely. Click to stop execution of the Initial Deployment until the option is manually 
changed (default). When selected, the boot option menu is displayed on the client computer. The 
user is required to select an option before proceeding.

Use Default Menu Timeout. Click to use the same timeout values set in the Boot Configuration dialog 
box. See Boot Configuration (page 291).

Timeout __ seconds. Enter a length of time (in seconds) to wait before running Initial Deployment. 
This is specific to the Initial Deployment option.

Make Boot Files
After creating a new Boot Configuration menu item, selecting it and clicking the Make Boot Files 
button, you are prompted to create a PXE boot file image from the Boot Disk Creator (BDC) 
program or to copy boot files from a floppy disk (for new computers). The PXE boot file image will 
include the DOS files and network adapter driver required to boot up the computer. You can also 
make boot files using the BDC for managed computers and for an initial deployment option.

Note Boot Disk Creator allows you to create and configure PXE boot files quickly and easily. You 
can create boot files using the DOS files that you copied to Deployment Server during installation 
and add network adapter drivers for each boot option. 

Create PXE Boot file image with Boot Disk Creator. Click to open the Boot Disk Creator utility program. 
This program allows you to create and modify boot disk images for this menu item.
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Create PXE Boot File image from floppy. Create a PXE boot image using by providing the DOS files 
on a floppy boot disk.

Create or Replace the PXE Boot Files
Follow these steps to modify the PXE boot files on the computer (most likely the Deployment Server 
computer) where you are running the utility. Both boot files (Managed and New Computer) are 
replaced when the configuration is changed. 

1 Open the PXE Configuration tool from the Windows Start menu by selecting Start > Programs > 
Altiris > PXE Services > PXE Configuration Utility.

2 Select Managed in Boot Option list. 
3 Select Make Boot Files. The Boot Disk Creator tool is launched. Defaults indicate current options 

chosen for the boot file. 
4 Select configuration and edit it. Then click Create PXE boot file.
5 Accept the defaults for the settings you want unchanged, and modify the settings that need to be 

changed. If you need details about the options on any of the screens, click Help.
6 Create the boot disk file.
7 Click Finish to save the new boot files. They will be saved to the boot file area automatically. 

(The directory path is not modifiable.) Client computers requesting boot services will now use 
these new files.

Note You will have to select this twice: once for a Managed computer option and once for the Initial 
Deployment option.

Manage Boot Menu Options
To change boot menu items, run the PXE Configuration tool on the PXE Server.

You can change the following behavior of the boot menu:

Change the default boot option
The first item in the boot option menu is the default. To change the default option, simply move the 
option that you want to be the default to the top of the menu.

1 Select Start > Programs > Altiris > PXE Services > PXE Configuration Utility.
2 From the PXE Boot Configuration screen, select the desired default and click Up until it is at the 

top of the list.
3 Click OK to save the menu.

Change the boot menu prompt
To change the text message that appears on client computers while they are booting: 

1 Select Start > Programs > Altiris > PXE Services > PXE Configuration Utility.
2 Modify the Prompt text and click OK.

Change the boot menu timeout
Change the length of time the boot prompt is displayed before the boot process starts:

1 Click Start > Programs > Altiris > PXE Services > PXE Configuration Utility.
2 Change the Timeout value to the length of time (in seconds) that you want the prompt to be 

displayed.
3 Click OK. 
Note If the F8 key is not pressed within the timeout period, the default boot option will run.
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To add, change, or delete menu items
1 Select Start > Programs > Altiris > PXE Services > PXE Configuration Utility.
2 Complete one of the following:

• To add a new item to the menu, click New. On the Menu Item Properties screen, enter the text 
for the new menu item. 

• To change an existing option, select it and click Edit. On the Menu Items screen, change the 
menu item text if desired.

• To delete an item from the menu, select the item and click Delete.
3 Click OK.

Query Deployment Server for Boot Control
To have managed computers ask the Deployment Server for the default boot option instead of using 
the PXE Server defaults, select Query Deployment Server for boot control. Enter the IP Address and 
Port of the Deployment Server. By default, this option is selected and the file server is selected for 
you.

Note When a computer contacts the PXE Server for boot files, the Deployment Server determines 
the computer's boot option as follows:

• If the computer is managed (known to the Deployment Database), but no work has been 
assigned, the Local Boot option is chosen.

• If the computer is managed and a DOS event (such as imaging or a registry task) is assigned, the 
Deployment Server boots the computer with the managed computer boot file.

• If the computer is new (not known to the Deployment Server Database), the new computer boot 
file is used.

General 
The General dialog box allows you to change the response mode for your PXE Server. In most cases, 
do not change the response mode for your PXE Server. However, if you have multiple PXE Servers 
installed on your network, you can delay the server response. This allows you to control the client 
boot requests that a PXE Server will respond to. 

Mode
These options control how the PXE Server responds to client computer requests for boot files:

Immediate Response. Click to respond without a delay to all requests from managed computers 
(default). This option is used most often. 

Short Delayed Response. Click to allow another PXE Server to respond to the managed computer. 
The server waits one-half second and then responds.

Delayed Response. Click to allow another PXE Server to respond to the managed computer. This 
option allows you to define the minimum and maximum waiting period. 

IP Address
PXE Server IP Address. This is the IP address PXE is using to service clients. Only change if the PXE 
Server IP address changes. 

MAC Filter
PXE was designed to allow managed computers to boot from any PXE Server on the network. By 
default, PXE Servers respond to all client requests for boot files. If multiple Deployment Server 
systems are installed on your network, you can control which boot requests that your PXE Server 
responds to using MAC address filtering (the unique Media Access Control number for each 
network adapter card). 
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Use MAC Address Filtering. Select this check box to include or exclude MAC numbers to filter. 

Service Only Addresses Below. Responds only to managed computers with the MAC address listed, 
even if the client computer exists in the Deployment Server Database. New computers will not be 
serviced unless their MAC address exists in the list.

Do NOT Service Addresses Below. Click to exclude managed computers whose MAC address is listed. 
This includes new computers whose MAC exists in the list.

MAC Address Patterns
MAC addresses are listed in this view box. Add, modify, or delete the addresses. You can also 
import or export MAC addresses using text files.

New. Click to enter MAC addresses to include or exclude depending on selected options. See Define 
MAC Addresses (page 296).

Edit. Click to change set addresses.

Import. Click to select and import a comma-separated file containing previously saved MAC 
addresses.

Export. Click to create and save a comma-separated file from displayed MAC addresses. You can 
export all or part of the list by selecting the MAC addresses.

Define MAC Addresses
Add new MAC addresses to include or exclude in the Mac Filter dialog box. See MAC Filter (page 
295).

Single Address. Click to enter a single MAC address. This address will display in the MAC Address 
Pattern list. 

Address Range. Click to enter multiple MAC addresses in a range. To set the range, enter the 
beginning of the address range in the From box and the end of the address range in the To box. 

Multicast 
To reduce network bandwidth requirements, PXE Server uses multicast features to download the 
boot file image to managed computers. This is very efficient when multiple computers are booting 
simultaneously. If your network configuration uses routers between subnets with clients on multiple 
subnets, your routers may not be configured to forward multicast packets.

These options control how the PXE Server utilizes multicast when transferring boot files:

Use Multicast for Boot File Transfer. Select to allow the PXE Server to use multicast when transferring 
boot files (default). Clearing this option causes the PXE server to use standard TFTP rather than 
MTFTP, which may work better in your routed environment. TFTP requires additional bandwidth.

Request Multicast Addresses from Master PXE Server. Click when running multiple PXE Servers on a 
network—all PXE servers must use unique multicast addresses when transferring boot files. Select 
this option to obtain a set of unique multicast addresses from a Master PXE Server.

Master PXE Server (Provide Addresses to Other PXE Servers). Select this option to make this PXE 
Server the Master PXE Server, then specify the multicast address ranges that will be used.

Only one Master PXE Server can be installed on a network, even if there are multiple Deployment 
Server systems on the network.

Beginning Multicast. Enter an IP multicast address. All multicast addresses must start with 224-254, 
but should be in the range 224.1.0.0 - 224.1.255.255. Other addresses may interfere with other 
products and communication protocols.
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Number of Multicast Addresses. Define the total number of multicast addresses a Master PXE Server 
can allocate to other PXE Servers. All addresses xx.xx.xx.0 and xx.xx.xx.255 are invalid for 
multicast use, so the default value of 65203 will allow all valid addresses in the range 224.1.0.1-
224.1.255.254 to be used.

Maximum Addresses Available to Single PXE Server. Each PXE Server will request only the number 
of multicast addresses it requires. This setting defines an upper boundary on the number of addresses 
that will be allocated to a given PXE Server. If a PXE Server cannot obtain all the necessary 
multicast addresses it will disable multicast use for Boot File Transfer.

Last Multicast Address. Identifies the last multicast address allocated by the Master PXE Server to 
another PXE Server. Each time a PXE Server boots it will obtain a new list of multicast addresses.

Using BIS in your PXE Environment
If you are using PXE boot files to manage your computers and you want to secure the computers so 
they accept only certified images, you can set up Boot Integrity Services (BIS) configuration boot 
files and certificates to do this. BIS allows you to sign boot files stored on the PXE Server with a 
certificate. Managed computers can be set up to accept only boot files that have the correct 
certificate.

Warning Once a certificate is installed, managed computers will require boot files with the 
certificate they are assigned. If you delete the certificate from the PXE Server, the client will not 
boot. If you want to remove a certificate, you must uninstall it from the managed computer before 
deleting it from the PXE Server.

 The following requirements apply:

• Your client computers must be PXE and BIS compliant.
• PXE must be installed in your Deployment Server system.
• You can have only one PXE Server serving BIS per network.
• You must have a Deployment Server Console installed on the PXE Server

Create a BIS configuration boot file on the PXE Server
1 Start the Boot Disk Creator on the PXE Server.
2 Select Tools > Create BIS Config Image. 
3 The Create Image screen appears, showing the path where the file will be created (The path and 

filename are not modifiable). Click Next to create the BIS boot file.

Set up the certificate/signature on the PXE Server
1 From the console on the PXE Server, click Tools > BIS Configuration.

2 Enter your password and select Create.
3 Click Sign Boot Images > Close.

Install the BIS certificate on managed computers
1 Reboot the managed computer.
2 Press F8 when you see the PXE menu to select boot option.
3 From the boot menu, click Install BIS certificate.
4 At the console on the PXE Server, locate and select the computer in the Computers list.
5 Right click and click Advanced > Install BIS certificate from the menu.
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Altiris ImageExplorer

The Altiris ImageExplorer provides features to view and edit image files. Image files are created 
using the RapiDeploy utility, a tool used most commonly in Deployment Solution to create and 
distribute hard disk image files, an IMG or EXE file containing a replication of the source 
computer’s hard disk. 

Using ImageExplorer, you can modify an image file — add or delete data files, folders and 
applications — before distributing and restoring its contents to a client computer. You can view 
properties and perform operations such as extracting and saving files to another destination volume, 
or exclude files from being restored when distributing the image file to a client computer. You can 
also print the contents of a folder or edit a file using its associated application. 

See also Using ImageExplorer (page 300).

ImageExplorer Features
• Add new files and folders
• Extract files and folders
• Exclude (or include) files from being restored
• Find files in an image
• Open a file with its associated program and edit
• Replace files
• Revert back to original image file contents
• Print image tree structure of files, folders and volumes
• View, add or change the image description
• View properties of files, folders, and volumes in an image

ImageExplorer User Interface

Altiris ImageExplorer provides the following features to view, manage and modify the volume, 
folder, and file elements of an image file. 

Click the ImageExplorer icon on the toolbar or click Tools > ImageExplorer. This 
opens the ImgExpl.exe program located in the Client Access Point folder. 
You can open and edit image files in the native IMG file type or image files with 
packaged rdeploy.exe runtime versions in an EXE file type.
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Feature Description Button Access
Add File Adds a new file to the image file. See Add 

New Files (page 302).
Add File is available when you right-click a 
volume, folder, or a file in the tree view. 
When you right-click on a file and select 
Add File, the new file is added to the same 
folder.

Ctrl-A
or
Click Edit > Add File
or
Right-click an item and 
select Add File

Add Folder Adds a new folder to the image file. Click on 
any item to add a folder to the container 
object. 
Add Folder is available when you right-click 
a volume, folder, or a file in the tree view.

Ctrl-D
or
Click Edit > Add Folder
or
Right-click an item and 
select Add Folder

Copy Copies a file or folder from one location and 
allows you to paste to a destination image 
file. 
Note Copying large amounts of data and 
large numbers of files between image files 
can take several minutes. 

Ctrl-C
or

Click Edit > Copy
or

Right-click an item and 
select Copy

Exclude Marks files only to not be included when 
deploying the image file to a client 
computers.
Note You can also exclude a file by clicking 
the check box next to the file in the Details 
pane. The  icon replaces the check box. 

Del key
or

Click Edit > Exclude
or

Right-click a file and 
select Exclude File(s)

Extract Extracts a complete folder (with its sub-
folders) or a file from the image file. It 
allows you to select a destination volume or 
directory to save the folders or files. See 
Extract a Folder (page 302).
Note Extracting large amounts of data and 
large numbers of files can take several 
minutes.

Ctrl-E
or

Click Edit > Extract
or

Right-click an item and 
select Extract File(s)

Find Search for files or folders within an image 
file using specific names or wildcard 
characters. You can use ? as a variable for a 
single character, or * (asterisk) for multiple 
characters. See Find Files (page 303).

Ctrl-F
or

Click Edit > Find

Right-click a container 
object and select Find

Include Allows files only that were previously 
marked Excluded to be included in the image 
file when it is deployed to a client computer.
Note You can also include a previously 
excluded file by clicking the  next to the 
file in the Details pane. A check box will 
reappear.

Insert key
or

Click Edit > Include
or

Right-click an excluded 
item and select Include

Open File
(available for 
files)

Opens a file using its associated application, 
if the application exists on the computer 
where ImageExplorer is being run.

Double-click
or

Click Edit > Open
or

Right-click the file and 
select Open
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Using ImageExplorer
With the ImageExplorer running, open the image file you want to view or modify by selecting 
Files > Open from the program menu bar. 

Note Older image files created with IBMaster.exe instead of the current RDeploy.exe cannot 
be modified with the version of ImageExplorer that ships with Deployment Solution 5.6 or higher. 
However, image files created with IBMaster can be viewed and files can be extracted. The 
ImageExplorer will always display the files created with IBMaster as Read-Only even when the file 
attributes are Read-Write. To modify older image files you will need to use the version of Altiris 
ImageExplorer that ships with the earlier versions of Deployment Solution. 

Open File with Allows you to open a file with a selected 
program. If the file is already associated 
with a program you can simply double-click 
to open. Use Open file with to change the 
program or select the default Quick Open 
feature. 

Double-click (if not 
associated)

or

Click Edit > Open with
or

Right-click the file and 
select Open with

Open Image File Opens image files created with 
RDeploy.exe or IBMaster.exe. Files 
created with IBMaster are read-only, 
however these file can be viewed and 
extracted. You need an older version of 
ImageExplorer (Deployment Solution 5.5 or 
earlier, or RapiDeploy 4.5 or earlier) to edit 
files created with IBMaster.exe.

Ctrl-O
or

Click File > Open

Paste Places a file or folder from one location to 
another.

Ctrl-V
or

Click Edit > Paste
or

Right-click an item and 
select Paste

Print Folders: Prints the folder structure. 
Includes sub-folders and files with their 
modification date, time, and size.

Files: Prints the actual file. You must have 
the associated application program installed 
to print the file (for example MS Word to 
print DOC files).
See Print Folder Contents (page 303) and 
Print a File (page 304).

Ctrl-P
or

Click File > Print
or

Right-click an item and 
select Print

Properties Provides general information about the 
folder or file, such as size, modification 
dates, and attributes. Properties are 
displayed differently for images, volumes, 
folders, or files. See View Properties (page 
301).

Alt-Enter
or

Click File > Properties
or

Right-click an item and 
select Properties

Replace Files
(available for 
files)

Provides a way to update a file in the image 
with a file from another source. Both files 
must have the same name.

Ctrl-L
or

Click Edit > Replace
or

Right-click a file and 
select Replace File(s)

Revert
(available for 
files)

An undo feature for the Replace File option. 
This will revert a previously changed file to 
its original file.

Ctrl-R
or

Click Edit > Revert
or

Right-click an item and 
select Revert File(s)

Feature Description Button Access
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See also View Properties (page 301), Add New Files (page 302), and Extract a Folder (page 302)

View Properties
After opening an image file with ImageExplorer, basic information about the image file and its 
elements can be viewed by selecting a file or volume (partition) name and clicking Properties. You 
can open the properties page for an image file, volume, or file by right-clicking and selecting 
Properties, clicking File > Properties, or typing Alt-Enter. Depending on the type of image element, a 
property page will open with the appropriate tabs: 

General Properties for an Image File 
This General property page displays data specifically for image files. After selecting Properties for 
a selected image, click the General tab to view the image items and additional property data such as 
size, location, and attributes.

The Image property page includes the name of the image file and its associated image data. For 
example: In the Size field you can view the amount of room that the image used on the hard drive of 
the source computer. In the Size on disk field, you can view the actual size of the compressed image 
file before it is deployed.

You can modify the password of the image file in this dialog box.

General Properties for a Volume 
This General property page displays data specifically for a volume. After selecting Properties for a 
selected folder in an image file, click the General tab to view its property data such as size, location, 
and attributes.

General Properties for a Folder 
This General property page displays data specifically for a folder. After selecting Properties for a 
selected file in an image, click the General tab to view its included files and additional property data 
such as size, location, and attributes.

General Properties for Files 
This General property page displays data specifically for files. After selecting Properties for a 
selected folder in an image file, click the General tab to view its included files and additional property 
data such as size, location, and attributes.

Description Properties for an Image 
The Description property page displays the constituent volumes within the image file. It provides a 
count of the volumes in the image and lists the name of each volume in the Volumes pane. If the 
image file has read-write access, you can modify the image description.

Disk Partition Properties 
The Miscellaneous property page provides a comprehensive list of system attributes for each volume 
in the image file. It includes volume data and statistics, including data imported from the partition 
table.

Open a File 
To open a specific file in an image, double-click the file in the Details pane of the ImageExplorer or 
right-click and select Open. The file will open with its associated program. If no associated program 
is located, an Open with dialog box will appear allowing the user to select and associate a program 
for the file. 
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Note You can also associate a file with a program by right-clicking the file and selecting the Open 
with command.

The Quick open feature allows you to select a default program to open files without associated 
programs (Microsoft Notepad is the default program). You can change the default program for the 
Quick Open feature by clicking View > Settings and editing the Open with program box.

See also Print a File (page 304) and Settings (page 304).

Opening Split Image Files 
If an image is too large or if you are trying to meet size restrictions to store an image (such as 
dividing image files to 600 MB to fit on multiple CDs), then you can use the features in RapiDeploy 
to split the image file into multiple files. When editing, ImageExplorer will keep track of these split 
image files and will prompt you to locate any additional linked image files not stored in the same 
directory.

Find Missing Split Image Files 
If multiple files from a split image are kept in different folders or on separate CDs, then this dialog 
box will open to help you locate the missing split image files. Enter a path in the field or browse to 
the missing files. ImageExplore keeps track of all files in a split image and will prompt you for any 
missing split image files if they are not located in the same folder.

Add New Files
1 Open Altiris ImageExplorer.
2 Click File > Open. Select an image file and click OK.
3 Right-click the preferred volume or folder in the image and select Add File. The Select Files to 

add dialog box will open.
4 Locate a file and click OK. The new file will now be displayed in the image.

OR
5 Drag a file from Windows Explorer to the selected folder or volume in an image file displayed 

in ImageExplorer, or copy and paste the file. If the option is selected (see the Paste / Drop 
operations in the Settings (page 304) dialog box), a message box will appear confirming your 
decision to copy a file to the image file.

Note You can access and edit text files by double-clicking the file in the Details pane of the 
ImageExplorer dialog box.

Extract a Folder
Use this feature to take a folder or file from an image and save it to an external destination folder:

1 Open Altiris ImageExplorer.
2 Click File > Open. Select an image file and click OK.
3 Select a folder in the image, right-click and select Extract Folder. The Browse dialog box will 

open.
4 Select a folder on your local disk or on the network to place the extracted folder.
5 Click OK.
Note Extracting large amounts of data and large numbers of files can take several minutes.
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Find Files 
To search for files or folders in an image file, enter a string or characters (alpha and numeric) in the 
Find what box. You can use the ? (question mark) as a variable for a single character, or use 
the * (asterisk) for multiple characters.

To search for a file, select the image file, volume name, or folder name from the tree view to set a 
search domain. You can change the search domain before clicking Find. 

Include folders. Select this option to include matching folders in the search results.

Include files. Select this option to include matching files in the search results.

Files and folders meeting specified search criteria will be listed in the results box, organized by File 
Name and Location.

Filter Results 
Click Filter on the Find Files dialog box to open an advanced search for files based on associated 
system attributes (Read-only, Hidden, System) and ImageExplorer attributes (Added, Excluded, 
Replaced). 

Find What. Enter the string or characters to find a file based on system attributes or ImageExplorer 
attributes of the file or folder. Click Include matching files to select files. 
Click Include matching folders to select folders.

Note To search in a specific directory, select that directory in the tree view pane and open the Find 
dialog box. 

The following attributes use three-way check boxes with these features: 

• A solid check mark means the item must contain the attribute. 
• An empty box means the item must not contain the attribute.
• A dimmed check mark means the value is NULL and the item can either have the value or not. 
Attributes. These are the system attributes of the files assigned by the operating system when the 
image was created.

Flags. These are the attributes assigned by ImageExplorer.

Print Folder Contents 
You can print a list of the files and sub-folders within an image file, a volume (partition), or a folder. 
Depending on the options selected, you can print a report that includes the constituent files and 
subfolders and includes fields with the modified date, time, size, and other attributes for each file.

When printing the contents of an image file, volume, or folder, click OK to view a Print Preview 
(page 304) of the report file.

Title. Enter a title that will appear at the top of the report page.

What to print

Just this folder. Print only the files in the selected image, volume, or folder. This will not print the 
subfolders.

This folder and subtree. Print the files in the image, volume, or folder and all the subfolders and files.

Print excluded items. Print the files that were marked previously as Excluded.

Print < . > entries. Print an entry in each folder identified as < . > (a dot notation). Attributes and date/
time properties will be saved for this hidden folder in the image file.
Deployment Solution Product Guide 303



 Altiris ImageExplorer Using ImageExplorer

 

Fields to Print

Include modified date and time. Print the date and time that the file or folder was modified.

Include size. Print the size of the file.

Include attributes. Print the Read-only, Archive, Hidden, System, or Compressed system attributes 
(Read-only, System, Hidden) and the ImageExplorer attributes (Added, Excluded, Replaced).

Include file number. Print the file number associated with each file.

See also Print a File (page 304).

Print Preview 
View an online display of the print report for image files, volumes, or folders. The name of the report 
will appear at the top of the page with details in a table that were selected in the Print Folder Contents 
dialog box.

Save. Click to save the report to a text file.

Lines. View the number of lines in the report.

Print. Click to print the report.

Print a File 
From the ImageExplorer dialog box, you can select and print an actual file using its associated 
program. If your file is not associated with a program, you can associate it by selecting from a 
provided list of installed programs on the computer. You can also attempt a Quick print to open the 
file using a standard program such as NotePad.

Quick print. Click this button to run a default program to open and print the selected file. The default 
program is Microsoft Notepad. You can change the default program to print files using the Print With 
program box in the Settings dialog box.

See also Print Folder Contents (page 303) and Open a File (page 301).

Setting a Password on an Image File 
Right-click an image file and select Properties. In the Attributes section, select Password. The Set / 
Change Password dialog box will open.

Current password. Enter current password.

New password. Enter new password. 

Confirm password. Type the password again to confirm that is was correctly typed in.

Settings 
You can set preferences for the Altiris ImageExplorer by clicking View > Settings. The Settings 
dialog box will open to set options to confirm specific operations using message boxes in the user 
interface, to set options for displaying items or excluding items, or to select default programs when 
using the Quick print (see Print a File (page 304)) or Quick open (see Open a File (page 301)) options.
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Confirmations
Read-only Open operations. Present a confirmation message to the user when opening a file in a read-
only state, and as a result any changes cannot be saved. For example, if an image file created in 
RapiDeploy 4.5 or earlier is opened, it will be read-only and any operation performed cannot be 
saved. As a result, when opening this file a confirmation box will appear reminding the user that the 
file cannot be saved.

File Overwrite operations. Present a confirmation message to the user when extracting a file from an 
image file and overwriting an existing file on a destination drive.

File Revert operations. Present a confirmation message when executing a Revert operation that 
returns the image file to its original file structure and content after replacing files. 

Paste & Drop operations. Present a confirmation message when dragging a file to a new folder in an 
image file, when using the copy and paste operation to move files to another folder, or when using 
the Add New Files command.

Exclude operations. Present a confirmation message to the user when assigning the Exclude option 
to a file (to not distribute the selected file as part of the image). This message will appear when 
clicking the check box on the file or folder or selecting the Exclude operation.

Folder Overwrite operations. Present a confirmation message to the user when extracting a folder from 
an image file and overwriting an existing folder on a destination drive.

Display Settings
Keep help on top. Select to keep open help file on top of the ImageExplorer user interface. This 
allows you to view the help side-by-side with the program rather than allowing it to be sent behind 
the ImageExplorer user interface.

Show file numbers. Display the associated file numbers in the image. In NTFS the files are numbered 
automatically. In FAT, EXT2, EXT3, and other file systems the files are numbered by RapiDeploy 
when creating the image file.

Show excluded items. Display the files marked as Excluded in the image. Files will be shown after a 
refresh of the screen. 

Extract excluded items. Allow the Excluded files and folders to be extracted from the image file to a 
destination folder. This setting allows you to include all files previously marked as Excluded to be 
saved to an external destination folder when running the Extract command.

Color added items. Select this option to mark files/folders added to the image with blue text. See Add 
File (page 299) and Add Folder (page 299).

Color replaced items. Select this option to mark files/folders replaced to the image with magenta text. 
See Replace Files (available for files) (page 300).

Color excluded items. Select this option to mark files and folders added to the image with red text. 
See Exclude (page 299).

Default Programs to Open and Print Files
These settings are default settings for the Quick Open and Quick Print options that appear with the 
Open with and Open features. Use to associate files to a common program such as Microsoft Notepad.

Open with program. Set the default program to run with a selected file. The default program is 
Microsoft Notepad. See Open a File (page 301).

Print with program. Set the default program to print a selected file. The default program is Microsoft 
Notepad. See Find Files (page 303).
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Deployment on Notification Server
This section provides concepts and procedures for integrating multiple Deployment Server sites and 
multiple Altiris Solutions to deploy, manage, and migrate computers from the Deployment view on 
Notification Server.

Quick Links

Using Deployment on 
Notification Server (page 307)

Instructions for scheduling and managing multiple 
Deployment Server installations from  
Deployment on Notification Server.

Deployment Web Reports (page 
325)

Details about generating Web Reports from 
Deployment on Notification Server

Deployment Solution Policies 
(page 322)

Details about configuring policies in Deployment 
on Notification Server. 

Installing Deployment on 
Notification Server (page 83)

See step-by-step instructions for installing 
Deployment on Notification Server and other DS 
components.



 

Using Deployment on Notification Server

The Deployment view on Notification Server lets you complete these deployment and management 
tasks, including:

• Scheduling Jobs for computers or computer groups for each Deployment Server installation. 
Click and drag to schedule deployment tasks for computers managed by a specific Deployment 
Server. 

• Viewing Computer Properties for managed computers using the Resource Explorer.
• Remotely Installing Deployment Server components from the Deployment on Notification 

Server.
• Using Package Servers to Replicate Deployment Jobs to automatically update packages 

(images, RIPs, scripts, and other package types) that are saved on a central Deployment Server 
Library and replicated to other peripheral Deployment Servers. 

• Setting Polling Intervals to automate updates between changes in the Notification Server 
Database (such as scheduling data performed in the Deployment view on Notification Server), 
and update deployment tasks or computers added to each Deployment Database.

• Updating Collection Settings to refresh collection membership in Notification Server computer 
groups.

• Synchronizing Databases to perform a complete data copy between the Notification Server 
Database and the Deployment Database. 

Scheduling Jobs
From the Deployment view on Notification Server, you can schedule deployment tasks using three 
different actions: 

• Click the Schedule Job link and follow steps in the wizard. 
• Drag a job from the Jobs pane to computers listed in the Details pane 
• Drag a job from the Jobs pane to computers listed above it in the Computer Groups/Collections 

area (upper-left pane). 
Note If you have nested groups of computers in multiple levels of folders in the Computer Groups/
Collections area, drag the deployment tasks from the Jobs pane to the Computer Groups/Collections 
(upper-left pane) to run or schedule deployment tasks. Using the Schedule Jobs Wizard, or using the 
drag-and-drop features in the Details area (the right pane) will not run or schedule deployment tasks 
to computer groups below the second level of folders in the tree. 

Schedule deployment jobs to individual computers or to groups of computers provided in the 
Deployment view on Notification Server. To select a single computer, first select the computer 
group in the Computer Groups/Collections pane, and then select the computer from the list of group 
members in the Details pane. Use the New Computers or All Computers collection for general 
application or for initial computer management. In addition, specialized groups are listed under the 
NS Collections folder.

Note From the Deployment view on Notification Server, you can only schedule deployment tasks 
against computers managed in the same Deployment Server installation. Deployment tasks residing 
in Deployment Server installation #1 will not run on computers managed by Deployment Server #2. 
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Using the Schedule Jobs Wizard
1 Click the Schedule Job link in the Deployment view on Notification Server. 

The Jobs dialog box will open.

2 Select a job from the list. Click Next.
The Computers dialog box will open.

3 Select a computer or group of computers from the list. Click Next.
The Schedule Jobs dialog box will open.

4 Either accept the default setting to run the deployment task immediately, or schedule the job 
using this dialog box.

5 Click Finish.

Drag and Drop Jobs to Computers
Drag and drop deployment jobs from the Jobs pane to computer groups or individual computers.   

1 Click a deployment task in the Jobs pane of the Deployment view on Notification Server.
2 Drag and drop a deployment task on a computer or folder with a group of computers listed in the 

Computer Groups/Collections area of the console. 
Note You can also drag and drop deployment tasks to computers or groups of computers listed 
in the Details area (right pane). Individual computers are listed in the Details area for each group.

The Schedule Jobs dialog box will open:

3 Either accept the default setting to run the job immediately, or schedule the job using this dialog 
box.

4 Click Finish.

Viewing Computer Properties
1 In the Computer Groups/ Collections pane, select a group such as All Computers.

The computers in this group or collection will appear in the Details area.
2 Right click on a computer.
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A Show Resource Computer link will open.

3 Click the Show Resource Computer link.

4 View the computer properties for the selected computer. Select the different tabs to view various 
property types for each computer.

Remotely Installing Deployment Server
Deployment Solution includes features to install Deployment Server (the Windows components) 
from the Deployment view on Notification Server. You can install to the same computer running 
Notification Server, or install to another computer on your network. 

1 Click the Options button.
2 Select Installation.
3 Follow the Deployment Server installation program to install the Windows components of 

Deployment Solution on selected Notification Server managed computers. 

Process and Data Flow for Remote Installation
To install Deployment Server from Deployment on Notification Server, all client software (agents) 
must be installed to the Deployment Server installation, including the Notification Server Client and 
the DS Agent. Deployment Server components are installed through manual installation steps with 
client agents installed automatically using Notification Server policies and collection updating.
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This section steps you through the process and data flow for remotely installing Deployment Server 
components from the Deployment view on Notification Server.

1 From the Deployment view > Options > Installation dialog box, select the target computer to install 
Deployment Server components. In this example, the computer DS9 is selected.

 
The computer to which you are installing Deployment Server must have the Notification Server 
Client installed. See the Altiris Notification Server User Guide for complete installation 
instructions for the Notification Server Client.   

2 The selected computer (DS9) is then added to the Deployment Server Agent Configuration 
collection (Deployment Solution > Collections > Deployment Server Agent Configuration > Full 
Installation/Upgrade of Deployment Solution). 

3 The policy to install Deployment Server is enabled (Deployment Solution > Policies > Deployment 
Server Agent Configuration > Full Installation/Upgrade of Deployment Solution).

4 When the computer’s timer elapses, Notification Server will run the policy to execute a package 
that runs the Deployment Server installation program.

5 Deployment Server installs on the selected computer (DS9) using the Simple install method.
6 When the timer elapses again, it checks with Notification Server and installs the Deployment 

Server Agent. 
This installs the Deployment Server. You can now set the polling intervals to set periodic updates to 
update the Deployment Server with the Deployment view on Notification Server. See Setting 
Polling Intervals (page 316). 

Using Package Servers to Replicate Deployment Jobs
Deployment Solution takes advantage of Package Servers (a basic component of Notification 
Server) to automatically copy images, RapidInstall Packages (RIPs), scripts, and other package files 
for building deployment tasks for use across multiple Deployment Server installations. From a 
central Deployment Server installation, packages can be built and saved to a local Library structure, 
where they are replicated to other Deployment Servers and used in deployment jobs for each 
installation.

Note Package Servers can only replicate packages on Deployment Server installations set up as a 
simple install (all Deployment Server components on a single computer).
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Overview of Package Servers
Package Servers are a basic feature of Notification Server and are used to reduce network traffic and 
HTTP download times when deploying packages across your system. Package Servers replicate and 
transmit packages from a central computer to local computers during off-peak hours. When 
deployment tasks are executed, package files are accessed quickly from local package libraries. 
Notification Server allows you to identify managed computers running the Notification Server 
Client as a Package Server.

Replication of packages from a central Deployment Server to other Deployment Servers is a one-
way process: You can build and copy packages from the Library of a central Deployment Server to 
replicate to other Deployment Servers; however, any changes made to a destination Deployment 
Server will not be replicated back to the central Deployment Server. After the package files have 
been copied once (per each package server), they will never be copied again unless the files are 
updated, new files are added to the package, or files are set manually to be copied down to other 
destinations again. 

When the Deployment view on Notification Server is installed, it creates many of the default 
packages, collections, and policies required to take advantage of Package Server features. To 
complete the setup process, however, additional configuration steps are required.

Setting up Package Servers requires three basic steps:

1 Setting Up a Central Deployment Server Library (page 311)
2 Setting Up Package Servers (page 312)
3 Exporting and Importing Deployment Jobs (page 314)

Note: Before deliverying packages, check the Package Server settings and the package settings to 
make sure that the package can be delivered. The DS install package by default is not set to use any 
Package Servers. There is a global configuration variable that says not to allow any package 
downloads from the server, leaving the DS Install in a state where there is no way to access the 
package.

The Deployment Solution install wizard does not account for this condition and, as a result, will not 
push the Deployment Server install to the selected remote computer. xxx

Setting Up a Central Deployment Server Library
Before setting up Package Server in a Notification Server Console, you need to select a central 
Deployment Server to copy and store all packages to be replicated to other Deployment Server 
installations. After selecting a Deployment Server in your system, you can set up the Deployment 
Server Library directory structure. The Library will be a directory structure that contains your 
images, RIPs, and any other package files needed for a Deployment Server Task. 
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Because the package used to replicate files only points to one location, all of the items to be 
replicated must reside under this substructure. You will need to manually create the Library 
directory and any other subdirectories on the Central Deployment Server. 

1 Go to your Central Deployment Server directory (default is c:\Program 
Files\Altiris\eXpress\Deployment Server).

2 Create a Library directory. 
3 Under the Library directory, create subdirectories to use for images, RIPs, or other package files. 
4 Create a Temp directory for deployment tasks that require a temp directory. 
5 Copy into this structure any required files accessed during execution of the jobs.
Note Any job that is automatically created will need to be modified before running or the default 
directories will not be correct. For example, if you choose to change the configuration of a computer 
by choosing the Configure option in the Deployment view on Notification Server, the task will create 
a CFG file in the temp directory located in the Deployment Server directory. For this task to replicate 
correctly, you will have to copy the file into a temp directory under the Library structure and edit the 
task to point to the file in the Library\temp directory. Remember that only the files under this 
structure will be replicated to the other Deployment Server installations.

After installing Deployment on Notification Server, you will have two packages and one policy 
created to help facilitate replication. You can manually modify the packages and enable the policy.

Setting Up Package Servers
After setting up a Library directory structure on the central Deployment Server computer, you can 
set up Package Servers on other Deployment Server installations. 

Before a computer can be selected as a Package Server, it must be running the following software:

• Windows NT (with MDAC 2.5), Windows 2000, or Windows XP.
• Notification Server Client.
• Deployment Server software (if you are planning to run exported deployment tasks from a 

central Deployment Server). 

Set up a Package Server
1 From the Notification Server’s Administration console, select the Configuration tab.
2 From the left pane, select Package Servers. 
3 Select the Add Package Server button from the bottom of the page.
4 Locate and select the Deployment Server computer (or the Client Access Point for each 

installation) and click Add. Use the search feature if required. 
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Modify the DS Library Package
To replicate files stored in the central Deployment Server Library directory, the DS Library package 
installed with the Deployment view on Notification Server and viewed from the Notification Server 
Administration Console must be edited with configuration information, including:

• The source of the files and programs to be replicated.
• The Package Servers that can receive the files to be replicated.
• The destination directory for the files being replicated.
• The programs that will run after the files are copied to the Package Servers.
Follow these steps to modify the DS Library package:

1 Select the Solutions tab and then select Deployment Solution > Packages > Deployment Server 
Replication > DS Library.

2 From the right pane, select the Package Distribution Method (Required) option to configure the path 
to the files that will be included in this package.

3 Select the applicable distribution method and enter the correct path to the Central Deployment 
Server Library. 
Choose from one of the following options:

• Access Package from a local directory on the Notification Server machine
Use this option when the central Deployment Server is installed on the same computer as the 
Notification Server. Fill in the Package Location box with the correct path for the Library.
For example: C:\Program Files\Altiris\eXpress\Notification 
Server\Library

• Access Package from Existing UNC
Use this option when the Deployment Server that has been configured as the Central 
Deployment Server Library is not installed on the same computer as the Notification Server. 
When using this option, read and follow the instruction on this page.

Note: Depending on the amount of data in the Central Deployment Server Library, a message 
warning you about the size of the files in the Package may be displayed. This message is to remind 
you that all of the files in this directory will be sent when this package is used. 

4 Select Package Servers. 
This option allows you to specify to which Package Servers you would like this package to be 
replicated to.

5 Enable all applicable Package Servers by clicking the Enabled check box. 
Warning Do not select the Select All Package Servers option. 

6 To identify the destination directory (where the package files will be sent) on the destination 
Deployment Server, scroll down to the Package Destination Location on Package Servers area. 
Clear the check box from the Default Location on Package Servers (recommended) option.

7 Enter the destination path: 
\\%COMPUTERNAME%\eXpress\Library
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The \\%COMPUTERNAME%\ token uses the environment variable to resolve the name of the 
computer. The token name is not case sensitive. A drive letter can be used instead of the token if 
required. 
eXpress is the default share name of the Deployment Server 5.5 installation directory (Client 
Access Point). 
Library is the name of the directory in the eXpress share where the files in this package will be 
saved.

8 Select Apply to save the changes.
As soon as the Notification Server Client’s Configuration request interval time (on the destination 
Deployment Servers) has elapsed, the files in the central Deployment Server will be sent to the 
Package Servers on other Deployment Servers.

Exporting and Importing Deployment Jobs
After creating a Library directory on the central Deployment Server and setting up Package Servers, 
you will need to create the jobs to copy and run the packages on the managed computers. These tasks 
then need to be exported from the central Deployment Server to the destination Deployment Servers 
by configuring the DS Task Import Utility package and modifying the DS Task Import Utility policy on 
the central Deployment Server. 

Note Replicated deployment tasks will need to reference files created in the Library directory 
structure. For example, a deployment task that deploys an image named NT4.img would use the file 
path of .\Library\Images\NT4.img instead of the standard .\images\Nt4.img path.

Create a Job Export File
After creating deployment jobs to use with the replicated packages, you can create a job export file. 

1 Right-click the jobs that you want to export. Select Export (or click File > Import/Export > Export 
Jobs). 
The Export Jobs dialog will open.

 
2 Browse to the \Notification Server\nscap\bin\win32\x86\DSUtil directory and 

enter a name for the export file. (The default file name used in the task replication package is 
task.bin.)
The DSUtil directory is added when you install the Deployment view on Notification Server. If 
you want to export the task subfolders, choose the Export subfolders check box. 

Note If you use an export file name other than task.bin, you will have to edit the program 
command-line in the task replication package. 

3 Click OK to start the export.

Configure the DS Task Import Utility Package
After creating deployment tasks and exporting them to the DSUtil directory, you need to configure 
(or verify) settings in the DS Task Import Utility package. Modifications to this package are required 
when any of these alterations are made:

• The Deployment Server jobs exported are not saved in a file called Task.bin.
• The method of handling duplicate job names on the destination Deployment Server needs to 

be changed.
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• Security for the Deployment view on Notification Server is enabled on the destination 

Deployment Server.
The DS Task Import Utility package runs the aximport.exe program to import deployment jobs. 
When the Deployment view on Notification Server is installed, the aximport.exe program file is 
copied to the \Notification Server\nscap\bin\win32\x86\DSUtil directory. This is the 
same directory where you saved your exported tasks.bin file from the central Deployment Server. 
When all steps are completed, no changes are required for this package. 

To configure or modify how the DS Task Import Utility package is configured, complete the following 
steps:

1 Open a Notification Server Administration console and select the Solutions tab. Select 
Deployment Solution > Packages > Deployment Server Replication > DS Task Import Utility.

2 In the right pane, select the Programs link. 
By default, the Identification section expands to view settings.

3 If needed, change the name of the file on the command line to match the name of the export file 
created when the Deployment Server tasks from the central Deployment Server were exported.
As can be seen in the figure above, the default command-line parameters for the aximport.exe 
program are configured to use the Task.bin file. This file contains the exported Deployment 
Server deployment tasks (jobs). 

Note The /o switch causes the import to replace any tasks with the same name as those being 
imported. If this is not the desired result, change the command-line options. 

If you have Console Security enabled, the username (/u) and password (/p) command line options 
will need to be included for this process to work correctly. 

/u Database user name
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/p Database user password

Example: aximport.exe task.bin /o /u administrator /p yourpw 

See the command-line chapter in the Altiris eXpress Deployment Solution User Guide for additional 
command-line options for aximport.exe.

4 Select Apply.
You can choose to force an update of the package to ensure that the task export file is in the package. 

Modify and Enable the DS Task Import Utility Policy 
You must enable the DS Task Import Utility policy to allow the Deployment Server tasks to be 
replicated to the destination Deployment Servers. 

1 Open a Notification Server Administration console and select the Solutions tab. Select 
Deployment Solution > Policies > Deployment Server Replication > DS Task Import Utility. 
The Identification section of the Advertisement page will be displayed by default.

2 Verify that the Applies to Collection option has been configured to use the DS Package Servers 
collection. This collection is selected by default.
Before enabling the DS Task Import Utility policy, ensure that the task.bin file has been created 
and saved in the \Notification Server\nscap\bin\win32\x86\DSUtil directory.

3 Click the Enabled check box. 
4 Select Apply. 
The policy is now enabled. The next time the Notification Server Client’s configuration timer 
elapses on the Deployment Servers with Package Server installed, the policy will be executed. On 
the destination Deployment Servers, a DOS box will open on this computer and aximport.exe will 
run. 

Synchronize Deployment Server Tasks
You can update deployment tasks by creating a new task.bin file and placing it in the DSUtil 
directory. After all timers elapse, Notification Server will compare and detect the new export file by 
its time stamp. When the Notification Server Client checks for new policies, this policy will run on 
the destination Deployment Servers. 

To avoid waiting for Notification Server to detect that the file has been modified, the package can 
be refreshed manually by selecting the DS Task Import Utility package (from the Solutions tab of 
the Notification Server Administration Console) and selecting the Update Distribution Point option. 

From a destination Deployment Server, the policy to import the Deployment Server jobs can be 
forced to run again by manually scheduling the policy. 

Setting Polling Intervals
Deployment Solution uses two separate interval settings to synchronize data between the 
Deployment Database and the Notification Server Database. To update the Notification Server 
Database, new computers and deployment tasks created in the Deployment Server Console and 
saved to the Deployment Database are transmitted using the DS Agent to update the Notification 
Server Database. Conversely, scheduling information executed from the Deployment view on 
Notification Server is transmitted using the Notification Server Client to update the appropriate 
Deployment Database. 
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Setting polling intervals and configuration request intervals requires that you plan how often you 
want to refresh console and deployment information compared to network traffic requirements. If 
you set frequent updates (such as setting a polling interval to 1 minute), then your console 
information will be relatively up-to-date, but network traffic will be heavy because data is extracted 
and transmitted every minute from every Deployment Database to update the Notification Server 
Database. 

In contrast, if you set polling intervals and configuration requests for a larger polling interval (such 
as one day), then your network traffic will be light--and you can plan the polling updates for off-
hours--but your console information (computers, jobs, and properties for example) will be more 
static and out-of-date in the Deployment view on Notification Server. 

However, updating information on a daily basis may meet your needs for weekly reporting and task 
scheduling. The balance between timely deployment information displayed in the Deployment view 
on Notification Server and the level of network traffic should meet your IT policies, organizational 
requirements, and network design. 

• See Setting the DS Agent Polling Interval (page 317).
• See Setting the Notification Server Configuration Request (page 318).
• See Setting the DS Agent Polling Interval for Multiple Deployment Servers (page 318). 

Setting the DS Agent Polling Interval
To refresh new computers and deployment tasks to display in the Deployment view on Notification 
Server, set the polling interval in the Notification Server Administration Console.

1 Select the Solutions tab.
2 Select Deployment Solution > Policies > Deployment Server Agent Configuration.

Multiple policies to configure or install Deployment Server Agents are provided. 

3 Select the Deployment Server Agent for all Deployment Servers. 
You can also select settings for each Deployment Server installation. 

4 From the Deployment Solution Agent Configuration page, identify the Computer/Job Polling Interval 
setting.

5 Select the appropriate polling interval to update computer and deployment job data. 
6 Click Apply.
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Setting the Notification Server Configuration 
Request
To download scheduling and configuration information set in the Deployment view on Notification 
Server for each Deployment Server installation, the Notification Server Database must update the 
Deployment Database to run the scheduled tasks. This updated data is transmitted automatically 
through the Notification Server Client at defined configuration request intervals. 

To update scheduling and configuration information for each Deployment Server installation, you 
must set the interval request information in the Notification Server Administration Console.

1 Select the Solutions tab.
2 Select Altiris eXpress Configuration > Policies > NS Client Configuration > Client Settings. 
3 From the Policy Properties pages, click Configure the Win32 Client link.
4 Click the Client Communication link. 
5 Set the Configuration Request settings.

The client should request new configuration information every _______ field sends a request to 
Notification Server to flag all new scheduling records in the Notification Server Database. This 
transmits data to the Deployment Database to schedule the deployment jobs and display them in 
the Deployment Server Console.

Note: The second field, The client should send basic inventory every ______ field, transmits all 
inventory data from the computer running Deployment Server. This field is only used by 
Deployment Server when first installing the Deployment view on Notification Server. By 
sending basic inventory (including information that Deployment Server is installed on the 
computer), Notification Server identifies that the DS Agent needs to be installed. 

6 Click Apply.

Setting the DS Agent Polling Interval for Multiple 
Deployment Servers
You may want to transmit new computer and deployment jobs at different update rates for each 
Deployment Server installation. This requires that you set the polling intervals differently for each 
Deployment Server Agent running on each Deployment Server. By setting custom polling intervals 
for each Deployment Server, you will overwrite the global polling interval settings.

To refresh the view of new computers and deployment tasks in the Deployment view on Notification 
Server, set the polling interval for each DS Agent on each Deployment Server installation from the 
Deployment view  > Options menu.

1 Click the Deployment tab.
2 Click the Options button in the toolbar area of the Deployment view on Notification Server.

3 Click the Configuration menu item.
The Deployment Solution Configuration dialog box opens with boxes to add the installed 
Deployment Server, set the polling interval, and establish login credentials for the selected 
Deployment Database. 
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4 Click the Add button. 
The Select a Deployment Server dialog box will open listing all Deployment Servers running the 
Notification Server Client.   

 

5 Select a Deployment Server from the list and click OK.
6 From the Deployment Solution Configuration dialog, select the Deployment Server Config for 

<server name> setting from the drop-down list. 
7 For the selected Deployment Server, set the Computer/Job Polling interval.
8 Set the database credentials for that Deployment Database. 

Because the DS Agent on each system queries its Deployment Database for new computer and 
task data, database login credentials must be supplied when setting a database polling interval. 

The default value for setting polling intervals in the Deployment Solution Configuration dialog box 
is Deployment Server Agent Config for all Deployment Servers. If you set polling interval 
information for all Deployment Servers, then they must all have the same database login name 
and password. If a Deployment Database in the system has different login credentials, then you 
must create separate polling intervals for each Deployment Server installation.
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Note If you supply the wrong user ID or password for the Deployment Database, then polling 
interval configuration settings will not take effect. An error message will be written to the 
DSAgent.log file on the computer running the Deployment Database. Because the database 
may be installed on a remote computer, no error message will appear in the console but will be 
entered in the error log file on the database computer. 

Updating Collection Settings
When a managed Notification Server computer sends new inventory information to Notification 
Server, each computer is then placed in a collection of computers according to defined hardware or 
software features. For example, when Notification Server identifies a managed computer with 
Deployment Server installed, it will place the computer in the All eXpress Deployment Server 
Machines collection and automatically execute a policy to download the DS Agent to establish 
communication. 

After the new computer sends inventory information to Notification Server, the new computer is not 
placed into a collection until the collections are updated in the Notification Server Database. To 
speed this process, you can adjust the collection update setting using these steps:

1 Open the Notification Server Administration Console and click the Configuration tab.
2 From the left pane, scroll down and click Advanced Settings.
3 From the right pane, click Collections Update.

4 Change each setting to fit the needs of your network.
New Resource. This value applies to new computers added to the Notification Server database. 
When a computer is added, the information will be used to place it in the appropriate collection 
(as soon as time has elapsed).

Existing Resource. This value applies only to computers already in the Notification Server 
Database. When a computer is in the database, it will only be added or removed from a collection 
after the time has elapsed.

Always Update. This value applies to all computers in the Notification Server Database. 
Information from all computers, new or existing, will be used to populate the collections with the 
correct computers.
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Synchronizing Databases

This option allows you to perform a complete update and synchronization of the Deployment 
Database and the Notification Server Database. Data in all Deployment Server databases will be 
completely updated to the Notification Server Database (and appear in the Deployment view on 
Notification Server after completion). This process ensures complete synchronization, but it is time 
consuming and substantially increases traffic over the network.

1 Click the Options button.
2 Click Synchronize.

The Synchronize dialog box will open. 

3 Click OK.
A secondary dialog box will open.

4 Click OK.

Open Deployment Server Web Console from Deployment 
on Notification Server

Set up options in the Deployment view on Notification Server to open the Deployment Server Web 
Console (page 59), allowing you to drill down and manage computer devices in real time from the 
Deployment view on NS. This feature allows you to manage computer resources across multiple 
Deployment Server installations and integrate multiple IT solutions from a Notification Server 
console, while still providing direct computer management in real time from the Deployment Server 
Web Console.

Set Options to Open the Deployment Server Web Console
On the Deployment view for Notification Server, click Options > Configuration. In the Deployment 
Server Web Console section, enter the name and credentials (if required).

Web Console Server Name Enter the network name of the computer running the Deployment Server 
Web Console.

Role based Username Enter the user name set in the Deployment Solution Security (page 106).

Role based Password Enter the password set in the Deployment Solution Security.

Confirm Password Re-enter the password.

Access the Deployment Server Web Console
You can access the Deployment Server Web Console by drilling down to a selected computer or 
computer group from the Computers pane of the Deployment view on Notification Server or from 
the Resource Explorer.

From the Computers pane, right-click a computer or computer group. Select the Deployment Server 
Web Console link that appears. You can also right-click a computer or computer group in the Details 
pane and select Resource Explorer. Click the Deployment link on the page. 
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Deployment Solution Policies 

Deployment on Notification Server includes policies that can be scheduled to perform specific 
actions when defined conditions are met. Deployment Solution policies include configuration tasks 
that execute automatically when computers are added to certain collections (enabled by default), or 
policies with job handlers that are enabled and configured to respond with specified actions to 
specified conditions. In addition, the Deployment Solution on Notification Server imports all 
deployment jobs from each Deployment Server installation and groups them as Policies to be 
scheduled from the Notification Server Administration Console (Solutions tab > Deployment Solution 
> Policies > Deployment Server installation).

For example, when Notification Server identifies that a computer is running Deployment Server and 
adds it to the collection, it will automatically push down a DS Agent using the Deployment Agent 
Config policy. The Full Installation/Upgrade of Deployment Server policy also executes 
automatically when you remotely install Deployment Server components from the Deployment view 
on Notification Server. This policy includes advertisement properties to automatically download a 
Deployment Server installation package and install it on computers in the Full Installation/Upgrade 
of Deployment Server collection. 

In contrast, the Failed Jobs policy must be manually enabled to run against selected collections. 
When you select the Failed Jobs policy, you can click the Enabled check box that appears in the 
Details pane (or you can right-click the policy and select Enabled from the menu) to activate the 
policy. The policy then runs according to the settings in the job handler. By default, the job handler 
will identify deployment jobs that have failed and generate a report and a Helpdesk work item 
identifying that the exception has occurred. You can add other existing job handlers--such as a 
handler that sends an e-mail, or you can also add custom job handlers. Using policy features you can 
also set the update schedule for each policy and edit the SQL query. See the Altiris Notification 
Server User Guide for additional information. 

Deployment jobs imported from the Deployment Database to the Notification Server Database can 
be viewed in the Deployment view on Notification Server, where they are presented as Jobs/Tasks, 
or the Notification Server Administration Console where they are listed as Policies (as shown 
above). 

Enabled policies to
run automatically

Policy for task/Event
importing (requires
enabling)

Notification Policies
used to report
problems

Folder with imported
tasks/events from a
Deployment Server
installation  
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Note Deployment tasks imported into the Policies folder cannot be enabled, disabled, cloned, 
exported or actuated in any way by right-clicking and selecting a menu option. These restrictions 
apply only to policies imported from Deployment Server installations. 

Scheduling an Imported Job
Imported deployment jobs from each Deployment Server installation are organized as policies and 
placed in a folder identified by the Deployment Server name. The deployment tasks can be accessed 
and scheduled from Notification Server > Administration console > Solution tab. These deployment 
tasks can also be scheduled from the Deployment view on Notification Server (click the Deployment 
tab). 

To schedule a deployment job in the Policies folder of Deployment Solution, click on a task and view 
its details in the right pane. Select the Schedule Job link to open the scheduling dialog box. See 
Scheduling Jobs (page 158) for complete information. 

Deployment Server AClient Configuration
Deployment Server AClient Install policy allows you to install the Deployment Server client 
application, AClient, to client computers. This policy can be enabled to push down the Deployment 
Server AClient Package to computers in the All NS Clients without AClient collection (the group 
defined by default). The All NS Clients without AClient collection is defined as computers with 
Notification Server client installed and without Deployment Server components installed.

Deployment Server Agent Configuration
Deployment Server Agent Config for all Deployment Servers policy allows you to upgrade or install a 
new Deployment Server Agent on Deployment Server systems. These policies are enabled by 
default and apply to a group (the All NS Clients without AClient group is the default and reasonable 
group to apply the policy). 

• Select all computers or a defined groups of computers to install DS Agent.
• Set the polling interval for the DS Agent to transmit computer and job data.
• Enter the database login ID and passwords.
• Synchronize all Deployment Server data for computers/tasks in the Deployment Databases 

with data in the Notification Server Database.
Deployment Server Agent Install/Upgrade installs the DS Agent that runs on Deployment Server 
computers. This agent transmits changes from the Deployment Database to the Notification Server 
Database to display in the Deployment view on Notification Server. This policy runs automatically 
when installing Deployment Server or when the Deployment view on Notification Server identifies 
a computer running Deployment Server.
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Full Installation/Upgrade of Deployment Server policy allows you run a complete remote install of 
Deployment Server to any managed computer with an NS Client. The Full Installation/Upgrade of 
Deployment Server runs automatically when installing Deployment Server components; however, 
you cannot install Deployment Server components by enabling or actuating this policy. Instead, 
install Deployment Server from the Deployment view on Notification Server (the Deployment tab). 

Deployment Server Replication Policy
DS Task Import Utility allows you to replicate the Deployment Server packages and export 
deployment jobs. See Using Package Servers to Replicate Deployment Jobs (page 310).

Notification Policies
Failed Jobs policy alerts you to failed deployment jobs within the specified number of hours. This 
policy sends an e-mail alert with an attached web report and generates a Helpdesk incident.

New Machines Group is populated policy alerts you when computers are present in the New Machines 
group. It allows you to move them into management groups.

Problematic managed computers policy identifies job failures over a specified time frame. This helps 
you identify problems throughout your system.

Imported Server Policies 
For every managed Deployment Server installation, the Deployment Solution on Notification Server 
will import the deployment jobs from the separate Deployment Databases to the Notification Server 
Database, allowing you to schedule and execute these tasks from Deployment Solution on 
Notification Server for the specific Deployment Server installation. The deployment tasks from each 
Deployment Server installation will appear in the policies folder for the managing Notification 
Server.

For additional general information about Notification Server policies, see Altiris eXpress 
Notification Server User Guide.
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Deployment Web Reports

Generate Web reports from all Deployment Server installations in your organization using the 
Deployment view on Notification Server. These pre-built reports allow you to track deployment jobs 
and generate centralized reports for all computers managed by Deployment Solution. Deployment 
Web Reports list deployment tasks available per Deployment Server, identify problem computers, 
report managed network servers by domain, view job status by name, type, or scheduling period, and 
generate many other types of reports specific to Deployment Solution.

View Deployment Web Reports by clicking the Deployment  > Reports. You can create, modify, and 
save reports by clicking Solutions  > Deployment Solution > Reports.

Note When generating large, complex reports across extraordinary amounts of data, you may wait 
several minutes before the report is compiled and displayed on screen. If the report takes too long to 
build, then the Active Server Page (ASP) will time out and return errors. To avoid this problem, 
adjust the SQL connection and ASP timeouts as described in the Altiris Notification Server User 
Guide.

Web Reports for Deployment Solution

Client Information

Client count by OS Reports managed computers by operating system.
Client summary by OS Summarizes managed computers by operating 

system.
Managed computers by 
Deployment Server group

Reports list of Deployment Server installations and 
a count of managed computers for each installation. 

Managed computers in the New 
Machines group

Identifies computers in the New Machines group to 
be reassigned to management groups.

Problematic managed 
computers

Reports computers with multiple job failures for a 
specified time period.

Total Deployment Servers and 
total managed computers

Reports the total number of managed computers 
(computers with the Deployment Agent for 
Windows [AClient] installed and reporting to the 
Deployment Database) for each Deployment 
Solution system.

Job Information

Assigned jobs by Deployment 
ServerDeployment Solution

Displays jobs per Deployment Server and the total 
number of managed computers the job has been 
assigned to.

Assigned jobs by managed 
computer

Displays the jobs currently assigned to a managed 
computer. 

Assigned single run jobs Displays a list of jobs assigned to run only once, and 
a count of managed computers that the job is to run 
on.
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Saving Web Reports
You can save reports using Report Properties in the Administration console of Notification Server. 
Past reports can be viewed and compared against reports generated from new data. 

1 From the Notification Server Administration console, click the Solutions tab.
2 Select a Deployment Web report from the Deployment Solution > Reports folder. 

For example, click Reports > Client Information > Client summary by OS.

3 From the Report Properties page (in the right pane), click the View report on latest data link
4 Add values for parameters required for the report. Click Submit.

The report will be generated and displayed in the right pane. 

Job availability by Deployment 
Server

Lists available jobs grouped by Deployment Server.

Scheduled recurring jobs Reports information for jobs scheduled to run on a 
regular basis on managed computers.

Job Status

Job status by Deployment 
Server

Summarizes jobs and their run status per each 
Deployment Server installation

Job status by job name Summarizes status for a specific job.
Job status by job type Summarizes jobs and their status.
Job status history detail (by 
client)

Lists jobs assigned to a specific managed computer 
for a defined number of past days. 

Jobs assigned in last N days Displays a list of jobs assigned to managed 
computers in a defined number of past days. 

Jobs completed in last N days Displays a list of jobs completed to managed 
computers in a defined number of past days.

Job Deployment Solutions 
failed in last N days

Displays a list of jobs that have failed in a defined 
number of past days.

Overall job status by 
Deployment Solution

Summarizes job status per Deployment Server 
installation, including the Deployment Server name, 
number of scheduled managed computers, count of 
successful job executions, and more details.

Server Information

Count computers by Deployment 
Server

Reports the number of computers managed by 
each Deployment Server installation.

List of computers by Deployment 
Server

Lists the computers managed by each Deployment 
Server installation.

Managed servers by domain Reports the number of managed network or web 
servers by domain.

Server summary by OS Reports the number of managed network or web 
servers managed by Deployment Server 
installations per operating system.

Job Information
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5 Click the Save button on the report page toolbar.

The Save Report dialog opens. Enter a name for the saved report.

6 Click OK.
7 To view the report, go to the report template in the left pane of the Solutions page. 

For example, go to Deployment Solution > Reports > Client Information > Client Summary by OS. 

8 Click View Saved Reports link. 

A list of saved reports will be listed.

9 Double-click on selected report to view.

Configuring Web Reports
You can reconfigure existing reports or build completely new reports using the Query Configuration 
feature in the Notification Server Administration Console. You can define and edit SQL queries, 
generate parameters replaced at runtime or add new parameters, and make other configuration 
changes for Web reports. 

1 From the Notification Server Administration Console, click the Solutions tab.
2 Click a Deployment Web report from the Deployment Solution > Reports folder. 

For example, select Reports > Client Information > Client summary by OS.

3 Click the Configure this report link.
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4 Double-click on the SELECT statement in the Query and edit it for your specific requirements. 

You can also click the New Query button to add another SELECT statement to the SQL query. 
Click Next.

5 Edit parameters for the SQL query from this page. Double-click to edit a value and then Enter. 
Click Next.

6 Set views from this page. See the Altiris eXpress Notification Server User Guide for complete 
information. Click Next. 

7 Click Finish.

Deleting Old Reports
Deployment Solution can be configured to automatically delete old reports that you have generated 
and saved.

1 In the Notification Server Administration console, click the Solutions tab.
2 Click Deployment Solution.
3 Click the Purge old events and reports link. 

The Data Purging Configuration page will open.

4 Click the Purge saved reports after check box and enter a time period to automatically delete 
reports.

5 Click the Apply button.
6 Click the Purge Now button to immediately delete old data and reports.
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Reference
The Reference section provides identification information for command-line switches, return code 
values and other detailed information for Deployment Solution components.

Quick Links

Error Messages (page 330) View the error messages for components in Deployment 
Solution.

Command-Line Switches (page 329) View command-line switches (parameters) for each of the 
executables in Deployment Solution.

RapiDeploy Technical Reference 
(page 358)

View technical reference for rdeploy.exe.



 

 

Error Messages

This section presents some error messages generated by Ibmaster.exe and Ibclient.exe. They 
are divided into the following groups: 

• General (SeeGeneral Error Messages (page 331))
• Client (See Client Error Messages (page 332))
• Communication (See Communication Error Messages (page 333))
• Critical (See Communication Error Messages (page 333))
• Memory (See Memory Error Messages (page 334))
• Partition (See Partition Error Messages (page 335))
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General Error Messages

Error Message Description
"Error reading . . ." 
"Error writing . . ."

Explanation: An error occurred while reading or writing to the 
disk. 
Possible causes: 
Faulty disk hardware. 
A write-protected disk. The BIOS in some computers has an anti-
virus capability which attempts to protect the disk from Master 
Boot Record (MBR) viruses by write-protecting the first sector or 
track on the hard disk. 

"Error reading from file." 
"Error writing to file."
"Error opening file for 
reading." 
"Error opening file for 
writing." 
"Error saving image info to 
file." 
"Error closing file." 
"Error reading image 
information." 

Explanation: An image file could not be accessed. 
Possible causes: 
The file does not exist, or cannot be read (for downloads).
The image file is corrupt. 
The directory does not exist or cannot be written to (for uploads). 
The disk where the image file is being written is full. 

"Geometry Error . . ." 
"Invalid geometry exception . . 
."

Explanation: There was an error converting cylinders, heads, and 
sectors to logical blocks or vice versa. 
Possible cause: Invalid or corrupt BIOS drive geometry settings.

"No such drive . . ." Explanation: The specified drive could not be accessed.
Possible cause: An invalid drive letter was entered.

"Error reading drive 
parameters from BIOS."

Explanation: The program received an error from the BIOS while 
trying to read disk geometry information. 
Possible Cause: Often occurs when trying to run a DOS 
application from Windows.

"Bad magic number. File is not 
an image file." 
"Bad magic number. Buffer 
doesn't contain image data."
"Bad file version number. 
Cannot read the file." 
"Bad version number. Buffer 
doesn't contain image data."

Explanation: The file is not recognized as an image file.
Possible causes: 
The file is not a valid image file.
File was created with a different version of the imaging program, 
which is not compatible.
Data loss is occurring over the network.

"Too many clients for current 
license count."

Explanation: More clients connected to the Console or Master 
computer than the license allows.
Action: Upgrade your license to support more nodes. Call your 
authorized reseller for more information. 
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Client Error Messages

"This program is not licensed 
for multicasting (peer-to-peer 
imaging)."

Explanation: Multicasting works only when the license count is 
greater than one. 
Action: Upgrade your license to support more nodes. Call your 
authorized reseller for more information. 

"Exiting with error code . . ." Explanation: The program failed. 
Possible causes: 
The operator aborted the program prematurely.
A serious program error occurred. 
Action: A descriptive error message should appear before this 
message to give you information about the problem that is causing 
the program to exit. If you do not see a preceding descriptive 
message, notify Altiris Technical Support. Write down the error 
code and a description of what was happening before the error 
occurred.

Error Message Description
"The master PC ended the 
transfer before we received all 
of the data."

Explanation: The Master computer sent a "goodbye" packet 
before the image-transfer was finished. The download didn't finish, 
so the client disk will be in an indeterminate state.
Possible cause: The user aborted the download before it was 
complete.

"Error: Received cluster chunk 
with wrong version . . . (want .. 
.)." 
"Client and master versions do 
not match." 
"Error: Received cluster map 
with wrong version . . ." 
"Error: End of Block packet 
has wrong version . . . (want . . 
.)."

Explanation: The Master computer sent a packet with the wrong 
version number. 
Possible cause: The Master computer and clients are running 
different versions, and there are packet-header differences. 
Action: Make sure both master and client programs are updated to 
the same software version.

"Error: Received Wrong 
NetBlock . . . (expected . . .)." 
"Received Wrong segment . . . 
(expected . . .)."

Explanation: The Master computer moved on to the next segment 
in an image transfer before the client successfully received all of 
the data in a previous segment.
Possible cause: The client may have lost contact with the Master 
computer during a download.

"Error: Master started before 
we could register."

Explanation: The client received an unknown packet before it was 
ready to begin the download.
Possible cause: The "download confirmation" packet sent from the 
Master to the client is lost.
Action: Re-send the image.

"Error decoding buffer."
"Error while getting image info 
from master."

Explanation: The client was unable to decode packet or image 
information. 
Possible cause: Data corruption in a packet somewhere between 
the Master computer and the client (likely), or a bug in either the 
master or client software (much less likely).
Action: Call Altiris if you see this message and you believe your 
network is operating reliably.

Error Message Description
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Communication Error Messages

Critical Error Messages

Error Message Description
"Error opening IP socket." 
"Error canceling IP listen 
packets." 
"IP SendPacket error, code . . ." 
"IP Error sending packet ..." 
"Error sending farewell packet: 
ECB code . . ." 
"IP error getting local target 
address." 
"Unable to bind socket 0x . . ."

Explanation: An error was returned from a call to the network 
protocol stack. 
Possible causes: 
The IP protocol stack isn't loaded.
An internal error occurred in the protocol stack code.

Note The same errors can occur with IPX.

Error Message Description
"Compression failure, result is 0x. . 
."
"Decompression failure, result 0x . 
. ."

Explanation: Compression or decompression failure. 
Possible causes:
A decompression failure can be caused by corrupt data in an 
image file or data accessed across the wire.
A compression failure is probably caused by a bug in the 
program. 
Action: If you get a compression or decompression failure on 
a file that you know to be good (i.e. not corrupted), isolate the 
system from the network and try to reproduce the error. This 
will determine if the error is on the network or in the Altiris 
program. If the problem recurs on the isolated system, report 
the error to Altiris.

"Unable to send packet: buffer too 
big."

Explanation: The program tried to send a packet that was 
larger than the internal limit. 
Action: Isolate the system from the network and try to 
reproduce the error. This will determine if the error is on the 
network or in the Altiris program. If the problem recurs on the 
isolated system, report the error to Altiris.

"Unable to register multicast 
cleanup function." 

Explanation: Indicates a failure in the program’s library 
routines.
Action: Isolate the system from the network and try to 
reproduce the error. This will determine if the error is on the 
network or in the Altiris program. If the problem recurs on the 
isolated system, report the error to Altiris.

"Unhandled exception detected.
Please call technical support."

Explanation: A top-level handler in the program detected an 
exception from an unknown location in the program.
Action: Isolate the system from the network and try to 
reproduce the error. This will determine if the error is on the 
network or in the Altiris program. If the problem recurs on the 
isolated system, report the error to Altiris.

"Error: Missing chunk number . . . 
too big."

Explanation: Indicates an internal error in the client. 
Action: Isolate the system from the network and try to 
reproduce the error. This will determine if the error is on the 
network or in the Altiris program. If the problem recurs on the 
isolated system, report the error to Altiris.
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Memory Error Messages

"Error: Received non cluster map 
block type 0x . . ."

Explanation: The client received a block of data containing 
unexpected information. 
Action: Isolate the system from the network and try to 
reproduce the error. This will determine if the error is on the 
network or in the Altiris program. If the problem recurs on the 
isolated system, report the error to Altiris.

"Out of range index . . . in 
removeItem. ElementCount is . . ." 
"Error removing child subtree." 
"Invalid item to remove." 
"Error: Attempted removal of top-
level container segment." 
"Error: unable to copy source 
segment."
"Error getting download info space 
requirements." 
"Error getting image info space 
requirements." 
"Error getting bitmap space 
requirements." 
"Error encoding image info into 
buffer." 
"Error encoding bitmap."

Explanation: Internal program error. 
Action: Please report the error to Altiris. Write down the error 
code and message and a description of what was happening 
just before the error occurred. 

"Container segment has invalid 
Partition-table slot . . ."

Explanation: A partition table in an extended partition 
contains a reference to a nonexistent slot in the partition table.
Action: Please report this error to Altiris.

Error Message Description
"Insufficient memory for . . ." 
"Ran out of memory while . . ." 
"Exception . . . while allocating 
. . ."

Explanation: The program is out of memory.
Possible cause: The Altiris program requires 16 MB to run. It 
could also be a lack of conventional memory.
Action: Add the emm386.exe file, and load as many drivers, 
devices, etc. as possible into high memory. Check the Altiris 
support forum for information on memory errors.

"Error adding . . ." Explanation: There was a problem building an internal list 
structure. 
Possible cause: This is almost always a result of memory 
exhaustion.

Error Message Description
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Partition Error Messages

Error Message Description
"Collision in partition-table . ." 
"Collision with . . ."

Explanation: More than one partition was defined for a given 
partition table slot. It can mean one of two things: 
Possible cause: The on-disk partition-tables (including partition 
tables in extended partitions) are corrupt. 
The program was unable to merge an image file with the local disk 
contents because both the image and the local disk contain a 
partition definition that must reside in the same slot.

"No partitions to process." Explanation: No partitions were found in the partition table. The 
program has nothing to image (upload). 

"Segment boundary error: 
doesn't start on track 
boundary." 
"Invalid partition . . . "

Explanation: An invalid partition definition exists.
Possible cause: The invalid entry might be in the partition table’s 
extended partitions.
Action: Try running ibmaster.exe with the -sz or -szf switch.

"Error: No partition-table 
segment to update."
"Error: Expected container 
segment not found."

Explanation: An extended partition was found that contained no 
internal partition table, or contained no internal definitions. 
Action: The invalid configuration can be resolved by removing 
the invalid partition definition (using FDISK or similar utility).

"Not enough free disk space to 
accept image." 
"Underlap error while placing 
segment." 
"Overlap error while placing 
segment."

Explanation: The local disk doesn't have enough free space to 
accept the image being downloaded. 
Possible cause: The image may have more data than can fit on the 
client computer hard drive, or the partition cannot be resized to fit 
the drive. 

"Collision at beginning of disk 
while trying to place boot 
record."

Explanation: The program was unable to place the boot record on 
the disk.
Possible cause: Another partition may be defined to “cover” the 
required space. This usually indicates corruption in the target 
disk's partition table, because it is illegal for a partition to occupy 
the space required by the boot record.
Action: Run FDISK to remove all partitions, then reboot the 
computer and run FDISK/MBR. Also check for viruses.

"This image requires that the 
destination drive have the same 
geometry . . ."

Explanation: The image being transferred contains a geometry-
dependent partition, and the geometry of the source disk does not 
match the geometry of the target disk. This means the disks are not 
seen as identical drives by the drive controller.

"Error flushing MBR sector." Explanation: The program was unable to write data to the first 
sector on the hard disk. The image transfer is incomplete because 
the partition-table and/or master boot record code was not 
successfully written, and the disk is in an indeterminate state.
Possible cause: This may be caused by a BIOS setting that 
prevents programmatic access to the boot sector (see the CMOS 
setup). 
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Command-Line Switches

This section provides detailed information about command-line switches for specific executables 
within Deployment Solution.

 Job Utilities
The Job Utility applications allow you to import, export, create and schedule jobs from the 
command line. Each action is performed from separate binaries installed in the Client Access Point 
file directory. For general job information, see Building and Scheduling Jobs (page 152).

axExport.exe — Exports jobs from Deployment Server. See Job Export Utility (page 336).

axImport.exe — Imports jobs in to Deployment Server. See Job Import Utility (page 337).

axJob.exe — Creates jobs in Deployment Server. See Create Job Utility (page 337).

axsched.exe — Schedules jobs in Deployment Server. See Schedule Job Utility (page 339).

Each utility connects to the Deployment Server Database to perform specific operations. As a result, 
the appropriate ODBC and security rights are required. Each job utility supports the /o /d /u /p 
switchs. 

The /o option (ODBC datasource) allows connectivity to the Deployment Server SQL database 
using a different DSN. By default the standard Deployment Database DSN is used. This is helpful 
when connecting to a second system from a common machine. 

The /d /u /p options can be used if no DSN is set up for a particular server. However, the SQL driver 
must be installed for any of these utilities to work. Each utility has the /? switch to display the 
version of the utility and all command line options.

Job Export Utility
This utility can be used to export jobs from the Deployment Database. It can be helpful in copying 
jobs from one Deployment system to another, backing up jobs, creating standard jobs during 
multiple installations, and other actions.

Syntax:  axExport <filename> (options)

Options:   

/f <folder-name>    Job folder to be exported 

/e <job-name>    Job to be exported 

/s  Process all subfolders also 

/i  Include Initial Deployment 

/y  Suppress confirmation prompts 

/o <odbc-dsn-name>    ODBC datasource name 
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/d <db-server>    Database server name 

/u <db-user>    Database user name 

/p <db-password>    Database user password 

Example 1:     Export all jobs to a binary backup file.

axExport /s /i backup.dat

Example 2:      Make a backup copy of a single job.

axExport /e "Deploy Office 2000" backup2.dat

Example 3:     Export all jobs in the Projects folder.

axExport /f Projects projects.dat

 

Job Import Utility 
Syntax: axImport <filename> (options)

Options
/f  <folder-name>    Job folder to be imported 

/r   Replace contents of this folder 

/n   Don't notify consoles of the changes 

/y   Suppress confirmation prompts 

/o <odbc-dsn-name>    ODBC datasource name 

/d <db-server>    Database server name 

/u <db-user>    Database user name 

/p <db-password>    Database user password 

Note When new jobs are created in a console, by default, Deployment Server will notify all other 
consoles that changes have been made so they can refresh and show the newly imported jobs. If 
several batches of jobs are imported, the '/n' option should be used until the last batch to reduce the 
amount of refreshes performed.

Example 1:     Restore all jobs from a binary backup file.

axImport /r backup.dat

Example 2:   Restore jobs from a backup file into pre-created folder (named Test Jobs).

axImport /f "Test Jobs" backup.dat

Create Job Utility     
Syntax: axJob <job-name> (options) <task-type> (switchs)
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 Tasks
/tci <filename>    Create disk image 

/tdi <filename>    Distribute disk image 

/tds <filename>    Distribute software 

/tbr <path>    Backup registry files 

/trr <path>    Restore registry files 

/trs <path>    Run Script 

/tcf <source> <dest>    Copy file 

/tre    Restart 

/tsd    Shutdown 

/tlo    Logoff 

Options
  /a    Add task to existing job 

  /r    Replace all tasks within this job 

  /x <switches>    Command-line switches for task 

  /f <folder-name>    Job folder to be created in 

  /i    Import script into task definition Deployment Solution

  /w    Run the script from Windows 

  /n    Don't notify consoles of the changes 

  /y    Suppress confirmation prompts 

  /o <odbc-dsn-name>    ODBC datasource name 

  /d <db-server>    Database server name 

  /u <db-user>    Database user name 

  /p <db-password>   Database user password 

Note To use the Run Script option (/trs), a script must be created in a file first. Then if you want the 
script to be embedded, include the /i option. Otherwise, the task will link to the script filename.

Example 1: Create a Job that makes an image of a computer named "Oscar" and run it immediately.

axJob CreateOscar /tci .\Images\oscar.img

axSched oscar CreateOscar /t "2000-12-31 08:00"

Example 2: Shutdown Oscar's computer right now.

axJob Shutdown /tsd

axSched oscar Shutdown /t "2000-12-31 08:00"

Example 3: Run a Windows program on all computers right now. (Calc.exe is the only line in 
script.txt.)
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axJob /w /i RunCalc /trs script.txt

axSched oscar RunCalc /t "2000-12-31 08:00"

Example 4: Create a Job (named Win2000 and Off2000) that reimages a computer with Windows 
2000 and deploys an Office 2000 Rapid Install Package.

axJob "Win2000 and Office 2000" /tdi .\Images\w2000.img

axJob "Win2000 and Office 2000" /a /tds .\RIPs\off2000.exe

To then migrate Oscar to Windows 2000:

axSched Oscar "Win2000 and Off2000" /t "2000-12-31 08:00"

 

Schedule Job Utility
Syntax: axSched <computer/group> <job-name> (options)

 Options: 

  /t <yyyy-mm-dd hh:mm>   Time to schedule 

  /n    Don't notify servers of the changes 

  /y    Suppress confirmation prompts 

  /o <odbc-dsn-name>    ODBC datasource name 

  /d <db-server>    Database server name 

  /u <db-user>    Database user name 

  /p <db-password>     Database user password 

Note The format for <time> is “yyyy-mm-dd hh:mm.” If the date is omitted, the current date is 
assumed.

If the /t switch is not used, the job is assigned to the computer but not scheduled. As a result, it will 
not execute.

If you would like the job to run immediately, choose a date in the past. 

If you have a group or computer name which include spaces, put the name in quotes.

All Computers can now be used as a group option.

Example 1: Schedule a job called Office2000 to run on Oscar’s computer at midnight on 12-31-
2002.

axSched Oscar’s Office2000 /t "2000-12-31 00:00"

Example 2: Schedule a job called Office2000 to run on the Accounting Group computers tonight at 
10PM.

axSched Accounting Office2000 /t "2001-2-15 22:00"

Example 3: Schedule a job called ShutDown to run on all computers at tonight at 10 PM.

axSched "All Computers" ShutDown /t "2001-2-15 22:00"
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 axengine.exe

The Altiris eXpress Server (axengine.exe)is the Deployment Server component of the 
Deployment Solution infrastructure. Command-line start parameters for this service are set in the 
registry setting rather than in the Start Parameters property of the service.

If you want to add start parameters after the install, you can modify the registry settings. The registry 
key is LOCAL_MACHINE\SYSTEM\ControlSetXXX\Services\Altiris Express Server. 

Deployment Agent for Windows (AClient)
The following sections identify command-line and input parameters for Aclient.exe, the 
executable file for the Deployment Agent for Windows.

Aclient.exe Command-line Switches
The Aclient.exe executable installs and runs on client computers, enabling them to be managed 
by a Deployment Server. It enables clients to receive work from the Deployment Server, and it 
reports client status to the Server.

The program is normally installed and configured remotely using the Client Install wizard, or the 
program is run at the client computer. However, you can use the command-line options to run it from 
a script file if you want to. (If you use a script file, see the following section on aclient.inp for 
information on using an import file to specify install switches for Aclient.)

You can use either a forward slash (/) or a dash (-) with the command-line options. Commands are 
not case sensitive.

Aclient.inp Parameters
You can use this input file to set installation parameters for aclient.exe, so you can install the 
client program from a script file. The file is copied to the Deployment Server program directory 
when you install the product. Command-line parameters are included in the file, but are marked with 
a REM statement.

To use the input file, open it and remove the REM commands from the parameters you want to use. 
When you have the file set up the way you want it, you can run it by entering the file name as the 
first parameter after the aclient command. You can also put the same line in a script file if you 
want to run it from a file. Type

Switch Details

-ver Function: Shows the version of aclient.exe running on the computer.
-install Function: Installs the client.

Option: -silent allows install to complete without sending output to the client.
Example: To install aclient.exe from the Deployment Server directory 
without sending messages to the client, type
Deployment Server /aclient /install /silent

-remove Function: Removes (uninstalls) aclient.exe from a computer.
Option: -silent removes the aclient without sending output to the client.
Example: To remove aclient, type
aclient -remove

-start Function: Manually starts aclient.exe on a computer.
Option: -silent starts the aclient.exe without sending output to the client.

-stop Function: Manually turns off aclient on a computer.
Option: -silent turns off aclient without sending output to the client.
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aclient aclient.inp

The input file name (aclient.inp) and InstallDir parameters are required; all others are optional. 
Parameters are case sensitive. 

Note: Many parameters will work after setting other parameters first. For example, you can only use 
ServerName after the multicast parameters, MCastAddr and MCastPort, are set.  

Parameters Details

ForceReboot Function: Specifies how the system should be shut down and rebooted. 
Applications are forced closed and the system shuts down even if 
programs hang. (User data could be lost.)
Example: To force clients to reboot when a reboot task is assigned, type
ForceReboot=Yes
The default is “No.”

HardTimeout Function: Specifies the length of time (in seconds) that aclient.exe 
will maintain an idle connection with the Deployment Server. After the 
time limit is exceeded, the client will disconnect and then establish a new 
connection with the Server.
Example: To establish a new connection with the Deployment Server 
whenever the connection is idle for 900 seconds, type
HardTimeout=900

InstallDir
(required)

Function: Specifies the full path name to the directory where 
aclient.exe will be installed. The default location is 
c:\altiris\aclient.
Example: To change the default location, replace it with a new path. Type
InstallDir=c:\programs\aclient

LogFile Function: Specifies the full path name to the log file.
Example: To write log entries to a log file in your aclient directory, type
LogFile=c:\altiris\aclient\aclient.log

LogSize Function: Sets the maximum log file size (in bytes).
Example: To set the log file size limit to 4096 bytes, type
LogSize=4096

MCastAddr Function: Specifies the multicast group address to be used to find the 
Deployment Server.
Example: To set the IP address for multicasting, type
MCastAddr=225.1.2.3

MCastPort Function: Specifies the port number to use for multicasting.
Example: To use port 402 for multicasting, type
MCastPort=402

Password Function: Sets a password on the client to prevent users from accessing 
aclient.exe settings.
Example: To lock the settings, type
Password=clientmanager

PromptExecute Function: Sends output (messages) to the client when tasks are being 
executed.
Options: Yes, No
Examples: To allow prompts and messages to be sent to the client, type
PromptExecute=Yes
To suppress output, type
PromptExecute=No
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PromptOverride Function: Specifies the default action to take when there is no user 

response to a restart prompt.
Options: Abort, Continue
Examples: To abort the client reboot, type
PromptOverride=Abort
To reboot the client, type
PromptOverride=Continue

PromptReboot Function: Prompts the user before restarting the client.
Options: Yes, No
Examples: To prompt for user input before restarting a client, type
PromptReboot=Yes
To restart a client without requiring user input, type
PromptReboot=No

PromptSeconds Function: Specifies the length of time (in seconds) that the client will 
wait for a response from the user.
Example: To wait 30 seconds for user input, type
PromptSeconds=30

ShowTrayIcon Function: Specifies whether or not to show the Altiris client icon in the 
system tray. If the icon is not in the tray, users can’t access Aclient.
Example: To not show the icon, type
ShowTrayIcon=No
The default is “Yes,” which loads the icon into the system tray.

SpeedLimit Function: Sets the minimum transfer rate accepted from the Deployment 
Server (in bytes per second). If aclient.exe cannot receive data from 
the Server at this rate, it will disconnect and retry at specified intervals. 
See HardTimeout below. 
Example: To set a minimum ransfer rate of 7500 bytes per second, type
SpeedLimit=7500

TcpAddr Function: Specifies the IP address of the Deployment Server that the 
client will connect to. Using this parameter causes the client to use TCP 
instead of multicasting to connect to the Server.
Example: To have the client connect to a Deployment Server using its IP 
address, type
TcpAddr=192.1.2.3

TcpPort Function: Specifies the port number of the Deployment Server listening 
for requests. Using this parameter causes the client to use TCP to connect 
to the Server.
Example: To specify the port number of the Deployment Server to 
connect to, type
TcpPort=402

TTL Function: Sets the maximum number of hops to multicast through.
Example: To limit the number of hops to 32, type
TTL=32

UpdateFileSystemSids Function: Specifies if you want SIDgen to update permissions on any 
local NTFS volumes. This parameter only applies if you have domains 
and use SIDgen to manage the computer IDs.
Example: To update permissions on the local NTFS volume, type
UpdateFileSystemSids=Yes
The default is “No.”
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Bootworks Command-line Switches
BootWorks (bootwork.exe) manages client-server connections in DOS for imaging and registry 
management tasks. Parameters and switches for Altiris program files can be used in batch files and 
from the command line, usually for troubleshooting. Under normal circumstances, the program 
interfaces and wizards provide the tools you need to manage your network; you won’t need to 
manually edit files.

Bootwork.exe
You can use either a forward slash (/) or a dash (-) with the command-line options. Commands are 
not case sensitive.

UseRCDrivers Function: Specifies whether or not to install keyboard and mouse filter 
drivers that enable remote control on Windows NT and 2000 client 
computers. (The default is “No,” so the drivers are not installed. This 
parameter is not necessary for Win 95/98 computers, because they don’t 
require Ctrl-Alt-Del input to log in.
Example: To install the drivers for remote control, type
UseRCDrivers=Yes

UserName Function: Associates a computer with the primary user or users. This is 
used to target RIP deployments to a specific user or group of users. To 
assign more than one user, separate the names with semicolons.
Examples: To associate user Fred with the client being installed, type
UserName=Fred
To associate users Fred and Sam with the client, type
UserName=Fred;Sam

ServerName Function: Specifies the computer name of the Deployment Server that 
you want the client to connect to. This is useful if you have multiple 
Deployment Servers on your network and you don’t want the client to 
connect to the first Server it finds.
The ServerName parameter is only valid if you are using multicasting (by 
setting MCastAddr and MCast Port parameters). 

Note ServerName can only be set after the multicast parameters, 
MCastAddr and MCastPort, are set.

Example: To restrict client connection to a Server named “Server3,” type
ServerName=Server3

Switch Details
-dsbios Function: Disables reading of the BIOS for system information. This is 

typically used for troubleshooting, if a client computer crashes when it first 
starts running BootWorks.
Example: To load and run BootWorks without reading the BIOS, type
bootwork -dsbios

-f Function: Causes a computer to pause during the BootWorks boot process 
and wait for a job from the Deployment Server, instead of booting to 
production if work is not assigned. This allows new computers that need to 
run Initial Deployment to wait for a connection to the Server.
Example: To have a new computer wait for the Deployment Server to assign 
a job, type
bootwork -f
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-hr Function: Specifies a hard reboot when a client computer boots to 

production. This is the default. It ensures the BootWorks boot data is cleared 
from memory, so the computer reads the MBR when booting to production. 
If this is not used, the client computer might lock up when it reboots.
Example: Because this is the default, you don’t need to enter anything.

-ip<address> Function: Specifies the IP address of the Deployment Server you want the 
client to connect to. Use this if the network is not configured for multicasting, 
or if there is more than one Deployment Server on the network. Specifying 
the Server’s IP address prevents the client from connecting to the wrong 
Deployment Server. The port number must also be specified if you change 
this parameter. (See -p<port>.)
Example: To connect a client directly to a Deployment Server, type
bootwork -ip207.197.28.38

-mcdelay[xx] Function: Sets the number of seconds the client waits between multicast 
requests for a Deployment Server. The default is 5 seconds.
Example: To set the interval for multicast requests to10 seconds, type
-mcdelay10

-mcwait[xx] Function: Sets the length of time (in seconds) that the client searches for a 
Deployment Server before rebooting to production. The default is 30 
seconds. This parameter applies to multicast sessions only. It does not apply 
if the clients connect using the Console IP address.
Example: To have the client search for a Deployment Server for 45 seconds, 
type
-mcwait45

-mip<IPaddress> Function: Specifies the multicast IP address of the Deployment Server. The 
default value is 225.1.2.3. If the address is changed on the Server, use this 
parameter to change the address in BootWorks so the client looks for the 
correct address. The port number must also be specified if you change this 
parameter. (See -mp<port>.)
Example: If you changed the Deployment Server’s multicast address to 
225.12.12.13, you would change the address for BootWorks by typing
bootwork -mip225.12.12.13

-mp<port> Function: Specifies the multicast port address of the Deployment Server. 
The default value is 402. If you have changed the port number of the Server, 
use this parameter to change the number in BootWorks. (Any unassigned 
number that is less than 65536 is valid.) The IP address must also be specified 
if you change this parameter. (See -mip<address>.)
Example: If the Deployment Server’s IP address was changed and you set a 
new port number of 1026, type
bootwork -mp1026

-name Function: Prompts the user to enter the name of the client computer. This 
name will be registered in the Console Computers list. If no name is specified, 
the client computer’s MAC address will be used.
Example: To prompt for a computer name, type
bootwork -name
The client computer will prompt you to enter a name. The name appears in 
the Computers list on the Console.

-new Function: Runs Initial Deployment.
Example: To run Initial Deployment on a client computer, type
bootwork -new

-nologin Function: Loads the LAN drivers on the client so BootWorks can check the 
Deployment Server for work without completing a user login.
Example: To load the network drivers and check the Deployment Server, 
type
bootwork -nologin
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BootWorks Install (Bwinst) Switches
BootWorks is installed by bwinst.exe, so if you have problems installing you might need to edit 
these settings in the BootWorks autoexec.bat file.

Parameters are case sensitive. Use a space between the command and the switch, and between 
switches if you use more than one.

-p<port> Function: Specifies the port number of the Deployment Server you want the 
client to connect to. The default port number is 402. If you have changed the 
port number of the Deployment Server, use this parameter to change the 
number in BootWorks. (Any unassigned number that is less than 65536 is 
valid.) The IP address must also be specified if you change this parameter. 
(See -ip<address>.)
Example: If the Deployment Server’s port number has been changed to 1026 
and clients are not multicasting to find the Server, type
bootwork -p1026

-pause Function: Causes the computer to pause for 5 seconds before beginning 
production boot processes. This allows time to access the bootworks 
program before the computer boots to production.
Example: To add a 5-second pause before a production boot, type
bootwork -pause

-s<name> Function: Specifies the computer name of the Deployment Server you want 
the client to connect to. Otherwise, if you have more than one Console on the 
network, clients will connect to the first one they find.
Example: If you want a client to connect only to a Deployment Server 
named ServerOne, type
bootwork -serverone

-sr Function: Specifies a soft reboot when a client computer boots to 
production.
Example: To reboot a client using a soft reboot instead of the default hard 
reboot, type
bootwork -sr

-wb Function: Specifies a warm reboot when a client computer boots to 
production.
Example: To reboot a client using a soft reboot instead of the default hard 
reboot, type
bootwork -wb

Switch Details
-mbr Function: Rewrites the BootWorks MBR code and exits.

Example: If the BootWorks code is overwritten by another program and you want 
to rewrite it to the boot record, type
bwinst -mbr

-u Function: Uninstalls BootWorks.
Example: To uninstall BootWorks from a client, type
bwinst -u

-c Function: Checks for Altiris MBR code.
Example: To find out if BootWorks is installed on a client, type
bwinst -c
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Keyboard and Screen Lock Utility (Kbdsclk) 
Switches
This utility can be used to limit user intervention while client computers are in BootWorks mode.

BootWorks connects client computers to the Deployment Server to run assigned Jobs (receive 
images, back up and restore registries, etc.). The Server then releases control of the computers to run 
their regular boot processes and come up in production mode. KBDSCLK is part of the BootWorks 
autoexec.bat file. The utility runs from the file as a TSR.

How the Keyboard and Screen Lock Utility (kbdsclk) Works
During the time the computer is in BootWorks mode, the Altiris client graphic displays so the user 
knows the Altiris boot processes are running. However, the keyboard is not locked, so the boot 
process can be interrupted if a user “breaks in” using Ctrl-C, Ctrl-Alt-Del, Ctrl-Break, or another 
interrupt command.

-s[x] Function: Works with the -old switch to set the partition size (in MB) for hidden 
BootWorks partitions. The minimum size is 5 MB, which is the default.
Note: If you install embedded BootWorks (new style for 4.x versions), this switch 
does not apply. A 5MB embedded partition is always installed.
Example: To set the BootWorks partition size at 10 MB for a hidden partition, 
type
bwinst -s10 -old

-old Function: Installs a hidden (old style) BootWorks partition instead of an 
embedded (new style) partition. The default size is 5 MB. To install a larger 
partition, use the -s switch.
Note: When this partition is installed, it will overwrite any data on the drive it is 
installed to. Make sure the drive is empty, or upload an image of the drive, and 
then download it to a different drive after BootWorks is installed.
Example: To install a hidden BootWorks partition of 30 MB, type
bwinst -s30 -old

-q Function: Runs BootWorks install in “quiet mode,” so no user input is required 
to complete the install. This switch is intended for use with unattended installs, so 
you should use it in conjunction with the -f switch to install from a file instead of 
disks.
Since there are no prompts, bwinst makes the following decisions/assumptions.
If a partition is found, you won’t be asked if you want to move or overwrite the 
partition. BootWorks will automatically overwrite the partition and existing data 
will be erased.
You won’t be prompted for the second BootWorks disk. You’ll see a message that 
a file could not be found.
If you’re installing an embedded partition, it is assumed that NT Service Pack 4 is 
installed.
Example: To install BootWorks unattended from a boot directory on a network 
drive, type
bwinst -q -f=f:\bootfile

-f= Function: Specifies the source path to the BootWorks files. The default is drive a:.
Example: To install BootWorks from a directory named “bootfile” on a network 
drive, type
bwinst -f=f:\bootfile

-b Function: Reads the BIOS settings for the hard drive if IDE settings fail or return 
incorrect values. If you get the message, “Error creating drive map” when 
installing BootWorks, run bwinst with this switch to correct the problem.
Example: To solve the “Error creating drive map” error and install bwinst, type
bwinst -b
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The screen and keyboard can be locked by setting the security option when you use the Boot Disk 
Creator to make BootWorks boot files. Or, you can change the settings in the BootWorks 
autoexec.bat file. Just remove the REM statements for the commands you want to use. You can 
also add commands to set and clear keyboard and screen locks in multiple places in the batch file. 
This is useful for enabling input when applications are loaded (such as the Microsoft client, which 
prompts for a password), and then relocking the screen and keyboard to complete the boot processes. 
You can also use KBDSCLK on the command line if you want to temporarily override the batch file 
settings.

Keyboard and Screen Lock Utility Usage
Commands are not case-sensitive. The syntax is as follows:

kbdsclk [p=password] [+|-k] [+|-s] [x [h#]] [c|t] [w=file] [b]

For help when running the utility, type KBDSCLK ?

The batch file includes keyboard and screen lock commands, which are marked out (REM). When 
you remove the REM commands and run the commands in a batch file, the utility behaves as a TSR. 
The defaults are:

• The Altiris client graphic is displayed.
• The keyboard and screen are not locked.
• If options are added to the batch file, they are executed in the order they appear in the file.

Option Description
p=pwd [b] Function: Sets a password to enable/disable the keyboard and screen lock. 

Maximum character length is 128.
Option:
b Scans keyboard input for a password to set locks when they are not set. (Be 
careful using this option. It can interfere with keyboard input for applications that 
are running!)

+|- k Function: Enables/disables keyboard input. To allow keyboard input, use +k. To 
lock the keyboard, use -k.
Default: Locked.

+|- s Function: Enables/disables screen output. To allow screen output, use +s. To 
disable it, use -s.
Default: Disabled.

x [h#] Function: Displays wallpaper or graphic and then exits the KBSCLK utility. 
Once the utility has exited (no longer running as a TSR), the keyboard and screen 
are not locked.
Default: 3 second graphic/wallpaper display, then unload TSR.
Options:
h Allows use of the Home key to bypass BootWorks and begin production boot 
processes.
# Specifies the time (in seconds) for the graphic to display (a maximum of 34 
seconds is possible). During that time, you can use the Home key to bypass the 
BootWorks processes. If zero is used, the graphic is displayed for 3 seconds and 
no bypass is allowed.

c Function: Clears the screen and exits the program. Used mostly for 
troubleshooting.

t Function: Sets video text mode (MODE CO80) and exits. Used mostly for 
troubleshooting.

w=file Function: Specifies the name of a graphic/wallpaper file to display. This is valid 
only if the x option is used. Valid files are pcx files with 640x480x16 color.
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Order Of Operations
The order of operations and utility behavior when KBDSCLK is run from the command line is as 
follows: 

• When c or t is used, it performs its functions and exits without performing any other functions, 
regardless of order. KBDSCLK does not remain loaded as a TSR, so the keyboard is not locked 
and no screen output is displayed.

• Use w to specify the name of a wallpaper/graphic file to replace the default. See the table above 
for details on using graphics files.

• When x is used, the wallpaper/graphic is displayed and the KBDSCLK program exits, ignoring 
all other commands except w and h, regardless of order. KBDSCLK does not remain loaded as 
a TSR, so the keyboard is not locked.

• If the utility is loaded as a TSR (in the autoexec.bat file), and you execute KBDSCLK on the 
command line and specify the k and s options, it changes the keyboard and screen lock settings 
of the TSR instance. Options w, p, and b are ignored, regardless of order. If the TSR is not 
loaded, w, p, and b can be used with k and s in any order. 

• The p option can be used on the command line to set a password for unlocking the screen and 
keyboard.

Deployment Server Install Switches
You can run the Deployment Server installation executable (axinstall.exe) from the command-
line using these switches:

Silent Install Options
You can add parameters for a silent install using an INI file that is accessed and used by the axinstall 
executable. The INI file can be named anything, but for the following section it will be identified as 
SILENT.INI. This file can be modified to directly input values when running an install without user 
interaction. 

Switch Details

-s Function: Runs a Simple install where all components are installed on a single 
computer. 
Example: axinstall -s

-a Function: Adds a component when installing a custom install where 
components—the Deployment Server database, PXE server, Client Access 
Point, services— can be installed on separate computers. 
Example: axinstall -a

-t Function: Allows you to run a silent install (where the install application 
executes without asking for user input. 
Example: axinstall -t

-t <INI file 
location>

Function: Allows you to run a silent install (where the install application 
executes without asking for user input) and read setting from an INI file.
See Silent Install Options (page 348).
Example: axinstall -t c:\silent.ini
Sample Silent.INI file:
[SilentInstall]
ProgramFiles=C:\Program Files\Altiris\eXpress\Deployment 
Server\
LicenseFile=axinstall.lic
Username=Administrator
Password=
DOSBootFilesPath=
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axinstall.exe -t <INI filename>

for example: axinstall -t c:\silent.ini

To add the ability to provide all of the inputs from a Simple Install, Custom Install, or an Add 
Component install, the Silent.ini file is required and must contain input parameters for each type 
of install.

By adding Version and InstallType entries to the [SilentInstall] group, Deployment Solution can 
identify if its working with an old SILENT.INI file or a new file. The old file type will be supported 
for backward compatibility and will continue to function.

Note The SILENT.INI file cannot have comments or blank lines between the header line and the 
key/value pairs.

[SilentInstall]

Version=2

InstallType=simple | custom | addcomponent

The Version and InstallType entries are both required in the new SILENT.INI file. If the Version 
entry is missing, it is assumed that it is an old SILENT.INI file (implicitly assumed to be version 1). 
If the InstallType entry is missing for a new version of SILENT.INI, an error will be logged to the 
log file and the installation will be aborted. Depending on the value of InstallType, different entries 
will be expected in the SILENT.INI file. The expected entries are listed in the following sections.

Note A validator checks all input values during a silent install. It ensures that all of the user input 
(such as the user name, password, data path, etc.) is valid before starting the silent install. The 
validator will inherit its behavior from the existing validation in the wizard pages of a non-silent 
install. If the validation fails, an appropriate error message writes to a log file and the installation 
process is aborted. 

Simple Install Entries
If the InstallType is set to "simple", the following entries will be expected in the SILENT.INI file. 
If any of the entries are missing, default values will be used. Using default values is not 
recommended because it may cause the validator function to abort the install because the default 
values won't work with the specified values. Any entries other than the ones listed below will be 
ignored for a simple install.

DAPath=C:\Program Files\Altiris\eXpress\Deployment Server

LicenseFile=ax85.lic

DAUsername=Administrator

DAPassword=password

   OR

DAEncryptedPassword=z%l$qry^w

InstallPXE=0

CreateExpressShare=FALSE | TRUE

DOSFilesPath=c:\dos

Custom Install Entries
If the InstallType is set to custom, the following entries will be expected in the SILENT.INI file. If 
any of the entries are missing then default values will be used. Using default values is not 
recommended because it may cause the validator function to abort the install because the default 
values won't work with the specified values. Any entries other than the ones listed below will be 
ignored for a custom install.
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Note If you attempt to push out a silent Deployment Solution install to a computer where Microsoft 
SQL Server is installed and SQL Server has a password for the "sa" account, then it will not work. 

 

DAPath=C:\Program Files\Altiris\eXpress\Deployment Server

LicenseFile=ax85.lic

DAUsername=Administrator

DAPassword=password

   OR

DAEncryptedPassword=z%l$qry^w

CreateExpressShare=FALSE | TRUE

DOSFilesPath=c:\dos

SEPath= C:\Program Files\Altiris\eXpress\Deployment Server

SELocation=local | remote

SERemoteComputerName=DESKPRO1

SEUsername=administrator

SEPassword=password

  OR

SEEncryptedPassword= z%l$qry^w

SEIPAddress=172.16.2.123

SEDBLocation=local | same | remote | sqlserver

SEDBRemoteComputerName=DESKPRO2

SEDBEnginePath=c:\mssql7

SEDBDataPath=c:\mssql7\data

SQLAuthentication=FALSE | TRUE

SQLMachineUsername=administrator

SQLMachinePassword=password

  OR

SQLEncryptedMachinePassword= z%l$qry^w

InstallPXE=FALSE | TRUE

PXLocation=dos | local | remote

PXRemoteComputerName=DESKPRO3

PXMakeMasterServer=FALSE | TRUE

PXIPAddress=172.16.2.123

PXDSIPAddress=172.16.2.123

PXPath=c:\Program Files\Altiris\express\Deployment Server

PXUsername=Administrator

PXPassword=password
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  OR

PXEncryptedPassword= z%l$qry^w

PXCreateDefaultPXEBootFiles=FALSE | TRUE

SQLAuthentication=FALSE | TRUE

SQLUsername=Administrator

SQLPassword=password

   OR

SQLEncryptedPassword=zlq%r*x+y

DSConnectionMethod=multicast | tcpip

DSConnectionServerName=* | <server name>

DSConnectionDSIPAddress=172.16.2.123

DSConnectionDSPort=402

COLocation=local | remote

CORemoteComputerName=DESKPRO4

COUsername=Administrator  

COPassword=password  

   OR

COEncryptedPassword=zlq%r*x+y

Add Component Entries
If the InstallType is set to addcomponent, the following entries will be expected in the SILENT.INI 
file. If any of the entries are missing then the default values will be used. Using default values is not 
recommended because it may cause the validator function to abort the install because the default 
values will not work with the specified values. Any entries other than the ones listed below will be 
ignored for adding new components.

AddDSConsole=FALSE | TRUE

AddPXEServer=FALSE | TRUE

AddDSWebConsole=FALSE | TRUE

DOSFilesPath=c:\dos

DAPath=C:\Program Files\Altiris\eXpress\Deployment Server

SEIPAddress=172.16.2.123

COLocation=local | remote

CORemoteComputerName=DESKPRO4

COUserName=Administrator

COPassword=password

   OR

COEncryptedPassword=zlq%r*x+y

PXLocation=dos | local | remote
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PXRemoteComputerName=DESKPRO3

PXMakeMasterServer=FALSE | TRUE

PXIPAddress=172.16.2.123

PXDSIPAddress=172.16.2.123

PXPath=c:\Program Files\Altiris\express\Deployment Server

PXCreateDefaultPXEBootFiles=FALSE | TRUE

PXUsername=Administrator

PXPassword=password

  OR

PXEncryptedPassword= zlq%r*x+y

Client BIOS Settings for Wake-On LAN and PXE
Some network cards have their own setup utilities. If there is a Wake On LAN option on your NIC, 
enable it.

If you want to use Wake On LAN, the motherboard and network card must support Intel’s Wired for 
Management (WfM) specification. You will also have to enable the features in the BIOS. (Settings 
are hardware specific.Your BIOS might not list all of these.).

Command-line Switches for the Pocket PC Agent
You can manage the Pocket PC Agent through command-line switches. The default path of the agent 
executable file is: C:\Altiris\PPCAgent\PPCAgent.exe.

The following table shows the optional switches and the functions they perform.

Note If PPCAgent.exe is run and if the agent has not previously been installed, then the agent 
will be installed automatically. If the agent was previously installed, it will simply load the agent.

Wake-On LAN settings

Power Management ON/ENABLED

Suspend/Wake-up Features ON/ENABLED

Wake On LAN ON/ENABLED

Remote Power Up ON/ENABLED

Power Switch/Wake-up ON/ENABLED
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Command Line Switches for the Pocket PC Agent

For example, to restart the agent, run 

C:\Altiris\PPCAgent\PPCAgent.exe -restart

To use more than one command-line parameter, separate the parameters with a space. For example, 
ppcagent -install -silent.

Computer Import File
Use the following format to import new computers from a text file. You can easily create a computer 
import file by entering data in the provided Microsoft Excel spreadsheet 
(ImportComputers55.xls) located in the Samples folder of the Client Access Point.

• A semicolon as the first character denotes comment lines.
• Quotes around fields are optional. 
• Leaving the job name blank will not assign the computer to any job.
• Leaving the start time blank will make an entry in the job for the computer, but will not schedule 

it for a specific time. 
• Only the Name field is required.
• Quotes around fields are optional.
You can populate your computer database using the format provided below. The Import Computers 
text file can then be imported into Deployment Solution using the File > New Computer > Import or 
File > Import/Export > Import Computers.

Tips for creating a new computers import file
• When using Boolean references, do not use quote marks. These fields are marked with a B: 

1=On/True and 0=Off/False.
• For some fields, this input format supports multiple IP Addresses, delimited by a “;” (semicolon) 

within the field. These fields are marked with a “(;)”. 
For example, the gateway field could read, 30.11.11.2, for a single IP address or, 
30.11.11.2;30.11.11.3;30.11.11.4, to support three IP addresses.

• All fields (up to and including “site”) must be present in the file, but all data except for “Name” 
is optional.

• To use optional fields for multiple network adapters, the preceding fields are required. For 
example, to use Nic3 fields, all fields for Nic2 are required.

• For Deployment Server to read the import text correctly, make sure there is a final hard return at 
the end of the file.

Format for the New Computers text file
Outlined below is the field order for the database input. Fields marked “(ignored)” are not used by 
version 5.5 and later, but are included to support previous versions.

Option Function
-install Installs the agent, or re-installs the agent if already installed.
-silent When used with -install, installs the agent without the 

installation dialog screens.
-stop Stops the agent.
-start Starts the agent after it has been stopped.
-restart Stops and restarts the agent.
-remove Stops and uninstalls the agent.
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;Name,MAC Address 1,Serial Number,Asset Tag,Computer Name,Domain(B),Domain/Workgroup 
Name,Domain Controller Name(ignored),DHCP(B),IP 
Address(;),Netmask(;),Gateway(;),Preferred DNS(;),Alternate DNS,Alternate 2 DNS,Preferred 
WINS,Alternate WINS,Hostname,Domain Suffix,Use Preferred Tree(B),Preferred Server,Preferred 
Tree,Netware User,NDS Context,Run Scripts(B),User,Organization,Key,Password Never 
Expires(B)(ignored),Cannot Change Password(B)(ignored),Must Change 
Password(B)(ignored),Username(ignored),Full 
Name(ignored),Groups(ignored),Password(ignored),Contact,Department,Email,Mailstop,Phone,Si
te,Computer Group,Job,Job Start Time,NIC2 MAC Address,DHCP(B),IP 
Address(;),Netmask(;),Gateway(;),DNS(;),WINS(;),Domain Suffix,NIC3 MAC 
Address,DHCP(B),IP Address(;),Netmask(;),Gateway(;),DNS(;),WINS(;),Domain Suffix,NIC4 
MAC Address,DHCP(B),IP Address(;),Netmask(;),Gateway(;),DNS(;),WINS(;),Domain 
Suffix,NIC5 MAC Address,DHCP(B),IP 
Address(;),Netmask(;),Gateway(;),DNS(;),WINS(;),Domain Suffix,NIC6 MAC 
Address,DHCP(B),IP Address(;),Netmask(;),Gateway(;),DNS(;),WINS(;),Domain Suffix,NIC7 
MAC Address,DHCP(B),IP Address(;),Netmask(;),Gateway(;),DNS(;),WINS(;),Domain 
Suffix,NIC8 MAC Address,DHCP(B),IP 
Address(;),Netmask(;),Gateway(;),DNS(;),WINS(;),Domain Suffix

Example Import File
DB Computer 
1,00a0c95c2640,6X18FHGZP21P,6X18FHGZP21P,Computer1,1,Altiris,,1,,,,,,,,,c
omputer1h,altiris.com1,1,server1,tree1,user1,context1,1,John 
Doe,"Altiris, Inc.",12345-OEM-1234567-12345,,,,,,,,John 
Doe,Engineering,jdoe@altiris.com,111,(801) 805-1111,Lindon,Test 
Group,Test Job,12/31/2001 
17:30,00a0c95c2641,0,172.25.10.180,255.255.0.0,172.32.0.4,172.32.0.1;172.
32.0.7,172.32.0.4,altiris.com2,00a0c95c2642,1,,,,,,altiris.com3,00a0c95c2
643,0,1.1.1.1;2.2.2.2,255.255.255.255;255.255.255.0,1.1.1.2;2.2.2.1,3.3.3
.3;4.4.4.4,5.5.5.5;6.6.6.6,altiris.com4,00a0c95c2644,1,,,,,,altiris.com5,
00a0c95c2645,0,1.1.1.1,2.2.2.2,3.3.3.3,4.4.4.4,5.5.5.5,altiris.com6,00a0c
95c2646,1,,,,,,altiris.com7,00a0c95c2647,0,5.5.5.5,4.4.4.4,3.3.3.3,2.2.2.
2,1.1.1.1,altiris.com8

System Tokens 
System tokens (variables), which are case sensitive, can be inserted in scripts (see Run Script (page 
172)) or answer files (in Scripted OS Install (page 163)) to extract information from the Deployment 
Database.

The following table lists all of the predefined system tokens supported by Deployment Solution 5.6 
or higher.

 

Token Description
%ASSETTAG% Asset tag from SMBIOS.
%BWIPADDR% The IP address of the client computer when booted to 

DOS from the Bootworks agent or PXE. 
%CALLINGJOBNAME% • The name of a job that called the current job (as 

used when Setting Up Return Codes (page 177)). 
• The name of the current job if it is not called by 

another job.
%COMPNAME% Actual computer name used by the OS.
%CONTACT% Contact name defined in the Location (page 135) 

properties.
%DATE% Date string in the form of mm/dd/yyyy.
%DEPT% Department description defined in the Location 

properties.
%DOMAIN% MS Workgroup or domain name.
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%DOMAINOU% Domain organization units. For example: 

MyCompany.com/MyParentOU/MyOU.

%DSSERVER% The NetBios name of the computer where the 
Deployment Server is installed.

%EMAIL% Email from the Location properties.
%ID% Unique Computer ID Generated by Deployment 

Server.
%IPNAME% Full DNS name of the computer.
%JOBNAME% The name of the current job.
%JOBUSER% The name of the user logged in to the Deployment 

console using Security (page 106).
%LDAPDOMAINOU% The LDAP format for AD domains. For example: 

dc=MyCompany, dc=com, OU=MyParentOU, 
OU=MyOU.

%MAILSTOP% Mail stop from the Location properties.
%MANUF% Computer manufacturer from SMBIOS.
%NAME% Complete computer name as displayed in the console.
%NETBIOSDOMAIN% The NetBios name for the Microsoft Domain.
%NICyIPADDR% IP Address for NIC y (y = 1-8). For example: the first 

NIC would be %NIC1IPADDR%I , second 
%NIC2IPADDR% …

%NICyIPDNSx% DNS entry x for NIC y. For example: the second NIC 
fourth DNS entry would be %NIC2IPDNS4%.

%NICyIPGATEWAY% Default gateway for NIC y (y = 1-8). For example: the 
first NIC would be %NIC1IPGATEWAY%, second 
%NIC2IPGATEWAY% …

%NICyIPHOST% IP Host for NIC y (y = 1-8). For example, the first NIC 
would be %NIC1IPHOST%; the second would be  
%NIC2IPHOST%.

%NICyIPNETMASK% Netmask for NIC y. For example: the first NIC would 
be %NIC1IPNETMASK%, second 
%NIC2IPNETMASK% …

%NICyIPWINSx% WINS entry x for NIC y. For example: the third NIC 
first WINS entry would be %NIC3IPDNS1%.

%NICyMACADDR% MAC for NIC y (y = 1-8). For example: the first NIC 
would be %NIC1MACADDR%, 
second%NIC2MACADDR% …

%NODEFULL% The computer name (in the BIOS) of the client 
computer.

%NODENAME% First 8 characters of actual computer name.
%NWCONTEXT% NetWare context name for Client Access Point (CAP).
%NWSERVER% NetWare preferred server (for the CAP).
%NWTREE% NetWare preferred tree  (for the CAP).
%OS% Specific operating system (Win98, Win2K, WinXP).
%OSTYPE% Operating system type (Win9x, WinNT, Linux).
%PHONE% Phone defined in the Location properties.

Token Description
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Custom Tokens
Custom tokens can be defined in a script or answer file to extract data from any MS SQL Server 
database table. This is most commonly used when creating custom tables to store additional 
computer inventory information. This token replacement feature allows you to specify any SQL 
database, look up a specified value, and replace the custom token with the value from the selected 
database (whether it resides on the local computer or not).

Syntax One
%#Alias^!table name@column name%

Examples:

To return the names of the computers:
%#!computer@computer_name%

To return the color column from a custom database and table that has the computer_id column in it:
%#DBAlias!table@color%

To return the color column from the first record from a custom database and table:
%#DBAlias^!table@color%

%PROCDESC% Description of the processor.
%PROCSPEED% Processor speed.
%PROCCOUNT% The number of processors installed (not the number of 

processor slots).
%PROD_LIC% Product License Key.
%RAMTOTAL% Total Random Access Memory.
%SERIALNUM% Serial number from SMBIOS.
%SITE% Site description defined in the Location properties.
%TIME% Time string in the form of hour:minutes.
%USER_NAME% The name of the registered user of the client computer.
%UUID% The Universally Unique Identifier (UUID) of the 

computer, if supported by hardware.

% Identifies the opening and closing of a variable token in the script.

# Indicates that this is a custom token.

Alias Specify the alias for an external database set up in the Tools > Options > Custom 
Data Sources dialog box. See Custom Data Sources options (page 106).

^ Indicates that this is a global identifier token. All tokens by default will be 
looked up using the Computer_ID value for which the token ID is being 
replaced. This global identifier tells Deployment Solution to NOT use the value 
in the computer_ID column. Instead, it will use the first value found in the 
specified table.

! Specifies that the following text is the table name in the Deployment Database. 
This field is required for all user-defined tokens.

@ Specifies that the following text is the column name in the table. This field is 
required for all user-defined tokens.

* Indicates that the text following this symbol is a SQL statement.

Token Description
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Syntax Two
%#Alias*SQL query statement%

Examples
To return the names of the computer with an SQL statement: 
%#*”SELECT computer_name from computer where computer_id = 1234567”%

To return the color column from a custom database and table with a computer_id column: 
%#DBAlias*”SELECT color from table where computer_id = 1234567”%

To return the color from the first record from a custom database and table: 
%#DBAlias*”SELECT color from table”%

* Indicates that the following text is an SQL statement.
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RapiDeploy Technical Reference

The purpose of this reference is to provide in-depth information about the tools included with Altiris 
RapiDeploy. 

For step-by-step instructions on how to do common tasks, see the Using RapiDeploy chapter in this 
product guide.

This section provides information on the following topics:

• RapiDeploy Executable Files (page 359)
• Running RapiDeploy from the Command-line (page 359)
• Using SIDgen (page 367)
• Using File System Independent Resource Management (FIRM) (page 370)
• Troubleshooting RapiDeploy (page 375)
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RapiDeploy Executable Files

The following table lists and gives a short description of RapiDeploy executable files:  

 

Running RapiDeploy from the Command-line
You can create and deploy images from the command-line using switches. This is useful if you want 
to run imaging from a batch file and not use the Rdeploy wizard. 

Switches can be entered in any order and they are not case sensitive. When using multiple switches, 
leave a space between each option.

You can also get a list of switches at the DOS prompt by typing the following:

rdeploy -?

If you want to redirect this list to a file, type the following:

rdeploy -? -text > rdparams.txt

RapiDeploy Executable Files

File Description
rdeploy.exe An Altiris DOS program with a graphical “wizard-like” interface. When run on 

a computer, rdeploy.exe temporarily designates the computer as the RapiDeploy 
“Master PC” or as the “Client PC”. The Master PC controls how images are 
created, uploaded, and downloaded, and how they are sent or multicasted to other 
computers.
Rdeploy.exe lets you set up configurations (such as TCP/IP, user settings, 
networking settings) on the computer after it has received an image. You can run 
rdeploy.exe with command-line switches (see “Running RapiDeploy from the 
Command-line” on page 359) and set up other options for imaging and 
multicasting.

firm.exe “File System Independent Resource Management (FIRM)” gives you basic file 
access to all FAT, NTFS, ext2, and ext3 file systems on your hard disk, 
regardless of the version of DOS you are running. This is an advanced feature. 
You don’t have to use it to perform normal management tasks. For more 
information, see “Using File System Independent Resource Management 
(FIRM)” on page 370.

bootwiz.exe The Boot Disk Creator executable file. The Boot Disk Creator creates the Master 
PC and Client PC boot disks. For more information, see “Create Boot Disks” on 
page 261 and Boot Disk Creator (page 275).

imgexpl.exe An Altiris Windows application, the ImageExplorer executable file lets you view 
and make modifications to Altiris image files (*.img). For more information, see 
“Managing Images” on page 274 and Using ImageExplorer (page 300).

aclient.exe The Deployment Agent for Windows (aclient.exe). For information about how 
aclient.exe is used with RapiDeploy, see “Install the Deployment Agent For 
Windows for Post Image Configuration” on page 263.

sidgen.exe An Altiris Windows utility that generates unique security IDs (SIDs) on 
Windows computers. For more information, see “Using SIDgen” on page 367.

clcfg.exe Installs the Deployment Agent for Windows (aclient.exe). For more information, 
see “Task Overview” on page 264.
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RapiDeploy Command-line Switches
The following table lists all the command-line switches that you can use with rdeploy.exe.    

RapiDeploy Command-line Switches

Switch [parameters] Details
-? Function Shows command-line help.
-bsl:[maximum bandwidth] Function Determines the maximum bandwidth to be used by the 

multicasting session.
Example To limit the bandwidth to 5 Megabits per second, type
rdeploy -bsl:5 

-c[compression mode] Function Sets the compression mode for image creation. 
Default balanced
Modes
• off (turn compression off) 
• size (make smallest image size with slight speed penalty) 
• speed (make a less compressed image in less time) 
• balanced (make a reasonable compressed image with a reduced 

speed penalty)
Example To optimize image creation for speed, type
rdeploy -mu -f[filename] -cspeed

-cfgfile:[filename] Function Sets the configuration filename (default is lastrun.cfg). The 
configuration file provides information for post configuration. The 
default configuration file is lastrun.cfg that can be edited in a text 
editor with the specific information needed for the computer.
This command is useful if you want to run imaging in a batch file 
using configuration information saved previously by the RapiDeploy 
program. (If you select the option to save settings in the RapiDeploy 
program, a configuration file will be created with the name 
lastrun.cfg.) You can rename lastrun.cfg and specify it in your batch 
file to apply configuration settings. 
Example If you have run RapiDeploy and have chosen the option to 
save configuration settings, you could rename lastrun.cfg to 
laptop1.cfg and use it in a batch file by typing the following:
rdeploy -md -f[filename] -cfgfile:laptop1.cfg
You can also put configuration files in a shared directory and load 
them from the network.
See also -m[mode], -f[path & file name]

-checkdisk Mark the partitions dirty so that checkdisk will run after the image is 
restored (works on all file systems).
Note Post configuration will fail when this switch is used.
Example rdeploy -mu -f[filename] -checkdisk
See also -m[mode], -f[path & file name]

-d[hard disk number] Function Specifies which hard disk to read from or write to, 
depending on whether you are uploading or downloading. This switch 
is used for computers that have more than one hard disk.
Default Disk 1
Examples 
To download an image to disk 2, combine with the -md switch and 
type
rdeploy -d2 -md -f[filename]
To create an image from disk 2, combine with the -mu switch and type
rdeploy -d2 -mu -f[filename]
See also -m[mode], -f[path & file name]
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-f[path & file name] Function Used with the -m switch. In upload mode, it specifies the 

filename and location for storing an image file. In download mode it 
specifies which image file to restore. 
To create (upload) a regular image file, use an .img extension. To 
create a self-extracting executable image file, use an .exe extension.
Examples 
To upload an image file to disk g:, type
rdeploy -mu -fg:\images\win98.img
To upload a self-extracting executable image file, type
rdeploy -mu -fg:\images\win98.exe
See also -m[mode], -f[path & file name]

-forcebw Function Forces the BootWorks partition to be restored. Use this 
switch when using PXE or to overwrite an existing BootWorks 
partition on the hard disk with the BootWorks partition in the image.
Example To restore an image and have the BootWorks partition in the 
image replace an existing BootWorks partition on the hard disk, type
rdeploy -md -f[filename] -forcebw
See also -m[mode], -f[path & file name]

-forcegui Function Forces the wizard to appear even if it doesn’t have to. Use 
this switch to force the wizard to appear so that you can view or edit 
settings for each computer.
Example To restore an image but first view or make changes in the 
settings, type
rdeploy -md -f[filename] -forcegui
See also -m[mode], -f[path & file name]

-forceoem Function Forces the OEM partition to be restored. Use this switch to 
overwrite an OEM partition on the hard disk with an OEM partition 
in the image.
Example To restore an image and have the OEM partition in the 
image replace an existing OEM partition on the hard disk, type
rdeploy -md -f[filename] -forceoem
See also -m[mode], -f[path & file name]

-frm:[name] Function Specifies a FIRM file that contains a list of FIRM 
commands to be executed after a restore. A FIRM file is a text file 
containing FIRM commands to execute.
Example After a computer has received an image, you can copy a file 
that is not in the image to the computer. For example, you may want 
to copy a .cfg file that a computer needs but is not in an image.
rdeploy -md -f[filename] -frm:firm.txt
In this example, you would have two files:
• The FIRM file that includes the FIRM command to perform the 

copy, firm.txt
• The file that you want copied to a computer, sample.cfg
Both of these files must be in the RapiDeploy/FIRM application 
folder.
The FIRM file, firm.txt, could have the following FIRM command:
copy sample.cfg c:\sample.cfg
In this example, after the image has been received, sample.cfg is 
copied from the RapiDeploy application folder on the server to the 
computer in the specified folder.

-h Function Shows command-line help.

RapiDeploy Command-line Switches (Continued)

Switch [parameters] Details
Deployment Solution Product Guide 361



 RapiDeploy Technical Reference Running RapiDeploy from the Command-line

 

-i:[20..25] Function Sets screen resolution.

For information on setting VESA modes, see -ve:[31.34]
Example To set screen resolution to VGA mode 23 (640x480x16), 
type
rdeploy -i:23

-i[IDnumber] Function Sets session ID when sending an image file to more than 
one computer. Use this switch with multicast sessions so the Master 
PC can identify Client PCs in the same session.
Example To send an image to 10 Client PCs, type
rdeploy -mdb -f[filename] -s9 -i5000001 
Note -i500001 is given as an example. This value is an example of 
what the Deployment Server console would send for a session ID.
See also -m[mode], -s[number of Client PCs], -f[path & file name]

-ip:[n.n.n.n:p] Function Sets the multicast IP address and port. This can be used for 
two purposes: 1) To allow multicasting through a router that is set up 
to use a different multicast IP address, and 2) to separate multiple 
multicasting sessions more efficiently. 
If you are manually running multiple multicast sessions, you can 
specify a different multicast IP address for each session to allow the 
NIC itself to filter out unwanted packets from other sessions. This 
speeds up all sessions involved. 
Important Remember to put the port number at the end of the IP 
address after a colon.
Example
rdeploy -mdb -f[filename] -s9 -ip:224.2.0.3:401
See also -m[mode], -s[number of Client PCs], -f[path & file name]

-kap Function Prevents rdeploy.exe from overwriting any existing 
partitions on the hard disk.

-kp[1-31] Function (Download only) Prevents rdeploy.exe from overwriting a 
specified partition.
n=partition 1 - 31
Example To keep partition 2 from being overwritten during imaging, 
type
rdeploy -md -f[filename] -kp2
See also -m[mode], -f[path & file name]

-m[mode] Function Sets the operating mode. 
Modes
• u (Upload image) 
• d (Download image) 
• b (Multicast only) 
• ub (Upload and multicast image) 
• db (Download and multicast image) 
• client (Client mode)
Examples 
To upload an image, type 
rdeploy -mu -f[filename]
To designate a computer as a Client PC, type
rdeploy -mclient
See also -f[path & file name], -i[IDnumber]

RapiDeploy Command-line Switches (Continued)
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-makeimx Function Minimizes the number of disk swaps that occur when 

restoring a hard disk image that has been split across multiple CDs or 
other storage media.  This switch causes RapiDeploy to create an .imx 
(IMage IndeX) file which contains data that may reside on other CDs.  
If RapiDeploy has access to the .imx file, it will not prompt you to 
insert any CD more than once.
Use the -makeimx switch when you create an image. However, no 
switches are needed when restoring the image. Once the split image 
file has been created and you are ready to burn the image to CDs, put 
the .imx file on the CD with the first .img split image file. Subsequent 
split image files do not require the .imx file to be placed on the CD. 

-mconv Function Used with the -f switch to convert an existing image file 
(.img) to a self-extracting .exe file. (Does not upload or download; 
just converts the file.) 
Example To convert a file named WIN98.IMG, type
rdeploy -mconv -fwin98.img
See also -f[path & file name]

-mig:[filename] Function Used to specify a migration file. Prompts before 
overwriting the drive. This is used mainly by PC Transplant Pro.

-nobw Function Makes sure that a BootWorks partition does not exist in the 
destination, is not on the disk when restoring, and is not in the image 
when creating.
Example To remove an existing BootWorks partition from a hard 
disk and exclude the BootWorks partition from being downloaded 
with an image, type
rdeploy -md -f[filename] -nobw
See also -m[mode], -f[path & file name]

-nocancel Function Doesn’t allow the user to cancel the imaging task.
-nooem Function Makes sure that an OEM partition does not exist in the 

destination, is not on the disk when restoring, and is not in the image 
when creating.
Example To remove an existing OEM partition from a hard disk and 
exclude the OEM partition in an images from being restored, type
rdeploy -md -f[filename] -nooem
See also -m[mode], -f[path & file name]

-noprompt Function Prevents any need for user interaction, for example, 
clicking OK after an error occurs. This is very useful in scripting 
situations where there won't be a user present to hit a key.

-nt64k 
(Download only) 

Function (NT computers only) Enables a 64K cluster size with a 
FAT16 partition. This allows you to resize a FAT16 partition up to 4 
GB rather than the normal 2 GB limit.
Example To change the size, type
rdeploy -md -f[filename] -nt64k
See also -m[mode], -f[path & file name]

RapiDeploy Command-line Switches (Continued)
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-p[partition] Function Specifies which partition to process. 

Parameters 
• n Number (1-31) uploads the partition (each partition must be 

designated separately)
• b images the BootWorks partition (works for both hidden and 

embedded types)
• oem images the oem partition
Examples
To upload an image of partition 2, type
rdeploy -mu -p2 -f[filename]
To upload multiple partitions, type
rdeploy -mu -p2 -p3 -p4 -f[filename]
To upload the BootWorks partition, type
rdeploy -mu -pb -f[filename]
To upload the oem partition, type
rdeploy -mu -poem -f[filename]
See also -m[mode], -f[path & file name]

-password:[pwd] Function Specifies the image password. Passwords are case sensitive.
Example To create a password-protected image file, type
rdeploy -mu -f[filename] -password:Altiris
To restore that file, type
rdeploy -md -f[filename] -password:Altiris
See also -m[mode], -f[path & file name]

-raw Function Treats all partitions as raw. The Master PC reads and 
images a partition by sectors rather than by files. This switch makes 
the image drive geometry dependent (must have the same heads, 
cylinders, and tracks as the image source). Used mostly by Altiris 
Technical Support for troubleshooting, or it could be used to make 
sure that any extra data residing outside of the file system is included 
in the image.

-restoresig Function Causes RapiDeploy to restore the unique disk signature in 
the MBR of the hard disk from which the image was created. 
Normally, RapiDeploy does not transfer the disk signature to the 
target computer when deploying an image. This switch can be used 
when restoring an image to the same or similar systems. The -szf 
switch may be needed in combination with the -restoresig switch.
Example One  This -restoresig switch has been added to the  
Distribute Disk Image job in the XP Embedded folder in the Samples 
folder to protect the Write Filter Partition. It is required for all Restore 
Image jobs for XPe Thin Clients.
Example Two  The -restoresig switch is needed when restoring an 
image to a Citrix Metaframe Server to preserve the alternate drive 
mappings. In this situation the -szf switch is also required.
Note This switch will function only if no production partitions are 
being preserved on the hard drive when deploying the disk image.

-s[number of Client PCs] Function Specifies the number of Client PCs included in a multicast 
session. When the Master PC detects the specified number of Client 
PCs, it automatically starts the multicast session. The number 
specified does not count the Master PC.
Example To set the number of Client PCs that will be connecting to 
the Master PC in a multicast session to 9 computers, type
rdeploy -mdb -f[filename] -s9 
See also -m[mode], -f[path & file name]

RapiDeploy Command-line Switches (Continued)
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-span Function Prompts between each piece of an image file (if set when 

using the -split command), allowing you to insert new media.
Example To prompt between each file in the image set, type
rdeploy -mu -f[filename] -split:500 -span
See also -m[mode], -f[path & file name]

-split:[n] Function Breaks an image into multiple files of a specified size 
during an upload (in megabytes).
Example To set the file size to 500 MB, type
rdeploy -mu -f[filename] -split:500
See also -m[mode], -f[path & file name]

-szf Function Use this switch to set fixed sizing for all partitions. By using 
this switch, RapiDeploy will use the original sizes that existed on the 
computer from which the image was created.
Example If the original size of the partition to be downloaded was 
250 MB and you want the destination partition to remain 250 MB, use 
the -szf switch. If the target disk has 500 MB of free space, you’ll have 
a 250 MB fixed partition and 250 MB of free space. 

-sz[parameter] Function Resizes partitions during imaging. 
Syntax 
rdeploy -sz[#]:[x{m|p}] where # is the partition number and x is the 
size based on the number of megabytes or a percentage.
Parameters
• [x]m (Resize partitions in megabytes) 
• [x]p (Resize partitions as a percentage of hard disk size for 

primary partitions or the percentage of the extended partition for 
logical drives)

Examples
If the size of partition 2 being downloaded is 300 MB and you want it 
to fit in half of the 500 MB of disk space on the client disk, type
rdeploy -sz2:50p -md -f[filename]
This resizes the 300 MB partition to 250 MB, leaving the other 250 
MB unused. 
You can set the target size for multiple partitions on the same 
command-line by including multiple instances of the switch: 
rdeploy -sz1:200m -sz2:50p -md -f[filename]
See also -m[mode], -f[path & file name]

-text Function Run in text mode instead of GUI mode. To use this switch, 
all settings must be specified at the command-line.
Examples
rdeploy -md -f[filename] -text
or
rdeploy -mu -f[filename] -text
If you want to save a list of command-line parameters to a text file, 
you can use the -text parameter
rdeploy -? -text > rdparams.txt
See also -m[mode], -f[path & file name]
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-threshold:[n] Function This option applies only to the “Restore and Send” (-mdb) 

mode. We have found that when using a small number of clients, it is 
faster to perform individual downloads on each client than it is to 
multicast to all of them. There is a point where it becomes more 
efficient to multicast than it is to perform individual downloads. This 
“threshold” is where it becomes faster to multicast than to do 
individual downloads and can be specified by the -threshold:[n] 
command line parameter. 
Depending upon the network environment, this number may vary. 
You should perform a few tests to pick a good threshold value for 
your network. It may be a small number, like four, or it could be much 
larger, like 15. 
Once you have found this threshold value, you can specify this 
number on the command line and then RapiDeploy will, depending on 
the number of clients that connect, have them do individual 
downloads or have them multicast. 
The number [n] specifies the minimum number of clients that will 
need to connect to the master in order for it to multicast. For example, 
if you specify -threshold=5, and four or fewer clients connect to 
the master PC, it will have them all do individual downloads of the 
image. If five or more clients connect to that master, it will multicast 
to them. 
This becomes more important when multicasting across subnets with 
a router that doesn't support multicasting. If you start one master and 
nine clients (10 PC's total), three of which are on one side of the router 
and seven of which are on the other side, RapiDeploy will detect that 
there are only three on one side of the router and do individual 
downloads to them. It will also detect that seven are on the other side 
and multicast to them. RapiDeploy does all of this automatically. All 
you must supply is the threshold value to let RapiDeploy determine 
when it should multicast or not.
Example
Suppose you have determined that the threshold value for your 
network is five. In other words, you have found that multicasting from 
one master to five or more clients is faster than doing individual 
downloads to those clients and the master. You could then specify the 
following threshold value on the command line:
rdeploy -mdb -f[filename] -s9 -threshold:5
See also -m[mode], -f[path & file name], -s[number of Client PCs]

-ve:[31.34] Function Set VESA screen resolution.

Example To set screen resolution to VESA mode 31 (640x480x256), 
type
rdeploy -ve:31

-w[n] Function When multicasting, specifies the maximum number of 
minutes to wait for Client PCs to connect. If all Client PCs connect, it 
will start right away.
Default: 5 minutes (or until the specified number of Client PCs is 
connected). 
Example To set the timeout to wait for PC Clients to 10 minutes, type
rdeploy -w10 -mdb -f[filename] -s9 
See also -m[mode], -s[number of Client PCs]

-x Function Cause the image to be saved as a self-extracting file. This 
setting will automatically be set if the image file name specified by the 
-f parameter ends with .EXE.

RapiDeploy Command-line Switches (Continued)

Switch [parameters] Details
Deployment Solution Product Guide 366



 RapiDeploy Technical Reference Using SIDgen

 

Using Command-line Switches with Executable 
Images
In rare cases, you might need to use switches with executable image files. Multiple switches can be 
used on the same command-line. As with other switches, you can use them on the command-line or 
in a batch file.

In addition, you can use the -noprompt switch, which bypasses the default screen that prompts the 
user before imaging begins. 

Example If you named your self-extracting file baseimag.exe when you created (uploaded) it, you 
would type the following on the command-line or in your autoexec.bat file:

baseimag.exe -noprompt

You can combine this switch with any of the other switches.

Using SIDgen
When you download an image to Windows computers in a domain, you will need to generate unique 
security IDs (SIDs) for each one. To accomplish this, RapiDeploy uses the Altiris SIDgen utility, a 
native 32-bit security attribute modification utility that works on Windows NT 4.0 and Windows 
2000/XP/2003 workstations and servers (including Primary and Backup Domain Controllers). The 
SIDgen executable is located in your RapiDeploy program directory. Deployment Agent 
(aclient.exe), assuming it is included in the image, runs SIDgen behind the scenes for you if you 
select Change the Windows Security ID (SID).

Note SIDgen uses the NT/2000/XP/2003 System Account to make security ID changes. If you have 
limited the rights on this account, SIDgen will not work.

How SIDgen Works
When SIDgen is run on a computer, it backs up the registry, then generates a unique SID for the 
computer. It searches all registry hives and replaces appropriate entries with the newly generated 
SID. Then, SIDgen replaces file system security assignments (NTFS file system security 
permissions), unless you choose not to check them. The entire process is transparent to the user. 
Security entries still list the same users/groups and all user preferences remain intact. If any errors 
occur during the replacement process, SIDgen restores the registry to its original state. If successful, 
everything appears normal. 

If you want to know for sure that a new SID was generated, write down the existing SID before 
running SIDgen, then check the number again after you run the utility. 

Warning If you run SIDgen on a production Primary Domain Controller (PDC), you will have to 
resynchronize all of the computers in the domain.

Load SIDgen on your Computers (Optional)
To run SIDgen, you must copy the program to the computers using one of the following methods:

• Include SIDgen in an image if you want to change the SID every time you image the computer 
and apply configuration changes. (If you want to include it in an image but you don’t want to run 
SIDgen each time you run the imaging event, you will have to use ImageExplorer to exclude the 
image file after you run the event the first time.)

• Use Copy File to Computers on the Deployment Windows Console to copy the program to the 
computers in the same folder as the Deployment Agent (aclient.exe). 

• Install sidgen.exe automatically when you install Deployment Agent (see “Using SIDgen” on 
page 368).

To determine the best option for you, consider how often you will need to change SIDs.
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When SIDgen is on the computers, it can be run as needed using a simple script file.

SIDgen Memory Requirements
Because SIDgen backs up the computer registry to memory, your Maximum Registry Size setting 
must be set to at least twice the size of the actual registry.

To check the memory settings
1 Right-click My Computer and click Properties.
2 For Windows NT, click the Performance tab. For Windows 2000, click Advanced > Performance 

Options.
3 In the Virtual Memory box, click Change.
4 In the Registry Size box, make sure the Maximum Registry Size is at least double Current 

Registry Size. 

Using SIDgen
You can change a SID every time you image a computer. You can also run SIDgen from the 
command-line. For a list of SIDgen command-line parameters, see “To run SIDgen from the 
Command-line” on page 368.

To change a SID every time you image a computer
1 When you install aclient.exe on the computer, select Enable Changing of Security ID on the Altiris 

Client install screen.
2 Choose the utility you want to use to make SID changes: 

• Altiris SIDgen utility. This utility is the most thorough way to change SIDs because it 
searches all registry entries and NTFS file system security permissions. Because of this, it 
takes longer for the program to run (unless you choose not to check NTFS permissions).

• Microsoft SysPrep utility. This utility changes the basic SID options. It is not provided by 
Altiris.

• Both utilities. Use both utilities if you want to use SysPrep to change the basic SID options 
and SIDgen to make in-depth changes.

3 If you are using SIDgen and you don’t want to check NTFS permissions, deselect the box.
Note If permissions are not checked, file restrictions set on the local computer will not be carried 
forward. Access rights will have to be reset manually.

4 Enter the path to the utility you want to use.
5 Click Next to complete the install. aclient.exe and SIDgen.exe are copied to the directory you 

specified on the Client PC.
Note SIDgen will run on the computer each time it is imaged and new configuration settings are 
applied. If you do only one of the tasks (deploy an image without reconfiguring or reconfigure 
without imaging), SIDgen will not run. After running SIDgen, you should back up the registry 
files to save the configuration changes. 

To run SIDgen from the Command-line
1 Boot the Windows computer whose SID you want to regenerate.
2 Log in to the computer as Local Administrator (or equivalent user).
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3 Run sidgen.exe and enter the information requested on the screens.

Scenarios for Generating SIDs
The following examples show you how to generate SIDs in various circumstances.

Scenario 1: Non-Domain NT Servers or Workstations
If you are only changing the SID of Windows NT/2000/XP workstations that are not installed into 
any domains, you can simply run the utility on the workstation, ignoring the -data parameter 
involving the synchronization file. In this case, you will not need to synchronize anything with these 
workstations.

Scenario 2: One PDC and Multiple Domain Members (No 
BDCs)
When you have a Primary Domain Controller and numerous computers booted into the domain, 
follow one of these sets of steps: 

• If you are running the Deployment Console on a Win NT/2000/XP/2003 computer with access 
to the domain server, and you have rights to create computer accounts on the primary domain 
controller (PDC), the console will manage SIDs in the domain for you. Follow the steps in Set A. 

• If one of these criteria is not met, the Deployment Windows Console cannot manage the domain 
for you, so you will have to enter the information manually. Follow the steps in Set B.

SIDgen Command-line Switches

Switch [parameters] Function
/clean Cleans a previous run, including all temporary files. SIDgen creates 

some temporary files that cannot be removed until after the computer 
restarts.

/data:[sync filename] Synchronizes permissions between Primary Domain Controllers 
(PDC), Backup Domain Controllers (BDC) and member NT 
workstations.
When running SIDgen on a PDC, you need to synchronize the changes 
with all the other computers in its domain. This file is created by the 
PDC and contains the previous and new SIDs to synchronize with 
Backup Domain Controllers and domain members. For examples of 
how to use this parameter, see “Scenarios for Generating SIDs” on 
page 369.

/install Installs the utility as a service (prompts for an account and password).
/log:[log filename] Creates a log file. (If the filename is omitted, C:\sidgen.log is created.)
/name:[new name] Changes the computer name along with the SID. (If the [new name] 

portion is omitted, you will be prompted upon execution of the utility.)
/nofs Bypasses NTFS checking. This option causes any permissions set up on 

user-created groups or user accounts to become unknown. Use this 
option only if you are using default groups to assign permissions and 
those groups do not have a full administrator account (that is, their 
administrator does not have access to some of the files on an NTFS 
partition).

/remove Removes the service entry.
/start Runs in unattended mode (starts interactive mode without prompting).
/verbose Includes verbose information in log.
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Set A
1 Install Windows NT on one workstation that is logged in to the domain.
2 Install SIDgen on this workstation (run sidgen /name /install).
3 Image this workstation to all other workstations.
4 Boot all imaged workstations. They should launch SIDgen to change their SIDs. You are 

prompted for the computer name on each computer. When complete, the computers should 
reboot and connect into the domain normally.

Set B
1 Create a computer entry in the domain database for one workstation.
2 Install Windows NT on one workstation, logged in to the domain.
3 Install SIDgen on this workstation (run sidgen /name /install).
4 Image this workstation to all other workstations.
5 From the PDC, remove the workstation’s domain database entry, and then add all the computer 

names that will be specified in Step 6.
6 Boot all imaged workstations. They should launch SIDgen to change their SIDs. You are 

prompted for the computer name of each computer. When complete, the computers should 
reboot and connect into the domain normally.

Scenario 3: Synchronizing Multiple PDCs and/or BDCs
Suppose you have multiple Primary Domain Controllers and one or more Backup Domain 
Controllers (as well as numerous computers installed into the domain) that have all received an 
image. You may change the SIDs of all of these computers by following these steps:

1 Create a synchronization file in a network shared location or on a floppy disk by running SIDgen 
on the PDC (for example, type sidgen /data:a:\pdc.dat).

2 When the PDC’s SID has been changed, run SIDgen on the BDCs, using the synchronization file 
that you created in Step 1.

3 The utility detects whether to read or write this file based on the role of the computer.
4 To change all occurrences of the old domain, run SIDgen on all workstations installed into the 

domain, specifying the same synchronization file created in Step 1.
If your system does not meet the criteria specified in Scenario 2, go to the PDC and remove and re-
add any domain members whose SIDs have been replaced. You can also add the /name parameter to 
any of these steps to change the computer names of these computers during this process.

Using File System Independent Resource Management 
(FIRM)

FIRM gives you basic file access to all FAT, NTFS, and EXT2 file systems on your hard disk, 
regardless of the version of DOS you are running. This is an advanced feature. You don’t have to 
use it to perform normal management tasks. 

FIRM serves as an interface between DOS and the hard disk(s). You can use FIRM commands to 
manage both DOS disks and FIRM drives (FAT,NTFS, and EXT2).

With FIRM, it’s easy to access and manage both BootWorks and production partitions. When you 
are in DOS, you can see only the BootWorks and FAT partitions. When you are in production mode, 
you cannot see the BootWorks partition. FIRM allows you to access both BootWorks and production 
partitions. This is important for copying files between operating systems. It’s also important for 
disaster recovery because you can use it to back up and restore the registry and other files on the 
production partition. 

Note If you are using RapiDeploy as a stand-alone product without Deployment Solution, 
BootWorks partitions are not available.
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How FIRM Works
FIRM identifies two drive type: DOS drives and FIRM drives. DOS drives are those that DOS 
recognizes, such as local drives and network drives. FIRM recognizes DOS drives in addition to 
other local partitions that are present but may not be recognized by DOS. FIRM assigns drive letters 
to partitions in the order they are defined on the hard disk. Because FIRM and DOS both assign drive 
letters, they might “see” different drives. So, the drive letter assignments might be different 
depending on which operating system you use to see the mappings.

Here is an example of what you would see with several operating systems compared to what you 
would see with FIRM. Note that the only way to see the location of the embedded BootWorks 
partition is with FIRM. 

*Drive letters are assigned according to where the drives physically reside on the disk.

FIRM uses the following logic to determine which type of drive to use:

• Drives A: and B: are DOS drives.
• All other drives are assumed FIRM drives unless prepended with the drive type identifier D. For 

example, DC: indicates DOS drive C:.
• If a FIRM drive is not found, then a DOS drive is assumed.
• FIRM drives can also be explicitly specified by prepending the drive type identifier F. For 

example, FK: indicates FIRM drive K:.

Running FIRM
• The computer must be booted to DOS.
• The firm.exe program must be on a disk or a server where you have rights to access it.

To run FIRM
1 Put the disk containing FIRM.EXE into drive a:, or log into the server where the program files 

are located.
2 Type FIRM to run the program. 

Drive mapping comparison

Sample Partitions Partitions 
recognized by 
Win ‘98

Partitions 
recognized by 
WIN NT

Partitions 
recognized by 
WIN 2000

Partitions 
recognized by 
FIRM

Embedded BootWorks 
partition (always drive 
W:)

           
           *

FAT 32           *           *           *
FAT 16           *           *           *           *
NTFS           *           *           *
EXT2/EXT3           *
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Using FIRM
Drive designations Because FIRM and DOS recognize drives differently, they might assign 
different letters to the same drive. So, for some commands you must specify the drive type in 
addition to the drive letter.

Drive types are: d (DOS drive), and f (FIRM drive).

Tokens You can use a token in place of a drive letter wherever one is required. Tokens are just 
another way of accessing a drive on the partition. FIRM replaces tokens with the appropriate drive 
letter. 

FIRM Tokens

Token Function
auto Function Used in place of the BootWorks partition letter (w: drive).

Examples
To delete the autoexec.bat file from the BootWorks partition, type
firm delete auto:\autoexec.bat
To see a directory list of the BootWorks partition, type
firm dir auto:\

prod Function Used in place of the production partition letter (for example, firm c: 
drive).
Examples
To see a directory list of firm drive c:, type
firm dir prod:\
To copy backup files from the production partition c: to the BootWorks partition, 
type
firm copy prod:\backup.lst auto:\backup.lst

temp Function This is an environment variable string that maps to wherever your 
TEMP directory is assigned.
Example 
To see a list of files and directories in your TEMP directory, type
firm dir temp:\

FIRM Modes and Switches

Mode Options
drives Function Gets a list of all partitions/drives. Shows the file system and FIRM 

drive letters. Also shows the percentage of the drive used by the partition. 
Usage firm drives
Example To see a list of all supported drives, including the embedded 
BootWorks partition, type
firm drives

type Function Sees the contents of an ascii text file. (Other file types don’t display 
correctly.)
Usage firm type [filename]
Option [filename]= path and name of the file you want to read
Syntax firm type[drive type][drive letter or token]:[path][filename]
Example To see the contents of a file called disk32.txt, type
firm type fc:\diskfiles\data\disk32.txt
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copy Function Copies a file from one directory to another.
Usage firm copy [source file][destination file] 
Options
[source file]=path and filename to be copied
[destination file]=location path and filename file will be copied to
Syntax firm copy [drive type][drive letter or 
token]:[path][filename]
Examples 
To copy an autoexec.bat file from DOS drive C: to the BootWorks partition, type
firm copy dc:\autoexec.bat auto:\autoexec.bat 
To copy backup files from the production partition to the BootWorks partition, 
type
firm copy prod:\backup.lst auto:\backup.lst 
To backup an autoexec.bat file on FIRM drive c: to FIRM drive c:, type
firm copy fc:\autoexec.bat fc:\autoexec.old 
To copy an autoexec.bat file from DOS drive c: to FIRM drive c:, type
firm copy dc:\autoexec.bat fc:\autoexec.bat 

dir Function Displays file and directory lists.
Usage firm dir [directory]
Option [directory]=directory letter or path
Syntax firm dir [drive type][drive letter or 
token]:[path] 
Don’t include a filename or you will get an error. The drive type is optional.
Examples 
To see a list of directories and files in the BootWorks directory, type
firm dir w:\ 
or, type
firm dir auto:\ 
(This shows the same results as dos: dir c:\ when running in BootWorks.)
When you are in the BootWorks partition, you can get a list of the contents of the 
TEMP directory on DOS drive c: by typing
firm dir auto:\temp
To see a list of files and directories in the Windows system directory, type
firm dir prod:\windows\system 

delete Function Deletes a file.
Usage firm delete [filename]
Option [filename]=path & name of file to delete
Syntax firm delete [drive type][drive letter or 
token]:[path][filename]
Always use the full path when deleting a file. You can also use tokens.
Examples 
To delete the autoexec file from your BootWorks partition, type
firm delete auto:\autoexec.old
To delete the file “foo.txt” from a directory on DOS drive d:, type
firm delete dd:\mydir\foo.txt
To delete the autoexec file from FIRM drive e:, type
firm delete fe:\autoexec.bat

FIRM Modes and Switches (Continued)

Mode Options
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backupreg Function Backs up registry files.
Usage firm backupreg [dest file][local path]
Options 
-noprofile Backs up default registries without the user profiles.
[destination file]=destination filename (must be a DOS filename)
[local path]=local path to registry files (source)
(Default source path for Win NT/2000 is c:\winnt\system32\config. Default for 
Win 95/98 is c:\windows). If files are stored in the default location, you don’t 
need to enter the path.
Syntax firm backupreg [destination path and filename] 
[drive letter or token]:[local path]
Include the complete path.
Examples
To back up registries without user profiles to c:\regback.lst, type
firm backupreg c:\regback.lst -noprofile
To back up registries from FIRM drive e: to regback.lst, type
firm backupreg c:\regback.lst e:\winnt 

restorereg Function Restores registry files.
Usage firm restorereg [source file] [local path]
Options
[source file]=source filename (must be a DOS filename)
[local path]=local path to registry files
(Default source path for Win NT/2000 is c:\winnt\system32\config. Default for 
Win 95/98 is c:\windows. If files are stored in the default location, you don’t need 
to enter the path.)
Syntax firm restorereg [source path and filename][drive 
letter or token]:[local path]
Include the complete path.
Examples 
To restore registries from c:\regback.lst to default location, type
firm restorereg c:\regback.lst
To restore registries from c:\regback.lst to e:\winnt
firm restorereg c:\regback.lst e:\winnt 

FIRM Modes and Switches (Continued)

Mode Options
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Troubleshooting RapiDeploy
If you an encounter an error, the event is recorded in the rd.log file (a text file located in the 
RapiDeploy application folder). View the log file for details about your error and information that 
can help you solve the error.

backuplist Function Backs up a set of files.
Usage firm backuplist [destination file] [list file]
Options
[destination file]=destination filename (must be a DOS filename)
[list file]=filename containing a list of files to back up (source) 
Must be in a DOS text/ascii file format. 
Syntax firm backuplist [destination path and 
filename][list filename] 
Include the full path.
Example 
To back up the files in c:\backup.lst and store them in c:\backup.txt, type
firm backuplist c:\backup.txt c:\backup.lst
The backup.lst file might contain the following:
c:\autoexec.bat
c:\config.sys
prod:\windows\command\format.com 

restorelist Function Restores a set of files.
Usage firm restorelist [source file][logical drive]
Options
[source file]=source filename (must be a DOS filename) 
[logical drive]= drive letter to overwrite default logical drive 
Default logical drive = PROD:\
Syntax firm restorelist [source path and filename][logical 
drive letter] 
Include the complete path.
Example 
To restore backup files to DOS drive c:, type
firm restorelist dc:\backup.txt

FIRM Modes and Switches (Continued)

Mode Options
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